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Logical Topology for ISE labs
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ISE v1.1 is connected to the network behind Router1 and has IP address of
172.31.1.20. Default gateway should be set to R1.
Management access to ISE should be allowed from WinXP PC (10.1.10.50).
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LAB 3.1. ISE Installation (optional)

Obijectives
This lab introduces Identity Service Engine v1.1 and verifies basic connectivity
with other network elements.

IP_Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 Lo0 1.1.1.1/32
EO/0 10.1.10.1/24
EON 172.31.1.1/24
R2 Lo0 2.22.2/32
E0/D 100.2.2.2/24
WinXP NIC 10.1.10.50/24

This is an optional task. If the ISE is already pre-installed, you can go directly

to next task.

Task
Perform ISE installation and bootstrapping. Provide the following information
during the installation process:
* Hostname: ISE
* IP Address and mask: 172.31.1.20/24
+ Default gateway: 172.31.1.1

+ Domain name and nameserver: micronics.local, 172.31.1.200
+ NTP server and timezone: 172.31.1.200, UTC
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Configuration
Complete these steps:

Step 1 Log into the ISE Virtual Appliance console (if you have access to it).
You should see the following prompt:

e e e e ok ke e e ke ok ol ol e ke ol ol ke ol ol ol ol ol ol ol o o e ke e e e e e ke ke ol ol ol ol ol ol o e ke ol e

Plaase type ‘setup’ to configure the appliance

FhEF T A A A A h bbb r b rr bbb bbb hhdrddd

lecalhoat login:

Enter setup as a username to start configuration wizard.

Step 2 Go through the configuration wizard.

Preass '‘Ctrl-C’ to abort setup

Enter hostname([]: ise

Enter IPF address []J: 172.31.1.20

Enter IPF default netmask[]: 255.255.255.0
Enter IP default gateway([]: 172.31.1.1
Enter default DHE domain[]: microniecs.leocal
Enter Primary nameserver([]: 172.31.1.200
Add secondary nameserver? ¥/H [N]: <enter>
Enter Primary NIF server[time.nist.gov]: 172.31.1.1
Add another NTP server? Y/N [H]: <enter>
Enter system timezone[UTC]: <enter>

Entar username[admin]: <sntar>

Enter password: Micronicsl

Enter password again: Microniosl

Bringing up network interface...

Finging the gateway...

Pinging the primary nameserver ...

Virtual machine detected, configuring VMware tools...
Do not use '‘Ctrl-C' from this point on...

Appliance is configured Installing applications...
Installing ise ...

The mode has been set to licensed.

Step 3 ISE installation. Provide passwords for ISE databased during

installation.

Application bundle (isa) installed successfully
=== Initial Satup for Application: ise =——
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Welcoma to the ISE initial setup. The purpose of this setup is
to provision the internal ISE database. This setup requires
you create a database administrator password and also create a
database user password.

Please follow the prompts below to create the database
administrator password.

Enter new database admin password: Micronicsl234

Confirm new database admin password: Micronicsl234
SBuccessfully created database administrator password.

Please follow the prompts below to create the data base user
password:

Enter new datahase user password: Microniosl23d

Confirm new Database user password: Micronicsl23d
Succassfully created databasse usar password.

Running database cloning script...

Funning database network config assistant teol...

Extracting ISE database content...

Starting ISE database processes...

Creating ISE M&iT session directory...

Performing ISE database priming...

Generating cenfiguration...

Verification

Connect to ISE using SSH and provide username/password of admin/Micronics1.
Check and note the following:

* |ISE application version

* |ISE daemon status

* Interface configuration

* Routing table (with default gateway)

* Clock configuration

* Timezone configuration

Connect to the GUI from WinXP desktop and check license and ISE deployment
options.
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Run Putty and connect using SSH to IP address of 172.31.1.20

Verify that ISE is installed properly

Cisoo ISE is an application installed on underlying operating system called Cisco ADE.

Cnos you're connected te ADE you must check what applications are installed. Then you

can use application name (in our case ‘isae)

ISE/admink show application

in all other commands.

Ty A <Dascriptien>
ise Cisco Identity Services Engine
ISE/admin$

Check ISE version

ISE/adminl show application version ise

Cisco Identity Services Engine

Version : 1.1.0.685
Fuild Date : Wed Mar T 22:51:03 2012
Install Date : Wed Jan 2 17:12:33 2013

The main wversion is 1.1 and the patech

development stage. By default ISE is

| K1

preduction license or use evaluation license.

file for ISE to ba working.

Check status of ISE processes

ISE/admind show application status ise

ISE Database listener is running, FID: 4166
ISE Database is running, number of processe

laval

in EVAL mode for 50

8: 26

ISE Application Server is running, FID: 5694
ISE MAT Session Database is running, FID: 3828

ISE MAT Log Cellector is running, FID: 5521
ISE MAT Log Processor is running, FID: 6005
ISE MET Alert Frocess is running, FID: 5840

665, The build depends on the

days. Yo can install

Tou de not need to provide any license

% WARNING: ISE DISK SIZE HOT LARGE ENOUGH FOR FRODUCTION USE
% RECOMMENDED DISK SIEE: 200 GE, CURRENT DISK SIEE: 64 GB
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If there is cother status than ‘is running’ it means theres something wrong with a
particular ISE subsystem/process. To fix that you can try bto restart ISE application
using ‘application step ise’ and then ‘application start ise’. Be patient as it may

take A whilea to atart All TSE procassss.

Check interface configuration and verify IP address and netmask

ISE/adminl show interface
GigabitEthernet 0
Link encap:Ethernet HWaddr 00:50:56:AE:Al:34

inet addr:172.31.1 20 Boast:172.31.1.255 Mask:255.255 255.0
inets addr: fefl::2850:56ff:feae:al3d/64 Scope:Link
UF BROADCAST RUOMNING MULTICAST MTU:1500 Metric:1
PX packets:T70870 errcrs:0 dropped:0 overruns:0 frame:0
TX packets:30676 errors:0 dropped:0 overruns:0 carrier:0
eollisions: 0 txgqueuelen :1000
RY bytes:8304352 (7.5 MiB) TX bytes:15521115 (15.1 MiB)
Interrupt: 59 Base address:Ox2024

1a Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
ineté addr: ::1/128 Scopa:Host
UF LOOFEACK RUNNING MTU:16436 Metric:1
RY packets: 29034318 errors:0 dropped:0 overruns:0 frame:D
TE packets:259034318 errors:0 dropped:0 cverruns:0 carrier:0
collisions:0 txquenelen:
BY bytes:501930492 (478.6 MiB) TX bytes:5015930452 (478.6 MiBE)

it Link encap:IPvé-in-IPwvd
WOARRF MIU:1480 HMetric:l
REX packets:0 arrors:0 dropped:0 overruns:0 frams:0
TX packets:0 errors:0 dropped:0 overruns:0 carrier:0
ocollisions:0 txqueuelan:0
BX bytes:0 (0.0 b) TE bytas:0 (0.0 b)

Make sure that you see BX and TX packets and no error counters increasing. This is the
first indicatoer that something can bes wrong with oconnectivity. If you do not see
GigabitEhernat0 interface that usually means the interface is down.

You may see more interfaces depending on ISE installation. Some interfaces may be used

for proafiling sarvioss.

Check routing table and default gateway
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ISE/admin# shew ip route
FKarnel IP routing table

Dastination Gatawan (Rarima sk Flags Matric Farl Use Iface
172.31.1.0 0.0.0.0 2B5 . 2B5 . 255.0 u o o 0 athd
0.0.0.0 i72.3.1.1 0.0.0.0 ug ] ] 0 athd

Kote that there is still interface ‘ethl’' in the command cutput. This interface is a

pointar to GigabitEthermnet0.

Check basic connectivity to the gateway and to other network elements

ISE/admind ping 172.51.1.1

PING 172.31.1.1 (172.31.1.1) 56(84) bytes of data.

64 bytes from 172.31.1.1: icmp segel ttl=255 time=0.853 ms
64 bytes from 172.31.1.1: icmp seg=2 ttl=255 time=0.810 ms
64 bytes frem 172.31.1.1: iemp sage3 ttl=255 timew=0.776 ma
64 bytes from 172.31.1.1: icmp seg=4 ttl=255 time=0.886 ms

-—-172.31.1.1 ping statistics ——-
4 packets transmitted, 4 received, 0% packet loss, time 3003ms
rtt min/avg/max/mdev = 0.776/0.831/0.886/0. 046 ms

ISE/admin$ ping 10.1.10.10
PING 10.1.10.10 {10.1.10.10) 56(84) bytes of data.

64 bytes from 10.1.10.10: icmp seqel ttle254 time=67.5
64 bytes from 10.1.10.10: icmp seq=2 ttl=254 time=1.17
64 bytes from 10.1.10.10: icmp_seqe3 ttl=254 time=15.3
84 bytes from 10.1.10.10: icmp seq=4 ttl=254 time=57.0

=== 10.1.10.10 ping statistics -——--
4 packets transmitted, 4 recaived, 0% packet loss, time 3001ms
rtt min/avg/max/mdev = 1.172/35.622/67.910/27.663 ms

Teu may noet reach ASa firewall at this stage. If net, check if ASA has static route te

172.31.1.0/24 network configured

ISE/admin# ping 10.1.10.50

FING 10.1.10.50 (10.1.10.50) 56(84) bytes of data.

64 bytas from 10.1.10.50: iomp seqgel ttl=127 times=0.262 ma
64 bytes from 10.1.10.80: icmp seqg=2 ttl=127 time=0.50% ms
64 bytes from 10.1.10.50: icmp saqe3 ttl=l27 time=l.00 ms
64 bytes froem 10.1.10.50: icmp seged ttl=127 time=0.856 ms

=== 10.1.10.50 ping statistics ---
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4 packets transmitted, 4 received, 0% packet loss, time 3002Zms
rtt min/favg/max/mdey = 0,.862/0.517/1.004/0. 084 ms

Check the name server and domain configuration. Verify if DNS works asking to
resolve FQDN of ise.micronics.local

ISE/admin# shew running-ecenfig | ine name

hostname ISE

ip domain-name micronics.local
ip nams-server 172_31.1.200
username admin password hash $15pAzQ9DDOSzWEHIRgMEmMIm1EZPELRhOY]l role admin

no-username

ISE/admin# ping 172.31.1.200

PING 172.31.1

200 (172.31.1.

64 bytes from 172.31.1.200:
64 bytes from 1T72.31.1.200:

64 bytes from
64 bytes from

172.31.1.200:
172.31.1.200:

200) 56(84) bytes of data.

icmp_segel ttl=128 time=l.345
iomp seqe? ttle=128 time=l. 5348
icnp seqe3 ttl=128 times0.382
icmp_seq=4 ttl=128 time=0.417

=== 172.31.1.200 ping statistics ---
4 packets transmitted, 4 received, 0% packet loss, tims 3003ms
rtt min/avg/max/mdev = 0.345/0.373/0.417/0.02% ms

ISE/admin# nslockup ise.micronics.local
Teying "ise mioronics.local"™

;¢ =»PHEADER<<- cpcode: QUERY, status: WOERROR, id: 47870

i+ flags: gr aa rd ra; QUERY:

ii QUEETION SECTION:
;ise.micronics.local.

/¢ AHSWER SECTION:

ise.micronics

lecal. 3600

1, ANMSWER: 1, AUTHORITY: 0O,

IN BANY

ADDITIONMAL: 0O

IH A 172.31.1.20

Racaived 53 bytes from 172.31.1.200#53 in 1 ms

Check clock and timezone configuration

ISE/admind show alock

Fri Jan 18 14

:02:13 Urc 2013

I3E/admin# show timezone

orc

If there is a different timezone configured you can always change

value using

‘alock timszons UTC' ocommand in the global

timazone names are available usa ‘show timezones’' command

configurtion.

Te check

it to tha correct

what

Page 16 of 507



CCIE SECURTY v4 Lab Worlkdb ook

ISE/admin# show ntp
Configured HTP Sarvers:
172.31.1.1

Unable te talk to NTP dasmon. Is it running?

% To restart NTF do 'no ntp server' followed by 'ntp server <servernamsa'

If you experience the above issue try to reapply the WTP server configuration.

ISE/admin¥ conf t

Enter configuration commands, one per line. End with CHTL/E.
ISE/admin(configl# ntp server 172.31.1.1

ISE/admin(config)§ and

RTF synchronization is wvery important espacially when ISE is a part of Active Directory
domain. If yeu plan te jein AD then cleck between Domain Centreller and ISE must be
synchroniged. The NTF related issues are causing most problems with AD integration.

Teu can alse check appliecatien legs when syneing with WTP.

Hote that ISE may not synchronize with a solirce that is not reliable (the sSource gets

time from its local aloak) .

I8E/admind show ntp
Configured NTF Servers:
172.31.1.1

ungyneheonl sed
time Server re-starting

polling sarver avery 64 =

Famate rafid gt & whan pall reach delsy offset jitkar
127.127.1.0 . LOCL. w1l 3 64 1 0.000 0.000  0.001
172.31.1.1 LOCKL{1) fu 2 B4 1  0.9%0 -0.146 0.001

* Current timeé scurce, + Candidate

Warning: Output results may conflict during paricds of changing synchronization.

<aftar a whila>

ISE/admink shew ntp
Configured NTF Sarvars:
17z2.31.1.1

synohronisad to HTF server (172.31.1.1) at stratum 8
time correct to within 944 ms

polling searver every 64 =

Femate rafid st t when poll reach delay offset Jitter

i2v.127.1.0 + LOCL. Wl 20 &4 77 0. 000 0.000 0.001
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*172.31.1.1 LOCAL{L) 8w 26 64 77 Q.778 0.357 0.529
* Current time scurce, + Camdidate

Warning: Cutput results may conflict during paricds of changing synchronization.

Connect through the GUI and check license. Open up web browser (IE or FF) and
enter the following URL https:/172.31.1.20
+ Authenticate as adminMicronics1.

D it Vea Hpoy Droioeis Ieh oo
| ety arvioes Ergi

lit=l

{*_h sy 172 30,0 3 ok B Fai |

B Ikentby Saervsces Engme
%4

l Usrragra | aChran |
I. 3 } Prdl .ﬂ'||‘Hf'1‘ _-
i < >

o) Pusreratey e

] e fypeelie, Do Sies Banen wad D Srmasn ks o At s o e Sl ke
elbeer M B e L o o e ek PR T

* You may see the following message while connecting to the ISE for the first time.

0 ISE Evalastion Copy

The Cioa Identiéy Service= Engine [[SE] can be porchesed onby Hrough Csoo Authorired Technology
Prowider [ETP] pwbrer= &0 Buthoied Technologey Prosider = & patner thed bas compleded 155 ATR
frairn ), demonsirated separt kasts of advanoed tad-noiogy Lnderstanding via the submissions of High-Lawal
D gres [HLDY) and has redlaoly mara gaed sucoessful deplosmants of Ckco Seouity badwology. Plaasa contact
your iocal oo sales raprasentative or Ceco Cartiied Channel Partren or mplementation ssshiaroe.

I Do ik st Bhis e 6554 00 S3ain

el

» Pick Do not show this message again and then click OK.
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Check the deployment mode by selecting ise on the top right of the current window.
To check license you must go to Administration -> System -> Li

=

ok Beron | B [dony Waragorort [ Plobark Rastumos

| wereng VG LOQED Ml

CANTEI Liies
Ligprus (perations

& ClsHE Laraes

68, ot M

s Aabvas tration. Mg, Bobcy Seeeor (60
Pk SEATAINE
Sratary Tirme W 311 20EF 12: 1581 FHWID
FIF Vool [Hrahing

Ednekwationfiode o I

Veeson Ienbfer (WIDT | BeeThoe | Bokie
L I

N i

[

Al i 20 4 D@0 | 54 Hoicstors )
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LAB 3.2. Generate and install a certificate

Obijectives
This lab shows how to import a certificate to ISE.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
E0M 172.31.1.1/24
WinXP NIC 10.1.10.50/24

Task
Create CSR (Certificate Signig Request) on ISE and send it to Microsoft CA to
issue a certificate. The CSR should have the following information:
* RSA key length: 2048
* Hashing: SHA-1
= X.509 Distinguished Name (DN):
=  Common name: ise.micronics.local
= Onmganizational Unit: lab
=  Company: Micronics
= Country: US
= State: CA

The certificate must be usable for management and EAP methods. Use Microsoft
CA server at hitp://ca_.micronics. local/certsrv to issue a certificate. To access the

server use caadmin/Micronics1 user credentials.
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Configuration

Complete these steps:
Step 1 Get CA Certificate and import it on ISE.

-

Open up web browser (IE preferred) and go to
hitp://ca.micronics.local/certsrv o Download a CA certificate,

certificate chain, or CRL. To access the server use
caadmin/Micronics1 user credentials.

Alcrmnit Certicain Seracsn -~ co.mermnics loca

Lz this Yl Site o recp eaTa cenlficate Torywour Wb browser, eomal dient, or ot program. By using & cartific abe, you can varily
your idemity bo peop e you communicate vath cwer the Wisb, =ign end encrypt messages, and, depanding upon the bype of
CErACate you recpssl, parom other Secunty 13 sks

i o ks it thin Wel Site o dosmkoad o cortific ae autferity [CA) cantiicats, caificals chain, of Cermifcats maddation §st
CLRLL O view e SDE00s Of & pervdind reduest

Formare information about Ceificas Ssnaces, =es Ceibificats Senoes Cocymsnbation

Eploot o task:

| Wi the Slalus of q perching corfificals et
| [owripade Ca cerifipate, cerficele chair or CF)

Click on Download CA certificate link and save the file as ca-
cert.cer
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B Herranit Cosificate Serenes - Seenselt Inbermst Epplnres

Bl B B Fpewies ook e

Qe - 0 - [x] 3] | J s o @ (21004 B

D | T e — TS S——

Alicrmeall Cartiie srArEr -~ £ ruicronien e

Downtoad a C& Certificate, Certificate Chain, orCRL

T wust cetificabes issied from tis cerifical on autharnity, (naial dhis ©& camitvats chain

To downicad & CA cemilicale, cemiicata chain, of CRL, selech the cenfcate and encoding method

O corificat:
| Euroct [camicoecelaal) |

Enading metlsnl:
# DER
I Bese B4
Dorwmingd A corificate
Dol g bapieest bers CRL
civenin g lafast cetla CF

[y Iramat

*  Go to|ISE Administration > System > Certificates > Certificate
Authority Certificates and click Import. Select ca-cert.cer file and
pick trust for client authentication checkbox. Click Submit.

e [ pew Hglwy  osteariy Rl b

190 - P < o T -

Ay

alsiilis
CISED @ty Seevices dane

% Geen & penn Hevgeran [ Betedh e[S Gt Smisgaent
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Step 2 Create CSR on ISE.
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Go to ISE Administration > System > Certificates > Local
Certificates, click Add > Generate Certificate Signing Request and

provide Certificate Subject in the comect DN format. Also, pick SHA-
1 for Digest to Sign With.
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Once CSR is generated, pick it from the list and click Export Save it
to the file or open directly in Wordpad.
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Once opened, copy all text to the clipboard.
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Open up web browser (IE preferred) and go to
http://ca. micronics.local/certsrv to Request a certificate.
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Select a task:

Click advanced certificate request.

Page 24 of 507



CCIE SECURTY v4 Lab Worlkdb ook

Eie Elt S Feeoies  Took  Heln

|
e bbb | &
= . a -
e - ) - [x] (F] ] Sl e @ (2400 CE B _
_mm|ﬂw-n-‘_m.qu.u...u...... - j-_.'u [as =
=
il Aberecall Cartitenis Sprarsr - 23 meranien e
| Request a Cetificate
| Sakst he catilicala bype
Igar Cariicele
| o, Bubrn £ an pokvancesd cenificaa ra gues
i e =l
| @ irimal :

* Click Submit a certificate request by using a base-64-encoded
CMC or PKCS #10 file, or submit a renewal request by using a
base-64-encoded PKCS #7 file link.
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Paste the CSR from the clipboard to Base-64-encoded certificate
request field, chose Web Server as Certificate Template and click

Page 25 of 507



CCIE SECURTY v4 Lab Worlkdb ook

Submit =.

B B B Feodes Dok ben

af

3 ] s o B E B

borsivartrrie s s

Acrmrafl Cartficnts Senices - camemones o

Submet a Certficate Request or Renewal Reguest

| Tiosaibardt 8 sapwed] racyueet fo the C A, peste g baga b encoded ChiC or FHCE #10 ceificate recues or PHICS T renewsl
| request generated by an esternal sauroe {much as & Web serer] in e Saved Request boc

| Sauid Rogeost
(B larkkc I OWESYIHplickp iz IiclowdpldDSias :I
| Baséblanidad ) cminEr e 19ht I KRS A~ AToF FREN+REY

§ carficats reque e TIn T U Mo PR D IFE ] 1o i dus
| o

o=
PECS®D ar CERTIFICATE BEQREST-
PECS#T -
' T :
Birvans o & ks i inperi
| Ceridicain Tomglais
| Additin al friliies

Slrbiglis |.| :
Eubimil :-]

B | L2

' rina

Click on Download certificate with DER encoded option. Save it to
ise-cert.cer file.
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Go to ISE Administration > System > Certificates > Local
Certificates, click Add > Bind CA Signed Certificate and provide
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Verification
Restart the web browser and check if ISE provides new certificate to the client.

-

ise-cert.cer file. Enter a Friendly Name e.g. CA-signed Identity
Certificate, pick options EAP and Management Interface and click
Submit.
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Certificate should be imported successfuly and ISE should be
restarted. You will be disconnected from the GUI. Try to reconnect
after a while. Meanwhile you can check show application status ise

command output to see the ISE restarting.
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LAB 3.3. Administrative access to ISE

Objectives

This lab shows how to setup an administrative access to ISE.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
E0M 172.31.1.1/24
WinXP NIC 10.1.10.50/24

Task

Configure the following settings for administrative access to the ISE:

o

o

Access is allowed from the WinXP management station only
Idle session timeout set to 30 minutes

Create helpdesk administrative user with a password of Help123 and access
to Operations menu only. You can use pre-configured user settings.
Set the following password policy for all accounts created on the ISE:

u]

o]

u]

Minimum password length is 6 characters

Password must not contain the admin name nor words like 'cisco’ and ‘test’
Password must contain at least one lowercase alphabetic character and one
numeric character

The admin account should not be disabled automatically

Page 29 of 507



CCIE SECURTY v4 Lab Worlkdb ook

Configuration
Complete these steps:
Step 1 Limit the administrative access to ISE from management workstation
only.
* Go to Administration > System > Admin Access > Settings >

Access and click Allow only listed IP addresses to connect. Then
click Add and provide the following settings. Then click OK.
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* Click Submit.
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Go to Administration > System > Admin Access > Settings >
Session Timeout and set it to 30 minutes. Click Save.
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Step 2 Create helpdesk user.

Go to Administration > System > Admin Access > Administrators
> Admin Users and click Add > Create an Admin User. Provide
Name, password and select Helpdesk Admin for Admin Groups.
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Click Submit.
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Step 3 Set up password policy.
* Go to Administration > System > Admin Access > Authentication
> Password Policy (tab). Change all required options as shown
below. Click Save.
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Verification

Logout and re-login using helpdesk user. Check if you have access to the
required options.
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Hote the helpdesk usernames in the top right comer. Only Operations

manu is available.
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LAB 3.4. Integration with Active Directroy

Obijectives
This lab shows how to integrate |SE with Microsoft Active Directory.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
E0/M 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24

Task
Configure ISE to join Active Directory domain of micronics.local. Use AD
user credentials of employee1/Micronics1 to join the domain. Import the
following groups from AD to the ISE:

o micronics.local/U sers/contractors
o micronics.local/Users/femployees
o micronics.local/Users/students
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Configuration
Complete these steps:
Step 1 Join the Active Directory domain.
* Go to Administration > Identity Management > External Identity
Sources > Active Directory and provide micronics.local as Domain
Name. Leave the default Identity Store Name.
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+ Click on Save Changes to save the changes. There will be a new
entry on the domain list Pick the checkbox and click Test
Connection > Basic Test. Provide username and password and click
OK.
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= Click Close and get back to the domain list. Click Join and provide
credentials for employeel user. Click OK.

* You should get the following success message. Click Close.
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Now the Status indicates the ISE joined the AD domain.
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Step 2

Import AD groups into ISE.
Go to Groups tab and click Add > Select Groups From Directory.

Click Retrive Groups to list all groups from AD. Select those three to
import them and click OK.
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Verification
There is no verification for that task.
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LAB 3.5. Configure ISE for MAB

Objectives

This lab shows how to configure MAC Authentication Bypass on switch and
use |SE as Autorization Server.

IP_Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 Lo0 1.1.1.1/32
E0/0 10.1.10.1/24
EOA 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24

Task

There is a Windows 7 host connected to SW1 port 0/7 through the IP Phone.
Configure the switch to authenticate IP Phone basing on its MAC address. The
Voice domain should be authorized to Vioice VLAN (VWVLAN). You may use
static policy assignment to preconfigured policy on the ISE.

Enable RADIUS authentication, authorization and accounting to the ISE ports
UDP/M812, UDP/1813 with a secret key of cisco123 sourcing the RADIUS
packets from vlan10 interface. Also, enable RADIUS Change of Authorization
(CoA) using the same credentials as for AAA. Configure two Network Devices
Groups based on Device Type: Wireless and Wired. Add SW1 to the Wired
NDG. You can enable EPM logging for verification.
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Configuration

Complete these steps:
Step 1 Configure SW1 for 802.1x

naw=model

authentication dotlx default group radius
authorization network default group radius
ascounting dotlx default start-step group radius
sarver radius dynamic-auther

alisnt 172.31.1.20 server-key 0 ciscolZ3

!

radius-server host 172.31.1.20 auth-port 1812 acct-port 1813
radius-server key ciscelf3

radius-server attribute § on-for-login-auth
radius-server attribute & include-in-access-req

ip radius source-interface vlan 10

FiEiE™

dotlx system-auth-control

!
interface FastEthernet0,7
desaription IFF + WinT7

switchpert access vlan 10
switchport mode access

switchpert veica vlan 500
authentication host-mode multi-domain
authentication crder mab dotlx
authentication priority dotlx mab
authentication port=-control auto
mab

dotlx pas authentiocator
spanning-tres portfast

!
epm logging

!

Step 2 Configure NDGs on ISE.

Go to Administration > Network Resources > Network Device
Groups > Groups > All Device Types and click Add. Enter Wired as
name and click Submit
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= Go to Administration > Network Resources > Network Device
Groups > Groups > All Device Types and click Add. Enter Wireless
as name and click Submit
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Step 3 Add SW1 as AAA client.

* Go to Administration > Network Resources > Network Devices
and click Add. Enter SW1 as name, provide |P address of SW1's
vlan10 interface, assign it to Wired Device Type, set Shared Secret
and click Submit.
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Step 4 Add IP Phone MAC address to ISE Endpoins Identity store.

-

Bounce switch port to restart authentication.

BW1 {config) #int £0/7

EWL (conf ig-if) #shut

*Mar 1 16:37:39.779: SLINK-5-CHANGED: Interface FastEthernet0/7,
changed state to administratiwvely down

Wl (config-if) #no shut

EWL [config-if) #

SLINK-3-UFDOWH: Interface FastEthernet0/7, changed state to up
YAUTHMGR ~=5=START: Starting 'mab' for client (0021.a084 . 6£ffd) on
Interface Fald/7 Audit3essionID OAD1O0ADTOO00000S03320ART
EMAB-5-FAIL: Authentication failed for client (0021.a084_ 6£f4) on
Interface Fal/7 AuditSsssionID OROLOAROTOO00000903920RET

SAUTHMGR -T-RESULT: Authentication result 'no-response’ from 'mab' for
aclient [(0021.a084.6ffd) on Interface Fal/7T AuditSessionID
OADLOADT 000000 0035 20ART

SAUTHMGR ~-T-FAILOVER: Failing ower from 'mab' for olisnt
(0021.a084.66€4) on Interface Fal/7 AuditSessionID

OAD1O0ADT 00000002035 20AET

FAUTHMGR -5-START: Starting 'dotlx' for clisnt (0021.a084.6ff4) on
Interface Fad/7 AuditSessionlD OADL1OADT 0000000903 920AB7T
SLIMEFROTO-5-UPDOWN : Line protocol on Interface FastEthernst0/7,
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changed state to up

Mote MAC address of IP Phone connected to the port.

2Wl¥sh mac address-table interface £0/7
Mas Address Tabla

Vian HMac Address Type Forts
i0 0015, 17a7. 2497 STATIC Drop
500 0021.a084. 6E£4 ETATIC Drop

Total Mas Addresses for this ariterion: 2

Go to Administration > Identity Management > Identities >
Endpoints and click Add. Enter MAC Address of IP Phone, select
Policy Assignment as preconfigured Cisco-IP-Phone, select
Identity Group Assignment as preconfigured Cisco-IP-Phone and
click Submit
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Verification

Bounce the switch port to restart authentication. You should see what's
happeing when ‘epm logging’ is enabled.

sWl#shew authentication sessions interface £0/7
Ho Ruth Manager contexts currently exist

ff this indicates that dotlx process is not working. Tou must bounce the port

to restart authentication.

EWl#conf t

Enter configuration commands, one per line. End with CNWTL/E.

SW1(config) #int £0/7

W1 (config-if ) #shut

SW1 (config=if)#

YL INKE-5-CHANGED: Interface FastEthernet0/7, changed state teo administratively deown
SW1 (config-if)#nc shut

SW1{config-if ) #end

sWld

SLINK-3-UFDOWH: Interface FastEthernet0/7, changed state to up
SAUTHMER-5-START: Starting "mab' for alient (0021.a084.6ffd) on Interface Fald/7
AuditSessionID OADLOADTOOO00O0EDISTECE4
WMAR-5~SUCCESS: Authentication sucocessful for alient (0021 .a084.6ff4) on Interface
Fal0/7 AuditSessienID OAOLOADTOO00000ED3STECZ4
RAUTHMGR-T-RESULT: Authentication result 'sucocess' from 'mab’ for alient
(0021.a084.6f£f4) on Interface Fald/7 AuditSessionID OAOLOADTOOO0OOOEDISTECZ4
%L INEFPROTO-5-UFDOWH: Line protocol on Interface FastEthernet0/7, changed state to up
SAUTHMER-5-SUCCESS: Authorizaticn succeeded for client (0021.a084.6ff4) on Interface
Fal/7 AuditSessionID OROLOADTOO00000ED39TECZY
aWig
EWllishow authentication sessions interface £0/7
Interface: FastEtherneto/7T
MAC Address: 0021.a084.8££4
IF Rddress: Unknown
Uger-Hams: 00-21-A0-84-6F-F4
Btatus: Authz Sucocess
Domain: VOICE
Cper host mode: multi-domain
Oper contrel dir: beth
Aathorized By: Authentication Server
Session timecut: HW/A
Idle timsocut: MHW/A
Common Session ID: OROLOROTOOOOO00OEQNISTECEL
Aoct Session ID: Ow00000011
Handle: Ox2300000E

Funnable methods list:
Hethod State
mab Autho Success
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dotlx Kot run

f/ note that MAC address is used as a username for MAB. You can check that in
RADIUE logs if ‘debug radius' is enabled. Alse note that the autheticatien has
passed for VOICE domain. You may see Authe Failed for UNFNOWN or DATA domain if
multi-domain authentication is enabled.

Check ISE logs.
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Check ISE configuration to see how the above authentication works.

1. Authentication.
The Authentication policy has two rules by default. There is a rule for MAB
clients and Wired 802.1x clients.
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How does ISE know the type of authentication?
Move the mouse pointer onto Wired_MAB condition and click a special
pointer sign when appears. The rule details will show up.

35 - et e ok a il - e PO b - il
Be Bl Sew Mgy Qedoasds fak bep
|:__|x B bargestion - b e TR b ol H;l

L TR el o T e

As you see |SE recognizes to connection type based on two RADIUS
attributes. In this particular case Service-Type = 10 (Call Check) and
NAS-Port = 156 (Ethernet).

If the connection match that rule, theldentity Store used for
authentication is Internal Endpoints.
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2. Authorization.
ISE check Authorization rules. There are two default rules:

+ Profiled Cisco IP Phone

* Default
The first rule matches IP Phone connection and provides RADIUS
attributes specified in Cisco_IP_Phones authorization profile to the
switch.

Ba EE 3= oy fpsdeacs Bek o

|+

larem @ 200 5 @0

What is authorization profile?

When you go to Policy > Policy Elements > Results > Authorization >

Authorization Profiles > Cisco_IP_Phones you'll see what RADIUS
attributes are set. In this particular case there are two attributes
configured:

= DACL Name = PERMIT_ALL_TRAFFIC

* Voice Domain Permission

The DACL is there to authorize the device to access specific

resources. There must be RADIUS network authorization enabled to

download DACL by the switch.
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LAB 3.6. Configure MAC Whitelist

Obijectives
This lab shows how to configure MAC Whitelist on ISE to quickly authenticate
endpoints based on their MAC address.

IP_Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 Lo0 1.1.1.1/32
E0/0 10.1.10.1/24
EOA 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24

Task
Configure a rule on ISE to enforce authorization for all MAC addresses added
to the Whietlist group. This must work no matter what device is connecting to
the switch. Add IP Phone MAC address to the Whitelist group for verification.
Change the default authorization rule so that all devices will be denied if not
matched by any rule.
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Configuration
Complete these steps:
Step 1 Create whitelist group on ISE.
* (Go to Administration > ldentity Management > Groups > Endpoint
Identity Groups and click Add. Enter Whitelist as name and click
Submit.

¥ e a0 g O 0| £ Sobicason (8

Step 2 Create Authorization rule on ISE.
= Go to Policy > Authorization and click arrow next to Edit bution of
the first line. Chose Insert New Rule Above option.

B PoladieoP oo Ui I Phvan i P_Phores
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Enter name for the new rule e.g. Whitelist, click plus to add identity
condition and select Endpoint ldentity Groups > Whitelist.
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Click plus button to add additional compound conditions to the rule.
Select two conditions from the library Wired_802_1X OR
Wired_MAB.
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For Permissions select PermitAccess.
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* Click Edit button in the last (Default) rule. Change permissions to
DenyAccess.
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Click Done and Save to finish.
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Verification

Bounce the switch port to restart authentication.

sWl{config)#int £0/7
SWl{config-if)#shut
SW1({config-if)#no shut

SLINK-3-UPDOWH: Interface FastEthernet(/7, changed state to up

$LINEFROTO-5-UFDOWN: Line protocol on Interface FastEthernet(/7, changed state to up
SAUTHMGR-5-53TART: Starting "mab' for client (0021.a084.6ff4) on Interface Fal/7
RuditSegsionID OROLOROTO000001B04D2ZTASE

RMAB-5-8UCCESS: Authentication successful for client (0021.a084.6ff4d) on Interface
Fa(/7 AuditSessionID OROLOAOTOO000001E804D27458

RAUTHMGR=-T-RESULT: Authentication result "success'" from 'mab' for client
(0021.a084.6££4) on Interface Fad/7 RAuditSessionID OROLOAOTOOO000LE04D2ZT45B
RRAUTHMGR-3=SUCCESS: Authorization succeeded for client (0021.a084.6f£f4) on Interface
Fa(/7 RuditSessienID OROLOROTOO000001B804D2745B

Check what rule the connection was authorized by.

LT Erdeairt [ [P racidress Hiaiwirk Deracs  Deawicn Port Storieation Profle | [deiiy G
Teria » Stati Dot il ol il ki i L i i
Mow 22,12 Mm1In I P a FLANEHARF 0 ELA0EAFF 5H1 FartEthemet Pk tooeas Wit
Mow 22,12 DRI PH g DEDCETETAOAT  ONOCIRET 040 Ml Fag T
Mow Z51Z DL1HFn TP a 31 A S T 1 HF 51 FartEthermstiy Choo [P _Phaores Profiect ezo-P-Ph

ff Tha previous authorization (last line) was matched by Cis :ﬁ_IP_PILnnﬂ:’l Fule.

The latest authorizatien (first line) has been matched by Whitelist ruls.
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LAB 3.7. MAB with VLAN authorization

Obijectives
This lab shows how to configure VLAN authorization.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
E0/M 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24

Task
There is a Wireless Access Point connected to port O/3 on SW1. Enable MAB
on the switch port and authorize the AP to be part of VLAN 10. You should use
AP endpoint group to accomplish this task.
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Configuration

Complete these steps:
Step 1 SWI1 configuration.

!

interface FastEthernet0/3
authentication port-control auto
mab

L

Kote that just after configuring the port (or unshut the port) yeou'll
get the fellewing MAE failing messages. This is because there is no MAC
address in the ISE Endpoint Identity store yet.

SAUTHMGR -5-START: Starting 'mab' for client (cd7d.4£39 _B423) on
Interface Fad,/3 AuditSessionID OADLOAOTO0O0O0001AO0d FFL1IBE

MABR-5-FAIL: Authentication failed for client (cd7d4d.4£39.8423) on
Interface Fal/3 AuditSessionID OADLOAROTOO00001A04FFLIBE

YAUTHMGR -7T-RESULT: Authentication result 'no-response’' from ‘mab' for
client [cd7d. 4f39_8423) on Interface Fal/3 AuditSessienID

0A0 LOADTO000001A04FFLIBE

SADTHMGR ~T-FAILOVER : Failing owvar from 'mab' for alient
(cd7d.4£35.8423) on Interface Fal/3 auditSessionID

QRO LOAODT OOOOOO0LAD4FFLIRE

WAUTHMER -7 -HOMOREME THODS : Exhausted all authentication methoda for
client (cd7d. 4£f39.8423) on Interface Pald/3 AuditSessionIDh

OAD 10ADTO000001A04FFLIBE

YAUTHMGR -5-FAIL: Authorization failed for client (cd7d.4£39.B423) on

Interface Fal,/3 AuditSessionID OADLOROTO000001AO0MFFLIBE

Step 2 Create new authorization profile for AP.

Go to Policy > Policy Elements > Results > Authorization >
Authorization Profiles and click Add. Enter AP_VLAN_Assignment
as name, check VLAN opfion and set it to 10, and click Submit.
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Step 3 Create new endpoint group and assign AP to that group.
* (Go to Administration > Identity Management > Groups > Endpoint

Identity Groups and click Add. Enter AP as a name and click
Submit.
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* (Go to Administration > Identity Management > |dentities >
Endpoints and click Add. Enter AP MAC address taken from the
switch assign it to the AP group. Click Submit
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* Notice that the Endpoint Profile is Cisco-Device. This is because the
MAC address OUl was recognized as beloning to Cisco Systems.
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Step 4 Create new authorization rule for AP.
* (Go to Policy > Authorization and click arrow next to Edit button in
the first rule and chose Insert New Rule Below.
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Enter name for new rnule e.g. Access Points, select AP endopoint
group for conditions and assign AP_VLAN_Assignment authorization
profile for pemmissions. Click Done and Submit
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Verification

Check switch commands and logs.

SWliksh authentication sess int £0/3

Interface: FastEthernet0/3
MAC Rddress: od7d.4£3%.8423
IF Rddress: Unknown
User-Hame: Cd=TD-4F-35-84-23
Status: Aukthz Success
Domain: DATR
Opar host mode: single-host
Oper control dir: both
Authorized By: Authentication Server
¥lan Pelicy: 10
Session timeocut: HN/R
Idle timsout: MN/A
Commen Session ID: OROLOAOTOO00001AD4F F1IEE
Acct Session ID: O=00000027
Handle: OxBEBOOOOLA
Runnable metheods list:
Method State
mak: Ruthe Success
SWl#sh vlan id 10
VLAN Hame Status Forts
10 ASA-Inside active Gil/3, Gi0/6, Gi0/7, Gi0/Z24
VLAN Type SAID HTU Parent Ringlo BridgeMo Stp BrdgMode Transl Trans2

10 enet 100010 1500 = = - - = 1] [i]

Check ISE logs to see Authorization Profile and Identity Group.

— Ervipwan| 11 Ak Visbate | Dades Pt e Bijihmion Probie (e Gmp

it v Blale Dutakk

Mo 21z LHZEBER g CImEms 47T AF 3 B Bl AP VLAN_fesgrment aF

The AP should get an IP address from local DHCP server on SWA.

SWlish ip dhep binding
Bindings from all pools not associated with VRF:

IF address client-ID/ Lease expiration Type
Hardware address/
Uger name

10.1.10.101 Dlc4.7d4£.3984.23 Mar 03 1993 03:40 AM RAutomatic
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You should see the following AP initialization messages (if you have access to
AP’s console).

WCAFWAP-3-ERRORLOG: Mot sending discovery request AF does not have an Ip 1
#CAPWAF-3-ERRORLOG: Mot sending discovery request AP does not have an Ip !!
YLINEFROTO-5-UFDOWH: Line protoecol on Inter face GigabitEthernet(, changed state te up
Hot in Bound state.

WCAFWAF-3-ERRORLOG: Mot sending discovery request AF does not have an Ip 1
$CAFWRF-3-DHCF_RENEW: Could not discover WLC using DHCEF IF. Renewing DHCE IE.
RCAFWAFP-3-ERRCRLOG: Invalid ewvent 38 & state 2 combination.

$DHCP-6~RODRESS ASSIGN: Interface BVIL assigned DHCP address 10.1.10,.101, mask
255.255.255. 0, hostnams AFE

Translating "CISCO-CAFWAP-CONTROLLER.miconics.local". ..domain server (172.31.1.200)
WCAPWAP-3-DHCFP_OFTION_43: Controller address 10.1.10.5 obtained through DHCF
YCAPWAP=3-ERRORLOG: Did not get log server settings from DHCP.

$CAPWARP-3-ERRORLOG: Could Mot resolve CISCO-CRAPWAP-CONTROLLER.miceonics.lecal
RCAPWAP- 3-ERRORLOG: Go join a capwap controller wmmAC status is FALSE

#CAPWAP- 5-DTLSREQSEND: DTLS connection request sent peer ip: 10.1.10.5 peer port: 5246
YCAPWAF-5-DTLSREQSUCC: DTLS connection created sucessfully peer ip: 10.1.10.5
pear port: 5246

WCAPWAF-5-S3ENDJOIN: sending Join Request to 10.1.10.5

$CAFWRF-3-ERRORLOG: CAFWAFP parameters update to forwarding plane failed
RCAPWAP-3-ERRORLOG: CAFWAF parameters plumbing to forwarding plane failed
HCAFWAF-5—JOINEDCONTROLLER: AF has jeined controller WILC

$LINE-5-CHANGED: Interface DotllRadiol, changed state to administratively down
YLWAFF-3-CLIENTEVENTLOG: SS5ID MICRONICS added to the slot[0]
$LWAFP-3-CLIENTEVENTLOG: SSID MICRONICS added te the slot[i]

WWIDS-6-EMABLED: IDS Signature is lecaded and enabled

$LINEFROTO-5-UFDOWN: Line protocol on Interface DotllRadiol, changed state to down
ALINEFROTO=-5=-UFDOWH: Line protocol on Interface DotllRadiol, changed state to down
$LINE-3-UFDOWN: Interface DotllRadiol, changed state teo down

RLIMNK=-5-CHANGED: Interface DotllRadicl, changed state to reset

SLINKE-3-UFDOWN: Interface DotllRadicl, changed state to up

RLIHEFROTO-5-UFDOWHN: Line protocol on Interface DotllRadio0, changed state to up

Check WLC GUI if there is Access Paint.

Page 60 of 507



CCIE SECURTY v4 Lab Worlkdb ook

L
ac R —— e

= . [——— = || F1|

- k.
AP s B AP AL T B MR M Faan AP e e R ey

T ERRTEETS
B rEok deaw
iy
Hwes
bR

Page 61 of 507



CCIE SECURTY v4 Lab Worlkdb ook

LAB 3.8. Windows 7 AD Integration
(optional)
Obijectives

This lab shows how to add Windows 7 PC client to Active Directory. This step
is useful to perform Machine authentication in the later task.

IP_Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

R1 Lo0 1.1.1.1/32
EO0/0 10.1.10.1/24
EONM 172.31.1.1/24

AD NIC 172.31.1.200

WinXP NIC 10.1.10.50/24

WLC G0/0M1 (mgmt.) 10.1.10.5/24
GO0/or2 10.1.30.5/24

ASA1 G0/0 (outside) 100.2.2.10/24
GO0/ (inside) 10.1.10.10/24
G0/2 (dmz) 10.1.30.10/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task

There is a Windows 7 host connected to SW1 port 0/7 through the IP Phone.
By default the PC is placed in VLAN 10 and should get IP address from
10.1.10.0/24 network. The PC should be a member of Active Directory.

If not, re-join Active Directory domain micronics.local using
employee1/Micronics1 user credentials.
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Configuration

Complete these steps:
Step 1 Win7 PC configuration.

-

-

Using VNC client connect to Win7 PC and authenticate using local
account cisco/Student0.

Switch User

Right click on Computer and select Properties. On the following
screen click Change Settings opfion next to the computer name.
Check Domain option and provide the following settings. Click OK.

Carmputer FlamesDotmain Changes

“fou can chanoe the name nd the membership of this

camputzr. Chanoes mighl alfect access 1 nebiwonk resolnces,
o= infomskion

Lomputel nams:
wAny oo

Ful compuier nanme:
winTpc

Mara...
WMember of
@ Diam ai:
mictonicslocal

T orkgioup:
WORKGROUP

[ Ok ] Cancel
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* Provide user's credentials of employee1/Micronics1 and click OK.
After a while you should get the following successful message.

Computer Hame/Domain Changs: E

ﬁ ‘Walcome to the rnicronics.local domain.

*  You must restart the Win7 PC to apply the changes.

Compukter Meme/Domen Change:

ﬂ You must restart your computer to apply
= these changes

Before restarting, seve any open fikes and close all
PEOGrAmS.

Step 2 Login to Win7 PC using local user account of cisco/StudentD.
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LAB 3.9. Configure Wired 802.1x

Objectives

This lab shows how to configure 802.1x for wired environment.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
EOM 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24
SWA VLAN10 10.1.10.7/24

There is a Windows 7 host connected to SW1 port 0/7 through the IP Phone.
The IP Phone is authenticated using MAB configured in previous tasks.
Configure Win7 PC to use its native supplicant with PEAP/MS-CHAPvZ2 only.
Use Active Directory user employee1 and computer’'s account (member of
Domain Computers AD group) for authentication. Upon successful
authentication the user and machine should get full access to the network.

Enable 802.1x low impact mode on the port and allow only DHCP, DNS, TFTP

and ICMP traffic. Ensure the following authentication order:
o B02.1x
o MAB

The switch should time out 802.1x authentication method after 15 seconds
and allow only one MAC address to be seen behind the IP Phone. If there are
more MAC addresses the switch should NOT authenticate them and silently
drop the packets.
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You can disable Whitelist authorization rule and put the IP Phone back to the
default Cisco-IP-Phone group.
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Configuration

Complete these steps:
Step 1 Switch configuration.

1
ip access-list extended DEFAULT
remark DHCP
permit udp any eq bootpo any eqg bootps
ramark DHES
permit udp any any &g domain
remark TFTP
permit udp any any eg tftp
remark Fing
permit icmp any any
!
interface GigabitEthernat0,7
ip access-group DEFAULT in
authentication open
authentication order dotlx mab
dotlx timesout tx-paried 5
i
ip device tracking
radius vsa send
!

Step 2 Create allowed protocols object.

Go to Policy > Policy Elements > Results > Authentication >
Allowed Protocols and click Add. Enter PEAP_Only as name, pick
Allow PEAP with Allow EAP-MS-CHAPv2, uncheck all other
methods and click Submit
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Step 3 Create authorization profile for AD clients to get full network access
upon successful authorization.

* (Go to Policy > Policy Elements > Results > Authorization >
Authorization Profiles and click Add. Enter AD_Success_Profile as
name, pick DACL Name checkbox and chose default
PERMIT_ALL_TRAFFIC from the drop-down list. Click Submit.
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Step4 Move IP Phone MAC address to the default Identity Group and disable

Whitelist authorization rule.

= Go to Administration > Identity Management > Identities >
Endpoints and click Cisco-IP-Phone (an entry with IP Phone MAC

address). Change the Identity Group Assignment to Cisco-IP-
Phone. Click Save.
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Go to Policy > Authorization and click Edit link next to the Whitelist

rule, Click on the green icon and chose Disabled. Click Done and
Save.

i
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Step 5 Add new authentication rule or edit default one.

-

Go to Policy > Authentication and click orange arrow next to
Allowed Protocols in Dot1X rule. Pick PEAP_Only from configured
objects. Then click black arrow to show more options of the rule and
change default identity source to AD1. Click Save.
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Step 6 Create new authorization rule for domain users.

Go to Policy > Authorization and insert new rule as a second to last
(before the default one). Enter a name e.g. Domain User and create
new Compound Condition where AD1:ExternalGroup =

micronics.local\Users/employees.
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As Pemissions chose AD_Success_Profile already created in the

previous steps. Click Done.
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Step 7 Create authorization rule for domain computers.
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L

Go to Administration > ldentity Management > External ldentity
Sources > Active Directory and click Add > Select Groups From
Directory on Groups tab. Click Retrieve Groups and pick
micronics.local/lUsers/Domain Computers group. Click OK.
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Click Save Configuration.
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Go to Policy > Authorization and insert new rule before Domain

User rule. Enter a name e.g9. Domain Computer and create new
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As Pemissions chose AD_Success_Profile already created in the
previous steps. Click Done.
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Click Save.
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Step 8 Win7 PC native supplicant configuration.

Go to Services (services.msc) and Enable/Start WiredA utoConfig
service.
EL =]
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Go to Network Connections right click on LAB-Network and select
Properties. You should see Authentication tab.
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On the Authentication tab select options as follows:
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Click on Settings button and uncheck Validate server certificate
option.
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Click on Configure button and uncheck the option:

- .
| EAPMECHAPG Propein: Ed

| ‘wWhan conracing

Britmrnatically uim rp windoev lagan rarma and
paepaond (e dossn § s

| [ | [ cocs

Click OK and go back to the Authentication tab. Click Additional
Settings button and check Specify authentication mode and select
User or computer authentication. Click OK and close network

adapter properties window.
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Verification

Enable debugging on the switch:

dabug radius
dabug dotlx event

Bounce the switchport and check debug output.

SWlkcont t

Enter configuration commands, one per line. End with CHWTL/E.

SW1{config) #int go/7
SW1l{config-if)#shut
SW1(config-if)éne shu
SW1{config-if)}#°E

[/ sea the AuthManager state bafore authentication. The domain is UNFEHOWN at

the moment but there is MAC address on the port. Hote that detlx is running but

it will fail over to mab after timeout.

SWlésh auth sess int g0/7

Interface:

MAC Rddress:

IP Rddress:
Status:

Domain:

Security Policy:
Security Status:
Cpar host mode:
Oper control dir:
Session timeout:
Idle timeout:
Common Session ID:
Roct Session ID:
Handle:

Runneble methods list:

Method  State
dotlx Running
mak Hot run

f/ First the IF Fhoene is being authenticated.

GigabitEthernatd/7
0021 ,a084 ., 6E54
Unknown

Runn ing

UNEN CWH

Should Secure
Unsecure

mult i-domain

both

H/R

H/R
QROLOROTOOQO0OZFOOEDSE3S
00000034
Ox3500002F

dotlx-ev(Gid/7): Hew client notification from RuthMgr for O0x0400005% - 0021.a084.6f£4
SAUTHMGR-5—-STRART: Starting "dotlx' for client (0021.a084.6ff4) on Interface GL0/7
RuditSessienID 0RO LOANTOO0000ZFODEDSEIS
$LINKE-3-UPDOWH: Interface GigabitEthernet(/7, changed state to up

$LINEFROTO-5-UPDOWHN: Line protecol on Interface GigabitEthernet(/7, changed state to up

f/ two dotlx retransmissions are configured by default
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dotlx-ev(GEi0/7): Sending ERAPOL packet to 0021.a084.6ff4
dotlx-ev(Gi0/7): Role determination not reguired
dotlx-ev(Gid/7): Sending out ERPOL packet

dotlx-ev(GLi0/7): Sending ERFCL packet to 0021.a084.6£14
dotlx-ev(Ei0/7): Role determination not reguired
dotlx=ev(GL0/T): Sending sut ERPOL packet

dotlx-ev{Gid/7): Received an EAF Timeout

$DOT1¥-5-FAIL: Ruthentication failed for client (0021.a084.6ff4) on Interface Gi0/7
AuditSessionID

dotlx-ev(GEi0/7): Sending event (2) to Auth Mgr for 0021.a084.6£f4

SAUTHMGR-7-RESULT: Authentication result 'no-response' from "dotlx' for client
(0021.a084.6££4) on Interface Gi0/7 AuditSessionID OROLOAGTOOO0OOZFOOEDSE 35
dotlx-ev(GLi0/T): Received Ruthz fail for the client O0x0400005% (0021.a084.6££4)
dotlx-ev(GL0/T): Deleting client Ox0400005% (0021.a0684.6LL£4)

RAUTHMER=-T=-FAILOVER: Failing owver from 'detlz" for client (0021.a084.6ff4) on Interface
GLO/T AuditSesgsionID OROLOAROTOOO0O00ZFDOEDSE IS

f/ dotlx has failed for IF Fhone because the phone has ne dotlx supplicant, now
the MAE is running

SAUTHMGR-5-STRART: Starting 'mab' for clisnt (0021.a084.6ff4} on Interface GLO/7
AuditSessionID O0ROLOADTO00000ZFODEDSE3S

dotlx-ev:Delete auth client (0x0400005%) message

dotlx-eviAuth client ctx destroyed

dotlz-ev:Rborted posting message to authenticator state machine: Invalid client
RADIUS/ ENCODE (00000034) :0rig. component type = DOT1X

RADIUS{ 00000034): Config MRS IP: 10.1.10.7

RADIUS/ ENCODE {00000034) = acct_session_id: 52

RADIUS{ 00000034} : sending

f/ RADIUS authentication message is sent to ISE. Hote that username is MAC
address of the IP Phone and we have Ssrvice-Types10 and HAS-Port-Types15 in the
massage. The ISE will match that connection teo the correct authentication rule
based on those attributes.

RADIUS{ 00000034): Send Access-Request to 172.31.1.20:1812 id 1645%/160, len 209
RADIUS: authenticater B% 13 0R 78 2E E0 32 C©7 - 75 AOQ &C 56 0D D3 27 83

RADIUS: User-Hame [1} 14 002 la08d cf£4"

BRADIUS: User-Password [2] g =

RADIUS: Service-Type [&] & Call Check [101]
BADIUS: Framed=MTU [12] & 1500

RADIUS: Called-Station-Id [20] 1% "C4-64-13-8C-E8-0T"
RADIUS: Calling-Station-Id [31] 1% "00-21-A0-84-cP-F4"
BADIUS: Message-RAuthenticate[80] 18

RADIUS: 48 AF 08 93 30 FBE 6C FA FD FBE 10 37 56 El 42 F5 [ HOLTVE]
BADIUS: EAP-HKey-Nama [102] 2 *

BADIUS: Vendor, Cisco [28] 4%

BADIUS: Cisco AVpair [1] 43 "audit-session-id=0RA010A0T0000002F00EDSE 357
BADIUS: HNAS-Fort-Type [61) & Ethernet [15])

Page 78 of 507



CCIE SECURTY vd Lab Workbook

RADIUS: HNAS=FPort [5] [ 50007
RADIUS: MNAS-Port-Id [87]1 20 "GigabitEthernet(/7"
RADIUS: HAS-IP-Address (4] 3 10.1.10.7

RADIUS{ 00000034} : Started 5 sec timecut

S/ RADIUS reply is received. This is an Access-Accept RADIUS message type so it
sontains some additional attributes. The most important attributes here are
‘device-traffic-class=voice’ and dACL name. The first attribute is very
important in case of Maulti-Auth. The switch knows what ‘authentication domain’
te use. Without this attribute the IF Fhene could be authenticated in DATA
domain as the MAC address of the phone is ‘visible’' in two VLANs (data vlan and
volce vlan).

Alsc note that there is just dACL name in the RADIUS message. There are no dACL
entriss yet. The switch must ask for that JdACL again to download ACEs (Rooass

List Entries).

BADIUS: Received from id 1645/160 172.31.1.20:1812, Access=Accept, len 297
RADIUS: authenticatoer B9 F8 Bl RS CD 82 74 B9 - CO 87 50 1 %8 AF BO TR
RADIUS: User-Hame [1] 1% "00=21-A0=-84-6F=-F4"

BADIUS: State [24] 40

RADIUS: 52 65 61 753 74 68 53 653 73 73 6% 6F 6E 3A 30 41 [ReauthSession:0A]
RADIUS: 30 31 30 41 30 37 30 320 30 30 30 30 32 46 30 30  [01OAOTOOO000ZF 00]
RADIUS: 45 44 3% 38 33 39 [ EDS835]

RADIUS: Class [25] S50

BADIUS: 43 41 43 53 3A 30 41 30 31 30 41 30 37 30 30 30 [CACS:O0ROLO0ROTO00)
RADIUS: 30 30 30 32 46 30 30 45 44 39 38 33 3% 3A 49 53 [000ZF00EDS839: IS]
BADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 30 32 39 [ E/143558553/3029)
RADIUS: Tarmination-RAction [29) 6 1

RADIUS: Message-Ruthenticato[80] 18

BADIUS: 53 41 4D 42 T4 Cc4 %0 4F AB 57 80 A8 86 9% 66 5D [ SAMBLOWL] ]
RADIUS: Vendor, Cisco [26] 34

RADIUS: Cisco AVpair [1) 28 “"device-traffic-class=voice"

RADIUS: Vender, Cisco [26] 75

BADIUS: Cisco AWpair [1] &% "ACS:CiscoSecure-Defined-ACL=#ACSACLE-IP-
FERMIT_ALL_TRAFFIC-4f57e406™

BADIUS: vendor, Cisco [28] 35

RADIUS: Cisco A¥pair [11 29 "profile-name=Cisco-IF-Fhone™

BRADIUS [ 00000034) : Received from id 1645/160

RADIUS/DECCDE: parse unknown cisco wsa "profile-name" - IGHORE

$MAB-5-SUCCESS: Authentication successful for client (0021.a084.6ff4) on Interface
G1i0/7 AuditSessionID O0AOLOAODTOO00OO2ZENIEDSS 35

FAUTHMGR-T-RESULT: Authentication result 'success'" from 'mab' for client
(0021.a084.6£fd) on Interface Gi0/7 AuditSessionID OAODLOAODTOOO0O00ZFOOEDSE 35
REPM-6-POLICY _REQ: IF 0.0.0.0] MAC 0021.a084.6££4] RuditSessicnlID
OROLOAGTOO00002ZFOOEDSB3 S| AUTHTYPE DOT1X| EVENT APFLY

REPM-6-RAR: POLICY xRCSACLX-IF-FERMIT ALL TRAFFIC-4£57e406| EVENT DOWNLOAD-REQUEST
BADIUS/ ENCODE (00000000) :0rig. component type = INVALID

RADIUS{ 00000000} : Config MRS IP: 10.1.10.7

BADIUS (00000000} : sending
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/f The switch must download ACL from ISE. This is done by ancther RADIUS request
whare usernams is a dACL name. There must ba three things configured on the switch
to make this happan:

- aaa authorization network

- ip device tracking

radius vsa send

RADIUS (00000000} : Send Access-Regquest teo 172.31,1.20:1812 id 1645/161, len 147
RADIUS: authenticateor D4 CD 40 OE F3 F8 F% 70 - 58 9% 86 ET7 AB 82 94 42

RADIUS: HBRS-IP-Rddress [41 3 10.1.10.7

BADIUS: User-Hame [1] 41 "RACSRCLE-IP-PERMIT_ALL_TRAFFIC-4£57e40&6"
RADIUS: Vendor, Clsce [2e] 32

RADIUS: Cisco AVpair [1) 26 "aaa:service=ip_ admission"

RADIUS: Vendor, Cisco [26] 30

RADIUS: Cisco AVpair [1) 24 "aaa:ewvent=acl-download™

RADIUS: Message-RAuthenticate[80] 18

RADIUS: De 1% Bl 96 C2 84 8C 3% Be F8 5% 11 B4 D5 CE 32 [ 9x2])

BADIUS (00000000} : Started 5 sec timecut

f/ with the FADIUS Access-Accept message the switeh gets ACL entries.

RADIUS: Receiwved from id 1645/161 172.31.1.20:1812, Access-Accept, len 211
BADIUS: authenticater FA 1C F2 32 B2 39 44 €8 - &2 3D 33 &7 81 1D B8C EF
RADIUS: User-Hame [1] 41 "HACSACL¥-IP-FPERMIT ALL THAFFIC-4f57ed06"
RADIUS: State [24] 40

RADIUS: 52 65 61 75 74 68 53 65 73 73 6% 6F 6E 3A 61 63 [ReauthSession:ac]
RADIUS: 31 &6 30 31 31 34 30 30 30 30 30 42 37 32 35 31 [1£011400000B7251])
RADIUS: 30 36 42 36 44 44 [ D&B&DD)

BADIUS: Class [25] S0

RADIUS: 43 41 43 53 3R 61 63 31 66 30 31 31 34 30 30 30 [CACS:aclf0lld4000]
RADIUS: 30 30 42 37 32 35 31 30 36 42 36 44 44 3A 4% 53 [00BT725106B6LDD: I58]
RADIUS: 4% 2F 31 34 33 35 3% 38 35 35 33 2F 33 30 33 30 [ E/143558553/3030)
RADIUS: Termination-Rction [29%) 6 1

RADIUS: Message-Authenticate[80] 18

RADIUS: B0 04 C& C4 03 3% C% E4 71 0% BE 6B D7 76 5F 5D [ 9gkw]]
RADIUS: Vendor, Cisco [26] 36
BADIUS: Cisco AVpair [1] 30 "ip:inacl#l=permit ip any any"

RADIUS{ 00000000} : Received from id 1645/161

$EFM-G-AAR: FOLICY xACSACLE-IP-FERMIT_ALL TRAFFIC-4£57e406| EVENT DOWHLORD-SUCCESS
YEPM-6-IFEVENT: IF 0.0.0.0] MAC 0021.a084.6ff4] RAuditSessionID

OROLOAOT 0000002ZFOOEDSS3 S| AUTHTIPE DOT1X| EVENT IP-WAIT

RAUTHMER=-5-3UCCESS: Authorization succeeded for client (0021.a084.6£f4) on Interface
GL0/T AuditsSessionID GROLOAOTOO000002ZF0OEDSE 39

BADIUS/ ENCODE (00000034) :0rig. component type = DOTL1X

RADIUS{00000034): Config NAS IP: 10.1.10.7

BADIUS(00000034) : sending

f/f Lif RADIUS acocounting is enabled, another massage is sant

RADIUS( 00000034) : Send Rccounting-Request teo 172.31.1.20:1813 id 1ed6/26, len 230
RADIUS: authenticater 53 F1 C6 46 5A C3 72 97 - DC 43 AF Cl 61 ZE 4F 96
RADIUS: RAcct-Session-Id [44] 10 ™"00000034%"
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(1]
(1]
[15]

[CRCS - GRO1 GROT0 00])
[0002 FOOED2833; 18]
[ EF143558553/3029)

[z}

BADIUS: WVendor, Cisco [26] 4%

RADIUS: Cisco AVpair [11 43 T"audit-session-id=0R010AO0T0000002F00EDSE 35"
BADIUS: User-Hame (1 1%  "00-21-R0-B84-6F-F4"
RADIUS: Vendor, Cisco [26] 32

RADIUS: Cisco AVpalr [1) 26 "connect-progress=Call Up"™
RADIUS: Acct=Authentic [45] & RADIUS

BADIUS: Acct-Status-Type [40] Start

RADIUS: HAS-Port-Type [81] Ethe rnet

RADIUS: MHAS-Fort [51 50007

RADIUS: HNAS-Fort-Id [87) 20 "GigabitEthernetd/7"
RADIUS: <Called-Station-Id [30] 1% "C4-64-13-6C-E8-07"
RADIUS: cCalling=-Station=-Id [31] 1% "00=-21-A0=-84=-6F=-F4"
RADIUS: Class [25] 50

RRADIUS: 43 41 43 53 3R 30 41 30 31 30 41 30 37 30 30 30
RADIUS: 30 30 30 32 46 30 30 43 44 35 38 33 39 3A 49 33
RADIUS: 45 ZF 31 34 33 35 35 38 35 35 33 2F 33 30 32 39
BADIUS: Sarvice-Type [6] & Framed

BADIUS: MNAS-IP-Rddress [41 & 10.1.10.7

BADIUS: Unsupported [151] 10

RADIUS: 44 45 37 41 45 41 43 37 [ DETRERCT]
BADIUS: Acct-Delay-Time [41) & 0

RADIUS{00000034): Started 5 sec timecut

RADIUS: Received from id 1éd6/26 172.31.1.20:1813, Rccounting-response, len 20

RADIUS: authenticater &1 24 0OC 05 95 95 3F 37 -

32 D5 DA 19 89 58 FD 40

f/ check the authentication session again. You should sea correct domain

(VOICE) based on the attribute received from the ISE, and ACL name. You will

not ses ACL entries here.

SWl#sh auth sess int g0/7

Interface: GigabitEthernet(/7
MAC RAddress: 0021.a084.6£f4
IF Address: Unknown
User-Name: 00-21-R0-84-6F-F4
Status: RAuthz Success
Domain: VOICE
Security Policy: Sheould Secure
Security Status: Unsecure
oper host mode: multi-domain
Cper contrel dir: both

Authorized By: Authentication Server

ACS ACL: =xACSACLy-IP-FERMIT ALL TRAFFIC-4f57ed0c
Sassion timecut: N/A
Idle timeocut: HN/R
Commen Session ID: OCROLOROTOOOQOOZFOOEDIEIR
Aoct Session ID: Ox00000034
Handle: O0x3a500002F

Funnable metheds list:
Method  State

Page 81 of 507



CCIE SECURTY vd Lab Workbook

dotlx Failed owver
mak Authc Success

Bounce the Win7 NIC (LAB-Network) to trigger dot1x and check debug output. Click
on the balloon message that appears and provide user/pass of
employee1/Micronics1 to authenticate.

i Additional infarm ation is neaded 1o connact 10 this penyork ™
. Click fo provide addiiimnal sfomabion, |

X

dotlxz-ev(Ei0/7): Dotlx authentication started for O=xC300005E (0026.55d0.0dSE)
SAUTHMGR-5—-START: Starting "dotlx' for client (0026.55d0.0d56) on Interface GL0/7
AuditSessionID GAOLOAOTO000003100EEIDER

S/ you may ses more dotlx reties hera. It depands on configqured tx-peried and

how quickly you provide username and password to the supplicant.

dotlx—-ev(GL0/T): Sending ERPOL packet to 0026.55d40.0d456
dotlx-ev(GL0/T): Role determination not regquired
dotlx-av(GEi0/7}: Sending ocut EAPOL packst

dotlz-ev(Gid/7)}: Sending EAPOL packet to 0026.55d0.0d56
dotlx—ev(GLi0/T): Role determination not required
dotlx-ev(GEi0/7): Sending out EAPOL packet

dotlx-ev(GL0/T): Role determination not reguired

dotlx-ev:Enqueuved the eapol packet to the global authenticateor gueue
ERAPOL pak dump rx

EAPOL Version: Oxl type: 0x0 length: 0x000E

dotlx-ev: dotlx auth queue event: Int Gi0/7 OCDE= 2,TYFE= 1,LEN= 14

dotlx-ev(GL0/T7): Received pkt saddr =0026.55d0.0456 , daddr = 0180.c200.0003,
pae=-ether-type = 888e.0100.000a

dotlx—ev(GLO/T): dotlx sendRespToServer: Response sent to the server from OxCI00005B

{0026.55d0. 0d56)

RADIUS/ ENCODE (00000036) :0rig. compenent type = DOTLX

RADIUS(00000036): Config MRZ IP: 10.1.10.7

RADIUS/ENCODE (00000036} : acct_session_id: 54

RADIUS(00000036) : sending

S/ BRADIUE muthentication message is sent. It includes provided username and
Barvice-Type=2 and HAS-Fort-Type=15 which should be matched by ISE te the
correct authentication rule. Hote that the ISE is configured with Allowed
Frotocels where only FEAF/ME-CHAFvZ is sealected. This will trigger ancther set
of RADIUS messages to negotiate and build TLS tunnel and authenticate securely

over that tunnel.

RADIUS{ 00000036) : Send RAccesa-Request to 172.31.1.20:1812 id 1645%/162, len 204

Page 82 of 507



CCIE SECURTY vd Lab Workbook

RADIUS: authenticateor 07 CE 7D 37 DF DA B8 D6 = 00 16 %7 E8 97 BC OF 4F

RADIUS: User-Name [11 11 "amployesl™
BADIUS: Service-Type [&] &  Framed [21
RADIUS: Framed-MTU [1z] & 1500

BRADIUS: Called-station-Id  [30] 1% "C4-64-13-6C-E8-07"
RADIUS: cCalling=-Station=Id [31] 1% "00=Z26=353=D0=0D=56"

BRDIUS: ERP-Mzssage [79] 18

RADIUS: 02 01 00 OE 01 65 6D 70 &C 6F 79 65 65 31 [ employesal]
RADIUS: Message-Authenticato[80] 18

RADIUS: SC 1F 81 CF 5F SE 64 34 E5 DA AC 68 D2 57 C1 41 [ d4hwWA]
BADIUS: EAP-Key-Name [102] 2 *

BADIUS: Vendor, Cisco [26] 48

RADIUS: Cisco AVpair [11 43 T"audit-session-id=0R010RA0T0000003100EELDEA"™
BADIUS: HAS-Port-Type [¢1] & Ethernet [1%)

RADIUS: HAS-Fort =1 [ 0007

RADIUS: HNAS-Port-Id [87) 20 "GigabitEthernet(/7"

RADIUS: HNAS=-IP-Rddress [4] -3 10.1.10.7

RADIUS{00000036): Started 5 sec timesout

// RADIUE challenge message 1§ to negotiate FEAF and build TLE tunnal.

RADIUS: Received from id 1645/162 172.31.1.20:1812, Access-Challenge, len 119
BADIUS: authenticator 5B FB D9 3A 4B B5 74 53 - 4C 54 58 C8 BC Al 08 56
RADIUS: State [z24] 73

BRADIUS: 33 37 43 50 4D 53 65 T3 73 63 6F 6B 4% 44 3D 30 [37CPMSessionID=0)
RADIUS: 41 30 31 30 41 30 37 30 30 30 30 30 30 33 31 30 [ROLOAODTOOO0000310]
BADIUS: 30 45 45 31 44 45 41 3B 32 38 53 65 73 73 69 oF |[OEELDER; 2B3essic]
RADIUS: GE 49 44 3D 49 53 45 2F 31 34 33 35 35 38 35 35 [nID=ISE/14355855)

RADIUS: 33 2F 33 30 33 32 3B [ 3/3032;)

RADIUS: EAP-Message [79] =8

RADIUS: 0l 47 00 06 1% 21 [ Gl1]

RADIUS: Message-Ruthenticato[80] 18

RADIUS: 48 01 CE 8% 5D 3B 52 D4 77 5C B3 &3 A8 16 D2 31 [ HrRwhel]

RADIUS{00000036) : Received from id 1645/162

RADIUS/DECODE: ERP-Message fragments, 6, total 6 bytes
dotlx-ev(GL0/T): Sending ERFCL packet to 0026.55d0.0d56
dotlx-ev(Gi0/7): Role determination not required

dotlx=ev(GL0/T): Sending sut ERPOL packet

dotlz-ev(Ei0/7}: Role determination not regquired

dotlz-ev:Enqueuned the sapol packet te the glebal authenticater gueue
ERPOL pak dump rx

EAPOL Version: Oxl type: 0x0 length: Ox007BE

dotlx-ev: dotlx auth_gqueue_ewvent: Int Gi0/7 CODE= 2,TYPE= 25,1EN= 123

dotlx-ev(Bi0/7}: Received pkt saddr =0026.55d0.0d5%6 , daddr = 0180.c200.0003,
pae—ether-type = 888e.0100,007k

dotlx-ev(GL0/T): dotlx sendRespToServer: Response sent to the server from 0=C3 000058

(0026.55d0. 0d56)

RADIUS/ENCODE (00000036) :0rig. compoenent type = DOTLX

RADIUS(00000036) : Config WAS IP: 10.1.10.7

RADIUS/ENCODE (00000036) : acct_session id: 54
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RADIUS(00000036) : sending

// another FADIUS request is sent. Hote that RADIUS message doeas HOT contain
any password. There is just username. The usarname/password will be carried

securely by EAP which is sent using RADIUS AVP/T9.

RADIUS { 00000036) : Send Accesg-Request to 172.31.1.20:1812 id 1645%/163, len 386
RADIUS: authenticater F0 57 7F CA SE 1E DE BO - &% SF 41 77 5C 32 EC CE

RADIUS: User-Hame [1] 11 "employesl"
RADIUS: Service-Type [8] -1 Framed [2]
RADIUS: Framed-MTU [12] & 1500

BADIUS: Called=Station=Id [30] 1% "Cd=g4=13=6C=E8=07"

RADIUS: calling-Station-Id [31]1 1% "00-26-55-D0-0D-58"

RADIUS: ERP-Message [73] 125

RADIUS: 02 47 00 7B 12 80 00 00 00 71 16 03 01 00 &C 01 00 00 68 03 01 51 06 B6 F7 BA
BC F% %E 91 CF &7 BE 3C FF 03 AF E3 E6 F2 65 2% F8 20 OF DS 12 97 87 AF DA 54 E1 00 00

13 00 2F 00 35 00 05 00 OAR CO 13 CO 14 CO 0% CO OR 00 32 00 38 00 13 00 04 01 00 00 27

[E{glhg<e} T/528")

BADIUS: FF 01 00 01 00 00 00 00 OE 00 OC 00 00 0% 65 6D 70 6C 6F 7% 65 65 31 00 0A 00

06 00 04 00 17 00 18 00 OB 00 02 01 00 [ employeel]

BADIUS: Message-Ruthenticatol[80] 18

READIUS: 24 89 84 4A AS 44 1A SA ©C AR TF 82 07 25 SE 03 [ $JD%°]
EADIUS: ERP-Key-Hame [102] 2 =+

BADIUS: Vendor, Cisco [261 49

BADIUS: Cisco RVpair [1] 43 T"audit-sessien-id=0RA010A070000003100EELDER"
RADIUS: HAS-Fort-Type [61] & Ethernet [151

ERDIUS: MRS-Fort [51 & 50007

BADIUS: HAS-FPort-Id [87] 20 "GigabitEtharnet/7"

RADIUS: State [24] 73

RADIUS: 33 37 43 50 4D 53 65 73 73 6% 6F 6E 4% 44 3D 30 [37CEMSessionID=0]
RADIUS: 41 30 31 30 41 30 37 30 30 30 30 30 30 33 31 30 [ROLOAODTOOOOO003L0]
RADIUS: 30 45 45 31 44 45 41 3B 32 38 53 63 73 73 6% 6F [0EE1DER; 283essio]
RADIUS: 49 44 3D 49 53 45 2F 31 34 33 35 35 38 35 35 [nID=ISE/14355855]
RADIUS: 33 ZF 33 30 33 32 3B [ 3/3032:)

RADIUS: HARS-IP-Rddress [4]1 [ 10.1.10.7

RADIUS (00000036) : Started 5 sec timecut

ff This RADIUE chal lenge message is for ISE authentisation. PEAP uses sarver
side authentication using digital certificate. This is why that message is so

long = it contains ISE caertificats.

RADIUS: Received from id 1645/163 172.31.1.20:1812, Access—Challenge, len 1131
RADIUS: authenticator FO C8 1D 6C %6 CE 6F 38 - 6D DD 18 54 &R 57 24 5C
RADIUS: State [24] 73

RADIUS: 33 37 43 50 4D 53 565 73 73 6% 6F EE 49 44 3D 30 [37CPMSessionID=0])
RADIUS: 41 30 31 30 41 30 3T 30 30 30 30 30 30 33 31 30 [AOLOROTOOO000310]
RADIUS: 30 45 45 31 44 45 41 3B 32 38 53 65 73 73 63 oF |[OEELDER; 283essio]
RADIUS: GE 49 44 3D 49 53 45 2F 31 34 33 35 35 38 35 35 [nID=ISE/14355855)
RADIUS: 33 2F 33 30 33 32 3B [ 3/3032;)

RANT LEN AW SRR e -1

BADTIER O AW OO LS OO R O OO O L8 0ROV 0N B NG O OO 4D OEN L ML 05 S FT BZ G TH OB BP DD N0 OW SO B2 DN B AR 3D A B9 5D 1N OO OO0 B O [EOHOE LSS0 ED
P AT B ik Bl B0 O B0 iR R MO T O R B T AR T RO LD i A P R B AR e L EY Y

RASTLE  FFOEA O 3 00 G O P 01 o o o0 16 O Ol oW B OO 00 06 RE O 0% 6 00 08 OF 30 kb O b d g G0 B0 RO O Gk o gk b ow 61 3T PT B0 ) o O om0 30 08 ol
O SA B 4 BeE T OB O 01 OF OF OO0 N0 4F N1 18 30 13 06 Oh 00 52 D6 80 50 P2 00 [wjS OOw" OHE0N Ody ]
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BANTIHD G 0119 16 05 62 &P &3 81 62 N1 19 30 L7 06 Ok 09 90 D6 69 50 P2 30 60 0L 19 16 09 & 69 & 72 &F  [dlocsll0d, delara]
BANTIHN BN 69 63 T3 NL 1N 30 19 O O3 B3 O 00 13 13 &3 61 3N 6B 69 53 T2 OF & [nd cwlilios. sl aron]

MO SNTANSTOANDNEIT @AE LR [ioloelilem

aiuR MMM BN HBITAN N [ i aiizia]

BATI LRI EAR-H ik W] i

BANTIHD N N1 M0 Nl X0 B4 X0 N1 B BA DO SA N1 OB N0 09 05 O3 53 [L1ZO0SMSLS0E )

BT OSIIOETE TATLOB 3OS SO0 BB OO 1302 M EL V1T W 1005 OB BB O 0K 13 05 W & 8 T & 4E  [uslilkowlileioron]

BAITUS: S S3TINL 00 MO CADS O3 S5 M OB 130080 Al X ML IO W IA DS M M O03 1313 & 75 3 [ioslOULebloes.]

FARE LR 68 R RN TR B R R &R TDOE R B & L &0 M [ sdos, Loaasl d]

BANTIHG  BE O 22 M0 0B 05 09 3K 86 48 B FP 0B 00 0L 01 05 00 O3 63 0L OF 00 30 62 01 OA 02 82 OL 0L 00 BL 53 13 TA O4 C5 00 M 95 32 Z1 60 02 OF 30 OF BF 60 AT FO OB 2 12
OF BT 00 05 05 FS N 6 7L 1A GE 00 3 AN BT S8 11 1E AF  [TOMH 3 clSguin]

BANTUS: A T L TOFE FS TH OO0 20 82 08 44 J2 3R OL 4T 85 S0 I3 BP ZE 05 B9 4A 15 00 FA PO TO 3E DS B 40 DB 48 [WpLDa’ i)

FASTUR PO OB PO IC S0 O R S AR O G TR OTOOBR B LS 10 b B0 9 e e o OB T R LR 1R MR IR 6 B G o0 66 Mh B e B [ 8 veupif) TREY)

PRSI LRI EAR-H i W]

BANTIHD L4 W1 G AP MOS0 D5 A L1 B8 S NL OB B0 B DS B0 40 64 AL 35 AR AR SO LN BA O BR D6 DR O B1 Gh BA 15 LA I3 WA TR FL 17 G5 0L ON G0 40 53 [lot) TIN5+ "]
BANTUS: B 44 10 13 62 T BN NN SO BN 4% 10 F3 PR 3E FU B4 3K O B TS B 05 6T 80 30 SR 08 OF 19 43 A8 07 B3 00 ON 3F DN 34 30 09 00 BN ON &5 [ Dbl ivge OROFL]
BTN M EENSDREIIEON MRS OHFIIRIAC MM E FTMATRIOTEG 1S DD [ETHRE e ]

Maid FoliMUGdOdMdddddRddFdeadad i@ dddidl bdadilBEd WMl aRuwE EGaaedEBired
0 LE 50 AF B 07 09 30 13 05 0N 55 18 35 [mOOUGLESRRS U]

BANTIED 04 O 30 0K OF O ZH 06 01 05 O 07 00 00 30 1P OF O 55 LB SN 04 16 30 18 0 L4 AN 4 P2 BE 63 59 50 M OF FO 7O BL 62 B0 56 34 [O+-0UN0 ik (4584 ]

BANTUS: B3 MG T 44 30 8T 0L [ 1m0

FADD LRI EAF-H ik [

BANTHD O O O3 55 18 LF O B 01 05 30 62 00 00 30 #1 FE AD S FH RO B P 86 6L B 60 60 61 TO 3K 3 GF OF 43 4H 30 63 61 [UO0kdep g =ax]

BANILG G GE G D TR 6K N 6P 63 TD N 60 OF & 6l & [.lorondon.locsl]

BANTUST DO 43 AN 0 G D D0 4D AE 30 4D 0 B0 D0 43 AE [ O s OHeI W]

RASTURI 0 RO TE R R BRI DD 0 NG W [shubl ok d]

RSt D OEE TR M G BN R TR RC A0 R 0 BN R TR M [l G, Ol ]

BANTIHG G5 6N ED TH 3O AN AN 0 AN OF BN 85 & &7 TS T [dos, Sietondigur]

BANTUS: L TH S5 P 6N 20 44 43 30 60 49 63 T2 6P & 9 [wilon JD0=wicrond]

BT D TINH D MM T SIA NN DS TE M [onb=loalioert]

FARE LRI R D L TR R SR M R E T OER @ [fas et o]

BANTIHD BN 4GS T M N X Gl TH OGS NP P 62 GA B &) [nidwt Hhsstobriec]

BANTIHD T4 A3 B EL T TH M BN BZ 4 M 69 TH M TR & [tlumwechilfiwtrd]

B ETEHOT AT ETN RSN MW [t b

FAIURI A ET IT R D IR D TR @ TD IR [, marandaas . ]

RASTURI R BT D 6L B T A0 R T MO B TD @ B0 &0 [Looul AoerEaial 1]

WAL OF 63 6L 0N &8 [ son.u]
RADIUS: Message-RAuthenticateo[80] 18
RADIUS: Al DC DF 16 43 35 CA SC B4 3C 55 31 71 31 41 01 [ C<UlglAl

RADIUS{00000036): Received from id 1645/163
BADIUS/DECCODE: EAP-Message fragments, 253+253+253+4253, total 1012 bytes

<snip>

dotlx-ev(Gi0/7): Received pkt saddr =0026.55d0.0d456 , daddr = 0180.c200.0003,
pas=-ether-type = 888e.0100.002b

dotlx-ev(GL0/T): dotlx sendRespToServer: Response sent to the server from 0xC300005B

(02e.55d0. 0d56)

BADIUS/ ENCODE (00000036) :0rig. compenent type = DOTLX

BADIUS(00000036) : Config WRAS IP: 10.1.10.7

BADIUS/ENCODE (00000036} : acct_session_id: 54

BADIUS (00000036} : sending

RADIUS{ 00000038) : Send Access-Regquest to 172.31.1.20:1812 id 1645/171, len 306

RADIUS: authenticater 3F 5% C2 5B F2 1% BO &2 - 48 B9 TF 62 62 24 C0O 46

RADIUS: User-Hame [1] 11 "employesl™
RADIUS: Service-Type [&] [ Framed [2]1
BADIUS: Framed-MTU [12] & 1500

BADIUS: Called-Station-Id [30] 158 "Cd4-64-13-6C-E8-07"
BADIUS: cCalling-Station-Id [31] 1% "00-26-55-D0-0D-58"

BADIUS: EAF-Message [79] 45

RADIUS: 02 4F 00 28 1% 00 17 03 01 00 20 37 07 DT 71 29 9D 4D 7D 5B C6 3D 7C 85 4R 3F
4F 83 2A 08 77 [0+ TglM)}[=]T70%]

RADIUS: 3% 7C 4A E& 44 13 12 04 RE C3 1& 13 [ %1JD])

RADIUS: Message-Ruthenticato[80] 18

RADIUS: 87 &R 31 76 49 99 00 &F 39 EB 04 26 99 FO F5 [ jlvIen¥sl
RADIUS: EAP=-HKey-Hamsa [102]) 2 .

RADIUS: Vendor, Cisco [26] 49

RADIUS: Cisco AVpair [1) 43 “audit-session-id=0R010A070000003100EE1IDER"
RADIUS: HAS-Fort-Type [61] & Ethernet [15]

BADIUS: MRS-Port [3] 3 50007
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RADIUS: NAS=Port=Id [87)] 20 "@EigabitEthernet(/7"

RADIUS: State [24] 73

RADIUS: 33 37 43 50 4D 53 &% 73 73 63 6F 6E 49 44 3D 30 [3TCEMSessionID=0])
RADIUS: 41 30 31 30 41 30 37 30 30 30 30 30 30 323 31 30 [AOLOAOTOOOOO00310]
RADIUS: 30 45 45 31 44 45 41 3B 32 38 53 6% 73 73 &% oF [OEELDER; 26Sessic)
RADIUS: 6E 4% 44 3D 49 53 45 2F 31 34 33 35 35 38 35 35 [nID=ISE/14355855)
RADIUS: 33 ZF 33 30 33 32 3B [ 3/3032:)

RADIUS: HAS-IP-Rddress [4] [ 10.1.10.7

RADIUS{00000036) : Started 5 sec timecut

f/ RADIUS Access-Accept message after successful authentication. It contains
additienal authorizatien attributes like dACL name.

RADIUS: Receiwved from id 1645/171 172.31.1.20:1812, Access-RAccept, len 40%
RADIUS: authenticater 04 5F 01 D2 2B 18 12 €3 - &% 37 ©C SE EBE C4 BE 7F
BRDIUS: User-Mame (1 11 “employeel™

RADIUS: State [z4] 40

RADIUS: 52 65 el 75 74 68 52 65 73 73 69 6F GE 3A 30 41 [ReauthSsasion:O0R)
RADIUS: 30 31 30 41 30 37 30 30 30 30 30 30 33 31 30 30 [010AOTOOO0003100)
RADIUS: 45 45 31 44 45 41 [ EE1LER]

RADIUS: Class [25] 50

RADIUS: 43 41 43 53 3A 30 41 30 31 30 41 30 37 30 30 30 [CACS:0R0LOADTODO0]
RADIUS: 30 30 30 33 31 30 30 45 45 31 44 45 41 3A 49 53 [0003100EELIDER:IS]
RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 30 33 32 [ BS143558553/3032]
BADIUS: Termination-Rction [29) 6 1

RADIUS: EAP-Message [791 &

RADIUS: 03 4F 00 04 [ o)

BADIUS: Message-RAuthenticato[80] 18

RADIUS: ES B3 8E 2B 05 7% 3F BS 2F 1B 48 A3 17 A? A4 FR [ +u?/H)
BADIUS: EAP-Key-Hame [102] &7 *

RADIUS: Vendor, Cisco [261 75

BADIUS: Cisco AVpair [1) &% "ACS:CiscoSecure-Defined=-ACL=§ACSACLE=-IF=-

FERMIT_ALL_TRAFFIC-4£57ed06™

RADIUS: Vendor, Microsoft  [28] 58

RADIUS: M5 -HMFFE- Sand-Key [18] 5z =

BADIUS: Vendor, Microsoft  [26] 58

RADIUS: M5 -HMFFE-Recv-Key [17] 52 *

BADIUS(00000036) : Received from id 1645/171

RADIUS/DECCDE: EAP-Meassage fragments, 4, total 4 bytes

$DOT1X-5-3UCCESS: Authentication successful for client (0026.55d0.0d456) on Interface
Gi0/7 AuditSessionID

dotlx-ev(Gi0/T): Sending event (2] to Ruth Mgr for 0026.55d0.0d56
RAUTHMGR=-7=RESULT: Authentication result 'success' from 'dotlz' for client
(0026.55d0.0d56) on Interface Gild/7 AuditSessionID OAOLOAQTOOO00003100EELDER

SEPM-6-POLICY_REQ: IF 0.0.0.0] MAC 0026.33d0.0d456] AuditSessicnlID
OROL0RGTO000003100EELIDER| RUTHTYFE DOT1X| EVENT AFPLY

WEPM=6~IFPEVENT: IF 0.0.0.0] MAC 0026.55d0.0d56| AuditSessionID
OAOLO0RGTO000003100EEIDER| AUTHTYPE DOT1X| EVENT IP-WAIT

RAUTHMGER=-5-3UCCESS : Authorization succeeded for client (0026.55d0.0d56) on Interface
GLO/T AuditSessionID (ROLOARDTOO00003L00EELDER
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f/ Hote that there is no ACL download in this case. This is becausa the ACL of
the =sams nams has bean alresdy downloaded in the previous stepa (IP Phone

authorization) .

dotlx=ev(GLi0/T):
dotlx-ev(GLO/ST):

Received Ruthz Success for the client 0mC300005B (0026.55d0.0d56)
Sending ERPOL packet te 0026.55d0. 0456

dotlz-ev(Ei0/7}: Role determination not regquired

dotlx-ev{Gid/T): Sending ocut ERAPOL packet

BADIUS/ ENCODE (00000036) :0rig. component type = DOTL1X

RADIUS{00000036) : Config MRS IF: 10.1.10.7

RADIUS(00000038) : sending

S/ BADIUE accounting message is sent

BADIUS(00000036) : Send Accounting-Request to 172.31.1.20:1813 id 1e4e/27, len 282

BRADIUS: authenticater 7F %6 5F 1E FA 14 C5 4A - 7F 46 CA 57 CD &2 E1 48
RADIUS: Roct-Seasion-Id [44] 10 ™"00O0O0O003&"

BADIUS: Vendor, Cisco (28] 48

RADIUS: Cisco A¥pair [11 43 "audit-session-id=0R010AO0TO000003L00EELDEA™
BADIUS: User-Hame [1] 11 “employesl"

RADIUS: Vendor, Cisco [26] 32

RADIUS: Ciseco RAVpair [1) 26 "connect-progresa=Call Up"

RADIUS: BAcct-Authentic [45] RADIUS [11

RADIUS: Roct-Status-Type [40) Start [1)

RADIUS: HAS-Fort-Type [61] Ethe rnet [13]

BRADIUS: HAS=PFort 3] 50007

RADIUS: HNAS-FPort-Id [87] 20 "GigabitBthernetd/7"

RADIUS: Called-3tation-Id [30] 1% ™C4-64-13-6C-EB-0T"

RADIUS: Calling-Station-Id [31] 1% "00-26-55-D0-0D-586"

RADIUS: Class [23] =0

RADIUS: 43 41 43 53 3A 30 41 30 31 30 41 30 37 30 30 30 [CRCS:O0RO0LOGAODTOOO)
RADIUS: 30 30 30 33 31 30 30 45 45 31 44 45 41 3A 4% 53 [0003100EE1DEA: IS)
RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 30 33 32 [ B/Ll43558553/3032)
RADIUS: Service-Type [5] 6  Framed [21

BADIUS: MNRS-IP-Rddress (4] 6  10.1.10.7

RADIUS: Unsupported [151] 10

BADIUS: 39 41 43 35 39 42 43 31 [ SRCSSBCL]

BADIUS: Acct-Delay-Time [41) & o

RADIUS(00000036) : Started 5 aec timeout

RADIUS: Receiwved from id 1646/27 172.31.1.20:1813, Accounting-response, len 20
RADIUS: authenticator 10 CE B8 B8F 5C 12 10 FR - RS 76 EF 72 17 01 ET 94
FADIUS/ENCODE (00000036) :0rig. component type = DOT1X

RADIUS (00000036} : Config MRS IP: 10.1.10.7

BADIUS(00000038) : sending

$EFM-6-IFEVENT: IF 10.1.10.104| MAC 0026.55d0.0456| AuditSessionID

OAL 10ALT 0000003100EELIDER| RUTHTYPE DOT1X| EVENT IP-RSSIGHNMENT
WEFM=-6-POLICY _APF SUCCESS: IPF 10.1.10.104] MAC 0026.55d0.0d56| AuditSessionID
OAD10ADT 0000003100EEIDER| AUTHTEPE DOT1X| POLICY TYPE Hamed ACL| POLICY MAME XRACSACLE-
IP-FERMIT_ALL_TRAFFIC-4£57ed406&]| RESULT SUCCESS
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WEPM=G-IFEVENT: IF 10.1.10.104| MAC 0026.55d0.0d56] AuditSessionID
OAOLOAXTOO0D0003L00EEIDEA] AUTHTYPE DOT1X| EVENT IP-RELERSE

$EPM-5-IFEVENT: IF 10.1.10.104| MAC 0026.55d0.0d56] AuditSessionID
OAOLOADTOOO00031L00EEIDER| AUTHTYFPE DOTI1X|] EVENT IP-WAIT

$EFM-G-IFEVENT: IF 10.1.10.104| MAC 0026.55d0.0d56| AuditSessionID
OAOLOADTOO00003L00EEIDER| AUTHTYPE DOT1X| EVENT IP=-ASSIGHMENT

$EPM=6=POLICY_APP SUCCESS: IP 10.1.10.104| MAC 0026.55d0.0456| AuditsSessienID
OAOLOANTOO0O0003L00EEIDER| AUTHTYPE DOTI1X| POLICY TYFE Hamed RCL| POLICY HAME xRCSACL=-
IP-FERMIT_ALL TRAFFIC-4£57ed406]| RESULT SUCCESS

// eheck sut authenticatien sessiens on the pert. You sheould ses two separate

domains (VOICE and DATA) sach authenticated separately.

SWl#sh auth sess int g0/7

Interface: GigabitEthernet(/7
MAC Rddress: 0026.55d0.0d56
IP Address: 10.1.10.104
User-Hame: emplojyesal
Status: RAuthz Success
Domain: DRTAR
Security Policy: Should Secure
Sscurity Status: Unsecure
Cper host mode: multi-domain
Cper control dir: both
Authorized By: Ruthentication Server
Vlian Group: HN/R
ACS ACL: =xRCSACLx-IP-PERMIT ALL TRAFFIC-4f5T7ad40c
Session timeocut: HN/R
Idle timecut: H/A
Commen Sessicn ID: OROLOAOTOOO0003L100EELIDER
Roct Session ID: O0=00000036
Handle: OxRE0OOOO3L

Runnable methods list:
Method  State

dotlx Authe Success
maks Kot run
Interface: GigabitEtherneti/7
MAC RAddress: 002Z1.a084.6££4
IF Address: Unknown
User-Hame: 00-21-A0-84-6F-F4
Status: Ruthz Success
Domain: VOICE
Security Policy: sShould Secure
Security Status: Unseacure
oper host mode: multi-demain
Cper control dir: both

Authorized By: Ruthentication Server
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RC3 RCL:

Session timecut:
Idle timeout:
Common Session ID:
Aocct Session ID:

Handle:

Funnable metheds list:

Method
dotlx
mak

Check ISE logs.

Tirs: vihng Dot

Isn 25013 P20 7 PN u
InBPEEISIEMN B
IndparEsmmaa . B

State
Failed

XRCSACLY=IP=-FERMIT ALL TRAFFIC-4f57ad06
H/R

H/R

OROL OADTOO0000ZFOOEDSE2S

0x00000034

0x3500002F

owvar

Authe Success

=
a ¥

@ ¥

ETLATE Endpoirk T [P Sddmr Hetwork Dirdcn Chrvicn Port

Surforestion Profim  [dantiy Group

E= N | AM_Fucree_Profls
F-FEA Wl

L S E e 1Choo_[P_Phiress Pt - [P-P

Check is the NIC is up and running.

. LAB-Metwrork
k“ micronics.oca

@i Intel () PRO/LO0D PT Dual Port N...
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LAB 3.10. Wired 802.1x VLAN assignment

Obijectives
This lab shows how to configure 802.1x for wired environment with VLAN
assignment.

IP_Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 Lo0 1.1.1.1/32
E0/0 10.1.10.1/24
EON 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24
SWi VLAN10 10.1.10.7/24

Task

Configure ISE so that it authorizes user from AD Contractors group to VLAN

60. The users should get access to Web Server at 200.1.1.1 and be
reauthenticated every 6 minutes.
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Configuration
Complete these steps:

Step 1 Switch configuration.

!

interface GigabitEthernetd/7
authentication paricdia

avthentication timer reauthenticate server

Step 2 Create Downloadable ACL.

» Go to Policy > Policy Elements > Results > Authorization >
Downloadable ACLs and click Add. Enter WEB_SERVER as name,
enter ‘permit fcp any host 200.1.1.1 eq 80’ into DACL Content field
and click Submit.

BE et Lomb Pooo

B i rp—TT

Step 3 Create Authorization Profile.

* (Go to Policy > Policy Elements > Results > Authorization >
Authorization Profiles and click Add. Enter Contractors_VLANG0
as name and select the following options:

o DACL Name = WEB_SERVER
o VLAN=60
o Reauthentication = 360
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¥ oy
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* Click Save to apply the changes.
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Verification
Enable debugging on the switch:

dabug radius
debug dotlx event

Bounce Win7 NIC (LAB-Network) and check debug output.

dotlz=ev({Gi0/7): Received pkt saddr =0026.55d0.0d456 , daddr = 0180.c200.0003,

pas—ather-type = 888«.0100.002k
dotlx-ev(Gil/7): dotlx_ sendRespToServer: Response sent to
(0026, 5540, 0d56)
RADIUS/ ENCCDE (0000003E) :0rig. component type = DOTLX
RADIUS{0000003E) : Config WAS IF: 10.1.10.7
RADIUS/ENCCDE (0000003E) : acet sessien id: 62
BADIUS( 00000 03E) : sending

the server from 0=4100007B

// RADIUS authenticatien regquest for contracterl user is sent.

BADIUS(0000003E): Send Access-Request to 172.31.1.20:1812 id 1645/241, len 314

BADIUS: authenticater €1 05 31 1E D7 5D EF 6F - Rl 66 FO
RADIUS: User-Hame [1) 13

BADIUS: Service-Type 61 &

"eontractorl®
Framed

&R 07 00 ZR BC

[21
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=4}

RADIUS: Framed-IP=-Rddress [§:1] 10.1.10.104

RADIUS: Framed-MTU [12] & 1500

RADIUS: Called-Station-Id  [30] 1% "“Cd-&4-13-6C-E8-07"
RADIUS: cCalling-Station-Id [31] 1% "00-26-55-D0-0D-56"

BADIUS: ERP-Message [79] 45

RADIUS: 02 4F 00 2B 1% 00 17 03 01 00 20 FE DF 1F 34 0B F5 AR RS 24 C2 EC 0E 53 D8 FF
9% 87 55 CE 2D 78 7C OF RD 58 FE OF D3 FR 97 E1 29 [ o+ 4380=x]X}]

RADIUS: Message-RAuthenticate[80] 18

RADIUS: 38 6A 82 9% 26 F2 50 BE6 2A B9 D5 50 88 Fé B3 D1 [ 836F*F]
BADIUS: EAP-Key-Hams [102] 2 =

RADIUS: Vendor, Cisco [26] 49

RADIUS: Cisco AVpair [1) 43 T"audit-session=-id=0R010A0TO000003TO4BEIZCAY
RADIUS: HAS-Port-Type [61] & Ethe rnet [15]

FRADIUS: MRAS-Port 5] [ 50007

RADIUS: HAS-Fort-Id [87] 20 "GigabitEthernet(/7"

RADIUS: State [24] 73

RADIUS: 33 37 43 50 4D 53 65 73 73 6% 6F 6E 4% 44 3D 30 [37CPMSessionID=0]
RADIUS: 41 30 31 30 41 30 37 30 30 30 30 30 30 33 37 30 ([ROLOROT000000370])
RADIUS: 34 42 45 33 32 43 41 3B 32 38 53 65 73 73 69 6F [4BE32CRr283essio]
BADIUS: 4% 44 3D 49 53 45 ZF 31 34 33 35 35 38 35 35 [nID=ISE/l43558355]
RADIUS: 33 2F 33 30 36 34 3B [ 3/3064:)

RADIUS: HNAS-IP-Rddress [4]1 & 10.1.10.7

RADIUS(0000003E): Started 5 sec timeout

ff RADIUS Aoosss-Rocept message with authorization attributes is receiwved.

Hotice all configured attributes.

BADIUS: Receiwved from id 1645/241 172.31.1.20:1812, Access-Rccept, len 426
RADIUS: authenticateor 38 73 8% 7D FC F8 48 &5 - 7C BE 22 &7 04 DD 47 EO
RADIUS: User-Hame [1] 13 "ceontractorl"

BADIUS: State [24] 40

RADIUS: 52 65 61 73 74 68 33 63 73 73 6% 6F 6E 3A 30 41 [ReauthSession:0R]
RADIUS: 30 31 30 41 30 37 30 20 30 30 30 30 33 37 30 34 [0LOAOTOOOO003TO4])
RRADIUS: 42 45 33 32 43 41 [ BE32CR]

RADIUS: Class [25] S0

RADIUS: 43 41 43 53 3R 30 41 30 31 30 41 30 37 30 30 30 [CRCS:0AOLOROTOO00)
RADIUS: 30 30 30 33 37 30 34 42 45 33 32 43 41 3R 4% 53 [0003704BE3ZCA: IS)
BADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 30 36 34 [ E/143558353/3084)

RADIUS: Session-Timeocut [27] & 380

BADIUS: Termination-Rcotion [29] @ i

RADIUS: Tunnel-Typs [64] & 01:VLAN [13]

FADIUS: Tunnel-Medium-Type [65] & D1:ALL_802 [&]

BRADIUS: EAP=-Message [79] &

RADIUS: 03 4F 00 04 [ 2]

RADIUS: Message-Ruthenticato[80] 18

RADIUS: 38 FA E1 C% 40 Al 44 €1 D1 50 D® 8% TA 2C A8 E9 [ 8RDPz,]
BADIUS: Tunnel-Private-Groupl[8l] 5 01; " 60"

RADIUS: EAP-Key-Nama [102] &7 *

RADIUS: Vendor, Clace [28] &7

RADIUS: Cisco AVpair [1) 61 "ACS:CiscoSecure-Defined-ACI=#RACSACIH-1P-

WEE SERVER-5107a5db"
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RADIUS: Vender, Micresoft [26] 58

RADIUS: M3-MFFE-Send-Key [1] 52 =

BADIUS: Vendor, Microsoft  [26] 58

RADIUS: M3 -MFFE-Recv-HKey [17] 52 =

RADIUS(0000003E) : Received from id 1645/241

RADIUS/DECCDE: EAP-Massage fragments, 4, total 4 bytes

$DOT1X=5=8UCCESS: Authentication successful for client (0026.55d0.0456) on Interface
GL0/7 AuditSessionID

dotlx-ev{Gid/T): Sending event ({2) to BRuth Mgr for 0026.55d0.0d456
RAUTHMGR-T7-RESULT: Authentication result '"success' from 'dotlx' for client
(0026.55d0. 0d56) on Interface Gid/7 RAuditSessionID OROLOAROTOO00003TO4BEIZCA

// Based on received attributes VLAN &0 is applied to the port.

RAUTHMGR-5-VLANASSIGN: VLAN 60 assigned to Interface GA0/7 AuditSessionID
ORO10ADTO000003T04BEI2CR

BE PM=6-POLICY_REQ: IF 0.0.0.0] MAC 0026.55d0.0d56]1 AuditSessionID
OROLOADTOO00003TO4BEI2CA| AUTHTYPE DOT1X| EVENMT REPLY

BEEM-E-ARR: POLICY xACSACLx-IP-WEE SERVER-5107aS5db| EVENT DOWNLOAD-REQUEST
RADIUS/, ENCODE (00000000} :0rig. component type = INVALID

BADIUS( 00000000) : Config MAS IP: 10.1.10.7

RADIUS({ 00000000) : sending

[/ Ancther RADIUS request is needed to download ACL entries.

RADIUS (00000000} : Send Access-Request to 172,31.1.20:1812 id 1645/242, len 139
RADIUS: authenticator SD OB 06 22 FE EF 84 43 - CC B3 &9 1C 6B 00 1A 16

RADIUS: MHAS-IP-RAddress [4] [ 10.1.10.7

RADIUS: User-Hame [1) 33 M™HACSACLE-IP-WEE SERVER-5107aS5db™
BADIUS: Vendor, Cisco [26] az

RADIUS: Cisco AVpair [1) 26 "aaa:service=ip admission"

RADIUS: Vendor, Cisco [286] 30

BADIUS: Cisco AVpair [1] 24 "aaa:event=acl-download"

RADIUS: Message-Ruthenticato[80] 18

BRADIUS: 07 RS 43 68 RE 51 C3 36 76 7% 4A D4 F3 18 4D 04 [ ChQewydM]

RADIUS{ 00000000} : Started 5 sec timecut

BADIUS: Received from id 1645/242 172.31.1.20:1812, Recess-Rocept, len 221
RADIUS: authenticateor 40 C6& E1 37 75 Dé CD E5 - F1 40 1C 5D 6E FF 4A AD
RADIUS: User-Hame [1) 33 “MACSACLE-IP-WEE SERVER-5107aSdb®
RADIUS: State [24] 40

RADIUS: 32 63 61 73 74 68 33 63 73 73 69 6F 3A 61 63 [ReauthSession:ac)
RADIUS: 31 66 30 31 31 34 30 30 30 30 30 42 37 33 35 31 [1£011400000B7351)
RADIUS: 30 37 42 30 45 34 [ OTBOE4]

RADIUS: Class [25] 50

RADIUS: 43 41 43 53 3A 61 63 31 &6 30 31 31 34 30 30 30 [CACS:aclf0ll4 o]
RADIUS: 30 30 42 37 33 35 31 30 37 42 30 45 34 3R 49 53  [00BT3IS510TBOE4:IS)
RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 30 36 35 [ ES143558553/3065)
BADIUS: Termination-Retien [28] & 1

BADIUS: Message-Authenticato[80] 18

RADIUS: 75 30 06 23 OR 46 62 60 17 DT 54 AR 2% 4D 4D D3 [ uOdFb " M)

Page 96 of 507



CCIE SECURTY vd Lab Workbook

RADIUS: Vendor, Cisco [26] 54
RADIUS: Cisco AVpair [11 48 "ip:inacl#l=permit top any host 200.1.1.1 eg 80"
$AUTHMGR-5-3UCCESS: futhorization succeedad for client (0026.55d0.045%6) on Interface
GL0/T AuditSessionID 0AOLOADTOOOOOOITOLBEIZCR

dotlx-ev(GL0/7): Received RAuthz Success for the client Ox41000078 (0026.55d0.0d56)

SEPM-E=AAR: POLICY XACSACLE-IP-WEB SERVER-53107aSdb| EVENT DOWNLORD-SUCCESS
REPM=-E-IFEVENT: IF 0.0.0.0] MAC 0026.55d0.0d56] AuditSessionID
OAOLOADTOOO0003TO4EEIZCH| AUTHTYPE DOT1X|] EVENT IP-WARIT

[/ Authorization is successful but the switch must include cliesnt’s IF address
in the downloaded ACL. The switch waits fer the elient te get an IP address
from DHCF. When IF address is assigned, the switch reapplies the access list.
REPM-6-IFEVENT: IP 10.1.60.100] MAC 0026.353d0.0d456] AuditSessionlD
OAOLOAGTOO00003TO4BE3ZCR| AUTHTYPE DOT1X| EVENT IP-ASSIGHMENT
WEPM=6=POLICY APP SUCCESS: IPF 10.1.60.100] MARC 0026.55d0.0d56| AuditSessionID
OAOLOAGTO000003T04BEI2CA| AUTHTYPE DOT1X| POLICY TYPE Hamed ACL| POLICY NAME XACSACLE-
IP-WEE_SERVER-3107aSdb| RESULT SUWCCESS

Check commands output on the switch.

f/f Tha following commands is most usaful to ses authentication on port. There
is all infermatien in one place including username, IF address, authenticatien

domain and attributes downloaded from authorization server (ISE).

SWl#sh auth sess int g0/7

Interface: GigabitEthernet(/7
MAC RAddress: 0026.55d40.0d456
IP Rddreas: 10.1.80.100
User-Hame: contractorl
Status: RAuthz Success
Domain: DRTR
Security Policy: Should Sscure
Security Status: Unsecure
Oper host mode: multi-domain
Cper control dir: both
Authorized By: RAuthentication Server
Vlian Pelicy: &0
ACS RCL: =xACSACLx-IP-WEEB_SERVER-510T7aSdb

Session timeout:
Timecut action:
Idle timeout:
Common Session ID:
Acct Session ID:
Handle:

Runneble methods list:
Maethod State
dotlx

3els (server), Remaining: 2é8s
Reauthenticate

H/R

OR0L ORDT 000000 3D04ECDZ3D

0x00 00004 4

0=Rd 00003 D

Ruthe Succesa
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Interface: GigabitEthernet0/7
MAC Address: 0021.a084.6L£4
IF Address: Unknown
User-Name: 00=21=-R0=84=6F=Fd4
Status: RAuthz Success
Domain: VOICE
Security Pelicy: Should Secure
Security Status: Unsecure
Cpar heost mode: multi=-domain
Oper contrel dir: both
Authorized By: Authentication Server
ACS ACL: xRCSACLx-IP-FERMIT ALL TRAFFIC-4£57e406
Session timeout: N/R
Idle timecut: H/R
Commen Session ID: OROLOAOTOO00002FOOEDSBIS
Acct Session ID: O=00000034
Handle: O0x3500002F

Runnable methods list:
Method State
dotlx Failed over
mak Authe Success

f/ Usa ‘shew ip davies tracking' command te sea IP addresses on ports where
authentication is anabled.

SWlish ip dev tra all

IF Dewvice Tracking = Enabled

IF Device Tracking Frobe Count = 3

IF Device Tracking Probe Interval = 30

IF Device Tracking Frobe Delay Interval = 0

IF Rddress MAC RAddress VYlan Interface STATE
10.1.60.100 0026.55d0.0d56 &0 GigabitEthernetd/7 ACTIVE
ig.1.16.101 cd7d.4£39.8423 10 GigabitEthernetd/3 RCTIVE

Total number interfaces enabled: 2
Enabled interfaces:
GL0/3, GLO/T

// To see an access-list applied to the port use the following command. Hote
that there is a default access-list still applied to that port.

sWillsh ip access-lists interface g0/7
permit tcp host 10.1.60.100 host 200.1.1.1 eg www
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/{ Even though the port is statically configured in VLAN 10, the AuthManager

cverrides that

SWl#sh wvlan id &0

YLAN Hama Status Forts
60  Win?7 active Gin/7, Gin/24
Check ISE logs.
e v |tatus [petate [ EETHNE Erycipan, [0 [P Addkess Meivaork Denice | Deatos Port Authorigation Proles
B FCtR ERR AT R I R . | a HR-ANER o9
231311115004 | Q et I 265 S [ 55 10.1.10,10< L i HET P P Coniy achors_WLAENGD
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LAB 3.11.

Configure Wireless 802.1x

Obijectives
This lab shows how to configure 802.1x for wireless environment.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
EOM 172.31.1.1/24
AD NIC 172.31.1.200
WinXP NIC 10.1.10.50/24
WLC Go/oM 10.1.10.5/24
G0o/or2 10.1.30.5/24

Task

There is a Wireless Controller (WLC) installed at https://wlc.micronics.local
and Access Point having an IP address in VLAN 10 assigned automatically.
The WLC is pre-configured with SSID MICRONICS. Configure WPA2 with
802.1x authentication on this SSID so that users from
micronics.local/Users/employees AD group have access to all Internet
resources on port 80. Wireless clients should get IP address from 10.1.30.0/24
subnet from DHCP Server at 172.31.1.200. You must configure ASA firewall to

pass that traffic as well as ICMP and TCP/80.

Create new NDG on ISE for Wireless devices, setup WLC as AAA client with
‘cisco123’ shared secret and enable CoA on the wireless controller.
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Configuration
Complete these steps:

Step 1 ASA configuration.

1

access-list DME IN parmit iemp any any

access-list DMZ TN permit udp any host 172.31.1.200 eg bootps
access-list DME IN parmit tcp any any eg www

1

access-group DME IN in interface dmz

1

Step 2 Enable WPA2/802.1x on WLC for MICRONICS SSID.
* Go to web browser and connet to hitp://wlc. micronics.local. Login
using admin/Micronics1 credentials.

biCkrn Sysberna: Lagn - Mozlls Farelos
Bl EM Wew Hgor Beknaks Dok Hed

s Byvkarnn Lagn _'I-_

* i o iy el i B Fa |

|||||||||
cisco

Wireless LAN
Contraller

ﬂ A il ria o paaiead il o bang repeadad by i e e ore. bad, Tha s aas China
ol

L T

[ ] _coad |

* Go to WIRELESS > Access Points > All APs and check if the WLC
sees Access Point. The name of AP can be different depending on
previous AP configuration.
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- P
------------ -
.

O SR

Go to SECURITY > AAA > RADIUS > Authentication and click New
to as RADIUS Server. Provide all required information. Make sure to
enable support for RFC3576 (RADIUS CoA). Click Apply.

Zareur IF Addinas "EER TN
Shered Secre Parmat SECI =
o P Sasdfees [amawae
Lha Cerliera Shared Lacret FErrrE—
Vet
g l, Sn——r— ¥ wd ap wrap complurt EADIS werear]
a5 T wireke hrmz |
] .
o W Enabled =l
b Local BAR Tkl |
¥ Pricsity Onder T sooemis
b Comilyin ¥ Grubls
b horess Cangrol Lists Wiaragarani = Erabl
¥ Wirplloxs Prebacten IFSer C E
Palicamx
b Weh Auth
TFassoD Sap
b sl

Go to WLANs and check if there is MICRONICS SSID on the list. If
s0, click 1 to make changes to that WLAN.

Page 102 of 507




CCIE SECURTY vd Lab Workbook

L

aleln
CISEn ECHITOR ‘flaks  COMTROLLER  wIFELESS  EECIRITY  SARASCEWEN

- WLERG [ Fibben,  Wors | Chisn ps Fiiar] [(asr Mifar] [Grvmin = gall
Fetugrard
WL ki
» Tree Preliic Haesr LA =T Stalin Srvrrdy Prdiee
ri WLAM FLCROR LS MICROME Easbied  Morm o

Go to Security > AAA Servers tab and pick RADIUS Server 1 from
the list. Alter Order Used for Authentication list so that there is only
RADIUS left.

WiLAHs WLANG » Edit WICROMICE CLITUM| Apply
T WLNh Gamersl | Secerty | Qab | Ademced |
v Liverced LeprD | Laperd | 4R Soemers
Authaaticatian fesvoen  Accamnmng Sarvars  Saees 7 [none 2] B
© Grabied seeer 3 [rarm 2
Sereerl
FTTe]

Trrmer 3 Wores =1 [ =1
Hadi s Server Acrpamimg
Inkaiina Updats. r

Losial EAF fghesaTioatian

Luesl EhF Raghandiogon T probdedd

Al arivH v tEon i ity ke foe
weab -sasths unor

L) Nrder Lied Fer Addfeeidic allen
?IJ » FRDIE = i
| =T |

ot : — | o

F ol Mok
1 Wb Falir cawet b andd A candeaoon it 5

x e L % WUEBH, AT AT OCLE

L S ey e, AT (WA LY BareLrineue e 1 reusd anolder’ sharer ]
+

Go to Security > Layer 2 tab and select WPA+WPA2 Layer 2
Security and pick WP A2 with AES. Select 802.1x for Auth Key Mgmt
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Go to Advanced tab and pick Allow AAA Override option. This
option is required to allow the WLC apply downloaded ACL name. The
ACL must be configured locally.
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Go to SECURITY > Access Control Lists > Access Control Lists
and click New. Enter a name for the ACL e.g.
ACL_INTERNET_ONLY and click Apply.

¢ Lacal Fis
* Pricrily Grdar

» Loraficete

= Arcews Comtrnl Livks

Aocdtn Coaired Lora

o Firslec Praisclion
Pulicles

B R Rl
Tawsittaiy G

g L |

Once the new ACL is created you should be able to edit it. On the
following screen pick Enable Counters checkbox (optional but useful

» Priedly Order
» Leraficete

= Aroevy Comvirsl Livis
Aodel b Caried Lt

TiwssiCany GRF

Add new entry in the ACL as presented on the following screen and
click Apply.
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alveals
CISC0

- AgE e 1
[ay =l
- o —
[ p—— fare -

* macal Fid
* Bricdily Grdar
b Lordtceta

= Aroevy Comirel Livks
Recsdn Coarined L

p Firelece Praiecin
Pulicles

B A R
T iSay KIP
b Mkl

* Once again click Add new rule and add another entry as presented

OecliRin Pt [am =l
» Lacal Bl e oy =
+ Brirly Grdar f— ECToRC
» Leraticete

= Aroevy Comirel Livks
Aucidn Coarinod Lt

o Firslec Praisction
ekl

R Rl
Tiwssitany G

o ik

+ The whole ACL should look like on the following screen.
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Step 3 Configure ISE. Check if there is NDG for Wireless devices and add
WLC as AAA Client.

* Go to Administration > Network Resources > Network Device
Groups > Groups > All Device Types and check if there is Wireless

group. The group should be there from previous tasks. If there is no
such group - create it.
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riatwark Davees ot Depdcm Groups el LSLILE Sarwars RADIES Servm Sensanom o b, Sarven WAL Harsgen:
Mk Dhegios Groups
reeivendl iDvavioe e R 5
4iae 2
L - il Oy - » hos |[d gk}
* = o e T e
Lo Y
£ o o
& Miccsion:
J r
|
- = v " g e _chrvTen_mm.cn_an - Fateon i Ty e L

* Go to Administration > Network Resources > Network Devices
and click Add. Enter a name for device and provide its IP address.
Make ita member of Wireless NDG and configure RADIUS shared
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secret. Click Submit.

¥ - rtenrh Dewicns - 5o smani i o - rarie s
Bl R e gy Gooimsle ok b
Ty g | 071 ¥
+ & i brd |- L |
stnafn
IS0 Tdewtky Seruboes Eaglee [T S
Tk Higion = B
N B L
P T b Db
Y ST R ey a———
Febamrk Deser "
Lz i
| eac
o i
L TN
= Mebracrk Dt '
I Dok s
*[Dadiem W | -
Aacel Farmes "
L] -
o [eo]
® i T i
Locattn [ 2 oralios Gk To Dol
D T | ey St T Dot
1 e atharticstion Settings
Erak Ao Sedting:
Fawed  RAHIE
L e S p—— o
Frastise eyt
* pp Froppbon Hes
* Fsuage Luienticsion Code Kes
Wy Inpodd Fomest & 2501 HERELERA
SR EgTings
ol sntiuie
B
[ Ee= Pl 2TTR £ O D | 56 Pioteatiorn ()

Step 4 Create new authentication policy.

-

Go to Policy > Authentication and add a new rule before the last
default rule. Enter a name for the rule e.g. Wireless Employee and
select Wireless_B802.1X as a condition (select it from library).
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Click black arrow on the left of the new rule to show more options. For
Identity Source select AD1. Click Save.
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Step 5 Create new authorization rule.

Go to Policy > Policy Elelments > Authorization > Authorization
Profiles and click Add. Enter a name for the profile e.g.

Wireless_Internet and pick Airespace ACL Name option. Provide
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-

ACL name exactly as it is created on the WLC. In this case
ACL_INTERNET_ONLY is the ACL name. Click Submit.
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Go to Policy > Authorization and add a new rule before Domain
Computer rule. Enter a name for the rule e.g. Wireless Domain User
and select the following compound conditions:
o The device through the user is connected to the network is in
Wireless NDG

AND
o The user belongs to AD group
micronics.locallUsers/iemployees
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For Permissions column select Wireless_Internet authorization
profile.
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Verification

Enable debugging on the WLC:

dabug alisnt <clisnt-MAC-address>

Create new connection on the Win7 PC.
* Go to Control Panel > Network and Internet > Manage Wireless Networks and
click Add. Select Manually create a network profile option and provide the following
settings:

o [
@\_;'dl v Contral Panel ¢ Hebwork snd Intemet ¢ Manage Wirdless Metrmrks i > elens Met =
tanage wirebess netwarks that use (Wirsk=ss Ketwark Connection)
Wind s Tries b0 conredt o these netwaris in the onderlgted beaw,
Add  Adegierpropartiaes Profisbyps  Mtwark and Shaning Cantar (7]
[E=2 0 ="
W+ el comcct o o wieless network
Eriter infarmation for the wireless retwark you want to ado
et th e MICROHICE
Sacuriy typ WAL -Enlarprice -
Encryplion type AES -
Security Ky
o Start thin cornactizn sxtomatical iy
Conract mwan # the netsrk in not Brosdcating
Waming [f you select this ok, W CompuosT's privacy might be o rsk
[ b | Cancal
i ems — .
Ll

* Click Next and then Change connection settings. On the Security tab select
options as follows:
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MICROAICS Wireless Metwerk Properties

Conneclion | Beourty

Sgoriy type: WP AZ-Enfarmies -

Encrypion type; #ES Ld

Chogose & retrvort auhentcebon nethad;

Weorasnfh Pratestar EAR (FEAR) || et
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rez Tm lopped on
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o || cams |

Click on Settings button and uncheck Validate server certificate option.
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o Enabls Fact Reonnadt
Endioece Mebwork ducess Protsdion
Becarnad: § server doms nok pramrt oypecbindng LY
Enable Jcrk ity Privacy

ik Caneal

Click on Configure button and uncheck the option:

|
EAPMECHARE Propasins Ed

‘ Wharn carracing

Srdurnatical uis g 'windors egan res and
peeepared (el choassin @ e

‘ || Cwed

Click OK and go back to the Security tab. Click Advanced Settings button and
check Specify authentication mode and select User authentication. Click OK and

close properties window.

Page 114 of 507



CCIE SECURTY vd Lab Workbook

Bedean ced settings

B L seitings |

Lbsay i hesri bt in "'| 5 e el s

aiertisks For ol ieers

Erasbolm wingln nign aan for B rebevor b

* Click on network connection icon on the Windows tray and select MICRONICS
network. Click Connect.

Cumantly corvesched b 4

g Unidentified network
Ho [riemat aces

MICRORECS M
[_Sonnfze |

* Provide user credentials to connect to the network.

| Waredosns Secuity =

Metaark Authenisatan
Mgzt anbs iner oedertink

smglcysal
===

] =

* You should see Connected status.
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Currently connected fo: %

ey MEOROMICS
T o bkemet sccess

T Unidentifisd nebaork
T o tomot accon

Wirde Netwark Conmechon -
MICRONICS Connecied ol
(b Btk o

Cipen Metwork and Shanng Center

Go to ISE and check authentication logs.

Entdpoint D F Addiess Netwark Devte  Dawca Port

Authoreation Profies

T v Statin Doriuk Mm | | | |
4

Ini0 = nnIEearm 8 =mrpiee] SETE WLE

Click on details icon to see more information.

Aulhenlication Summeany
Lagped A Januarp 30,2013 12:16: 3 537 PW

RADIUS Statu= Futhentication succee ded
S Faibre

Lt==mame Empkoyee]

R Address OEIE CEEH:0d
Fetwork Dedca WL 101905

Mlowed Prolocol Dafai Mebwork Arpess

Idamiy Stara am

Authonzation Profles:  Winless_inlamat

iZGA Sacuily Group

duthentication Prolacol : PEAP[EAP-MECHAPWD)

FLAuthemicaion Re= i
Ussr-Mame=amployes
State=Reauth=assior Cali 0 20500000 00935 105005
Clermeg =0 A L5 0 il Do DFS000C0000 351090606 | SEN 43556553/51 73
TeminationeAcior=RADLES- R eguest
W 5-WIPFE-Serd-bley =61 2d &2 OF B:47:29: 0h: 26: 0. 12 28 et e e B :chud £:08:23:/0: b3 0b:45:15 2a:3d:14: 7 b: fe: 3 o6
bl 5-MIFPE- Rlmzy-b =10t 61 - Bl el B D02 Ot DB F1 7R3 261 2 a7 22 e a3 B 23:63:90:65: 02: 33:6b: 52 16: 09:44: 0 2: 60

Airbepeal a-BC-Mare=ALL_INTERNET_DOALY

FLRelxied Evert=

5 Aurthaniicatice Dt s

Lagged 24 danuary 30,2012 12+ 1628 627 P
Oecumad A1 danuary 30,2013 12+ 16:38 634 P
Canar I5E

Ay hentication Mathod cotix

EOP Authertication Mathad : EAP-MECH&P2

EAF Turnal Mathad : FEAFR

kg armployoe

RADIUS Lkamama armployee

Callng Station 1D [OE € CERIM

Framad P Addeas

Lizay Caeal

Tstyark DEce Luie

Ftvar b Dgce Gmups: Ciesin:e Typeread Desice Typestvieless, Localion#all Lucaions
HAS F ddiess WIS

WLC debug while connecting the client.

{Cisco Contreoller) »debug client 00:0e:2e:ce:68: 54

Wirelezs_[ntemat
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f/ elient debug is enabled. There is a new client discovered on AF with the

following MAC address.

[Eace Conteollar) >*IHCF Socket Taak:
sacver id: 172.31.

*apfMaConnTask_3:
*apitoCannTask 3

Jan 23 1547400575 00e0ed 2eicai 68 [HCF  secvar Bdi 11.11.11.11  pevd
1. 200
Jan 30 10:33:11.057:

dan 3 10933111057

Qs 2esoe 6l 04 Remaciation peceived from mobdles on AP od:7d:4 Er 464k 00
Odifeidercerilds 84 1001.30.20 AWM (20) Changing IPvd ACL ‘none® [ACL ID 255)

=== "none’ (AL ID 255) === [caller apf_ policy.c1l697)

*apftaCoannTaak _3:

Jan 30 10:33411.057: 000w i2e oG8 B4 10.1.30.20 RIN [20) Changing IFvE ACL "nore” [ACL ID 255)

m— Tnema [ACL ITD 235) === [callar apd polioy.c:1864)

*apfMaConn Task_3:
00 (e 2w oond Gl 4
*apiMsConnTask s
Ol thea 2ea coma B8
*apitoConnTask 3a
*apftaConnTask _3:
*apfMaCannTask 34
o0 0
*apfMaConnTask_3:
*apfMsConnTask 3z
LN
*apftaCoannTask_3:
1
*apfMaConnTask_3:
Ol fres 2o cons Gl 4
*apfMsConnTask 3z
*apiMsConnTask i

Jan 30 10:33:11.057: 000w ileicws6i: M Rgplying site-specific Local Beidging oveccids for station
= vapld 1, site "defsult=group', intecface “dmz_intecface"

dan 30 10333:11.0571 0dndeidercerids 94 Applying Local Bridging Intecface Policy for station

= vlan &, intecface id 11, interfacs *dmz interface*

dan 30 10333:11.0571 0dadeidercerids 94 pooocassisidiE statustode is O and status is O

Jan 30 10:33:11.057: 00:0ai2e o068 M procassdsidiE  asid done flag Ls O finish flag ia O

Jan 30 10:33411.057: 00:0ai2eo0468: 04 OTA - pates [3): 130 132 139 12 18 150 24 36 48 72 96 108 O

Jan 30 103333110573
dan 3 10333111057

Dl e som 1680 04
Ol e roe il 44

supphates statusCode is 0 and gotSupphatesElement is 1
STA = rates [12)1 130 132 139 12 18 150 24 36 &8 72 96 104
Jan 30 10:33:11 057

Q000 126 420 168: 3 axtIuppRates statuaCods ia 0 and gotExtSuppRatesElamant ia

Jan 30 10:33411.057: 000w deicei68: 04 Processing RS IE type 48, lergth 20 for mobdle
dan 30 10:33:111.0571 000w idescerilis 94

Jdan 30 10333:11.057 1 dadei2esce il 4

Received RSN IE with O FPIDs from mobdle OQulwr2escer G894
Found an cache entrcy for BSSID cdiTdid f1461dba00 in PMKID

cache at indax O of station 00:0%:2erca: 6834

*apftaConnTask _3:

Jan 3 10:33:11.057: 0004260068 34 Removing BASTD o4 :Td:40: 46140200 from REKID cacha of

atation (0:0eile:ce: 68 M4

*apfMaConn Task_3:
i e 2o om B8 94
‘apfiaConnTask M
*apfMaCann Taak_3:
*apfaCannTaak_3:
*ap EMaConn Task_3:
*ag fMaConn Task_3:
R (200

*apfMsConnTask 3z
Q.
*apfMaConnTask_3:
*apfMaConnTask_3:
atate RUN [20)

*apitoConnTask 3:

Jan 3 10:33:411.057: 0008 ide icei68: 04 Rasetting MOCH PME Cache Entey O for station
dan 30 10:33:11.057 0 ddadeilescesdln 84
Jan 30 10:33411.057: 000424 1204681 04
Jan 30 10:33:11.057: 00:0aidecai6d 94
Jan 3 10:33:11.050: 000w ile e 168 04
Jan 30 10:33:111.058: 000w e o168 04

Setting actiwe key cache index & ==== @

unsetting FaklaVal Dis tedByh

apfMafundtatales

apfMelzitatelec

10, 1.30.20 RN [20) Change state to START (D) last state

dan 30 10:33:11.0581 0drderercerif 94 pamhpfhidiMobdlesStation?s AFF MS FEM WATT I3 MITH COMFPLETE =

Jan 30 10:33:11.058: 000w e ca168: 4
Jan 30 10:33:11.058 1 000w 2eice6d: B4

10.1.30.20 START [0) Initializing policy
10,1.30,20 START (1) change state to RUTHCHECK (2) last

dan 3 10933110580 ¢dadei2escedfls 94 100 1.30.20 AUTHOHECK (2) Change state to 8021K REQD (3)

last atate RUW [20)

*apfMaConnTask_3:
AT A E 46 4B 0D
*apfMsConnTask 3z
*apitoCannTask 3
e Tt 4 46 4l D0
*apfMaCoannTaak_3:
005 Qe Ded ool Gl 4

*apfMsConnTask 3z
*apiMsConnTask 3a
e Tt 4 E 464 A DD
*apftaConnTask 3:

dan 30 10433411058 00ileideicei6; 04
vapld 1 apVapld 1for this client

Jan 30 10:33111.0581 000w r2erceriln %4
dan 3¢ 10:33:11.058 00rdeidercerids 94
vapld 1 apVapld 1

Jan 30 10:33411.088 ¢ 00092 oai68: 04 apfPanhddUser? [apf palioy.o:268) Changing state fop mokile
an AP of A 46400 Erom Rssociated to Rssociated

10, 1.30,20 8021K_REQD (3) DHCP cequiced on AP

Mot Using WM Compliance code goaCap 00
10 1,30.20 021K REQD [3) Flunbed mobile IWAFF rule on AP

dan 30 10:33:11.0581 0drderiercerifs 94 Stopping deletion of kbbdle Station: [(callecid: 48)

dan 30 10:33:11.058 0dideiZercerids 94 Sending Assoc Response to station on BSSID

[atatua 0] ApVapld 1 Slet O

Jan 30 10:33:11.05: 0000826081680 M apiFrocesafssocheq [apd_80211.c:6230) hanging state for

mold le 00 0e: deice 68 04 on AP ST dEi 4634k 00 from Aasociated to Amsociated

*pomfmcnl veTask: Jan 30 10033711.0610 Odaderderomsdd 94 10.1. 30,20 Removed WPU entrcy.
*dotlxMagTask: Jan 30 10333011.064: Odadeilesce 6194 Disable ce=auth, use PMK Lifetime.

S/ BOZ.1x i= starting here. There are couple of Access-Challenge messsges

because there is FEAP negotiation and certificate authentication.
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*dotlxMagTask: Jan 30 10:33:11.064: 00:04 12020168134 dotlx = moving moblila 00:04:2aicei68: 94 Into Comecting state
*dotlxMagTask: Jan 30 10:33+11.064: 004043620 16854 Sending EAF-Request/Tdantity to mobile 00:0w:2e:0a:63:94 [ERF
Id 1)

Fhotls MW _MegTask 4: Jan 30 10:33:10.088: 00:0ei2eice: 68: 04 Recsived EAPCL STRRT from mobdle 00:0w:leice:6d:i4
*lotlx MW_MagTask d1 Jan 30 107331110881 d0dei2erom d819% dotlx = moving mobdle Odiler2ercerdls 4 into Connecting
atata

*Dotle M MagTask_4: Jan 30 10:33:11.088: 000w :2a0a: 68: 94 Hending EFF-Requast/Tdentity to mobila 00:0aileica:68:04
[ERF Td 2)

*hotlx MW _MegTask _4: Jan 30 10:33:18.1827 00:0ei2eice: 68: 04 Recsived EAPCL EAPPKT from mobile Od:0eilesce:6i: M
*hotls MW _MagTask 4: Jan 30 10:33:18,1825 00:0e:2eioe 6804 Recsived Identity Responss [coint=2) fcom mobdls

O v 2o o B8

*Dotlx_BW_MogTask di oJan 30 10:33:18.1827 ddudei2escer 8194 EAF Stabte update from Commecting to Authenticating for
meed Lo 00206+ 2o soa 168 134

*Dotlx MA_MagTask_4: Jan 30 10:33:18.182: 00:08 12600 6804 Jotlx - moving mokdle 00:08:2e:cei68: M Lnto
Buthenticating state

*hotlx MW _MegTask 4: Jan 30 10:33:18.182¢ 00:0e:12eioei 68: 04 Entecing Backend Auth Response state for mobile

Ol 2o e B M

*fotix bW_MegTask dr Jan 30 1033371819 ddodeilerce 6819 Processing Aocean=challenge for mobdle Odadwes 2escerffn 4
*heotlx BA_MegTask_4: Jan 30 10:33:18.184 ¢ 00:09 12000 68: 34 Entering Backand Ruth Rag state [Ld=230) for monila

D0 Dt 2t cld G814

*hotls MW _MegTask 4: Jan 30 10:33:18.18 ¢ 00:0ei2e e 68: 04 WARNING: wpdated EAP=Tdentiffier 2 == 230 for STA

Ol (e 2 oms G2 4

*hotls bW _MegTask _4: Jan 30 10:33:18.18 ¢ 00:0e 2610w 68: 04 Sending EAP Request from RAAR to mobdle 00:0e:2e:ce:68:94
[ERP Id 2309

*Dotlx_bW_MogTask di <Jan 30 10333018, 22% 00dwei2escm 6819 Recedved EAPOL ERFFKT from mobile OdndwiZesoma6lia
*Dotlx B _MegTask _4: Jan 30 10:33:18.229¢ 00:08:2e:29: 68: 94 Recelived EAP Response from mobile O0:de:Ze:ca:ed: M [ERF
Id 230, EAF Tygs 3)
Dot lx_MW_MegTask _4: Ja
O iy 2 o Gl B4
*lotlx MW_MagTask A1 Jan 30 10333718, 231 0010w 12erce 6819 Procassing Aocsas=Challenge for mobdle OQalwer2ercerd8r
*Dotle_bW_MogTask 41 <Jan 30 10:33:18.231 0rdeiZercm 6819 Entering Backend Auth Req state [1d=231) for mobdle
002 0 20 ot 681

A0 10433310, 228 000w leice: 68 4 Entecing Backend Ruth Responss astate for mokdle

<and g

*lotlx MW_MegTask di Jan 30 10733018, 42341 0010w i2erom 68194 Sending EAF Request from ARA to mobdle OQulwer2escer G894
[ERP Id 239

*Ootle MW _MagTask_4: Jan 30 10:33:18.438: 00:0%:24 0242 68: 94 Recalived EAPOL EAPFKT from mobile 0didw:2e:ca:6l: 8
*Dotlx MW MagTask _4: Jan 30 10:33:18.438¢ 00:08 126109 68: 34 Recelived EAF Response from mobdle O0:0e:Ze:ca:e8: M [ERF
Id 238, EAP Type 25)

*hotls MW _MagTask 4: Jan 30 10:33:18.4305 00:0e 2610w 68: 04 Entecing Backend Auth Responss state for mobile

O v 2o o B8

*Dotlx_bW_MogTask di <Jan 30 103337118, 5271 00udei2esce 68194 Processing Aoceas=-hooept for mobdle Odalwilescesds 94
*Dotlx MW MagTask_4: Jan 30 10:33:18.527¢ 00:00 126201 6804 Rasetting wak IFvd asl fpom 255 to 255

*Dotlx_WW_MegTask_4: Jan 30 10:33:18.527¢ 00:0wi2eicw: 68:04 10,1.30.20 @021X_REQD [3) changing IPv4 ACL "nene' [(ACL
ID 255) === 'mone’ [(ACL ID 255) === [caller apf palisy.c:1697)
*Dotlx MW _MagTask_4: Jan 30 1043318, 5271 000w ideice: 68: 04 10,1.30.20 S021K_REQD [3) Charging IPvE ACL "nene' (AL
ID 255) === ‘none’ [(ACL ID 255) === (caller apf palicy.cilddd)
*lotlx_ MW_MegTask d1 Jan 30 10733118, 5571 d0dei2eroer 6819 Inserting ARA Cvercide struct for mobdle

MRC: 000w :i2atoa 68104, soubsa 4

// access list is applied as par AAA server reguast.

*Dotlx BA_MagTask_4: Jan 30 10:33:18.537¢ 00:08:2e:00 68184 10.1.30.20 8021 REQD [3) Changing IFvd ACL "none' [ACL
ID 255) === 'RCLINTERMET OWLY' [(ACL ID ) === [zallar apf policy.c:1750)

*hotlx MW _MegTask 4: Jan 30 10:33:18, 5275 00:0ei2eice 68: 04 Setting ce=auth timecut to 1800 seconds, got from WLEN
canflig.

*fotlx BW_MegTask di Jan 30 10:33:18. 527 ddodeilescer 89 Station Odvder2escerffr % setting dotlx reauth timsout =
18040

*Detlx BA MagTask 4: Jan 30 10:33:18. 5374 00:04 26100 68: 34 Creating a FIT REKID Cacha antey for station

000w 2eica: 68: 94 RN 2)

*hotlx MW _MegTask 4: Jan 30 10:33:18. 5273 00:0ei2eiced 6804 Resstting MSCH MK Cache Entey O for station

05 (e 2w coad Gl 4

*fotlx BW_MegTask di Jan 30 10:33:18. 527 ddodeilescerd8i% Setting actiwe ey cache index 8 ===> @
*Dotlx_bW_MogTask dn oJan 30 10033118, 5271 dddei2esgm 6819 Setting active key cache index 8 ===> O

Page 118 of 507



CCIE SECURTY vd Lab Workbook

*Dotlx MW_MagTask 41 Jan 30 10:33118.5281 d01de12erca 68194
for station 00:04:2e:ce 168194

*hotlx BA_MagTask_4: Jan 30 10:33:18. 528+

Rdding BSSID cd17didfad6idba 00 to FMKID cacha at index &

Haw FRCID: [16)

*hotls MW _MegTask _4: Jan 30 10:33:18,528: [0000]) b5 ea 8 £1 2c 5c 67 B0 £9 & 64 25 33 60 8k 47

*Dotlx MW_MagTask 41 Jan 30 10133118, 5281 0010e12e1ce: 68194 Disabling re-auth since FMK lifetime can take care of
B L

*hotle MW _MagTaak _d:
Dot lx_WW_MagTask _4:
Dot lx MW_MagTask 4:

233

Jan 30 10:33:18. 528
JTan 30 10333318, 5285
SJan 30 10433318, 5244

00 e 120 ooh: 631 34
Qe s 2e o 68 04
D i0w i e icw: 68: 04

unsetting FekldVal idatedBylg
P sent to mobdlity gooug
Sending EAP=Success to mobdle (00 ilesce68:04 [EAP Id

sfan 30 10333018, 528 0dadeiZeasce 68194

*Dotix_MW_MagTask_d:
FHEID 2acha at Dndax
*Dot Li_b_pagTaak_4:
PMEID csche at indesx
*Dotlx_MA_MegTask_i:

*lotlx_bW_MagTask dz

*Dotlx_MA_bagTask_i:

Found an cache entrcy for BSSID cdiTdidfrdéadordd in
0 of atation 00:06: 2a:oa: 63104

Jdan 30 10:33:18.528¢ 0009 12609 68: 0 Found an cache entry for BASTD c4: T4 f:46:40:00 in
0 of station 00:0e: 2eice: 684

oJan 30 10:33:18, 5238 Including PMKID in ML [16)

Jan 30 10033.18, 520 [0000) b5 ea Bf £1 2o 5c 67 9 £3 =b & 25 33 49 b 47

Jan 30 10:33:18. 528 000w 2eoa 63104 Starting key exchange to mobile 00:0a:2eicai68:94, data

packets will be deoppsd

*hotlx MW _MegTask 4: Jan 30 10:33:18, 5205 00:0ei2eice 6804 Sending ERPOL-Key Message to mobdle 00:0wile:ce; 604

state INMITRME (message 1), peplay counbec O Od. 00 . 0d. Od. Od., 00, 00
*Dotlx_bW_MogTask di oJan 30 10733118, 5281 dddei2esce 681 % Entering Backend Auth Suocess state [(id=23%) for mobdle

00 0 20 o 63194

f/ authentication is successful. The client gets encryption keys from the WLC

for its sassion.

*Dotlx_BW_MogTask_ds Jan 30 10433718, 5289
molvd le 00101 2o ace B8 194
*Dstln B _MagTask_4: Jan 30 10:33:18. 5294
Authanticated atate

*Dotlx_WW_MegTask_4: Jan 30 10:33:148.535:
*hetlx MW MegTask 4: Jan 30 10433:18,535:
from moblle Ouder2eroni G
“Potix b MogTask_d: Jan 30 10433.18, 535:
maind Le 00 1 0m 1 2eroe B8 194
*Dotlx BN MagTask _4: Jan 30 10:33:18. 5362
Dot ln_BW_MagTask_4: Jan 30 10:33:18. 5362
00 Qe 2o oond Gl 4
*Dot 1x_NW_MegTask_4:
Ol rea 2ema coma Bl
*Dotlx_BW_MogTask_d:

il e aces G871 %4

00408 124 420 68194

000w i 2e iowd 683 94
Q00w 12w icw: 68 4

il 12 e aces $81 %4

000 120 020 63134
000w 120 120 68194
ofan 30 10333018, 5363 000w ile o 68104

dan 30 10333118, 5361 ddadei2eager 681

Aecedved Muth Success while in Authenticating state for

AStlR - mwing mobile 00:06:26:26:68: 04 inte

Received EAML~Key fcom mokile 00:0w: 2e:ce: 6l
Ignaring dnvalid EAPOL version [1) in EAML=key message

Recedved EAPdl~key in PIK START state [(message 2) from

FHE: Sanding cache add
Stopping eeteanamiasion timer for mebdilas

Sending the candom GIK in M3 for WPAZ client

Sending EAFOL~Hey Message to mobdle Odaldwiesce: G4

atate PIKIMITHEGDTIATING [rasssgs 3), eaplay counter 00.00.00.00.00.00,00.01

*Dotlx_MW_MegTask_4: Jan 30 10433:10. 5425 000w i2eicm: 68 04
*Dotlx_WW_MegTask_4: Jan 30 10:33:10.542: 0010w 20w 6804
from mobdle O0u0erderonr 68

*Dotle bW _MogTask 41 Jan 30 10733118, 5421 ddadeiesger 68104
4 feom mokile 00:08:2e:ice168:94

*Dotlx_MW_MagTask_d4: Jan 30 10:33:18.542¢ 00106 126109 68184
*Dotlx MW _MegTask_4: Jan 30 10433:10. 5427 000w i2eice: 6804
i4) last state MM [20)

*Dotlx_bW_MogTask di Jan 30 10733718, 5421 ddadeiesger 68104
4T AL 464200 vapTd 1 apiapld 1far thia clieant
*Dotlx M6 _MagTaak 4: Jan 30 10:33:18.5342: 00:06 126100 68184
*Dotlx MW_MegTask_d4: Jan 30 10:33:18, 5421 000w 260w 68: 04
on AP cd: Tdidfi 46400 vapld 1 apVapld 1
*Dotlx_bW_MogTask dn oJan 30 10333118, 5421 ddadeieager 68194
*Dotlx_BW_MogTask di Jan 30 10333718, 5421 ddadeiesger 68104
last atate AUN (200

*Dotlx MW _MagTaak _4: Jan 30 10:33:18.542: 00106126109 681584
5362

Received EAMEL~FKey fcom mokile 005 0w: 2e:ce: 6l
Ignering invalid EAPOL version (1) in EAFL~key message

Recedved EAFL~key in FIKIMITHEGOTIATING state [(massage

apfMalxStatsaIne

10,130,230 §021K_REQD [3) change state to LIAUTHOOMPLETE

10.1.30.20 LEAFTHCMPIETE (4) DHCEF required on AP

Mot Using WHM Coppliance code gosCap 00
10.1,30,20 LEAUTHCCMPLETE (4) Plurbesd mobdle LWAPFPF cule

apfMafunitatelng
10.1.30.20 LEAUFTHOMPIETE (4) Change state to RN [(20)

10.1.30.20 RIW [20) Reached FLUMBFASTFATH: from line
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*Dn Jan 30 10033118, 5421 00rderZercar 68194 10.1.30.20 RUN [20) Adding Fast Fath rule

typs = Alraspece

AF Cliant

on AF ed: 7464k 00, slot O, intarfess = 1, Q08 = O

IPvéd KL ID = 9O,

Dok 1_b_plagTask_d:
0, DSCE = O, TokeniD
*Dotle_MW_MagTask_d:
[TFvd ACL TD O, TPvE
*Dot 1x_Wd_MsgTask_i:

O iy 2 o Gl B4

*pambacalveTask: Jan

IPve FCL IR = 255,

Jdan 30 10:33:18, 5425 000w sZescw: 6804 10.1.30.20 RN [20) Fast Path cule [(contd...) #02.1F =
= 7004 Local Bridging Vian = O, Local Bridging intf id = 11

Jan 30 10133118, 543y ddader2erca 68194 10.1.30.20 RN [20) Succassfully plunbed mobile rulae
AL I 255

Jdan 30 10:33:18. 543 0004 126109 68: 34 Stopping etransmiasion timer for modla

0 1033308, 543 00i0ei 2 oni 6004 10.1,30,.20 Rdded NPV entiy of type 1, dtlFlags 00

// after authenticatien (which is done at Layer 2) the client asks fer IP

address.

There must be path opened betwean WLC and DHCF server to get an IF

address fer the elient.

*IHCF Socket Task:
ancap Owmecdd)
*[HCF Sooket Task:

*[HCP Socket Task:
10.1,30.5, gatewy

Jan 30 10733518, 6677 dhdwmilerom 681 IHCF cecedved op BOOTRECUEST (1) (len 324,vlan 10, port 1,

Jan 30 10:33:18. 6674 00:0et2aroat 6819 [HCF salecting relay 1 = control bBlack settings:
dhepfarvar: 0.0.0.0, dhepiatrask: 0.0.0.0,
dhepGatewsy: 0.0.0.0, dhephelay: 0.0.0.0 VIAM: O
Jan 30 10533 18, 6683 00: 0w 2esce; 6 [HCF selected pelsy 1 = 172.31.1.200 (local addoess
10.1.30.10, VL8 O, port 2]

*MHCP Socket Task: Jan 30 10033210, 6687 dvdearlercerdls 9 IHCP tranamdtting DHCE REQUEST (3)
*HCE Socket Task: Jan 30 10033018, 6687 dvdmiZerom @819 DHCF  opr BOOTREQUEST, htyper Ethecrnet, hlen: 6, hopair 1
*MHCF Socket Task: Jam 30 10:33:18.668: Jife:leioa:68: 9 [HCF xid: OxdaeSfda? [12565895374), secar Oy flags: O
*[HCF Sacket Task: Jam 30 10:33:18.668: (0ai2aicai Gl [HCP  chadde: 00:04:12ai0a:68: 04
*MHCP Socket Task: Jan 30 1053318, 6683 Mdeileicei6iiM HCP oladde: 0.0.0.0, yiadde: 0.0.0.0
*MHCP Socket Task: Jam 30 10433118, 6683 Mlwileicei 6l [HCPF  sladde: 0.0.0.0, gladde: 10.1.30.5
*IHCP Socket Task:r Jan 30 10033718, 6687 OvdmrZercerdlsd DHNCPF requested dpr 10.1.30.20
*MHCEF Socket Task: Jan 30 10033118, 6687 vdeilercer®d i DHCF sending REQUEST to 10.1.30.10 [len 32, port &, vlan
a1
*MHCF Socket Task: Jam 30 10:33:148.668: 0:0e:deicai 60194 [HCF selecting celay £ = conteol block settings:
dhepfecves: 0.0.0.0, dhapietmask: 0.0.0.0,
dhepatewsr: 0.0.0.0, dhephelay: 10.1.30.5 VIAN: O
*IHCF Socket Task: Jan 30 10033018, 6687 OudwiZeroerd819d DHCF selected oelay 2 = MONE
*DHCF Socket Task: Jan 30 10033:18.7547 ddvdeaZeicerdd 19 DHCF recedved op BOOTREFLY (2) (len 312,vlan @, port 2,
anzap Oxecll)
*MHCF Socket Task: Jam 30 10:33:18.754: O0e:eicai 68194 [HCF setting secver feom ACK [secver 172.31.1.200;, yiadde
10.1.30.20)
*MHCP Socket Taak: Jam 30 10433418, 7543 Mkdwileicni 60 HCP sending REPLY to STA (len 418, pact 1, vlan 100
*MHCE Socket Task: Jan 30 10933018, 7547 dvdeiZeromid819 DHCF tranandtting DHCE MK (5)
*DHCF Socket Task: Jan 30 10033318.7547 dvderlercer @19 DHCF  opr BOOTREFLY, hiyper Ethermet, hlens &, hopar O
*MHCF Sacket Task: Jam 30 10:33:18.754: fi0e:2aioai 6810 HCP xid OxdaaSdas? [1256585378), secsmr O, flaga: O
*OHCF Socket Task: Jan 30 10:33:18.755¢ d0eideicai 684984 DHCF  chadde: 00:0w:iZaicai68: M4
*MHCP Socket Task: Jam 30 10:33:18.7553 Madwileicei6li HCP  cladde: 0.0.0.0, yiadde: 10.1.30.20
*IHCP Sacket Task: Jam 30 10:33:18.7553 (0w leicei 6l IHCP sdadde: 0.0.0.0, gladde: 0.0.0.0
*MHCP Socket Task: Jan 30 10533518, 755 Mdwileicei 60 M HCP  secver idi 11.11.11.11 covd secver dids
172, 3.1, 200

*IFv#_Mag_Task: Jan 30
MAT: 00:0E:2E:TEs 681 84
*MHCF Socket Task: Jam
encap Oxecid)

*[HCPF Sacket Task:

107 33718.7551 Odnder 2ercmr G819 Pushing IPvésr felle 000010000 100007 TdEf 167 0er 20nfr 2045 , and
¢ Binding to Data Flame, SUCCESS 11

30 10:33:21.8502 00+ 0% 2eroai 68 13 DHCP recelived op BOOTREQUEST (1) [lan 308,vlan 10, part 1,
Jan 30 10433321, 8503 00s0e:2eicei Gl i [HOP selecting relay 1 = canteal Black settings:
dhopfervers 172, 31.1.204, dhopietmask: 255.255.255.0,

dhopGateway: 10.1.30.10, dhopfelay: 10.1.30.5 VIAM: O

*[HCF Socket Task: Jan 30 10:33:21.8502 (:0e:2e:ca:6l: M [HCF salected malay 1 = 172.31.:1.200 [local addrass
10.1.30.5, gatewy 10.1.30.10, VLA O, part 2)

// here's the DHCF INFORM (or OFFER if this is first attempt to get an IF

address) with IP address for the client.
*DHCE Socket Task: Jan 30 10733:21.0500 OduderZercertd 94 BHCPF tranamdtting DHCE INFGRM (8)
*IHCP Socket Taskr Jan 30 100331218507 On0mrZercerdlsd DHCP  opr BOOTRECQUEST, htyper Ethernet, hlan: 6, hopar 1
*[HCF Socket Task: Jan 30 10:33:21.850: 00:0ei2e:cadi 6819 [HCF  xick OxbdboB2M [3216TMI64), seca O, flaga: O
*[HCF Socket Task: Jan 30 10:33:21.8504¢ 00:0e:2e:cadi68:9 [HCF  chadde: 00:0e:2eioai68:94
TIHCP Socket Task: Jan 30 10:33:21.8503 00:0w:lercei6i s [HCP  slsdde: 10.1.30.20, iadde: 0.0.0.0
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*MHCF Sockat Taak:
*MHCF Socket Taak:
LY

*MHCP Socket Task:

*DHCF Sockat Taak:
*[HCF Socket Task:
ancap 0xecdl)

*MHCP Socket Task:
*MHCP Socket Task:
*MCE Socket Taski
*DHCF Socket Task:
*[HCF Sockat Task:
*IHCF Sockat Taak:
*MHCP Socket Task:
TIHCP Sacket Task:
172,31, 1. 200

Jam
Jan

Jan

Jamn

Jam

Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan

30 10133121, 85801 dduder2ercer6819d DNCF  asdaddr: d.0u0.0, gladde: 1d.1.30.5
30 10433:21. 851 00:0a:2eioa: 6813 [HCF sending REQUEST te 10.1.30.10 [lan 346, paet 2, vian

30 10533321, 851 00w leicei 60 i DHCP selecting celay 2 = conteel klock settings:
dhepfecver: 172,311,200, dhepbetmask: 255,255, 255.0,

dhopGateway: 10.1.30.10, dhopflelay: 10.1.30.5 VLAN1 O

30 10933221.8511 ddudereice1 68194 DHNCF salected relay 2 - HOME

30 10:33:21. 8232 00 0e:2aioai 68 18 DHCP recelived op BOOTREFLY [2) [len 308,vlan O, poct 2,

30 1053321, 8233 00w 2eicwi 6l i [HCP sending REPLY to STA (len 418, poct 1, vlan 100
30 103320, 9233 000w e 681 DHCP teansmitting DHCP KOK (5

I 10933321, 9237 dvdmiZerom a9 IHNCF  opa BOOTREFLY, htyper Ethecmet, hlen: 6, hopar O
A 10933321, 9237 dhderlercm 6819 DHCF  xidi OxbfbofiM (3216794164, secor O, flagsr O
30 10:33:21.9232 0009 20 oai 68100 IHCP  chadde: 00:0% 126106168104

A0 1033218233 00 deioad 6840 DHCF  cdedde: 10.1.30.20, yiadde: 0.0.0.0

30 1053321, 0243 000w Rescwi 6l i DHCP  adadde: 0.0.0.0, gladde: 0.0.0.0

30 1023321, 0243 000w Rescwi 6l i DHCP  swcver id: 11.11.11.11 pevd sacvac id:
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LAB 3.12. Local Web Authentication (LWA)
for Wired
Objectives

This lab shows how to configure Local WebAuth on switch.

IP Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

R1 LoO 1.1.1.1/32
E0/0 10.1.10.1/24
EO0/M 172.31.1.1/24

AD NIC 172.31.1.200

WinXP NIC 10.1.10.50/24

WLC GO0/0/1 (mgmt.) 10.1.10.5/24
Go/or2 10.1.30.5/24

ASA1 GO0/0 (outside) 100.2.2.10/24
GO0/ (inside) 10.1.10.10/24
G0/2 (dmz) 10.1.30.10/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task

Disable Win7 native supplicant and Wireless connection. Enable LAN

connection and setup ISE to use WebAuth as a last resort authentication
mechanism for members of AD group micronics.local/Users/students. The
members of that group should have access to the following services after

authentication:
DSTIP
172.31.1.200

Protocol
TCP 80

DST Port

Service
www
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Any ICMP - Ping
172.31.1.200 UDP 53 DNS
Any TCP 3389 RDP

Allow only DNS and DHCP packets before authentication. You can alter
default authentication rule to first authenticate users against Internal |dentity
Store and then Active Directory. DO NOT use Downloadable ACL to
accomplish this task.
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Configuration

Complete these steps:
Step 1 Switch configuration.

Step 2

ISE configuration. Add Identity Source Sequence and change default

1
aas authentication login default group radius
aaa authorization auth-prexy default group radius
1
ip http sarver
ip http secure-server
ip admission name WEBADTH proxy http
!
ip accass-list extendsd PRE AUTH POLICY
permit udp any any eq bootps
permit udp any any eq domain
1
fallback profile WEBAUTH FROFILE
ip access-group FRE_AUTH POLICT in
ip admission WEBAUTH
1
interface GigabitEthernet0/7
no ip acocass-group DEFAULT in
authentication fallback WEBAUTH FROFILE
authentication order dotlx mab webauth
authentication event fail action next-method
1
ip access-list extended ACL WEBAUTH STUDENTS
permit tcp any host 172.31.1.200 eg www
permit icmp any any
permit tcp any any &g 3385
parmit udp any hest 172.31.1.200 &g domain
!

authentication rule.

-

Go to Administration > Identity Management > Identity Source
Sequences and click Add. Enter a name for the object e g.
Internal_then_AD and move Internal Users & AD1 identity stores o

the right pane. Click Submit
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Go to Policy > Authentication and for default rule (the last one)
change the identity source to Internal_then_AD.
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+ (Click Save 1o apply changes.
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Step 3 Create new authorization profile for Students.
* Go to Policy > Policy Elements > Results > Authorization >
Authorization Profiles and click Add. Enter a name for the object
e.g. Students_WebAuth, select Web Authentication (Local Web
Auth) and set Filter-1D to ACL_WEBAUTH_STUDENTS (the ACL
name as it is configured on the switch). Click Save.
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Step 4 Create new authorization rule for Students.

-

Go to Policy > Authorization and add anew rule. Enter a name for
the rule e.g. Students WebA uth and select compound condifion that
AD1:ExternalGroups Equals micronics.local/Users/students.
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For Permissions select Students_WebAuth authorization profile.
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Click Done and Save.
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Step 5 Win7 PC configuration.
* Go to Control Panel > Network and Internet > Network
Connections and disable wireless adapter.
* Go to Services (services msc) and disable Wired AutoConfig
service.
+ Enable LAN interface (LAB-Network)

Veri n

Enable debugging on the switch:

debug radius
dabug dotlx events

Check settings on the switch.

SWliésh run int g0/7
Building configuration...

Current configuration : 546 bytes
[

interface GigabitEthernetd/7
description IFF + Win7
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switchport access wlan 10

switchport mode access

switchport nonegotiate

switchport veoice wlan 3500

authentication event fall action next-method
authentication host-mode multi-domain
authentication order dotlx mab webauth
authentication port-contrel auto
authentication pericdic

authentication timer reauthenticate server
authentication wvioclation protect
authentication fallback WEERAUTH PROFILE
mak

dotlx pae authenticator

dotlx timecut tx-pericd 5

spanning-tree portfast
end

swWwi#sh ip access-lists interface gi/7

/f there is no ACL applied te the port. There is only IF Fhone authenticated

(VOICE domain)

SW1l#sh auth sess int g0/7
Interface: GigabitEthernatil/s?
MAC RAddress: 0021.a084.6££4
IF Rddress: Unknown
User-Hams: 00=21-A0-34-6F-F4
Btatus: RAuthz Success
Domain: VOICE
Security Pelicy: Should Secure
Security Status: Unsecure
Cpar host mode: milti-domain
Cper control dir: both
Authorized By: Ruthentication Server
RACE RACL: m—IP—E‘EMT_m_TMFIE—i:EE?eiDE
Session timeocut: H/R
Idle timeout: N/R
Common Session ID: OROLOAOTOOOO00ZFOOEDSE3S
Acct Session ID: Ox00000034
Handle: O0=x3500002F

Funnable methods list:
Mathed State
dotlx Failed owver
mak Authec Success
webauth HNot run

Enable LAB-Network connection on the Win7 PC. Check out switch logs.

F/ Datlx i=s starting on the awitch. It tries thres times and fails.
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dotlx-av G40/ 7) ¢ Couldn't find the supglizant in tha list

dotlx=av[GL0/7) ¢ Sanding ceeate new context event te EAF for On380000ET [0026. 5540, 0d456)
dotlz=av[GL0ST): Cosated a Glent entey [uIH0Q00ET)

dotlx=av[GL0ST) : Dotls authentication stacted foc OxBOO000ET (0026, 5540 . Dd56)

ANITWIGR=5=5TART: Starting ‘dotlx® for client [0024.5540.0d456) on Intecface GAdY7? AuditSessionID
Ol 1 R MOO0006 S0RDADF0D

dob1x-av[GL0S7) : Sending EAROL packet to 0026, 55300456
datlz=av [GL0S7) i Role determinstion not cegquiced
dotlz=av [GL0ST) : Sending out EAPOL packet

dotlx=av(Gi0S 7)1 Sending EAPOL packet to 0026, 55d0.0d456
dab1x-av [GL0S7) ¢ Rale deteerdnation nat eequiced
dotlx-ev[GL0/7) ¢ Sending out EAFOL pachket

dat lp=av (GL0ST): Sending ERPOL packet ts 0026, 55400456
dotlr=av (G0 7)1 Role determination not rcequired
dotlx=av(GEdF 7)1 Sending out EAFOL pachket

dot1x-av[GL0/7) ¢ Reseived an EAF Timeout

BDOTIH=-5=-FAIL: Puthentication falled for Sllent (0026, 5540.0456) on Intecface G007 RudtdsssdonlD

dotlx=av [GL0F 7] 1 Sending event [2) to Futh Mgr for 0026.5540, 0456

JAUTHEGR=T=RESULT : Authertication cesult ‘no-cesponss’ from 'dotlx' for client [0026.5540.0456) on Intecface GLOST
Audi tSeasionTD GROI0KOT 0000006 20ADAD0D

dotlx=av (G071 Recedved Authz fail for the client OxSO0OET (0026.55d0. 0d56)

dotlx-av[GL0S7) ¢ Deleting client Ox380000ET (0026, 5540, 0456)

f/ dotlx has failed, the next method is MAB.

WAUTHAGR-7-FAILVER: Falling over from "dotlx® for client [0026.5540.0456) on Intercfsse GL0/7 AuddtSassionlD
QA0 1 BADN000006 20ANIDF0D

FHITHMGR-5=-START: Stacting 'mak" foc client [D026.55d40.0456) on Intecface GI0/7 RuddtSessionlD
OR01 BAD000006 20ADI DF0D

dotlx=avibelete auth client [OxS80000E7) measage

dotlx=evifuth client ctx destcoyed

dotly-aviibspted pasting measage to authenticator state machine: Inwalid eliant

RADT UG/ BNCCDE (00000074) 1 Celg. comporant typs = DOTIX

RADTUS (90000074 ) Conflg WAS IF: 19.1.10.7

RADTUS/ ENCCDE (00000074) ¢ acct_session_id: 116

RADTUS (000000 )1 sanding

S/ HMAB newver times out because there is no supplicat required on the alient.

8o, the authentication based on MAC address is running.

RADTUS (00000074 ) Send Access=Request to 172.31.1.2041812 id 16457236, len 215
RADIUS: authenticator SF F3 35 47 990 D5 OF B7 = 1F B 59 60 D9 91 47 A9

RADIWER:  Wlasc=—plams (1] 4 "OO2aEEA00dEE "

RADIUS: User=Pasaword 2y 1w =

RADIUS: Secvice=Type (6] & Call check i
RADTUE: Feansed-TF-Rddeasa (8] & 10.1.00.104

RADIUS:  Freamsed-HTU rz] & 1500

RADTUS: Callsd=Station=Id [30] 18 "Cé=fi=]3=60=E)=(7"
RADTUS: Calling=Station=Id [31] 1% "00=26=55= 0= 0= 56"
RADIUS: Message=Ruthenticato[B83] 18

RADIUS: 26 &7 D2 19 10 3 AE F5 22 F5 47 91 6% 27 OF &8 [ &"ci*)
RADIUS: ERF-Hay-Havs w2y 2+

RADIUE: Vendar, Claso [26] 483

RADIWR:  Chaso AVpair (1] 43 "audit-sessaionLd=080 1 0R0P0000006 20RDADEOO"
RADIUS: MNRS=Poct=Typs [61] & Ethecnet s

RADIUS: MAS=Port 5 & 50007

RADIUS: MAS-Port=Id (&7) 20 “GigabitEthecmetdy7?"

RADIUS: MNRI=-TP-Rddraas 41 & 19.1.10.7

RADTUS [D0000074) + Started 5 sas timssut

// Tha ISE has no MAC address in the Endpeint Identity Store so it rejects the

aliant.

Page 130 of 507



CCIE SECURTY vd Lab Workbook

RADIUE: Received from Ld 16450236 172.31.1.20:1812, Recess-Reject, lan 38

RADIUE: authenticator 74 78 74 54 CE 6D 62 ED - 4D OO0 E6 7E 23 EF 16 FB
RADIWS: Messsge-Ruthenticato[80] 18
RADTUS: 1B 5 Bl 9B 26 F5 DB F6 15 CB Bl 64 OF 30 53 80 [ wecd0R)

RADIUS (D00000T )1 Received from id 1645723

AMRE-5-FAIL1 Muthentication failed for client [0026.5540.0486) on Interface GLGyf7 AuditSeasionID
TAD] GROTOO00006 20ADDFOD

WAUTHAGR-T-RESULT: Authentication result 'nmo-cesponse’
Rudi tSeasionID GANIDANT 0000006 20ADI DE0D

feom "mak' for clisnt [0026. 5530.0456) on Inteciecs GL0/7

f/ sinece we have third method configured en the pert the WebAuth is starting.

FHITHIGR-7=FRILVER: Palling over from "mak' for client [D026.5540,0456) on Interface GLOS7 BuditSessionll
DR BRD0000006 20RDI DF0D

ANITWIGR=5=5TART: Starting ‘webauth® for client (0026, 3530.0d458) on Intercface EO/7 MuditSessioniD

Ol 1 GO NDO0008 20RDA DR

[EPM=6=-FOLICY REQ: IF 0.0.0.001 MAC 0026, 5540045 | AuditleasionID ORII0RITOO0000620ADADF0N MFTHIYFE AFTHRROXYI
EVENT AFFLY

ff EMM is assigning a Fre-Auth ACL configured in the fallback profile.

REFM=6=-FOLICY RFF_SUCCESS: IF 10.1.10.1041 MAT 0026, 5540, 0456 AuditlasslonID 0ROI0ROVOI0000E20ADADEOO] RUTHTYFE
AUTHPROKY | POLICY_TYPE Mamed BCL| BELICT_MAME PRE_BUFTH_PFOLICY| RESULT SUCCESS

SHITHGR=T7=RESILT: Ruthentication cesult "succsss' from "webauth' for client (0026, 5530.0456) on Interfscs GLOS7
Audi tSeasionID GROIOADT 0000006 20ADADE0D

SAFTHGR=-5=5UCCESS: Authorization succeeded for cliemt [0024.5540.0d58) on Intecface Gi0/7 AuditSessionil

QR0 1 TADNOO0006 20ADDF0D

// Check the status on the switch. How we should ses authentication success on
DATA domain.

SWl#sh auth sess int g0/7

Interface: GigabitEthernet(/7
MAC Rddress: 0026.55d40.0d456
IP Rddress: 10.1.10.104
User-Hame: 002655d00d56
Status: Ruthz Success
Domain: DATR
Security Policy: Should Secure
Security Status: Unsecure
Oper host mode: multi-domain
Cper control dir: both

Authorized By:

ARuthentication Server

Vlan Group: N/R
Session timecut: H/A
Idle timeout: N/R
Common Session ID: OAOLOAOGTOO0000G620ADIDEOD
Acct Session ID: Ox00000074
Handle: OxzREOO0OGEZ
Funnable methods list:
Method State
dotlx Failed owver
maky Failed owver
webauth RAuthe Success
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Interface:

MAC Rddress:

IF Rddress:
User-Hame:
Status:

Domain:

Security Policy:
Security Status:
Cpar host mode:
Cper contrel dir:
Ruthorized By:
RACS RACL:

Session timecut:
Idle timeout:
Commen Session ID:
Acct Session ID:
Handle:

Funnable metheds list:

GigabitEtherneti/7
0021.a084 . 6££4

Unknown
00-21-A0-84-6F-F4

Ruthz Success

YOICE

Bhould Secure

Unsacurse

mult i—domain

both

ARuthentication Server
EACSACIE=-TP-FERMIT_ALL_TRAFFIC- 4£57ad06
H/A

H/R
OROLOADTOO0000ZFOOEDSE2S
000000034

0x3500002F

Methed State

dotlx Failed over
mak Authe Success
webauth Hot run

f/ There is pre-auth ACL applied to the port.

SWlWsh ip access=lists interface g0/7
parmit udp host 10.1.10.104 any ag bootps
permit udp host 10.1.10.104 any =q domain

Now go to Win7 PC and open up web browser. Enter some IP address and hit enter.
*«  You should get a special webpage asking for authentication. Provide user credentials
of student1/Micronics1 and click OK.

= =R

& hripy .d" Authmnbcstion Prosy Login.. fr, A E

F= 172.31.1 200 DX

Username: e

Pﬂ ssward M
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-

L]

A pop-up window appears with certificate warning. Accept the connection.

2 Certificate Erron Naviggation Blo.. |-—-|| & [m3s]
2 |

-

|g There is a problem with th

The secunty certificate presented
The secun Ly oerl ficate preseniec

3
Security certificate problems may
SRV,

We recommend that you clase
& Click nere to dose this webgpa)

& Continue to this website (not =

You should be successfully authenficated.

L
=) Success Page - Windows Interme,., |- — || @ |

"

Authentication
Successful !

| DOME

Now you can access the web page.
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& hoip:172.31.1.200 L= X[l g72311300

== =R "5

& T

Welcome to default website

Check logs on the switch.

RADIUS/ENCODE (00000075) :Orig. compenent type = AUTH PROXY
RADIUS{ 00000075} : Cenfig WAS IF: 10.1.10.7

RADIUS/ENCODE (00000075) : acct_session_id: 117

RADIUS{ 000000735} : sending

f/ RADIUS request is sent to the ISE for usernams ‘studentl’

RADIUS{ 00000075): Send Rccesa-Request to 172.31.1.20:1812 id 1645%/237, len 185
authenticator D6 23 03 51 BF E7 68 D2 - D7 DD Al ZA 8D F2 23 76

BADIUS:
RADIUS:
RADIUS:
RADIUS:
RADIUS:
BADIUS:
RADIUS:
RADIUS:
BADIUS:
RADIUS:
BADIUS:
RADIUS:
BADIUS:

Use r-Name (1 10 "studentl™
User-Fassword [21 18 =

Framed-IP-Address [B] & 10.1.10.104
Service-Type [&] &  Outbound [51
Message-Ruthenticate[80] 18

36 AF DO 76 A0 ZE 0C DD 28 3C EC A6 7C 6B BF 92 [ &v.{<lk]
Vendor, Clisco [28] 43

Ciseco AVpair (1 43 "audit-gession-id=0R010A0T7000000620RDIDF 00"
HAS-Port—Type [61] & Ethernet [151
MAS-Port [31 & 50007
HAS-Port-Id [87] 20 "GigabitEthernet0/7"
HAS=IP-Rddress [41 6 10.1.10.7

RADIUS({00000075): Started 5 sec timecut

RRADIUS:
RADIUS:
RADIUS:
RADIUS:

f/ I8E authenticates and authorizes the user because of modified default

avthentication rule (now the user can be search in two identity stores) and new

authorization rule for Students WebAuth.

Received from id 1645/237 172.31.1.20:1812, Rocess-Accept, len 188
authenticater BE AR &C 50 EF F1 7F 9F - C8 12 87 CA D7 C3 C3 Fl

Use r-Hame [1) 10 "studentl™
Filter-Id [111 25
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RADIUS:
RADIUS:
RRADIUS:
RADIUS:
RADIUS:
RADIUS:
BADIUS:
RADIUS:
RADIUS:
BADIUS:
RADIUS:
RADIUS:
RADIUS:
RRADIUS:
BADIUS:

41 43
45 4E
State
52 65
30 31
44 33
Classe
43 41
30 30
45 2F

4c
54

5F
53

&1
30
44

75
11
46

43
an
31

53
36
34

57
2B

74
30
30

an
iz
33

45
2]

4]
37
30

30
an
35

Terminaticn-Retion
Mas sage-Ruthenticato[80)
4F F4 1A 7C SE EE C©4 DF
Vendor, Cisco
Cisco AVpair
RADIUS (00000075} : Received from id 1645/237

4z 41
[24)
53 65
30 30

[25]
41 30
41 44
35 38

[291

[28]
[11

55 54 48 5F 533

54 55

[ ENTS.4in]

40

73 73 62 6F

30 30 30 30 36
[ D3DFOO]

50

31 30 41 30 37

33 44 46 30 30

35 35 33 2F 33

6 1

18

3A 320
32 30

30 30
3n 49
32 34

48 FD 1C 4D B4 ©4 63

is
13

"priv-1vl=15"

44

41
11

30
53
36

3

[ACL_WEBAUTH_STUD]

[ReauthSessicn : 0R]
[010R0TODO00062Z0R)

[CACS: 0RO 10ADT 000]
[000620RD3DE00 : 1S]
[ E/143558553/ 3246]

[ ©lHHe]

f/ EPM is changing ACL on port. Mow the ACL sent from the ISE is applied.

BEPM-6-POLICY_REQ: IP 10.1.10.104| MAC 0026.55d0.0456| AuditSessionID
OAO10A0T000000620ADIDFO0| AUTHTYPE RUTHPROXY| EVENT APPLY
SEPN-6-POLICY AP SUCCESS: IF 1001.10.104] MAC 0026.55d0.0d56] RAuditSessionID

OAOL0A0 70000 00620RDIDFO0| AUTHTYPE AUTHPROXY| POLICY_TYPE Named ACL| POLICY NAME
ACL_WEBAUTH STUDENTS| RESULT SUCCESS

sWillsh ip access-lists interface g0/7

parmit tep host 10.1.10.104 hest 172.31.1.200 eag www

permit icmp host 10.1.10.104 any
permit tcp host 10.1.10.104 any =g 3389
permit udp host 10.1.10.104 hest 172.31.1.200 g domain

sWilish auth sess int g0/7

Interface: GigabitEthernetd/7
MAC Rddress: 0026.55d0.0d5%6
IF Rddress: 10.1.10.104
User-Name: 002655400456
Status: RAuthz Success
Domain: DRTR
Security Pelicy: Should Secure
Security Status: Unsecure
Cpar host mode: multi=-domain
Cper contrel dir: both
Authorized By: Authentication Server
Ylan Group: N/A
Filter-Id: RACL WEBAUTH_STUDENTS
Session timecut: H/R
Idle timesout: HN/R

Common Session ID:
Acct Session ID:

OR01 0ROTO 00000 620RD IDF00

Ox0000007 4
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Handle:

Runnable methods liast:

OxRE 000062

Mathed State
dotlx Failed owver
mab Failed owver
webauth Ruthe Success
Interface: GigabitEtherneti/7
MAC Rddress: 0021.a084.6£f4
IF Address: Unknown
User-Hame: 00-21-A0-84-6F-F4
Status: RAuthz Success
Domain: VOICE

Security Policy:
Security Status:
Oper host mode:
Cper control dir:
Authorized By:
RCS RACL:

Session timecut:
Idle timeout:
Commen Session ID:
Acct Session ID:
Handle:

Runnable matheds list:

Should Secure

Unsacure

multi-domain

both

Authenticatiocn Server
EACIACIE-TP-FERMIT_ALL_TRAFFIC- 4£5 7406
H/R

H/R
OROLJADTOO0000ZFOOEDSE2S
000000034

0x3500002F

Authc Success

Method State

dotlx Failed owver
mak

webauth Hot run
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LAB 3.13. Central Web Authentication (CWA)

for Wired

Objectives

This lab shows how to configure Centralized WebAuth on.

IP Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

R1 LoO 1.1.1.1/32
E0/0 10.1.10.1/24
EO0/M 172.31.1.1/24

AD NIC 172.31.1.200

WinXP NIC 10.1.10.50/24

WLC GO0/0/1 (mgmt.) 10.1.10.5/24
Go/or2 10.1.30.5/24

ASA1 GO0/0 (outside) 100.2.2.10/24
GO0/ (inside) 10.1.10.10/24
G0/2 (dmz) 10.1.30.10/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task

Reconfigure switch so that it uses ISE to perform Central WebAuth. All users
without supplicant must be authenticated using WebAuth as a last resort

method. Configure ISE so that users from AD group

micronics.local/Users/employees get full access to the network after
authenticating through the website.
Use 802.1x low impact mode on the port and allow only DHCP, DNS, TFTP
and ICMP traffic without authentication.
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Configuration

Complete these steps:
Step 1 Switch configuration.

1
no aaa authentication login default group radius
ne aaa autherizatioen auth-prexy dafault group radius
1
ip access-list extendsd DEFAULT

remark DHCP

permit udp any eq bootpo any eq bootps

remark DHS

permit udp any any eq domain

remark TFIF

permit udp any any ag tftp

ramark Ping

parmit icmp any any

!

interface GigabitEthernet0/7

ne authantiecatien fallback WEBAUTH FROFILE

ip access-group DEFAIULT in

authentication order dotlx mab

authentication event fail action next-method

!

ip access-list extended ACL _REDIRECT

dany udp any any &g domain

dany top any host 172.31.1.20 eq 8443

permit ip any any

Step 2 |SE configuration. Change authentication rule for MAB.

-

Go to Policy > Authentication and click black arrow for MAB rule to
see more options. Click on orange arrow to see Identity Source (which
should be Internal Endpoints) and change advanced option ‘If user
not found’ to Continue. Click Save.
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Step 3 Create authorization profile and reconfigure default authorization rule.
* Go to Policy > Policy Elements > Results > Authorization >
Authorization Profiles and click Add. Enter a name for new profile
e.g WEBAUTH and select Web Authentication option. Additional
options should show up. Provide ACL name for redirection e.g.
ACL_REDIRECT (this ACL must be configured on the switch). Click
Submit.
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* (Go to Policy > Authorization and change Default rule to use
WEBAUTH authorization profile. Click Done and Save.
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Step 4 Configure ISE Guest portal to authenticate users against AD store.
* (Go to Administration > ldentity Management >ldentity Source
Sequences and click on Guest_Portal_Sequence on the list. For
Authentication Search List move AD1 to the right pane. Click Save.
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Verification

Enable debugging on the

dabug radius
dabug dotlx ewvents

switch:

Check settings on the switch.

SWlgsh auth sess int g0/7

Interface: GigabitEthernetd/7
MAC Rddress: 0026.55d0.0d5%6
IP Address: 10.1.10.104
Status: Running
Domain: UNENOWN

Security Policy:
Security Status:
Oper host mode:
Cper contrel dir:
Session timeout:
Idle timeocut:
Common Session ID:
Aoct Session ID:

Should Secure

Unsecure

multi-domain

both

H/R

H/R

OROL ORITO 00000 TTOCE GEFID
0000008

Mlamms i 252 5 0@ 0 | S bt 10
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Handle: O0x04000077

Runneble methods list:
Method State

dotlx Running
mab Hot run
Interface: GigabitEthernetl/?7
MAC Address 0021 .a084.6££4
IF Rddress: Unknown
User-Hama: 00=21=RA0=34=6F=F4
Status: Ruthz Success
Domain: VOICE
Security Pelicy: Should Secure
Security Status: Unsecure
Cpar heost mode: multi=-domain
Cper contral dir: both

Authorized By:
RCS RCL:
Session timecut:

Authentication Server
ERCSACLE-IP-FERMIT _ALL TRAFFIC-4£57e406
H{R

Idle timecut: N/A
Common Sesgsion ID:  OROLOROTOOO000ZFOOEDSE3IS
Acct Session ID: Om00000034
Handle: Ox3500002F
Runnable methods list:
Mathod State
dotlx Failed owver
mak Authc Success

Enable LAB-Network connection on the Win7 PC. Check out switch logs.

f/ Dotlx is starting and it times out after two retries.

SAUTHMGR-5—-START: Starting "dotlx' for client (0026.55d0.0d56) on Interface GL0/7
FuditSessionID ORO10ROT0000007TOCZEEFID

dotlx—ev(GL0/T): Sending ERFOL packet to 0026.55d0.0d456

dotlx-ev(Gi0/7): Role determination not reguired

dotlx-ev(GEi0/7): Sending out EAPOL packet

dotlz-av(Gi0/T):
dotlx—ev{GL0/T):
dotlx-av(Gio/ 7):

Sending EAPOL packet to 0026.55d0.0d456
Rele determination not reguired
Sending cut ERPOL packet

dotlx-ev(GEi0/7):
dotlx—-ev(GL0/T):
dotlx-ev(EL0/7):

Sending ERFOL packet to 0026.55d40.0d56
Role determination not regquired
Sending ocut ERPOL packet
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dotlx-ev(Gi0/7): Received an EAP Timeout

$DOT1X-5-FAIL: Ruthentication failed for client (0026.55d0.0d56) on Interface Gi0/7
RuditSessionID

dotlx-ev(GEi0/7): Sending event (2) to Auth Mgr for 0026.55d0.0d56
SAUTHMGR=T=RESULT: RAuthentication result 'ne-response' from 'dotlx' for client
(0026.55d40.0458) on Interface Gi0/7 AuditSessionID OADLOADTOOO00O00TTIOC2ZEEFID
dotlx—-ev({GLi0/T): Received Ruthz fail for the client OxTT0000FE (0026.55d40.0456)
dotlx-ev(Gi0/7}: Deleting client O0x770000FE (0026.55d0.0d56)

// MAE is starting. FADIUS request is sent for MAC authenticatien.

SAUTHMGR-T-FAILOVER: Failing over from ‘dotlx® for client (0026.5540.0d458) on Interface
GLO/ 7 AuditSessienID 0ROLOADTOOOOQOTTICIGERID

$AUTHMGR-5-3TRRT: Starting "mab® for client (0026.55d0.0d56) on Interface GL0/7
AuditSessionID OROL0AOTOO0O000TTOCZEEFID

dotlx-ev:Delete auth client (0=770000FE} message

dotlz-avifuth client ctx destroyed

detlx-ev:Aborted posting message to authenticater state machine: Invalid client
BADIUS/ ENCODE (0000008E) :0rig. component type = DOT1X

RADIUS({0000008B) : Config HAS IF: 10.1.10.7

RADIUS/ENCCDE (0000008B) : acet seasien id: 139

RADIUS{0000008E) : sending

RADIUS{ 000000BE) : Send Rocess-Request to 172.31.1.20:1812 id 1645/253, len 215
RADIUS: authenticator 36 78 57 9D 8D 27 8B F8 - 8A C6 1% 64 44 70 71 06

RERDIUS: User-Name (1 14 "002 65540 0d56"

RADIUS: User-Password [2] g =

BADIUS: Service-Type [&] & Call Check [10]
RADIUS: Framed-IP-RAddress [a] [ 10.1.10.104

RADIUS: Framed-MTU [12] & 1500

BADIUS: Called=Station=Id [30] 1% "C4=64=-13=-6C=-E8=07"
RADIUS: Calling-Station-Id [31] 1% "O00-26-55-DO-0D-56"
BADIUS: Message-Ruthenticato[80] 18

BADIUS: BF 5F BR 6F 62 03 22 17 CA A% 54 EC 55 51 E3 38 [ _eb"TU]
FADIUS: EAP-Key-Hame [0z 2 =

BADIUS: Vendor, Cisco [26] 49

BADIUS: Ciseo AVpair [1) 43 "audit-gsessien=1d=0R010R0T0000007T0C2EEF 3D
BADTUS: HAS-Port-Type [1] & Ethernet [15]

BADIUS: NAS-Fort (51 & 50007

BADIUS: HAS-Fort-Id [87] 20 "GigabitEthernet/7"

RADIUS: HAS-IF-RAddress [41 6 10.1.10.7

RADIUS({0000008E): Started 5 sec timecut

// BADIUS Access-Rocept is received. This is because of advanced options in MAR
rule on ISE. If user net found = Continue. The ideai behind that is to get
Aocess-Aoocept message back and some attributes specified in authorization rule.
Since we do not have any specifie authorizatien rule for MAC address of cur
Win7TPC the session is matched agains the default WEBADTH rule. This
autheorization prefile is configured to send Redirect URL and Fedirect ACL name
down to the switch.
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RADIUS: Received from id 1645/253 172.31.1.20:1812, Access-RAccept, len 309
RADIUS: authenticater 02 05 36 2F %C CO A2 52 - AC ED 56 Bl BO F8 FE C3
RADIUS: User-Hame [1] 13  "00-26-55-D0-0D0-56"

RADIUS: State [24] 4

RADIUS: 52 65 61 73 74 68 33 63 73 73 6% 6F 6E 3A 30 41 [ReauthSession: 0R]
RADIUS: 30 31 30 41 30 37 30 30 30 30 30 30 37 37 30 43 [0L0ROT000000770C)
RADIUS: 32 36 45 46 33 44 [ 26EF3D)

RADIUS: Class [23] 50

BADIUS: 43 41 43 53 3A 30 41 30 31 30 41 30 37 30 30 30 [CARCS:0ROLOAOTOOO]
RADIUS: 30 30 30 37 37 30 43 32 36 45 46 33 44 3R 49 33 [000TTOCZGEF3D: IS]
RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 32 38 33 [ E/143558553/3283)
RADIUS: Termination-Retion [28] & 1

RADIUS: Message-Ruthenticato(8d] 18

RADIUS: FC FB 13 D& A1 82 84 5E 14 Dé B4 DC 54 R4 BS 0E [ Tl

BRDIUS: Vendor, Clsce (28] 37

RADIUS: Cisco AVpair [1) 31 "url=-redirect-acl=ACL REDIRECT"

BRDIUS: Vendor, Clsce [28] 113

BADIUS: Cisco AVpair [1] 113 "Gri=
redirect=https://ise.micrenics.local:8443/gquestportal /gateway?sessionId=0RA010A0TO000007
TOC26EF 3D&action=cwa"

RADIUS({0000008E) : Received from id 1645/253

RMAB-5-SUCCESS: Authentication successful for client (0026.55d0.0d456) on Interface
GLO/T AuditSessionID OROLOAOTOOO00OTTOCIEER 3D

WAUTHMGR-T-RESULT: Ruthentication result 'success" from "mab' for client
(0026.55d40.0d456) on Interface Gi0/7 AuditSesgsionID O0ROLOAOTOOO000TTOCZEEF 3D
WEPM-6-POLICY _REQ: IP 0.0.0.0] MAC 0026.55d40.0d456] RAuditSessionID
OAOLOADTOOO000TTOC2ZEEFAD| AUTHTYPE DOT1X| EVENT APPLY

YEPM-6-POLICY_APP_SUCCESS: IF 10.1.10.104| MAC 0026.55d0.0d56| AuditSessionID
QAOLOARTOODO00TTOCZEEF3D] AUTHTYFE DOT1X| POLICY TYFE Hamed ACL| POLICY _HAME EFM-HOLE-
ACL| RESULT SUCCESS

f/ EPM is applying Redirect URL toe the port.

$EFM-6-POLICY APP SUCCESS: IP 10.1.10.104| MAC 0026.55d0.0d56| AuditsessionID
OROLOADTOO0000TTOCZEEF3D| RUTHTYFE DOT1X| FOLICY TYFE URL Redirect| POLICY NAME
https://ise.micronics.local: 8443/ questportal/gateway?sessionld=0R010ANTON0000T TOC2ZEEFID
Eaction=cwa| RESULT SUCCESS

$EPM-6-POLICY APP SUCCESS: IP 10.1.10.104| MAC 0026.55d0.0456] AunditSessionID
QAOLOADTO00000TTOCZEEF3D] AUTHTYPE DOT1X| POLICY TYFE URL Match ACL| POLICY HAME
ACL_REDIRECT| RESULT SUCCESS

RAUTHMGR=-5=-SUCCESS : Authorization succeeded for client

(0026.5540. 0456} on Interface Gid/7 AuditSessionID OAROLO0A0TO00000TTOCZEEFID

Check commands on the switch.
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SWlgsh auth sess int g0/7

Interface:

MAC Rddress:

IF hddress:
User-Name:
Status:

Domain:

Security Peolicy:
Security Status:
Cper host mode:
COper contrel dir:
Authorized By:
Ylan Group:

URL Redirect ACL:
URL Redirect:

GigabitEt hernetd/7
0026 . 5540 . 0456
10.1.10.104

Q=2 6-535-D0-0D-56
Ruthz Success

DATR

Should Secure
Unsecure
multi=-domain

both
Authentication Server
H/A

ACL_REDIRECT

https://ise.micronics.local: 8443/ guestportal/gateway?sesslonld=0R010ANT0000007 TOCZEEFID

Eaction=cwa
Zesaion timeout: H/A
Idle timecut: H/A
Commen Session ID:  OQROLOAOTOOOOQOOTTOCZ GEFID
Acct Session ID: O0=0000008B
Handle: O0x04000077
Runnable methods list:
Method State
dotlx Failed over
makb Authc Success
Interface: GigabitEthernetd/7?
MAC Rddress: 0021.a084.6£f4
IF Address: Unknown
User-Hame: 00-21-A0-84-6F-F4
Btatus: RAuthz Success
Domain: VOICE

Security Policy:
Security Status:
Oper host mode:
Opar contrel dir:
Authorized By:
RACS RCL:

Should Secure

Unsecure

multi-domain

both

Authentication Server
EACIACLE-IP-FERMIT_ALL_ TRAFFIC- 4£5 7406

Session timeout: H/R
Idle timecut: MN/A
Commen Session ID: OQROLOAOTOOOQOOZFOOEDSE3S
Acct Session ID: Ox00000034
Handle: O0x3500002F
Funnable methods list:
Mathod State
dotlx Failed owver
makb Authe Success
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Now go to Win7 PC and open up web browser. Enter some IP address and hit enter.

L]

-

-

You should be redirected to ISE Guest Portal. Provid

e user credentials of

employeel/Micronics1 and click OK.

e o - - .
ok .-|ﬂ hetpe e microrics ocat AT O+ B € X | G Gumk Portal » fadit 2

Afual  |dentity Services Engine

CISCO Guest Porta

After successful authentication you should be asked to read and accept default AUC

{Acceptable Use Policy). Pick the checkbox and click Accept

W

=2 micronicslocal 442

g0~ B X h I

|¢M 1.1 Guest Portal

Plaase aocepl hia poicy

1. You are responsible Tor
- mainiamning the confideniality of the password and
- 3l 3oiRRES Mal DOCUT UROET FOUT UBSrnans S Cos Ewgid

in
CISCO

smployes!  Lopot Abert

2 Clsoo Syshome offars tha Sanios far acuilios sudh 2= tha acive usa of g-mail, inslani messaging, browsing Tie Wodd Widas
Web and accessing corparade intraneis. Highwvolume data iransd=rs, espedally sustained high wolume data ransfers, are nod
permitied. Hosing & web =emer ar amy other =enver by uze of our Berace i= prohibked Trang o access sameone else's
QDN garing ureniciasd Dulk e-mail, tullecion of OEr peapla’s pareonal daia Wikl heir knosiedgs and intefersncs
with other nebwork u=ers arg all prohibiied

3 Cisco Systems resenss the rightio =uspend the Semice i
- Cizco Syziems rea=onably beleves thal your uz= of the Serace iz unreazonably sscessve or
- 0 R USInG Wk Serdce 0r Gimingl or illegal acidies

4. You do not hawe e right b resad this Sarvice fo a third pary.

. ClaoD Syalams resanes ha ighi 1o revdes, amend or modily ek Terma & Condtions, our oiher palicdes and agreaments,
ared s=pects of the Jenice Taell Nolce of any revision, amendment or modifcation will be posted on Clsco Svstem’s websile
and will be FRactive 33 b axisting wsers 30 davs after posting

{¥]i accaptterms and condrtions

You should get Login Successful message.

Page 146 of 507




CCIE SECURTY vd Lab Workbook

+ :._._.:lEfﬂpﬁ""'m'mninluml 443/ JO = @S X || B Guet Portal

cisco  |dentity Services Engine

» Now you can resend your original request to the website.

| & rep 7232000

- e x| @areaim |

Welcome to defanli website

Check ISE log messages.

B e paiy T Ert D r— Utk Dawic  Dowsicr P Andsssion Brolin. Kby Sea Postirs Sakn et
- » s Duls -5 . | = .

1| L L1 e A -] I kL T, Ciresnind,
maLmmnazs @ 5 i AL ) s ary WO

w0 mupm @ o Al Oy Ly
T Y TN I RN n & iy it By derd
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Check switch logs from user authentication.

f/ RADIUS CoR message should be received to trigger the switch te re-

authenticate the sessien. That's why it is se impertant te have CoA enabled on

the switch.

BADIUS: COA received from id 1 172.31.1.20:27981, CoA Reguest, len 183
RADIUS/DECCDE: parse unknown cisco wsa "reauthenticate-type®™ - IGHCRE
RADIUS/ENCODE (00000000} :0rig. compenent type = INVALID

RADIUS ( 00000000} : sending

RADIUS{ 00000000} : Send CoR Ack Response to 172.31.1.20:27381 id 1, len Z0
RADIUS: authenticater 3B 48 BD 65 E4 2B 36 BR - 33 7B 54 BO 46 AD OC E4
RADIUS/ENCODE (00000088} :0rig. component type = DOTIX

RADIUS{ 00000088} : Config WRS IP: 10.1.10.7

HADIUS/ENCODE (0000008E) : acct_session_id: 13%

RADIUS({0000008E) : sending

[/ dotlx reauthentication is sending ancther RADIUS request to the ISE. Wotice

that the awitch has no idea of username, =o it uses MAC address of the aclient

and Sassion-ID to identify the session on thea ISE.

RADIUS{0000008E) : Send Access-Requast £o 172.31.1.20:1812 id 1645/254, len 253

FADIUS: authenticater 1A D3 BR C8 OC 83 9B 00 - ES 3E {B 8B DO EF BE 08
BADIUS: User-Hame [1] 14 "002655d00d56"

BADIUS: User-Password £y 18 =

BADIUS: Service-Type [6] & Call Check [10]

RADIUS: Framed-IP-Address [8] 6 10.1.10.104

BADIUS: Framed-MTU [12] & 1500

RADIUS: Called-Station-Id [30] 1% "C4-64-13-6C-E8-07"

RADIUS: calling-Station-Id [31] 1% "00-26-55-D0-0D-56"

RADIUS: Message-Ruthenticato[80] 18

RADIUS: OF 27 F3 FE 92 4F E1 95 B% RE E& FC 5D &5 0C BB [ 'O)e]
BADIUS: EAP-Hey-Hame [102] 2 =

BADIUS: Vendor, Clsco [26] 49

RADIUS: Cisco AVpair [1] 43 "audit-session-id=0A010A0T000000770C2EEF D"
RADIUS: HMAS-Fort-Type [61)] & Ethernet [15]

BADIUS: MAS-Port [5] & 50007

BADIUS: HAS-Port-Id [87] 20 "GigabitEthernet(/7"

BADIUS: Called-Station-Id  [30] 1% "Cd-84-13-8C-Ef=-07"

RADIUS: cCalling-Station-Id [31] 1% "00-26-55-D0-0D-56"

RADIUS: MHAS-IP-Rddress [41 & 10.,1.10.7

RADIUS{0000008E): Started 5 sec timecut

// RADIUS Access-Accept is having correct username now and provides additionall

attributes for that user such as dACL.

BADIUS: Received from id 1645/254 172.31.1.20:1812, Rccess-Rocept, len 220
BADIUS: authenticator 25 DS C6 OA 44 BB 54 A6 - CF 26 A9 63 A7 5E 6D CA
BADIUS: User-Hame [1]1 11 “"exployesl”

BADIUS: State [24] 40

BRDIUS: 52 65 61 75 74 68 53 65 73 73 6% 6F 3A 30 41 [ReauthSession:0R]
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RADIUS: 30 31 30 41 30 37 30 30 30 30 30 30 37 37 30 43 [0LOAOTOOOO0O0TTOC]
RADIUS: 32 36 45 46 33 44 [ 2Z6EF3D]

RADIUS: Class [25) 50

RADIUS: 43 41 43 53 3A 30 41 30 31 30 41 30 37 20 30 30 [CACS:0ROL0AR0TOO00]
BRADIUS: 30 30 30 37 37 30 43 32 36 4% 46 33 44 3A 4% 53 [000T7TOCZGEF3D:IS)
RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 32 38 35 [ ES143558553/3285)
RADIUS: Termination-Rctien ([29] & 1

RADIUS: Message-RAuthenticate[80] 18

BADIUS: B4 EE 8B 92 1D 51 €2 4A 9F 35 TF 02 A0 AF ES 37 [ ©I5]
BADIUS: WVendor, Cisco (261 75
BADIUS: Cisco AVpair [1] 693 "ACS:CiscoSecure-Defined-ACL=#ACSACLE-1F-

FERMIT_ALL TRAFFIC-4f57ad06"
RADIUS{0000008B) : Received from id 1645/254

SMAB-5-SUCCESS: Authentication successful for client (0026.55d0.0d56) on Interface
GLO/T AuditSessionID OROLOAOTOOO000TTOCZEEF 3D

RAUTHMER=T=-RESULT: Authentication result 'success' from 'mab' for client
(0026.5540.0d456) on Interface GL0/7 AuditSessionID OROLO0AR0TOO0000TTIOCZEEF 3D
SEPM-6-POLICY_REQ: IP 10.1.10.1041 MAC 0026.55d0.0d456| AuditSessionID
OROLOADTOOOOO0OTTCZEEF3ID] AUTHTYPE DOTL1X|] EVENT APPLY

SEPM-6-ARR: POLICY =zRCSACLE-IP-FERMIT_ALL TRAFFIC-4£57e406| EVENT DOWHNLOAD-REQUEST

// Anothar BADIUS request message is sent te download the ACL.

FADIUS/ ENCCDE (00000000} :0Orig. compenent type = INVALID

RADIUS{ 00000000} : Config MAS IF: 10.1.10.7

RADIUS (00000000} : sending

RADIUS { 00000000) : Sand Access-Request to 1720310 1020:1812 id 1645/255, lan 147
BADIUS: authenticator B2 85 44 71 1C 7B 7D &4 - 2C &5 DO 53 D3 DF 63 57

BADIUS: HNAS-IP-Rddress [4] 1 10.1.10.7

RADIUS: User-Hame [11 41 "#ACSRCL#-IF-FERMIT_ALL TRAFFIC-4£57ed06"
RADIUS: WVendor, Ciasco [26] 32

RADIUS: Cisco AVpair [1] 26 T"aaa:service=ip_ admission"

RADIUS: Vendor, Clsce [28] 30

RADIUS: Cisco A¥pair [1] 24 "aaa :event=acl-download™

RADIUS: Message-Ruthenticato[80) 18

RADIUS: E7 62 B2 14 A3 BT AZ BE 17 OF 5C Bl 5D 6D C4 OC [ bm]

RADIUS{ 00000000): Started 5 sec timeocut

f/ Here are RCEs.

RADIUS: Received from id 1645/255 172.31.1.20:1812, Access-Rccept, len Z11
RADIUS: authenticater B2 DD 86 61 D8 52 CO 6F - 8D B3 OB F2 7B 57 1A 1B

RADIUS: User-Hame [1]1 41 "$ACSACL#-IP-PERMIT_ALL TRAFFIC-4£5Tad06"
BADIUS: State [24) 40

BADIUS: 32 63 Bl 73 74 68 33 63 73 T3 69 6F 3A 61 &3 [ReauthSession:ac]
RADIUS: 31 66 30 31 31 34 30 30 30 30 30 42 39 41 35 31 ([1£011400000B3A51)
RADIUS: 30 41 33 37 36 36 [ 0R3T7EE]

BADIUS: Class [25] 50

RADIUS: 43 41 43 53 3A 61 63 31 66 30 31 31 34 30 30 30 [CACS:aclf0114000]
BADIUS: 30 30 42 3% 41 35 31 30 41 33 37 36 36 3R 49 33 [00BSRS10A3ITEG:IS)
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RADIUS: 45 2F 31 34 33 35 35 38 35 35 33 2F 33 32 38 36

RADIUS: Termination-Retion [29] 6 1
RADIUS: Message-Ruthenticato[80] 18
RADIUS: 98 CE 34 A5 CB AF F5 CO 68 90 A6 37 EA OA 83 33

BADIUS: Vendor, Clisco
RADIUS: Cisco AVpair

(28] 38

[1) 30 "ip:inacl#l=permit ip any any"

RADIUS (00000000} : Received from id 1645/255

[ E/143558553/3286)

[ 4h7s8]

/4 tha authorization is successful and EFM appliss the 4dACL to the user.

REFM-6-ARA: POLICY xACSACLx-IP-FERMIT ALL TRAFFIC-4£57ed406] EVENT DOWNLOAD-SUCCESS

RE PM=6=POLICY_APP SUCCESS: IF 10.1.10.104| MAC 0026.55d0.0d56| AuditSessionID
ORO10AGT000000770C26EF3D| AUTHTYFE DOT1X| POLICY TYFE Mamed ACL| FOLICY MAME xRCSACL—
IP-FERMIT ALL_ TRAFFIC-4f£57e406| RESULT SUCCESS
RAUTHMGR-5-SUCCESS : Authorization succeeded for client (0026.55d0.0d56) on Interface
G10/7 AuditSessionID O0RAOLOAOTOO00O00TTOCIZEEF 3D

sWwi#sh authentication sessions interface gi/7

Interface:
MAC Rddress:
IF hddress:

Security Policy:
Security status:
Opar host mods:
Cper control dir:
Authorized By:
Ylan Group:

RACS RCL:

Session timeout:
Idle timeout:
Common Session ID:
Acct Session ID:
Handle:

Funnable metheds list:
Method  State

GigabitEthernetd/7

0026 . 55d0 . 0d56
10.1.10.104

empleyeel

Ruthz Success

DRTR

Should Secure

Unsecure

mlti-domain

both

Authentication Server
H/R
XRCSACLY=IP=-FERMIT ALL TRAFFIC-4f57ad06
H/R

H/R

OROL OROTO 00000 TTOCE EEFID
O=0000008E

Q0 000077

dotlx Failed over

mak Ruthc Success
Interface: GigabitEthernet(/7?
MAC Rddress: 0021.a084.6ff4
IP RAddress: Unknown
Usear=-Hame: 00=21=-A0=-84=-6F=-F4
Status: Ruthz Success
Domain: VOICE

Security Policy:

should Secure
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Security Status: Unsecure
Cpar host mode: milti-domain
Cper control dir: both
Authorized By: Ruthentication Server
RACE RACL: m—IP—F‘EMT_m_TMFIE—iEE?eiDE
Session timecut: H/R
Idle timeout: N/R
Commeon Session ID:  OROLOAROTOOOOO0ZFOOEDSE3S
Acocct Session ID: O0x0Q0000034
Handle: O(=x3500002F

Funnable methods list:
Mathed State
dotlx Failed owver
mak Authec Success
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LAB 3.14. Central Web Authentication (CWA)

for Wireless

Objectives

This lab shows how to configure Centralized WebAuth on wireless controller.

IP Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

R1 LoO 1.1.1.1/32
E0/0 10.1.10.1/24
EO0/M 172.31.1.1/24

AD NIC 172.31.1.200

WinXP NIC 10.1.10.50/24

WLC GO0/0/1 (mgmt.) 10.1.10.5/24
Go/or2 10.1.30.5/24

ASA1 GO0/0 (outside) 100.2.2.10/24
GO0/ (inside) 10.1.10.10/24
G0/2 (dmz) 10.1.30.10/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task

Based on the previous task, configure WLC to perform CWA for all clients
without supplicant. Configure Authentication Open on MICRONICS SSID.
Allow only DNS and ICMP traffic without authentication. You can alter default
MAB authentication rule to work also for Wireless clients. After authentication
users from AD employees group should get access to the Internet (all tcp/80).
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Configuration

Complete these steps:
Step 1 ASA configuration changes. New required lines are highlighted.

access-list DME IN parmit iemp any any
access-list DMZ TN permit udp hest 10.1.30.5 eqg bootps host

172.31.1.200 eg bootps
access-list DMZ IN permit tcp any any &g www
access-list DMZ IN permit udp any host 172.31.1.200 eg domain
access=-list [MZ IN permit tcp any host 172.31.1.20 egq 8443

Step 2 WLC configuration. Make changes to MICRONICS SSID.
Go to SECURITY > AAA > RADIUS > Accounting and click New...
Configure ISE as RADIUS Accounting server with ‘cisco123’ as

-

-

shared secret. Click Apply.

¥ Lescal EAP

¥ Priwwity Drder

el L]
Rodass Cosbl LSS

. Wirdess Prebschios
Fa lirier

» ‘Weh idnth

TrastSer SEP
b Rdvandd

RADILES Accounbing Servers > Maw

Sarear Inaac (Priortp|
arvar [P Add e
Suwen | Saoret Rt
Ehargil Sennd

Sawkrm Fhared Doost

Park Mrksr

|||||

feaiim . .

Go to WLANSs and click on 1 to edit MICRONICS SSID.
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vl
Cisca

Go to Security > AAA Servers tab and pick already defined RADIUS
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Accounting server from the drop-down list.
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Go to Advanced tab and select Radius NAC for NAC State option.
Ensure that Allow AAA Override option is enabled.
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Go to Security > Layer 2 tab and change Layer 2 Security to
None. Pick MAC Filtering checkbox. Click Apply.
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Step 3 Redirect ACL on WLC.
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* (Goto SECURITY > Access Control Lists > Access Control Lists
and click New... Enter a name for ACL e.,g. ACL_REDIRECT (this
name must be the same as it is configured on ISE for WEBAUTH
authorization policy). Click Apply to create ACL.

(B waternts ‘=0
e [ peee bl Wcclmade Jook b
L MO - e B | vz

* rricropien ol o > & |- TR

v Rkl
dcrman Conerel Ll

* Click on newly created ACL_REDIRECT to edit it. Enter the following
entries. Remember that redirect ACL works differently on WLC than
on I0S. Here, permit statements are those that NOT trigger
redirection. Click < Back and Apply to save the changes.

[aep Cmriers

......

------

k
¥
O oo o o a

Step 4 |SE configuration. Change authentication rule for MAB to work for both
Wired and Wireless MAB.
* (Go to Policy > Policy Elements > Conditions > Authentication >
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Compound Conditions and pick Wired_MAB condition on the list.
Click Duplicate button.
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Change the default name to Wireless_MAB and change second rule
to match against Wireless — IEEE 802.11. Click Submit
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Go to Policy > Authentication and click Wired_MAB condition. Add
Wireless_MAB condition with OR in between.
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Click Save to apply the changes.
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Verification

Enable debugging on the WLC:

dabug alisnt <clisnt-MAC-address>

On Win7 PC disable LAN NIC and enable Wireless NIC.

g__ﬂ :J'-EH:*""I:";“ I l___.' ':'ﬁ::?:s‘wakCunnutun
S NG PRGAMA BT nc e =l e9a g e e
. %::: 0 Enable L
Stafi
S Thagnose

% Bridgs Cormections
Cresle Shortcut

Creste Shorout -

. zlete
& | Rerome ¥ FRename
B  Propatics % Properties

* Go to Control Panel > Network and Internet > Manage Wireless Networks and
display Properties of MICRONICS connection.

Miskeentks you zan view, meadify, and reerder (1]

= MECRORECS SEourit
&' Properties |
— Remicren m:rﬁ
Amame

* On the Security tab select options as follows and click OK.

MICASAICS Wireless Mlebwork Properties
Conrescion | ety |
Seority type: Wi authandcaten {Opan] -
Encrypion type; Hon= L
o || cance

= Click on network connection icon on the Windows tray and select MICRONICS
network. Click Connect.
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Cumently conrescied to: &

Ty Dnddenbiied nebwork
M Irieamat 3ccae

Wirabun Mubvwecrk Conraction

MICEDRECE

%l';.:

* You should see Connected status.

Cumentty conneched boc o

ey Uinidendified metwori
Ho[nbemet pocess

Ly |dentihying.. (MICROSICE)

Mo [Ftssmet 3Csese
Wirelesy Metwoik Connechon a

MICROMICS connected S

* QOpen up web browser and enter some IP address or FQDN. You should be
redirected to ISE for CWA. Provide user credentials and hit Login.

i fua]n, ity Services Engine
Cisco G ral

* Accept the policy.

* _ :l 2 htpsyEemigonicslocal B4 O - @ & X || & Guet Poral

=

hox B

Uzsernams ElahiTE]
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Cisco

Ploase gocept e poicy

1. You are rasponsibia for
- mainianireg the confideniality of the passyword and
- 3l Ao MAL DOSUr Urder FOUT UBSrName e Sasewand.

2 Clsco Sysmme offars the Sanice far acvties sudh 23 e acive U= of B-mail inslant messagng. browsing Tie World Wde
Wab and acceEssing carporste intranets. Highwvolume data iransters, espedaly sustained high woluma dala ranshars, ans nol
permiti=d. Hosing & web =ewer or amy otber =ener by w== of pur 2enace i= prohibbsd Tranglo access someone else's
ACCoUNL gersding urSobcisd oulk e-mEl, tollecion of Ser peaple's gareonal 0313 witoul e Enowedde and intemerence
WAL DinaT nehwork iEers are all prohioied

3. Clsco Syslems resenss e nght1o suspend the Seniog i
- Cimco Sy=i=ms rea=onably beleves that your u== of the Serace is unreasonably sscessve or
- oL 38 URing T Sepdce jor ciminal or illegal acthaiea.

4. ou e nat haws Tie Aght ke el this Sardca 1 a third pary.

&, Cisco Syslem= resens== th= nghtio revise, amard ar modify the=s Terme & Condbions, our olher poliges and agreemends,
ardd aspecds of e Sandce il Molce ol 3y revision, amendmend, of modifcation wil ba pogted on Cleco Syelems wabalis
ared will be placlive &2 o exisling u=ers 30 days aller posting

{i#fl} socaptierms and condifions

MNow you should be able to access all web servers.

= IE
2 hitps ioronicslocz g 0= @S X | & Gust Portal & :?—:i'

atfvanlne smployes!  Logoit Sbe

W AL FF T RS _FF T8 F L8

Q{:_ | &8 repuarzan Lo p- x| @urnx

Welcome to defanlt website

Log on ISE.

Strkn Dt LaTams ) Endpant IO F ardes tmlm_ Devce ot ) ﬁmm Wiy oo Poetirs Stahis m
B a e 3y Wit e [noamat arw hioCappica
B Q b Dryvave dasthe
[~} o X e Bt Autheri:
-] F WD WERALTH Parging Resthatcation.. .

WLC debug while connecting the client.

[(Cace Conteallar) >debug eliant 00:04 124 00068 1904

#f slient delbug is enabled. There is a new client discoversd on AF with the following MAWC address .

*ppiMaConnTask 31 Jan 31 13112113084 Odrderierce1éd: 94 Rasociation recalved from mobdle on AF cdifdidf14614ba 00
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*gpiMaConnTask 31 Jan 31 131121130841 Odrderderceréd 94 10.1.30.20 WEBAUTH REQD [8) Changing IFvd ACL ‘noma’ [ACL
ID 255) ===x 'noma' [ACL ID 255) == [callar apf pallioy.c:1697)

*apftaConnTask 3: Jan 31 1311241309 0000 2e 2068094 10.1,30.20 WEBRUTH RECD [8) Changing IFvé ACL 'nome' [ACL
I 255) ===z "meme’ [(ACL ID 253) == [(callec api policy.c:1064)

*apfMaConnTask_3: Jan 31 13:12:13.004: 00:0e:leice 68 M4 apfippl WlanPolicy: Retaining the ACL recleved in RRAR
attributes I on mobile

*gpifMaConnTask 31 Jan 31 13112113.08401 Oduderierce1éd: 94 Agplying site-specific Local Bridging override for statfion
O 0a: 2aica: 68: M - vapld 1, site "dafsult-gesup', intecface "dmz_interfece’

*apftaConnTask 3: Jan 31 13:12:13.09: 00:04:2e 108 :68: 34 Rpplyving Local Bridging Interface Policy for atation

O e 2@ ol 68394 = vian O, dnterface &d 11, Antecface “dmz_intecface"

*apfMaConnTask _3: Jan 31 13412413004 00:0e:i2e o868 M processfsldiE statustode La O and status is O
*spitoConnTask 31 Jan 31 13012013000 ddolei2esce il 9 poocessSsidiE  asdid done flag is O findsh flag is O
*apfMaConnTask 31 Jan 31 1301201300 dadei2eicefli % STA = cates (B): 130 132 139 12 18 150 24 36 48 72 96 108 ¢
o090

*apftaCoannTaak 3: Jan 31 13:12:13.00: 00:06:2e:20:68: 04 aupplates statuaCods L3 0 and gotdupplatesElament L2 1
*apfMaConnTask _3: Jan 31 13:12:13.09: 00:0e:leicei68:04 STA = pates [12): 130 132 139 12 18 150 24 36 48 72 086 104
o000

*apitoConnTask 31 Jan 31 13012113.085: Ododei2ercerids M extSuyppfates ostatusCode i ¢ and gotExt SuppRatesElement iz
1

*apfMaCoannTask 3: Jan 31 13412413095 00:0a:2e 00168 3 apiMaisseltatalas

*apftaConnTaak 3: Jan 31 13412:13.035: 00:06:24 126168 04 apfFrocesafascchay [apf 80211.246171) hanging atate fop
moked le 0008 deice 68104 on AP o4 Tdidfi 4624100 from Rasociated to ARA Pending

*apfMaConnTask_3: Jan 31 13:12:13.005: 000w ileicei68: 94 Scheduling deletion of Mobdle Station: (callecld: 20 in
18 seconds

ff Redivest KL naes has Been Pecelved from TSE.

*apihecelveTask: Jan 31 13312:13.225 00i0e:deice: 6004 Received SGT for this Qient,
*apfReceiveTask: Jan 31 13:12:13,225:; 00:0e:deioe:60:04 Redicect URL ceceived for client from RADIUS. Client will be
movad to WebAuth Reqd state to facilitate redircection.
*apifeceiveTask: Jan 31 13a12:13. 2261 O0i0er2eroesaid 10,1, 30,20 WEBAUTH_REQD (@) changing IFwd ACL ‘none” [(ACL ID
255) m==> 'none' [ACL ID 255) --- [caller apf policy.c:1687)
*apiRaceiveTask: Jan 31 13:12:13.226: 00:0a:da:oe:6diid 10.1.30.20 WEEAUTH _REQD [8) Changing IFve ACL "none” [ACL ID
255) === 'none' [(ACL ID 255) == [caller apf policy.c:1064)
*apihecelveTask: Jan 31 13:12:13.226: 00:0e:deicei 6l apfipplyWlanPolicy: Retaining the ACL recieved in ARR
attributes 2 on mobile
*spifecelveTask: Jan 31 13a12713.2261 O0adwiderosi®d 194 Inserting ARA Overcide struct for mobile

HAC: 00104 :2a toa 168194, source 2

*apfhecelveTask: Jan 31 13:12:13,226: 00:0e:deicei 6l 04 apiMalxitatelec
*apfhecalveTask: Jan 31 13:12:13,226: O0i0e:2e:oai68 04 10.1,30,20 WEBAUTH_MEQD [8) change state to START (D) last
state WEBAUTH REQD (8)

*apfRacaivaTask: Jan 31 13212:13,226: 0040a:28:o0i68 04 panhpihdiabl ladtation?: APF_M3 FEM_WRIT L2 _RUTH CCMPLETE =
0.

*apfhecelveTask: Jan 31 13:12:13.226: 00:0eideicei6dii4 10.1.30.20 START (D) Initializing policy

*apfhecaiveTask: Jan 31 13112:13,226: O0i0e:2e:oe:68:04 10.1,30,.20 STERT (0 Changs stsats to RUTHCHECK [2) last

atate WEBAUTH_REQR (@)

*apfRecel veTask: Jan 31 13212713, 2246 O010erderoms®d %4 10.1.30.230 MFTHCHECK (2) Change state to LEAUFTHCOMPLETE [d)
last state WEBRUTH RECD [3)

*apfheceiveTask: Jan 31 13:12:13.226: 00:0e:de:oei6lii4 10.1.30.20 LIAFTHOOMPLETE (4) DHCPF Mot cequiced on AP

cAi T A E 464k 00 vapld 1 apVapld 1for this client

*apffscel veTask: Jan 31 13:12:13.224: Odaderderoerdl s Mot Uming WM Compliancs code goalap OO

*apfReceiveTask: Jan 31 13a12:13.2261 0010t 2eronifiid 10.1.30. 20 LIAMFTHOOMPLETE (4) Flunbed mobile IWAFE rule on
AP cd: Tt 4 L1 462402000 vapTd 1 apVapld 1

*apiRacaiveTask: Jan 31 13:12:13.226: 00:0a:de:oui6d 84 10.1.30.20 LIAFTHDOMFLETE [4) Change state te WEBRUTH_RECD
[8) last state WEBAUTH REQD (@)

*apfRsceiveTask: Jan 31 13112:13.224r O010m:2eroeréla®d 10.1.30. 20 WEBAUTH REQD (8) pemhpfhddMobi leStation? 3121,
Rdding TMF cule
*apfRecelveTask: Jan 31 13:12:13.226: 00:09:26:ce:68:94 10.1,30.20 WEBAUTH_REQD [8) Adding Fast Path ruls

typs = Rirespece AF Clisnt = ACL passtheu

on AP od:7did £ 46:4B:00, slot 0, interfacs = 1, B8 = 0

IFvé AL ID -
*apfReceivelask: Jan 31 13:12:13.2261 O010m12ercerédi®d 10.1.30.30 WEBAUTH FEQD (8) Fast Path rule (contd...) 802.1F
= &, BSCP = @, TokenlD = 7048 Local Bridging Vlan = &, Local Bridging intf id = 11
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*ppiRecalveTask: Jan 31 13113:13,.226: O010e12e1ce168194 10.1.30.20 WEEAUTH REQD [8) Succeasfully plumbed mobdle rule
[TFv4 RCL ID 2, IPvE ACL ID 255)
*apfRacaiveTask: Jan 31 13212:13,226: 0040a:2aroc0t68:04 10.1.30.20 KEBAUTH REQD [8) panfupfidddoldlaftation? 3719,
Bdding TMPF cule
*apfhecaiveTask: Jan 31 13:12:13,226: ODile:lesce:68:04 10.1.30,20 WEBAUTH_REQD (8) Replacing Fast Path culs

type = Airespace AF Client = ACL passthou

an AP cd17dad frdGadba 00, alot O, interface = 1, Q08 = O

IPvd KT I
*apfRecaiveTask: Jan 31 13212:13.226: 00i0e:2a:ce68:34 10.1.30.20 WEBRUTH REQD [8) Fast Fath rpule [contd...) 802.1F
= 0, DSCPF = O, TokenID = 7006 Local Beidging Vian = O, Local Bridging intf &d = 11
*apfhecaiveTask: Jan 31 13412:13,226: O0i0e:2e:oai 6804 10.1.30,20 WEBAUTH_MEQD (8) Succssasfully plumbsd mebile mils
[IBvd ACL ID 2, IPvE ACL ID 255
*spifecelveTask: Jan 31 13a12:13.22461 O0adwi2eroeidd 194 apiMshosoStatelno
*apfRacaivaTask: Jan 31 13:12:13.226: 0040a:2a:cai68:04 apfPanfddlisar? [apf policy, oi268) Changling state for mobila
O 0ai 20 6813 on AP o434 46400 feom RFRA Pending to Rascciated

*apfheceiveTask: Jan 31 13:12:13.226: 00:0e:de:oe:6liid Scheduling deletion of Mokile Station: [callecTld: 49) in
18040 asconds

*apffecel veTask: Jan 31 13:12:13.224: Odadwrderomrddo®d Sending Assoc Response to station on BSSID ocdVdod frddrdbaOd
[status 0) ApVapld 1 Slat O

*apiRaceiveTask: Jan 31 13:12:13.226: 0040a:2ae:oai6d i apifrocessRadivsfascciasp [apd 80711.0:2504) Changing atate
for mobdle 00:0eileice: 68:04 on AP od:didfi46:db:00 from Resociated to Rssociated

*pembaceiveTask: Jan 31 13:12:13,227: O0i0e:lesos:68:04 10.1.30.20 Reroved NPU entcy.
*pemfscel veTask: Jan 31 13:12:13.227 O0aderdescerdfatd 10.1.30.20 Added NEU entry of type 2, dtlFlags dxd
*pomfmcnl veTask: Jan 31 13:12:13.22Tr O0ider2eromidd 194 Pushing IFvds fefls 0000 0000100007 Tdf 16T 0ma 20efr 2045 , and
MAC: 00:0E:2E4CE468: 94 , Binding to Data Flane. SUCTESS 11
*pamBacaiveTask: Jan 31 13212:13.227: 0040e:2e:cai68:04 Sant an XID feans
*pembeceiveTask: Jan 31 13412313, 227 O0i0eideicei 6004 10.1.30,.20 Added WPV entiy of type 2, dtlFlags M0
*pembeceiveTask: Jan 31 13:12:13,227: O0ile:le:os: 6804 Pushing IPve: £edl:0000: 00000000 THEE:6706: 20ei: 2045 , and
MACT 000E2ECEr G819 , Binding to Data Flane. SUCCESS 11
*pemfmcelveTask: Jan 31 13:12:13.22Tr O0idei2eromi®d %4 Sent an XID frame
*IFvE_Mag Task: Jan 31 13:12:13.372: 0Qe:i2etca68: 94 10,1, 30,20 WEBMFTH REQD [8) DHCF Addrass Re—sstakblishad
*IFvE_Mag Tasak: Jan 31 13:12:13.372: 00:0e:2ezce:68:94 10,1, 30,20 WEBMITH REQD [8) Reached PLUMBFRITFATH: from lina
5373
*IPvE_Mag_Task: Jan 31 13:12:13.372: 0dade: 2ecces68: 04 10.1,30,20 WEBMFTH REQD (8) Replacing Fast Path rule

type = Airespace AF Client = ACL passthou

on AP cdiTdaid frdfadba 00y slot O, intecface = 1, Q05 = O

IPvd KT I
*IFvE_Mag Task: Jan 31 13:12:13.372: 00:0e:Zeice:68: 94 10.1.30.20 WEBMITH REQD [8) Fast Fath rule [2ontd...) 802.1F
= 0, DSCP = O, TokenID = 7006 Local Bridging Vian = O, Local Bridging intf &d = 11
*IPvE_Mag Task: Jan 31 13:12:13.372: 00a0e: 2ecce: 68: 04 10,1, 30,20 WEBMFTH REQD (8) Successfully plumbed mobile cule
[IBvd ACL ID 2, IPvE ACL ID 255
*pomfscel veTask: Jan 31 13312713, 3% O00adeideromr®dadd 10.1.30.20 Added WEU entry of type 2, dtlFlags Oxd
*pamBacaiveTask: Jan 31 13212:13.373: 0040a:2a:00168:04 Pushing IPvE: £280:0000: 000000000 F4EE6700: 200022045 ; and
MAC: 0030B:2B4CE168: 4 , Binding to Data Flame. SUCCEIS 11
*pembaceiveTask: Jan 31 13:12:13,373: ODile:lesos:60:04 Sent an XID frame
*IHCP Socket Task: Jan 31 13:12:13. 4683 O00u0eslercei 6l 1 [HCP received op BOOTRECUEST (1) (len 326,vlan 10, parct 1,
ancap Onec(d)
*IHCE Socket Task: Jan 31 13012013468 ddvdwrZercerdli Sl HCP selecting relay 1 = control block assttingsa

dhopSecver: O.0.0.0, dhopietmaks 0. 0.0.0,
cheplatawayr: 0.0.0.0, dhepRalay: 0.0.0.0 VIAN: O

§f WL raliss DHCF Reguest to the secves and gekbs IF address to the client,

*MHCP Socket Task: Jan 31 13012013, 488 ddhdmilercer a9 DHCP selected oelay 1 = 172.31.1.200 (local address
10.1.30.5, gabteway 10.1.30.10, VLA O, poct 2)

*MHCF Socket Task: Jam 31 13:12:13.468: J:0e:2eioa: 6819 [HCF transmitting DHCP REQUEST (3)

*MHCF Socket Task: Jam 31 13:12:13.468: Oe0eleteat 68194 [HCF op: BOOTREQUEST, htyes: Ethaendat, hlan: 6, hopa: 1
*HCP Socket Task: Jan 31 13312313, 4685 deideicei6iiM HCP xidi 0x3PP<RO6l (PGG5723485), sece: O, flage: O
*HCP Socket Task: Jan 31 13:12:13. 4683 Odo0eileicei 6l [HCP  chadde: 00:0ei2eicei68: 94

*IHCP Socket Taskr Jam 31 13120134687 On0mrZercerdlosd DHCP  odaddrr O.000.0, yiadder O.0.0.0

*HCE Socket Task: Jan 31 131l2rld. 4687 dvdmilerom i DHCF  sdaddo: O.0.0.0, gladdes 10u1.30.5

*MHCF Socket Task: Jam 31 13:12:13.468: O0e:Zaioai 6819 [HCP  regquasted Sp: 10.1.30.20

*MHCF Socket Task: Jam 31 13:12:13.468: O:0eleteat 68494 [HCF sending REQUEST te 10.1.30.10 [len 362, port 2, vlan
@

*MHCP Socket Task: Jan 3

-

L I o

-

13:12:13. 4683 00:0wiZescni 6l i IHCT swlecting celay 2 = conteol block settings:
dhopSecver: O.0.0.0, dhopietmaks 0. 0.0.0,
dhopGateway: O.0.0.0, dhophelayr 10.1.30.5 VIAMN: ©
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*MHCF Sockat Taak:
*[HCF Sockat Task:
ancap 0xac0l)
*HCP Socket
10,130,290

*MNCF Socket
*DHCF Sockat
*[HCF Sockat
*HCF Sockaet
*MHCP Socket
FMHCP Socket
*MCE Socket
*MCE Socket
172, 31.1.200
*IHCF Sockat
ancap Oxecld)
TIHCP Sacket Task:

Task;

Task:
Taak:
Tasak:
Task:
Taak:
Taak:
Tazki
Task:

Taak:

Jan 31 13121134691 diderZerce 68194 DHCF salaected pelay 2 - HOME

Jam 31 13:12:13. 4712 Ji0e:leioa: 6819 [HCF recelived op BOOTREFLY (2] [len 312,vlan O, port 2,
Jan 31 13123134715 Mdwileicei 60 [HCP setting secver from ACK [secver 172.31.1.204, yiaddc
Jan 31 133121134717 Ol Zeromr 819 INCF sending REPLY to STA (len 418, poct 1, vlan 1d)

Jam 31 131121134711 dduderZerce1 68194 DHCF tranandtting DHCF FCK [5)

Jan 31 13:12+13. 4714 00e0ed2ercai 68134 [HCP  op: BOOTREFLY, hiype: Etheemat, hlan: 6, hops: 0
Jan 31 1313:13.471¢ O0edeioai 68194 [HCF xid: Qu383cyi6l [366572383),; seca: O; flags: O
Jan 31 13312313, 4713 0w leicei 6l [HCP  chadde: 00:0ei2eicei68: 94

Jan 31 134124134713 hdwileicei 6l HCP  cladde: 0.0.0.0, viadde: 10.1.30.20

Jan 31 133121134710 dvdmiierom 89 DHCF  sdaddrs 00000,  gladdes o000

Jan 31 13121384710 Onder2ercer @@ 9 DHCP  secver ids 11.11.11.11 povd secver ids

Jan 31 1313116, 4003 Pi0eideioni 6813 [HCF cecelived op BOOTRECUEST (1) [lan 304,vlan 10, part 1,

Jan 31 13412116, 4003

O (s 2ecowd 60 1 [HCP selecting relay 1 = control bBlack ssttings:

dhopfecver: 172.31.1.200, dhopietmask: 255.255.255.0,
dhopGateway: 10.1.38.10, dhoplelay: 10.1.30.5 WVLAN: O

*[HCF Sockat Task:
10.1.30.5, gatawmy
*MHCP Socket Task:
*[HCP Socket Task:
*[HCP Socket Task:
*MNCP Socket Task:
*IMCE Socket Taski
*[HCF Sockat Task:
*[HCF Sockat Task:
o

*MHCP Socket

*MHCF Sockat
*IHCF Socket Task:
ancap Onec(l)
FIHCP Socket
*MNCF Socket
*IHCF Socket
*[HCF Sockat
*HCF Sockaet
*HCP Socket
FMHCP Socket
*MCE Socket
172, 31,1, 200
*dotlli: Jan
at ¢ aas
*dotllk:

Task:
Task:
Task:
Tasak:
Task:
Taak:
Taak:
Tazki

Tan

31 133

Jan 31 1312416, 4004 00: Qe 2aroai 68134 [HOF salacted palay 1 = 172.31.1.200 [local addrass
10.1.30.10, VI8 O, part 20

31
31
31
1
31
31
3

133125 146, 4003
133121 146, 4003
13412516, 4013
13312214, #4010
1312314, 4010
13412216, 4012
13412216, 4012

Jan
Jan
Jan
Jan
Jan
Jan
Jan

-

Jam 31 13312316, 4013

Ol Qe 2es w6 3 4
005 Qe 2ed cond G 1 94
O g 2w ol 60 4
il (e 2ea coma B 1 5
i (e 2 e oo B8 1 94
Ol 02 2aond 68 1 94
00 0ad 2aioni 63 194

0 (e 2 ed cond 6 3 4

[HCPF teansmitting DHCP INFORM (8)

HCPF  op: BOOTRECUEST, htyps: Ethecnet, hlen: 6, hopa: 1
[HCP  xidh Ox4Sedl0ed [117250871), seca: O, flaga: 0
MMEPF  chaddr: Odadwi2escerdls 4

MHCP  odaddes 1001, 3020, yladdes G000

[HCP  siedde: 0.0.0.0, giadde: 10.1.30.5

[HCP sending REQUEST ta 10.1.30.10 [lan M6, paet 2, vian

HCP selecting celay 2 = contool block settings:

dhopServers 172.91.1.200, dhoptietmask: 255,285, 255.0,
dhcpSatewayr 10.1.30.10, dhopfelay: 10.1.30.5 VLAMN: ©

31 13:12:16. 4014
31 13:12:16. 409

Jan
Jan

31
kb |
1
3
3

13:12: 16, 4103
1312164102
131211464103
13:12:16. 4102
13:12:16. 4102
13512316, 4103
13312306, 4103
1312116 410a

Jan
Jan
Jam
Jam
Jan
Jan 31
Jan 31
Jan 31

[

12:28.221:

clisnt Heileiced Gl 4

*IMNCE Socket Task:
ancap Owmecid)
*[HCF Sockat Task:

*MHCP Socket Task:

*MCE Socket
*[HCF Sockat
*HCF Sockat
*HCP Socket
*MHCP Socket
*NCP Socket
*NCE Socket
)

*HCF Sockat

Tazki
Task:
Task:
Task;
Task:
Tank:
Tazki

Taak:

Q0 2aiond 68 1 94
0 0a: 2 cnd 63 194

Ol Qe 2o w6 1 4
il (e 2y o 68 1 94
Qi e 2ercma 68 194
00 Dat 2aroad 68 + 94
00 Da: 2atond 63 1 54
O g 2w ol 60 4
0 Qe 2o a6 1 4
i e 2 e oo B8 1 94

MHCF salacted palay 2 - HOME
[HCF epecweived op BOOTREFLY [2) [len 308,vlan O; port 2,
HCP sending REPLY to STA (len 418, poct 1, vlan 100
MHCF tranamdtting DHCR ACK (5

MHCF  opi1 BOOTREFLY, htyper Ethermet, hlen: &, hopar O
HCF  xid: OxdSedl0ed [1172508W1), seca: O, flaga: O
DHCF chadde: 0006 128 000168134

HCPF cisdde: 10.1.30.20, yladde: 0.0.0.0

P  adadde: 0.0.0.0, gladde: 0.0.0.0

MHCF  secver ids 11.11.11.11 rpovd secver dds

31 13412:28.221: 00:dailetoasGd 0y Cliant stats updata: Tins now In ses 1350637ME, Last Aset Mag Sant

O0i0e i 2eice 68104 Recuested to send acct intecim update cequest mag to APF task for

Jan 31 130130328527 ddudmilerom$l a9 IHNCEF recedved op BOOTRECUEST (1) (len 308, vlan 10, porct 1,

Jan 31 13:13:32.852¢ 00109220 cn 6818 DHCP selecting relay 1 - contral klack settings:
dheplarvar: 172.31.1.200, dhepbatmask: 255.255.255.0,
dhepGatewsy: 10.1.30.10, dhephelay: 10.1.30.5 VIAN: O
Jan 31 13313332, 8523 Mlesleicei 6l [HOP selected pelsy 1 = 172.31.1.200 [local addcess
10.1.30.5, gabeway 10.1.30.10, VLM O, poct 2)

Jan 31 131332, 8523

i (e 2 e oo B8 1 94

MHCP tranamdtting DHCE INFGRM (@)

Jan 31 13:13:32.8524 00:0a:2e:oai 683 [HCF  op: BOOTREQUEST, hiyps: Ethaenst, hlan: 6, hepas 1
Jan 31 13413:32.8524 00:0ud2eroad 689 [HCF  xick Onafdlacsd [H023512205), secsd 0, flags: O
Jan 31 1341332, 85283 Mhdeileicei6ii M HCP chadde: 00:0wileicei6i: 4

Jan 31 13413432, 8533 00:0ws e 6l HCP  clsdde: 10.1,30,20, wladde: 0.0.0.0

Jan 31 13113232, 053 Odndwa2ercerdl i DHCP  sdadde: O.0.0.0, giaddes 10.1.30.5

Jan 31 13313332, 853 dhvdmierom 819 IHCF sending REQUEST to 10.1.30.10 [len Mé, poct 2, vlan

Jan 31 13413:32. 8534

00 Ot 2wt cons 68 + B4

[HCF selacting rpalay 2 = control black sattings:

*MNCF Socket

Task:

dhepfecver: 172.31.1.200, dheptetmask: 255.255.255.0,
dhepGatewsy: 10.1.30.10, dhephelay: 10.1.30.5 WVIAH: O
Jan 31 13713032, 8537 dndwreromrd8 19 DHCF selected oelay 2 = MONE
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*DHCF Sockat Task: Jam 31 13113132,933:1 dduderZerce 68194 DHCF recedved op BOOTREFLY ([2) [len 308,vian Oy port 2,
ancap OxacOl)

*[HCF Socket Task: Jam 31 13:13:32,.833: Qe0e:Zeion: 68490 [HCF sending REFLY to STA [len 418, paet 1, vian 100
*MHCP Socket Task: Jan 31 1341332, 8333 Mideideicei 60i M [HCP toansmitting DHOF KK (5)

*IHCP Socket Task: Jam 31 13:13:32. 8343 Mhdwileicei 6l [HCP  op: BOOTREFLY, hiyvps: Etlecret, hlen: 6, hopss O
*IHCF Socket Task: Jam 31 13013032, 9347 On0wrZerom B89 DHCF xidt Omefdlectd WO23512205), secmr O, flagar O
*DHCF Sockat Taak: Jan 31 13113132, 9341 Odudes2eroar6d194 HCF  chaddry O0ude12etoa168: 94

*IHCF Socket Task: Jan 31 13:13:32.834: 0deQw:2eson: 68104 [HCP  cdedde: 10.1.30.20, yiadde: 0.0.0.0

*MHCF Socket Task: Jam 31 13:13:32.334: O0e:deicai 60194 HCF siedde: 0.0.0.0; gladde: 0.0.0.0

*MHCP Socket Task: Jam 31 13:13:32. 8343 adwileicei 6l IHCPF  swcver id: 11.11.11.11 cevd secvec dds

172,31.1.200

i the
*apihacalvaTaak:
*apfhecel vaTask:
anakled WLAN.

*ap{Recel vaTask:
255) m==x inone?
*apihacai vaTaak:
255) === Tnore”
*apfhecalveTask:

slient authenticates with web browser., The WIC sppliss new AL for that client.
Jan 3 132132561132

Jan 31 133133 56,1133

000828006034 Recaived 30T for thia Qlent.
000 : 28 omi 60 104 ARR cedirect Gs WULL, Skipping Web-auth for Radius NAC

Jan 31 13313:56,112 00r0erdercerdd it 10,1, 30,30 WEBAUTH_REGD (8) Changing IPvi ACL ‘none’ ACL ID
(FCL ID 255) == (caller apf policy.c11887)

Jan 31 13:13:56.112: 00¢0a:2a:oa 6854 10.1.30.20 WEBAUTH_FEQD [8) Changing IFve ACL "none’
[ACL ID 255) —- [zaller apf pelicy.c:1964)

Jan 31 13:13:56.112: 00:0e:de:ce:6i 04 spfipplyilanPolicy: Retaining the ACL recieved in BRR

[ACL I

attributes 255 on mobdle

*apfhecel veTask:

Jan 31 13313356, 1125 O0:0eideicei 6004 Insecting ARR Oveccide stouct for mobile

MAS: Oaleilescerff ¥, soupce 2

* o fRacal vaTask:

Jan 31 13:13:56.112+ 00:0a:de:ioa 694 10.1.30,20 KEBRUTH _REQD [3) Changing IFw ACL "nene” [(ACL ID

255) === "ACT INTERMET LYY [(ACL ID 0) == [callar apf palloy.o:1750)

*apihecel valask:
*apfhecel veTask:

Jan 31 133133 56.11 383
Jan 31 13:13: 56,1123

00 0ed 28 e 6 104 apiMalnitatelec
000w 2eioni 6l 104 10,1, 30,20 WEBAUTH_RECD (@) Change state to START [0 last

state WEBAUTH_REQD (@)

<an i po
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LAB 3.15.

Configure ISE for Guest Access

Objectives

This lab shows how to configure guest access on ISE and wireless controller.

IP Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

R1 LoD 1.1.1.1/32
E0/0 10.1.10.1/24
EOM 172.31.1.1/24

AD NIC 172.31.1.200

WinXP NIC 10.1.10.50/24

WLC G0/0/1 (mgmt.) 10.1.10.5/24
G0o/or2 10.1.30.5/24

ASA1 G0/0 (outside) 100.2.2.10/24
G0/1 (inside) 10.1.10.10/24
G0/2 (dmz) 10.1.30.10/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task

Configure Guest Portal at hitp://guest.micronics.local with the following

properties:

* no Acceptable Use Palicy (AUC) is displayed for guests

* (Guest users can create accounts for themselves

* new account have the following attributes:

O

o}

O

o

account is valid for 8 hours staring from the first login
default timezone is setto UTC

account is valid only Mon-Fri

account belongs to Guest role

login name is an email of the user
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o guest user must provide at least First Name, Company Name and his
email to create an account

o password must be auto-generated based on at least 4 alphabetic
characters and 2 numbers and not contain any special characters

Guest users should get access to Internet only after successful authentication.
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Configuration
Complete these steps:
Step 1 ISE configuration. Configure Guest Portal settings.
* Go to Administration > Guest Management > Settings > General >
Ports and enter guest.micronics.local into Default Sponsor URL
field. Click Save.
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* (Go to Administration > Guest Management > Settings > Guest >
Multi-Portal Configuration > DefaultGuestPortal > Operations
(tab) and disable AUC on that portal. Enable Guest users should be
allowed to do self service opfion. Click Save.
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If self-service registration is enabled there must be two other options
comrectly configured. There is a message about that.

st sell service megshnation &
cnvaliied], Pleaie make sie pl soleot
el Regidiraton Guest Rok snd Sel
Reagitraton Timo Prable under tho

Proital Policy
o+

Go to Authentication tab and check below settings. The
Guest_Portal_Sequence defines Internal Users and AD users and
was reconfigured in one of previous tasks.

N W Tt
v [ Lot N B
L] LT T - el Ve A
......... L

‘wrim Pk " i e o o mnoe (Ue1_Priral B

F¥ vk Mawn i 0T0 L D@0 | & Rbiecstios 11

Go to Administration > Guest Management > Settings > Guest >
Time Profiles and click Add. Enter a name for the profile e.g. 8hours
and specify settings as follows:

Page 169 of 507



CCIE SECURTY vd Lab Workbook

als porer B ideniny Maraganeat W e Pt [T

.....

[=E b
= o ]
[ rea Zora For Basrciore | BT
[ L Tarcise
I iidrieed e .
g B i Dsslon (8[| Ham
Featal Pk At
— 1ita £ e oy el b kgl D R e gy
s bl c CCTEE T T T R T
Y
i ‘M wom [m ~| [m ~| To[z2 +| [ -
: | =
¥ ks

Bhuwn 0T L D@ O | & Ripfoatiorn 10

Go to Administration > Guest Management > Settings > Guest >
Portal Policy and set Self Registration Guest Role to Guest and
assign 8hours as Self Registration Time Profile. Click Save.
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Go to Administration > Guest Management > Settings > Guest >
Details Policy and set First Name, Company and Email as
Mandatory settings. Click Save.
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Go to Administration > Guest Management > Settings > Guest >
Usermname Policy and check Create username from email address

option. Click Save.
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Go to Administration > Guest Management > Settings > Guest >
Password Policy and set Minimum number of special characters
to include to 0 and Minimum number of digits to include to 2. Click
Save.
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Step 2 Create new authorization rule for Guests.
* (o to Policy > Authorization and add new rule at the end. Enter a
name for the rule e.g. Wireless Guests and set identity groups
condition to Guest.
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+ Set permissions to Wireless_Internet authorization profile. This
profile has ACL_REDIRECT for WLC configured.
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Click Done and Save to apply the changes.
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Verification

Go to Win7 PC and bounce Wireless NIC. Then connect to MICRONICS SSID. The
connection should be successful as the network is open.
Open up web browser and enter hitp:/guest.micronics.local

= e it fimmmicronica kcakd45) g criabiLagn 2 - @ G X | & Gunt Portal

il Identity Services Engine
CISED  Guest Fortal

Click on Self Service link. You should be moved to Self Registration portal. Fill up

all required fields and click Submit.
' ==

& hiips e micronics boo B questoortal Sel 0 = @ O X | B Guen Potdl

cisco |dentity Services Engine 1.1 Guest Portal

Self Registration

& Fired heames Piak
Las! Ha e
& Erviadl dedtigas:  POTEMETONKS kcal
Prosta huumbsr
& Canparny WLIonics
Cptianal Duls 1
Dobaral Data &
Dplaral Dats X
Dpbaral Data &
Cplaral Data &

& Th s uTo

You should get details of new auto-generated account. Check if this suffices all task
requirements. Write down user credentials and click OK.
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|8 wiips e micronacs kol BLL portal Tl D = § & " || Gued Potal

-III-II I poinfnicoonic ool dbout

cisco  Identity Services Engine 1.1 Guest Portal

. Successfully Created Guest Account: pintr@micronica.local
Self Registration

Limerreame: phrnimi cenice kcal
Prciawand Jediak

Firsi Ha s Fiidr

Lani Hamee

Ermail Adrirese: plan@miconice incal
P bhumbsr

i gy [TET T

Dbl Dale 1

Dol Data 2

Dplaml Data X

Opianai Dol &

Opianal Daks &

Timeaone: LUTC

Provide new user credentials and log in to the Guest Portal.

+ L ——— ot 2= @ X || 8 e o

Now you should be able to connect to any Website without being redirected to the
Guest Portal.
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LAB 3.16. Configure ISE Profiler

Obijectives
This lab shows how to configure profiling services on ISE.

IP Addressing and devices

Device Interface IP address
ISE NIC 172.31.1.20
WinXP NIC 10.1.10.50/24
Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)
Task

Configure ISE profiling services to discover Win7 PC. Use DHCP, RADIUS
and SNMP services on SW1. Configure SNMP v2c on the switch with read-
only community string of ‘cisco123’ and polling interval of 600 seconds. The
Windows client should be recognized based on its hostname carried in DHCP
packets. Configure new profiling policy so that WIN7-PC endpoint profile will
be created and use it in Domain Computers authorization rule.
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Configuration

Complete these steps:

Step 0 Check what devices ISE knows about (Internal Endpoint list).

(opt.) * Go to Administration > Identity Management > Identities >
Endpoints. There are only two devices: Cisco-Device (which is AP)
ad Cisco-IP-Phone (which is IP Phone). There is no Win7 PC.

Step 1 Switch configuration.

Alarn @ 2050 4 D@0 | & Rt [

!

snmp-sarver commmnity aiscsl23 RO

snmp-server enable traps snmp linkdown linkup
snmp-sarver anable traps mac-notification change move

snmp-sarver host 172.31.1.20 version 2c ciscollld
!

interface VlanlO

ip helper-address 172.31.1.20
!

Step 2 |SE configuration. Enable Profiling services.

* Go to Administration > System > Deployment and click ISE on the
list. Go to Profiling Configuration and check DHCP, RADIUS and

SNMPQUERY options. Leave default settings for profiling services.
Click Save.
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Go to Administration > Network Resources > Network Devices
and click SW1 on the list to edit it. Pick SNMP Settings checkbox and
configure SNMP v2c¢ with community string of ‘cisco123’ for that
device. Set Polling Interval to 600. Click Save.
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Step 3 Check if ISE profiled other devices.
* (Go to Administration > ldentity Management > |dentities >
Endpoints. There are only two devices: Cisco-Device (which is AP)
ad Cisco-IP-Phone (which is IP Phone). Now you should see
Microsoft-Workstation on the list. This is our Win7 PC.
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L

-

Click on the new device to see more details. There are attributes from
different sources. First we see attributes taken from RADIUS
messages.
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Scroll down to see more. There are more attibutes from RADIUS.
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Scroll down. There are attributes taken from DHCP messages. There
is an attribute host-name based on which we can create our profiling

rule.
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Step 4 Create profiler policy to match ‘win7' keyword and categorize Windows

client.

Go to Policy > Profiling > Profiling Policies and click Add. Enter
Win7-PC as a name for new policy (this name will be used to create
respective Endpoint Identity Group). Set Minimum Certainty Factor
to 10 and pick Windows-Workstation as a Parent Policy. Add new
rule at the bottom that DHC P:host-name attribute must contain
keyword ‘win7'. If this is true, increase the certainty factor by 10. Click

Save.
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Step 5 Check is profiling works.

Go to Administration > Identity Management > Identities >

Endpoints. There are now more devices on the list. You should see
Win7-PC on the list.

Be D& e Hiom besieat Dok ber
[T ——————]

[[RES e | e [*
+ & e
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wf bl
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Sl g OO

Step 6 Based on above Endpoint Profile, change authorization rule.

-

Go to Policy > Authorization and click Edit bution next to Domain

Computer rule. Click identity group condition list and pick Win7-PC
from the profiled devices.
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Click Done and Save.
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Verification

Some of verification steps have been done during the configuration.
Disable Wireless adapter and enable LAN NIC to trigger authentication.
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Enable Wired AutoConfig service. Authenticate using employee1 user.
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LAB 3.17. AnyConnect NAM

Obijectives
This lab shows how to configure and use AnyConnect Network Access
Manager instead of Win7 native supplicant.

IP_Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

WinXP NIC 10.1.10.50/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

Task
Configure Win7 client PC to use Cisco AnyConnect Network Access Manager
(NAM) as dot1x supplicant instead of native Windows 7 supplicant. The NAM
must provide to the user a new network connection profile ‘wired-peap’ with
PEAP/MS-CHAPv2 secure authentication method. Enable user and machine
authentication with open mode. Do not cache user’s credentials.
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Configuration

Complete these steps:
Step 0 Check switch configuration.
(opt.)

1
interface GigabitEthernet0d/7
description IFP + Win7
switchport access wvlan 10
switchport mode acocass
switchpert nonegotiate
switchport voloe wlan 500
ip access-group DEFAULT in

authentication
authentication
authentication
authentication
authentication

event fail action next-method
hes t-mede mul ti-domain

open

crder dotix mab

port-control auto

authentication vielation protect
mab

dotlx pas authenticater

dotlx timecut tx-pericd 5
spanning-tres portfast

Step1 Run NAM Profile Editor and create configuration file.

* Run Network Access Manager Profile Editor and click Networks
opfion in the left pane. Click Add...
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» Enter a name for new profile e.g. wired-peap and specify network
media as Wired (802.3) Network. Click Next.
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Fie Hig
Flepvork docess Hauger | Mabwarks
Chart Palicy -
e o Pebicy Profile: Usntitied
1 Ptarks . - [
I Richveceb Bapur — = E——
N Frnun Mrsherohin

In g
& [y ol g bl

Chooss Your Meteark: Meda
o Prad JHET] Mabvard

e minsd etk e e iations vell b coanscing 90 The i vwith 8 radtionsl
ahmr caba,

R fdrndeaa] labrork

T A e e 1 s v s vl e VRS B D BT o 5 Rk
ikt cOrTcaon b s Acomer Poant.

Comrson Sattrgn
Saripd oF SPPRCHIDE O Eadh L wachins e e s ponescisd

Conwetion Taesi fec) 4

= Select Authenticating Network for Security Level and tick Enable
port exceptions checkbox. Select Allow data traffic after
authentication even if radio button and tick EAP fails checkbox.
Click Next.
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Select Machine and User Connection option to authenticate
machine and user. Click Next.
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* For Machine Auth select PEAP as EAP method. Click Next.
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* For machine credentials leave all default settings. Click Next.
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For User Auth select PEAP as EAP method. Click Next
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For user credentials select Prompt for Credentials optiona and then
select Never Remember. Click Done.
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Go to Network Groups menu on the left pane and move wired-peap

Page 192 of 507




CCIE SECURTY vd Lab Workbook

-

-

network to the top of the list.
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From the top menu select File > Save As... Enter configuration.xml
as file name and select the following directory. Click Save.

[Cisee

s | L pemimtatie - [ =]

ﬂﬂﬂﬂﬂﬂ

....................

iy

Right click AnyConnect icon on the windows taskbar and select
Network Repair option.

Open AnyConnect
VPH Cormect

Hubwrk Rapaic I.:;
[seble#5-F

Abcul

Authenticate to the network as employee1 user. You should see a
message from AnyConnect.
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Verification

Show advanced options for AnyConnect NAM connection.

=

el AnyConneet 'S

Cowecisd [Autherdorsd)
BB SR
I e ek

110103
pL ]

Criacied
L)

Check logs on ISE.
s sl | — — —
PO 0L [ g snohmel 02 7 0 A0 5 Bl GoantEtemetny7 A0 Success Proe  Frodedimimkstatn

Check commands on the switch.

SWl#sh authentication sessions interface g0/7

Interface:
MAC Rddress:
IP Address:
User-Hame:
Status:
Domain:

GigabitEthernet0/7
0026 . 5540 . 0d56
10,1,10.103
enployeel

Ruthz Success

LRATA
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Security Pelicy:
Security Status:
COper host mode:
Cper contrel dir:
RAuthorized By:
¥lan Group:

RACS ACL:

Session timeout:
Idle timeout:
Commen Session ID:
Acct Session ID:
Handle:

Funnable methods list:
Methed State
dotlx
mak

Interface:

MAC Rddress:

IF Rddress:
User-Hames:
Status:

Domain:

Security Policy:
Security Status:
Opar host modsa:
Cper control dir:
Authorized By:
RCS RCL:
Session timecut:

Should Sacure

Unsecure

multi-domain

both

Authentication Server
H/R
XACSACLE=IP-FERMIT ALL TRAFFIC=4f572406
H/A

H/R

OROL 0ADTO 00000 LAOOTEDTEC
0x000000LF

0xFE00001E

Authc Success
Hot run

GigabitEthernetd/7
0021 .a084.6££4
Unknown
00=21-A0-84-6F-F4
Ruthz Success

VOICE

Should Secure
Unsecure

mlti-domain

both

Authentication Server
XACSACLE-IP-FERMIT_ALL_TRAFFIC-4f57e406
H/R

Idle timecut: MH/A
Common Sessieon ID: O0RO01OROTOOO00018007DOEER
Acct Session ID: Ox000000LC
Handle: Ox1800001%
Funnable methods list:
Meathod State
dotlx Failed owver
makb Authc Success
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LAB 3.18.

MACSec Switch-to-Host

Objectives

This lab shows how to configure AnyConnect NAM to encrypt data at Layer 2

between the client PC and the switch.

IP_Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

WinXP NIC 10.1.10.50/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

SwWA Vlan10 10.1.10.7/24

Task

Configure AnyConnect NAM to encrypt user data at Layer 2 using strong AES-
GCM-128 algorithm. The link must be secured all the time. If EAP negotiation
fails the user shouldn't be able to send traffic unencrypted. Disable machine
authentication. You can edit wired-peap connection profile to accomplish this

task.
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Configuration

Complete these steps:
Step 1 Switch configuration (commands required in this lab are highlighted).

i
interface GigabitEthernstd/7

descriptien IFF + Win7

switchport access wvlan 10

switchpeort mode access

switchport nonegotiate

switchport volioce wlan 500

ip access-group DEFAULT in
authentication event fail action next-method
authentication host-mode multi-domain
authantication opan

authentication linksec policy must-secure
authentication order dotlx mab
authenticatien poert-centrel aute
authentication viclation protect

Ma Caes

mka default-policy

mab

dotlx pae authenticator

dotlx timesout tx-pericd 5

spanning-trea portfast

Step 2 Run NAM Profile Editor and re-configure network profile.

-

Run Network Access Manager Profile Editor and Open
configuration.xml file. Click Networks option on the left pane, select
wired-peap profile from the list and click Edit... Change the profile
name to wired-peap-macsec and click Next.
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The requirement is to set Port Authentication Excepticon Pelicy te

‘i st-secure’

then we must enable

‘EAF succeeds but key management
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fails' optieon.
sarias switchas. Te accommedate for a macsec policy set to

sscura’ , uncheck

‘Sheuld-secure’ is the default policy set on Cisce X-

‘EAP sucoeads by key management fails’.

‘mast—

Select User Connection option to authenticate user only. Click Next

Film Halg

{3 CleiPokcy
Pt

5% hateork Groags

Autunbcabza Poky

* g ArryTiorrvmct Pactibe Biiber - Hetwork Rer a Manuger

Patert dccans Vanamr | Mesbaarks:

Frafile: _lenilersark Aoseas N ges i el g Filbaa 2 el ]

STl SOt THE
Fahing Connition
Thershairiba red 1 e aad Faben soad kg ords e rabenek sebe e e bap
This i Dyecallp sid Mo ConneTing fo dorain, bo pet RO and athe updades foan the
rateneh bk e vser hm s

% [Fwe Conrwston|
Tt i pOrwtion shawilc] b e vahen & shing: CRWIRTION B Nk PRIy, & e
tmrrachon ol makn the researt e mlitde st ta cme bas gt .
ictare i Ui Conractian

This tvpe of convecTion il be nade Bulneically when the rachie baas., Iwll hanbe
whan s user lagn i

il

it Trom
Cormectan T

| Crechnsas

T

Sy Level

e sl

* For User Auth select PEAP as EAP method. Click Next
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For user credentials select Prompt for Credentials optiona and then

select Never Remember. Click Done.
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-

Go to Network Groups menu on the left pane and move wired-peap-
macsec network to the top of the list
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From the top menu select File > Save. Right click AnyConnect icon on
the windows taskbar and select Network Repair option.

Open AnyConnect
VEH Cornact

Hubwark Rapaic I.:;
[sable#5-F

About

Authenticate to the network as employee1 user. You should see a
message from AnyConnect.
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Verification
Show advanced options for AnyConnect NAM connection.

il A mofe o
ciseg 1Y LORREE

O oS el B

L By il
el PUOss )

IR Mo [
atfuan]u. “ Wicda ez
CISCD iy T ek gty Do s PR 00 ¥T Dol Pt

Fickeerk Carrecion

Check commands on the switch.

SWlish macsec summary
Interface Transmit 8C Receive 5C
GigabitEthernetd/7 1 1

SWl#sh macsec interface g0/7
MACsec is enabled

Replay protect : enabled

Replay window : 0

Include 3CI : yes

Cipher : GCM-RES-128

Confidentiality Offset : 0O
Capabilities

Max. Rx SR : lé

Max. Tz 3R : 16

validate Frames : strict

PN threshold notification suppert : Yes

Ciphers supported : GOM-RES-128
Transmit Secure Channels

SCI : C4A64136CESQ0TO00Z
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Elapsed time : 00:01
Current AN: 0
BC Statistics
Ruth-cnly (0 / 0}

Encrypt (1263 / 0)

Freavious BAN:

20

Receive Secure Channels

BCI :
Elapsed time :
Current AN: 0
8C Statistics

KHotvalid pkts 0
valid pkts 64
Uncheck pkts 0

Port Statistics

00:01

Ingress untag pkts

Ingress noSCI pkts 0O
Hotusing pkts 0

Frewious HAN:

0026550000 560000
20

Invalid pkts 0
Late pkts 0
Delay pkts 0

o Ingress notag pkts 25567
Ingress badtag pkts 0

Ingress unknownsScI pkts 0
Unused pkts 0
Decrypt bytes 89423

Ingress miss pkts 25488

SWlgsh authentication sessions interface g0/7

Interface: GigabitEthernet(/7
MAC Rddress: 002&.55d40. 0456
IF Rddress: 10.1.10.103
User-Name: employesl
Status: Ruthz Success
Domain: DRTR
Security Pelicy: Must Securs
Security Status: Secured
Cper host mode: multi-domain
Cper contrel dir: both
Authorized By: Authentication Server
¥lan Group: MN/A
RACS ACL: m—IP—PEMT_ﬂ.L_TMFIE—ifETEIDE
Session timecut: HN/A
Idle timeout: N/R
Common Session ID:  OROLOROTOOOO00ZFOLYZE4ZE8
Acect Sessien ID:  O=O0000007%
Handle: O=xRE000030

Runnable metheds list:

Method State
dotlx RAuthe Success
mak Hot run

SWliksh ip access-lists interface g0/7
permit ip host 10.1.10.103 any
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LAB 3.19. MACSec Switch-to-Switch

Obijectives
This lab shows how to configure MACSec between two switches with manual

keyring.

IP_Addressing and devices

Device Interface IP address

ISE NIC 172.31.1.20

WinXP NIC 10.1.10.50/24

Win7 PC LAN NIC (LAB-Network) | DHCP-Assigned
WLAN NIC 10.1.30.x (DHCP)

SwWA G0/24 Trunk

SW2 G0/24 Trunk

Task
Enable link encryption between SW1 and SW2. Do not use authorization
server, Instead, configure encryption key of ‘987654321' manually and use
GCM-AES-128 encryption algorithm.

Page 204 of 507



CCIE SECURTY vd Lab Workbook

Configuration
Complete these steps:

Step 1 Switch 1 configuration.

1

interface GigabitEthernst0/ 24

dascription Teo SWITCHZ

switchport trunk encapsulation dotlg
switchport moda trunk

cts manual
no propagate sgt
sap pmk 987654321 mode-list gom-encrypt

Step 2 Switch 2 configuration.

!

interface GigabitEthernst0/24

description To SWITCHL

switchport trunk encapsulation datlg
switchport modsa trunk

ots manual
ne propagate sgt
sap pmk 987654321 mode-list gom-encrypt

Verification

Check commands on both switches.

SWlish cte interface
Global Dotlx feature is Enabled
Interface GlgabitEthernetd/24:

CTS is enabled, mode: MANUAL

IFC state: OFEN

RAuthentication Status: ROT AFFLICAELE
Feer identity: "unknown™
Pear's advertised capabilities: "sap"

Rutherization Status: HOT AFFPLICRELE

SAF Status: SUCCEEDED
Version: 2

Configured pairwise ciphers:
gom-encrypt

Replay protection: enabled
Replay protection mode: STRICT

Selected cipher: gom-encrypt
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Fropagate SGT:
Cache Info:
Cache appl

Statistics:
authc succ
authe reje
authc fail
authe no ¢
authe logo
SAp SUCCes
sap fail:
authz succ
authz fail
port auth

Ingress:

control frame bypassed:

Disabled

ied to link : HOME

ags:
[« M

ure:
BSPONSe:
££:

fail:

gsap frame bypassed:

esp packets:
unknown sa:
inwalid =a:

inverse binding failed:

auth failed:

replay

Egreﬂ-.ﬂ-:

contrel frame bypassed:

BIIOL:

egp packets:
agt filterad:

sap frame bypassed:

unknown sa dropped:
unknown sa bypassed:

SWlésh macsec inte
MACsec is enabled
Replay protect :

Replay window :
Include SCI : ye

rface gb/24

enab led
o

-]

Ciphar : GCM-AES-128
Cconfidentiality offset : 0O

Capabilities
Max. Rx SR : 16
Max. Tx SR : 16
Validate Frames

: striect

L=T = =R B = T = N = R = = ]

[=Ja == == - I = = ]

L=J = = R = = =]

PN threshold notification support : Yes
Ciphers supported : GCOM-RES-128
Transmit Secure Channels

5CI : C464136CE8
Elapsed time :
Current AN: O
SC Statistics

180000
Twid

Previous AN: 1
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Ruth=cnly (0 / 0}
Encrypt (38040 / 0}
Receive Secure Channels
SCI : CCEF4B8RAG3CHE0000
Elapsed time : Twid
Current RM: 0 Frevious AN: 1
8C Statistice

Hotwalid pkts 0O Invalid pkts 0

Valid pkts 165125 Late pkts 0

Uncheck pkts 0 Delay pkts 0
Port Statistics

Ingress untag pkts 0 Ingress notag pkts 19165
Ingress badtag pkts 0 Ingress unknownSCI pkts 0
Ingress no3CI pkts O Unused pkts 0

Hetusing pkts 0 Decrypt bytes 43163117

Ingress miss pkta 19153

f/ same commands on other switch. Hote that Dotlx is HOT hecessary bto ba

enabled in crder te make manual MACSec werk.

‘cts dotlx’ command on the interface.

swiésh cts interface
Global Dotlx feature is Disabled
Interface GigabitEthernet0/24:

CT3 is enabled, mode: MANUAL
IFC state: QFEN
RAuthentication Status: HOT APFLICRELE
Pear identity: "unknown™
Peer's advertised capabilities: "sap"
RAuthorization Status: ROT AFFLICRAELE
SRP Status: SUCCEEDED
Version: 2
Configured pairwise ciphers:
gem-encrypt
Replay protection: enabled

Replay protection mode: STRICT

Saelected cipher: gom-encrypt
Fropagate SGT: Disabled
Cache Info:

Cache applied to link : HONE

Statistics:
authc success:
authe reject:
authe failure:
authe no response:
authc logoff:
B8P BUCCESS!

L = R = = R = I =]

It is OI'I.].Y important wen we use
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sap fail:
authz success:
authz fail:
port auth fail:

L= = = R = |

Ingress:
control frame bypassed:
gap frame bypassed:
asp packets:
unknown sa:
inwvalid sa:
inverse binding failed:
auth failed:
replay error:

Egress:

L= = = = N = = = O =]

contrel frame bypassed:
esp packets:

agt filtered:

gsap frame bypassed:
unknown sa dropped:
unknown sa bypassed:

SW2ish macsec interface g0/24
MACsec is enabled

Replay protect : enabled

Replay window : 0

Include 3CI : yes

Ciphar : GCM-RES-128

Confidentiality Offset : O
Capabilities

Max. Rx SA : 16

Max. Tx 3R : 16

Validate Frames : strict

PN threshold notification support : Yes

Ciphers supported : GCOM-RES-128
Transmit Secure Channels

5CI : CCEF48RG3C380000

Elapsed time : 05:24:03

Current AN: O Frevious AN: 1

BC Statistics

Auth-only {0 / 0}

Encrypt (163371 / 0}

Receive Secure Channels

8CI : C4641386CEB 180000

Elapsed time : 05:24:03

Current AN: 0 Frevious AN: 1

3C Statistics

Hotwvalid pkts 0O Invalid pkts 0
valid pkts 38131 Late pkts 0
tncheck pkts 0 Delay pkta 0

Port Statistics
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Ingress untag pkts
Ingress badtag pkts
Ingress noSCI pkts 0
Hotusing pkts 0
Ingress miss pkts 23

o]
o

Ingress notag pkts 23
Ingress unknownSCIl pkts 0
Unused pkts 0

Decrypt bytes 5441050
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LAB 3.20. Basic Router Security

10.1.1.0 124

Lo

Lab Setup
» Ensure that R1's F0/0 and R2's G0/0 interface is configured in VLAN 12.
» Assign the IP addressing using the chart below.

IP Addressin

Router Interface IP address

R1 Lo0 1.1.1.1/8
FO/0 10.1.1.1/24

R2 Lo0 2222/8
G0/ 10.1.1.2/24

Task 1

Ensure that R1 is configured with the following policy:
» Configure this router such that the user needs to enter a password of
“Cisco07" before the user is allowed access to the privilege mode
The password must be at least seven characters in length
Use the strongest hashing method based on MD5
No recovery of the passwords are allowed on this routers

A A A o
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Configuration

Complete these steps:

Step 1

Task 2

R1 configuration.

Fl (cenf ig) #securi ty passwords min-length 7
Bl (conf ig) #no service password-recovery

WARNING :

Executing this command will disable password recovery me
chanism.

Do not axecute this command without ancther plan for

password recovery.
Are you sure you want to continue? [yes/no]: yes
Fl (conf ig) #enable secret Cisce

# Invalid FPassword length - must contain 7 to 25 characters.
Password configuration failed

Hote above message is saying that the length of the

password must be 7 characters.
Bl (conf ig) #enable secret Ciscol7

Hotéa the “"Sscourity pasawords min-length 7 command affects

all the passwords on this router.

Ensure that all the passwords on both routers are unreadable if a “show run”

command is issued.

Configuration

Complete these steps:

Step 1

On both routers.

(config) #service password-encryption

Hote a “ne service password-encryption” ocommand will not

decrypt the passwords, but all the passwords oconfigqured
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after this command is entered will be displayed in the

running configuration as unencrypted

Task 3

Ensure that if the console port of any of these routers stops functioning, the
administrator has another way to connect to the routers locally. DO NOT configure
telnet or modems for to accomplish this task. The password for this task should be

“Cisc@??07"

Configuration
Complete these steps:
Step 1 On both routers.

(config)#line aux 0O
(cenfig-line) #login
({config-line) #password Ciscf??07

Hote in order to configqure the password

of these routers

ba “Ciscl8??07", you must enter the “Esc

typing sach “?%, in this task, the

to bae done twice one for esach YV,

and then Q" bafors
and than Q" needs
but to anter the

password whean a login attempt is made,

you MUST HOT use the

“Esc and then Q% for entering the “2v

Task 4

On R1 configure the number of allowable unsuccessful login attempts to 3 within one
minute, if this policy is violated, the router should generate a syslog message.
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Configuration
Complete these steps:

Step 1 R1 configuration.

Fl (config) #security authentication failure rate 3 log

When the number of failed login attempts reaches the
configured threshold, the router will send a

“TOOMANY AUTHFAILS"Y event message to the configured STISLOG
sarvar. The router will alsc start a 15 second delay timer,
cnoe this delay timer expires, the user can try to login

again

Task 5

Configure both Routers to terminate an unattended console connection after 4
minutes and 30 seconds

Configuration
Complete these steps:
Step 1 On both routers.

{config)#line con O
{coenfig-line ) #fexec-timecut 4 30

Hote that a command “axec-timescsut 0 0¥ should be ussed to

disable console timecit at all.

Task 6
Create the following users on R2 using the chart below and ensure that ONLY the
assigned commands are available to these users via the console:

User name Password Available commands:

U2 Cisco2 Show interface GO0/0, Show ip int brief, ping and
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Traceroute.
u3 Cisco3 All the User level commands, The user should be able
to assign an |P addresses and shut and no shut the
interfaces.
Admin Cisco All levels and commands.
Con r n
Complete these steps:

Step 1 R2 configuration.

To configure the privilege level for User U2:

2 (config) #privilege EXEC level 2 Show interface FO/0
B2 (conf ig) #privilege EXEC level 2 Show ip int brie
R2 (config) #privilege EXEC level 2 ping

B2 (config) #privilege EXEC level 2 Traceroute

R2 (config)#username U2 privilege 2 password cisco2

Hota that user U2, has access to all privilagse laval 1

commands also. For axample:

B2 f§sh privilege
Current privilege level is 2
B2f§sh ip routa | ins 10.1.1.0

c
B2 ¥

10.1.1.0 is directly connected, FastEthernet/0

To confiqure the privilege level for User U3:

B2 {configl¥privilege EXEC level 3 configure terminal
B2 (conf ig) #privilege configure level 3 interface

R2 (cenf ig) #privilege interface level 3 shutdewn

B2 (conf ig) #privilege interface level 3 ip address

B2 (conf ig) fusarname U3 privilege 3 password aiscel

To confiqure the privilege level for User Admin:

R2 (config) husername admin privilege 15 password cisco

Lastly force the users to login using the local user account

database:
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R2 (config)#line con ©
B2 (config-line)#login local

Task 7
Create a message of the day banner on R1 using the following policy:

The banner should state the router, line and it should also state that you are
connected to www.MicronicsTraining.com

Configuration
Complete these steps:
Step 1 R1 configuration.

Fl (config) #banner motd #You are connected to S(hostnama) on line
§(line) on domain §(domain) #

Rl (config) #ip domain-name www.MicronicsTraining.com

Verification

Fl #logout

You should sea the following message on the console:

Tou are connected to Rl on line 0 on domain www.MicronicsTraining.com

Task 8

Router R1 should be configured such that when user U2 logs in to the router the
following menu is displayed. The following policy must be configured for the menu:
The screen must be cleared prior in displaying the menu, the menu should allow the
user to type the desired number and then press the enter key to select that option,
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option 3 should logout the user whereas, option 4 should exit the menu and into

privilege exec mode (enable mode)

This is the menu for CCIE candidates

1 Display all the interfaces and their assigned IF addresses
2 Display the configuration of FO/0 interface

3 Logout

4 Exit out of the menu

Please Choose an option and press Enter :

Configuration
Complete these steps:

Step 1 R1 configuration.

Fl {cenf ig) #manu

Rl (eonf ig) #menu
IP addresses
Rl (conf ig) #menu

U2 title # This is the menu for CCIE candidates #

U2 text 1 Display the interfaces and their assigned

U2 command 1 Show ip int brie

Bl (conf ig) #menu U2 options 1 pause
If the pausa is not configured, the user will not sea the
cutput

Fl {cenf ig) #menu
interface
Bl { conf ig) #manu

Bl { conf ig) #meanu

Bl {conf ig) #menu
Fl {cenf ig) #manu

Fl (conf ig) #manu
Rl (conf ig) #menu

U2 text 2 Display the configuratien of FO/0

U2 command 2 Show run int £0/0

U2 options 2 pauss

U2 text 3 Logout
U2 command 3 legout

U2 text 4 Exit out of the menu
U2 command 4 menu-exit

Page 218 of 507



CCIE SECURTY vd Lab Workbook

Rl (config) #manu U2 claar-scraan

Bl {conf ig) #menu U2 line-mode

Rl (config) #fmenu U2 prompt # Flease Choose an cption and press Enter
#

Bl (conf ig) fusername U2 privilege 15 password usar2009
Fl (conf ig) fusername U2 autocommand menu U2
Rl {conf ig) #usernama Admin password Ciscol2009

Always create another user so0 you won't lock yoursalf out
of the con port, onos tested you can always remove that

T SEE TS

Rl (config)#line con ©
Bl (config-line)#login local

Task 9
Configure R2 using the following policy:

# Disable the service that when a wrong command is entered the router
performs a broadcast looking for a DNS server to resolve the bad command to
an |P address. This search should be restricted to 10.1.1.5 |IP address.

Disable the service that can be used to find out which users are logged into a
network device. Although this information is considered not sensitive by many
administrators, the information can be used by a hacker for reconnaissance
attack.

hd

# Disable the service that instructs an end node to use another and more
efficient path to a particular destination.

Configuration
Complete these steps:

Step 1 R2 configuration.
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B2 (config) #ip name-server 10.1.1.5
R2 (config) #no ip finger
B2 (conf ig) #ne ip iomp redirect

Task 10
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.21. Standard Named Access List

10.1.12.0 124

I:H
Rl
A |F it

4 || gip  Le? Led  fpp

| 5 S
o 10.1.45.0 /24 e 0.5
e =
R4 RS

Lab Setup
» R1 and R2's GO/0 interface should be configured in VLAN 12

» R2and R5's 50/1/0 interface should be configured in a frame-relay point-to-
point manner.

» R5 and R4's FO/0 interface should be configured in VLAN 45

» Configure telnet on all routers using password “cisco”

> Run RIPv2 on the routers and advertise their directly connected networks

IP Addressing

Router Interface IP address

R1 Lo0 1.1.1.1/24
FO/0 10.1.12.1/24

R2 Lo0 222224
G0/0 10.1.12.2/24
S0/1/0.25 10.1.25.2/24

R4 Lo0 4.44.4/24
FO/0 10.1.45.4/24

R5 Lo0 5.5.5.5/24
FO/0 10.1.45.5/24
S0/M1/0.52 10.1.25.5/24
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Task 1
Configure a standard numbered access-list on R1 to block host 4.4.4.4 from
accessing any of its interfaces.

Configuration
Complete these steps:

Step 1 R1 configuration.

Rl (config) laccess=list 1 deny 4.4.4.4
Bl (conf ig) #acoess-1list 1 permit any

Bl (conf ig) #int £0,/0
Fl (conf ig-if ) #ip access-group 1 in

Verification

Rli#debug ip packet

Rd#ping 1.1.1.1 source lod

Type ascape seguence to abort.
Sanding 5, 100-byte ICMP Eches to 1.1.1.1, timecut is 2 seconds:

Packet sent with a source address of 4.4.4.4
o.o.u
Success rate is 0 percent (0/5)

Tou should sea the fellowing debug sutput on Rl
IF: s=4.4.4.4 {l‘ut&l‘.hurnutﬂ.-"ﬂ}, d=1.1.1.1, len 100, access denied
IF: tableid=0, s=10.1.12.1 (locall, d=4.4.4.4 (FastBthernet0/0}, routed via FIB

IF: 5=10.1.12.1 (local}, d=4.4.4.4 (FastEthernet(/0), len 56, sending

Hote the ping fails

Task 2
Replace the previous task using a standard named access-list.
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Configuration
Complete these steps:
Step 1 R1 configuration.
Fl (conf ig) #70 access-list 1
Fl (cenfig) #ip access-list standard TEST
Fl (cenf ig-atd-nacl) #dany host 4.4.4.4
Rl {config-std-nacl) ipermit any
Rl (config)#int £0/0
Fl (cenfig-if ) #ip access-group TEST in
Task 3

Remove the access-list from the previous step before proceeding to the next Lab.

Configuration
Complete these steps:
Step 1 R1 configuration.

Rl {config)¥no ip access-list standard TEST

Pl (config) #int £0/0
Fl (cenfig-if ) #no ip access-group TEST in
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LAB 3.22. Controlling telnet access and
SSH

Based on the previous Lab’s IP addressing, topology and Lab setup

Led

R2
- S01025
10.1.12.0 124 Gum| 277

1
i
1 L6024
\

e ordsons e sl 5 A

Configure an access-list on R2 such that only 1.1.1.1/24 is allowed to telnet in, other
packets should NOT be subject to inspection by this access-list.

Configuration
Complete these steps:
Step 1 R2 configuration.

B2 (conf ig) #acoess-1ist 1 permit hest 1.1.1.1

R2 {config)#line vty O 7
B2 (config-line)#faccess-class 1 in

The reascon a guesticn maArk was used in the *“line vty O 7¢
command is because different routers with different IOSes
have different numbar of telnat ports. Most awitchas have
15 ¥VT¥s by default.
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Verification

Rl#telnet 10.1.12.2

Trying 10.1.12.2 ...
% Connecticon refused by remote host

Rl #telneat 10.1.12.2 /source-interface lo0

Teying 10.1.12.2 ... Open

User Access Verification

Password:

Hete the first time Rl telnet using its 10.1.12.1 IF address and the telnet was

refused by R2. The second telnet was successful, because the source IF addreass

ef the talnet was 1.1.1.1

RS#telnet 10.1.25.2

Trying 10.1.25.2 ...

% Connection refused by remote host

ES#telnet 10.1.25.2 /source-interface lod

Trying 10.1.25.2 ...
% Connectien refused by remote host

Hote RS is WOT successful

Bd #telnet 10.1.25.2

Trying 10.1.25.2 ...
% Connecticn refused by remote host

Fd#telnet 2.2.2.2

Teying 2.2.2.2 ...
% Connection refused by remote host

Fd #telnet 2.2.2.2 Sscurce-interface Lol

Trying 2.2.2.2 ...
% Connection refused by remote host

Hote Rd is HOT successful.
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Task 2

Configure R2 such that when host 1.1.1.1/24 telnets into any of its interfaces, from
the telnet session, this host can only telnet to R4 and no other router. This access-list
should not be applied to any of the routers interface.

Configuration

Complete these steps:
Before configuring the task, you should test to ensure that

Step 1

Step 2

the telnet works properly.

Rlételnet 10.1.12.2 /source-interface lod

Trying 10.1.12.2 ... Opaen

User Access Verification

Password:

Enter Ycisco as the password

R2>telnet 10.1.25.5

Trying 10.1.25.5 ... Opan

User Access Verificatien

Fassword:

Hote Rl can successfully telnet into RS

B2>telnet 10.1.45.4

Trying 10.1.45.4 ... Opan

User Aoocass Verification

Password:

Hote Rl can successfully telnet into R4

R2 confguration.
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B2 (config)#line vty O 871
R2 (config-line)#access-class 2 out

M(mﬂig)lﬁm—list 2 permit host 4.4.4.4

Verification

Hote Rl has sucoassfully telnet to R2

Bl i#telnet 10.1.12.2 /source-interface loO

Trying 10.1.12.2 ... Open

User Access Verification

Password:

Hote Rl can ROT telnet to RS

B2>telnet 5.5.5.5

Trying 5.5.5.5 ...
% Connecticns to that host not permitted from this terminal

Hote Rl can ONLYI telnat to Ra

F2rtelnet 4.4.4.4
Trying 4.4.4.4 ... Cpen

User Access Verification

Password:
Rd>quit

[Connection to 4.4.4.4 closed by foreign host)
R2rquit
[Connection to 10.1.12.2 clesed by foreign host]

Hote that this solution works only for telnet connections originated from R2

¥Tia (for usars already connected to the router via telnet) It doas not work

for reqular telnet originated from R2 (i.e. where user is

and issus telnet command).

Task 3
Configure SSH on R4 using the following policy:
Domain name: MicronicsTraining.com

connected via console
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Key: 512 bit
Authentication: The authentication should be performed based on the local database.
Usermname: User1
Password: Cisco
Authentication Ports:
Local authentication should be configured on VTY.
No authentication should be done on the AUX or the CON lines.
You should only allow SSH connection to the VTY lines.

83H (Sscure Shell) is a protocol that anables a S5H client to make a sacure and

ancrypted connecticon to Cisco Devices

Configuration
Complete these steps:

Step 1 R4 configuration.

The following command configures a host demain for this router

Rd {config) #ip domain name MicronicsTraining.com

The following command generates an REA key pair for your router,
which automatically snables 28H, the last line of this message
states that. Remember if you need to delete the REA key pair, use
the “crypte key Zercilie rsa” command, once the key pair is

deleted, S55H is automatically disabled.
Rd (config) #crypte key generate rsa usage-keys

tnocae the above command is entered, the fellowing message should

appaar on the console:

The name for the keys will be: R4 MicronicsTraining.com

Cheose the size of the key modulus in the range of 360 te 2048 for your
Signature Keys. Choosing a key modulus greater than 512 may take
a few minutes.

Hoew many bits in the medulus [512]:
Cheosa the size of the key modulus in the range of 360 to 2048 for your
Encryption Feys. Choesing a key medulus greater than 512 may take

a few minutes.

How many bits in the modulus [512]:
% Generating 512 bit REA keys, keys will be non-exportable... [OK]
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% Genarating 512 bit RSA keys, keys will bse non-exportable... [0K]
REZH-5-EHABLED: 25H 1.99 has been enabled
Hote that in order to use SS5Hv2 a key of at least 768 bits must

bae genarated.

The following command anables the ARA sarvicas
R4 (config) #aaa new-modal

To create the reguested usernama and password:
Fd (config) fusername Userl password Cisco

The following command is created so it can be applied to all VT

ports.

Bd (conf ig) #aaa authentication login LOCAL-AUTH local

The following commands will apply the “LOCAL-AUTH" pelicy to the

vty ports
Bd (sonfig) #line wviey 0 181
Fd (config-line) #login authentication LOCAL-AUTH
Bd (conf ig=-line)#transport input =ssh
Hote that there is no need to oreate “no authentication® polioy

for AUX and CON. This is because a named authenticatien list is

ussd and it is only applied to the VIY ports.

Verification

BS#ssh -1 Usarl -o 3des -v 1 10.1.45.4

Fassword:

Rd »exit

[Connection te 10.1.45.4 closed by foreign host]
RS #

Task 4
Remove the configuration commands from the previous four steps before proceeding

to the next lab.
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LAB 3.23. Extended Access List IP and
ICMP

Based on lab 2's IP addressing. topology and Lab setup

Led

10.1.12.0 124

10.1.45.0 124

Deny communication between hosts 1.1.1.1 and 4.4.4.4. This must be configured on
R2. If these hosts attempt to communicate their packets should not reach their
destination.

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config)#access-list 100 dany ip host 4.4.4.4 host 1.1.1.1
B2 (config) laccess-list 100 permit ip any any

B2 (config) #access-list 101 deny ip host 1.1.1.1 host 4.4.4.4
B2 (conf ig) #acoess-1list 101 parmit ip any any

B2 (config) #int =0/1/0.25
R2 (config-subif) #ip access-group 100 in

R2 (config) #int g0 /0
R2 (conf ig=subif) #ip access-group 101 in
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Veri

Rléping 2.2.2.2 source 1.1.1.1

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos teo 2.2.2.2, timeout is 2 seconds:
Facket sent with a source address of 1.1.1.1

Success rate is 100 percant (5/5) , round-trip minfavg/max = 1/2/4 ms

Fléping 5.5.5.5 source 1.1.1.1

Type escape segquence to abort.

Sending 5, l00-byte ICMPF Eches te 5.5.5.5, timeout is 2 seconds:
Packet sent with a source address of 1.1.1.1

IEREE

Success rate is 100 percent (5/5) , round-trip minfavg/max = 56/56/60 ms

Rléping 4.4.4.4 source 1.1.1.1

Type escape sequence to abort.

Sending 5, l00-byte ICMFP Echos to 4.4.4.4, timeout is 2 seconds:
Packet sent with a scurce address of 1.1.1.1

U.o.o

Success rate is 0 percent (0/5)

Rlish ip ro rip
2.0.0.0/24 is subnetted, 1 subnets

R 2.2.2.0 [120/1) wie 10.1.12.2, 00:00:21, FastEthernet0/0
4.0.0.0/24 is subnetted, 1 subnets

R 4.4.4.0 [120/3] wia 10.1.12.2, 00:00:21, FastEthernetd,/0
5.0.0.0/24 is subnetted, 1 subnsts

R 5.5.5.0 [120/2) wia 10.1.12.2, 00:00:21, FastEthernetd/0
10.0.0.0/24 is subnetted, 3 subnats

R 10.1.25.0 [120/1] wvia 10.1.12.2, 00:00:21, FastEthernet0/ /0

R 10.1.45.0 [120/2) wia 10.1.12.2, 00:00:21, FastEthernetd/0

Hote even though network 4.4.4.0/24 is in Bl's routing table, Rl can't ping
4.4.4.4 IF address, because of the inbound access-list 101 configured on R2's
&0/0 interface.

Fd#ping 5.5.5.5 source 4.4.4.4

Type ascape segquence to abort.
Sending 5, 100-byte ICMP Echos to 5.5.5.5, timeout is 2 seconds:
Packet sent with a source address of 4.4.4.4
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Success rate is 100 percent (5/5) , round=trip minfavg/max = 1/2/4 ms

RBddping 2.2.2.2 source 4.4.4.4

Type escape sequence to abort.
Sanding 5, 100=byte ICMF Echeos to 2.2.2.2, timecut is 2 seconds:
Packet sent with & source address of 4.4.4.4

Success rate is 100 percent (5/5), round-trip minfavg/max = 56/57/60 ms

Rédd#ping 1.1.1.1 source 4.4.4.4

Type escape sequence to abort.

Sending 5, l00-byte ICHMF Echos to 1.1.1.1, timecut is 2 seconds:
Packet sent with a source address of 4.4.4.4

U.U.o

Sucoass rate is 0 parcant [(0/5)

Refpi 1.1.1.1

Type ascape seguence to abort.
Sending 5, 100-byte ICMP Echas to 1.1.1.1, timssut is 2 seconds:

RN BRI

Success rate is 100 parcent (5/5) , round-trip min/avg/max = 56/57/60 ms

Hote Rd can ping any IP address axocept 1.1.1.1 TP address using its Lo0 as the
source, this is because of the inbound access-list configurad on R2'a 20/1/0.25

interfaos .

Task 2
Configure R1 based on the following policy:
> R1 should successfully be able to ping R2 and receive the replies, but R2

should not be able to ping R1.

Configuration

Complete these steps:
Step 1 R1 configuration.

Rl {cenfig) #access-list 100 deny icmp hest 10.1.12.2 any eche
Rl {config) #access-list 100 deny icmp host 2.2.2.2 any echo
Rl (config) #access-list 100 deny icmp host 10.1.25.2 any echo
Rl (config) #laccess-list 100 permit ip any any

Rl {configilint £0/0
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Fl (conf ig-if ) #ip access-group 100 in

Verification

Fléping 10.1.12.2

Type escape sequence to abort.

Sanding 5, 100<byte ICMP Echos to 10.1.12.2, timeout is 2 seconds:

Sucoass rate is 100 parcent (5/5) . raund—trip min.-'aug.-’max = 1/1/4 m=

Rl 2.2.2.2

Type escape sequence to abort.
Sanding 5, 100-byte ICMP Echeos to 2.2.2.2, timecut is 2 seconds:

Success rate is 100 percent (5/5), round-trip minfavg/max = 1/2/4 ms

Rliping 10.1.25.2

Type escape sequence to abort.
Sending 5, l00-byte ICHMF Echos to 10.1.25.2, timeocut is 2 seconds:

Success rate is 100 percant (5/5) , round-trip minfavg/max = 1/2/4 ms

Hote Rl can successfully ping esvery IF address on R2

B2 10.1.12.1

Type ascape sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.12.1, timeout is 2 seconds:
.00

Sucomss rate is 0 percent (0/5)

B2 1.1.1.1

Type escape sequence to abort,
Sending 5, 100-byte ICMP Echos to 1.1.1.1, timeocut is 2 seconds:
u.u.n

Sucoass rate is 0 parcant [(0/5)

Hote RZ2 cannot ping any IF address configured on Rl.

REdping 10.1.12.1
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Type ascape segquence to abort.
Saending 5, 100<byte ICMP Echos to 10.1.12.1, timeout is £ seconds:

fuccess rate is 100 percent (5/5) , round=trip min/favg/max = 56/57/60 m=

Hote RS can successfully ping any IF address configured on Rl

Redpi 1.1.1.1

Type ascape segquence to abort.
Sending 5, 100-byte ICMP Echos to 1.1.1.1, timeocut is 2 seconds:

Sucocess rate is 100 percent (5/5), round-trip min/avg/max = 56/57/60 ms

Hotea Rd can alsos sucoassfully ping any IP addrass configursed on R1

Task 3

R5 should be configured such that if R2 pings a host that is not reachable, R5 does
NOT send ICMP host unreachable messages back to R2

Configuration

Complete these steps:

Step 1 Before configuring this task, you should test to see the host
unreachable messages. In order to test you must configure
the following on R2:

R2 (configl#ip route 0.0.0.0 0.0.0.0 10.1.25.5

This static route is needed on RZ so R2 uses RS for any

dastination/s that it is not aware of.
B2 ldebug ip icmp
ICMFP packet debugging is on
B2 5.6.6.6

Type escape sequence to abort,

Sanding 5, 100=byte ICHMF Echos to 6.6.6.6, timeocut is 2 seconds:
o.u.n

ICME: dst (10.1.25.2) hest unreachable rev frem 10.1.25.5.0
ICHMF: dst (10.1.25.2) host unreachable rov from 10.1.25.5.0
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Success rate is 0 pearcent (0/5)

ICMP: dset {10.1.25.2) host unreachable rov from 10.1.25.5

Hote the default route was needed for tasting this

scenaric. (noa 65.6.6.6 18 pinged, the local router (RZ)

will parform a routa table lookup and the closast matah to
that destinatieon is the default gateway which is pointing
toe RS

Bince RE is not aware of this IF address, it sends

iamp hest unreachables back to the asource (RZ)

Step 2 R5 configuration.

R5 (config)#int 30/1/0.52
R3 {config-subifl#nc ip unreachables

Verification

B2 6.6.6.6

Type escape sequence to abort.
Sending 5, l00-byte ICHMF Echos to 6.6.6.6, timeout is Z seconds:

Success rate is 0 parcent (0/5)

Hete R 18 ne longer recelving the IGHMF unreachables

Task 4
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.24. Extended Access List OSPF &

EIGRP

Basedon Lab 2’'s IP addressing and Topology

Led

R2
- S01025
10.1.12.0 124 Gum| 277

10.1.45.0 124 L Fum| J

Task 0 - Preconfiquration
» Configure OSPF Area 0 and EIGRP 100 on all routers and advertise every
interface in both routing protocols

» Ensure that “no auto-summary” command is used when configuring EIGRP

100

# In OSPF routing protocol, the loopback interfaces should be advertised with
their correct mask

Configuration
Complete these steps:
Step 1 On all routers.

{config) #router ospf 1

{config-router)fnetwork 0.0.0.0 0.0.0.0 area 0
(config-roeuter) fexi

{config) #frouter eigrp 100
{config-router)#ne aute
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Task 1

{config-reuter) fnetwerk 0.0.0.0 0.0.0.0
{config-router) faxi

{config) #int

1o

(config-if) #ip cspf network point-to-point
(config-if) #exi

Configure an access-list on R1 to block EIGRP routing protocol and allow the rest of
the IP protocol stack, if this configuration is performed successfully router R1 should
only have OSPF routes in its routing table.

Configuration

Complete these steps:
Before you configure this task, you should display the existing routing

Step 1

table:

Rlish ip route

Codes: C - connected, 8 - static, R - RIF, M - mchile, B - BGF
D — EIGRP, EX — EIGRP external, O — OSPF, IA — OSPF inter area
N1l - OSPF MSSR external type 1, M2 - OSPF NSSR external type 2
El - QSFF external type 1, EZ - OSPF external type 2
i = IS-I8, su - IS-IS summary, Ll - IS-IS lewel-1, L2 = IS-IS lewel-2
ia - I8-I8 inter area, * - candidate default, U - per-user static

route

o = ODR,

Gateway of last

1.0.0.0/24
c 1.1.1.0
2.0.0.0/24
D 2.2.2.0
4.0.0.0/24
D 4.4.4.0
5.0.0.0/24
D F. 3. 3.0

F - paricdic downloaded static route

rasort is not set

is subnetted, 1 subnets

is directly connected, Loopback(

is subnetted, 1 subnets

[20/156160] wia 10.1.12.2, 00:01:47, FastEthernet0/ 0
iz subnetted, 1 subnets

[30/2302576] wvia 10.1.12.2, 00:01:35, FastEthernetd/0
is subnetted, 1 subnets

[90/2300416] wvia 10.1.12.2, 00:01:35, FastEthernetd/0

10.0.0.0/24 is subnetted, 3 subnets

c 10.1.12.
D 10.1.25.
D 10.1.45.

0 is directly connected, FastEthernet(/0
0 [90/2172416] wia 10.1.12.2, 00:01:49, FastEthernet(/0
0 [90/2174976] wia 10.1.12.2, 00:01:37, FastEthernet(/0
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Veri

KHote you only see the EIGRP advertised routes because EIGRF has a

lowar administrative distance - 50 wversus 110.

Step 2 R1 configuration.

Rl (config) #access-list 100 deany eigrp any any
Pl (config) #access-list 100 permit ip any any

Rl (config) #int £0/0
Rl (config=if ) #ip access-group 100 in

SDUAL-5-HERCHAMGE: IF-EIGRF(0) 100: Heighbor 10.1.12.2 (FastEthernet0/0) is down:
hoelding time expired

Bli#sh ip route

Codes: C - connected, 5 - static, R - RIF, M - mobile, B - BGF
D - EIGRF, EX - EIGRF external, © - OSFF, IR - OSFF inter area
Nl - OSPF NSSA external type 1, N2 - OSPF HSSA external type 2
El = OSPF external type 1, E2 = OSFF external type 2
i =18-1I3, su - I3-I3 summary, Ll - I5-I5 lewvel=-1, L2 - IS-IS level-2
ia - IS-IS inter area, * - candidate default, U - per-user static route
o = ODR, P = pericdic downloaded static route

Gateway of last resort is not set

1.0.0.0/24 is subnetted, 1 subnets

c 1.1.1.0 is directly connected, Loopback(
2:.0.0.0/24 is subnetted, 1 subnets

=] 2.2.2.0 [110/2] wia 10.1.12.2, 00:00:08, FastEtharnat0/0
4.0.0.0/24 is aubnetted, 1 subnets

=] 4.4.4.0 [110/67]) wvia 10.1.12.2, 00:00:08, FastEthernetd/0
5.0.0.0/24 is subnetted, 1 subnets

[s] 5.5.5.0 [110/66] wvia 10.1.12.2, 00:00:08, FastEthernetd/0
10.0.0.0/24 is subnetted, 3 subnets

c 10.1.12.0 is directly connectad, FastEthernet0/0

Q 10.1.25.0 [110/65] wia 10.1.12.2, 00:00:09, FastEthernetl/0

o 10.1.45.0 [110/66) wia 10.1.12.2, 00:00:09, FastEthernetd/o

Hote when the access-list is configured, the EIGRP neighbor adjacency between
Fl and R2 fails, and OSPF is allewed in the routing table.
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Task 2

Remove the configuration command from the previous step (Task 1), erase the
startup config and reload the routers before proceeding to the next lab.

Configuration
Complete these steps:
Step 1 R1 configuration.

Bl {conf ig) #70 access-list 100

Rl (config)#int £0/0
Fl (conf ig-if ) #150 ip access-group 100 in
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LAB 3.25. Extended Access List With
Established

Based on Lab 2s IP addressing and Topology

Led

N

Eum| zﬁiunm.zs

10.1.12.0 124

1
1
1 L1250 24
\

| 1 H
10.1.45.0 /24 L] Fool_ .

Task 0 -P nfiguration

» Configure OSPF routing protocol on all routers and advertise every interface in
OSPF Area 0.

Configuration
Complete these steps:
Step 1 On all routers.

(config) #router ospf 1
{eenfig-reuter) inetwerk 0.0.0.0 0.0.0.0 area 0
{config-router) fexi

Task 1
R1, R4 and R5 are offering telnet and HTTP services. R1 and R2 are the routers in
your company; your company's policy is as follows:
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R2 is the border router that connects R1 to the other routers. R2 should be
configured with an inbound access-list such that it ONLY allows ftraffic that was
initiated locally and by R1 to be returned. Ensure that the appropriate traffic is
allowed. No other traffic should be allowed in.

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config) #acosss=-list 100 permit ospf any any
B2 (conf ig) #acoess-1ist 100 parmit top any any established

B2 (config) #int 20/1/0.25
B2 (conf ig-subif) #ip access-group 100 in

Veri n

Rlé#telnet 10.1.45.4

Trying 10.1.45.4 ... Open

Password required, but nonhe set

F2#sh acceas-list

Extended IP accegs list 100
10 permit ospf any any (5 matches)
20 permit tcp any any established (& matches)

To test the configuration using ICMP and UDP

Ré#sh flash | in bin
g 594535672 Feb 03 2010 13:34: 44 c280inm-adventerprisekd-mz.124-24.T2.bin

Bd (config) #efep-sarvar flash:ad800nm-adventarpri sakf-me.124=-24. T2 . bin

Flf#copy tftp flash

Rddress or name of remote host [10.1.45.4]17%

Spurce filename [c2800nm-adventerprisekS-mz.124-24.T2.bin]?

Destination filename [cZB0lnm-adventerprisek9-mz.124-24.T2.bin]? test .bin
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Accessing tftp://10.1.45.4/c2800nm~adventerpriseks-mz.124-24.7T2 .bin.. .
%Error opening tftp://10.1.45.4/c280inm-adventerprisekd-mz.124-24.T2.bin (Timed out)

Hote “"Established” only works on TCF based application and TFTIF in this case
failed.

Rl 10.1.45.4

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.45.4, timeout is 2 seconds:

Success rate is 0 perecent (0/5)

Hote ICHME will not be allowed back in, even though the traffic was initisted
from Rl, because the “Established” keyword only works on TCF based

applications.

Rli#sh ip route oepf
2.0.0.0/8 is wariably subnetted, 2 subnets, 2 masks

Q 2.2.2.2/32 [110/2) wia 10.1.12.2, 00:09; 14, FastEthernst(/0
4.0.0.0/32 is subnetted, 1 subnets

o 4.4.4.4 [110/67] wvia 10.1.12.2, 00:09:14, FastEthernetd/0
5.0.0.0/32 ia subnetted, 1 subnets

o 5.5.5.5 [110/66] wvia 10.1.12.2, 00:09:04, FastBEthernetd/0
10.0.0.0/24 is subnetted, 3 subnets

Q 10.1.25.0 [110/65] wia 10.1.12.2, 00:09:14, FastEthernet0d/0

s} 10.1.45.0 [110/66] wia 10.1.12.2, 00:09:14, FastEthernet0/0

Hote the routing protocel was HOT affected becausse it was specifically allowed

in the access-list.

Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.26. Dynamic Access List

10.1.12.0 124
.4 ||: oo Lad
— 10.1.45.0 /24
R4

Based on Lab 2s IP addressing and Topology

Task 0 - Preconfiguration
» Configure OSPF routing protocol on all routers and advertise their directly

connected interfaces in OSPF Area 0
» The loopback interfaces should be advertised with their correct mask

# Create

the following users on R2:

First user name: U3, password: U3
Second user name: U4, password U4

Configuration

Complete these steps:

Step 1 On all routers.
{config) #router ospf 1
(config-router) fnetwork 0.0.0.0 0.0.0.0 area 0
(config-router) fexi
{config) #int lob
{config-if) #ip ocspf network point-to-point
{config-if) #exi

Step 2 R2 configuration.
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Task 1

R2 (config) #usernams U3 password U3
B2 (conf ig) fusername U4 password U4

R1 and R2 belong to the same company; R2 is the border router connecting their
company (consisting of R1 and R2) to the other routers belonging to another
company (consisting of R4 and R5). Create a dynamic access-list on R2 using the
following policy:
» Only the authenticated users are allowed to have access to R1
» Allow R5 andfor R4 to telnet into R2's S0/1/0.25 interface to get authenticated
(using the usernames created in the lab setup) before they can access any of
the services offered by R1

w7

This policy should NOT affect the routing protocol

# R1 orR2 should be able to have access to R5 and R4, without authentication

Con r
Complete these steps:
Step 1 R2 configuration.

R2 {config) #access-list 100 permit tcp any hest 10.1.25.2 ag 23

This access-list is needed 3¢ RS and B4 can telnet teo, in orpder to

get authenticated.

R2 {config) #access-list 100 permit ocspf any any

This statement is required to allow QOSPF through.

B2 (config) lacoess-1ist 100 parmit tep any any establi shed

This statemsnt allows the return traffic in the network that was

initiated by any of the users within the company (Rl and/or R2 in

this casa) .

R2 (config)#access-list 100 dynamic TEST permit ip any any

Hote the above statement in the access-list tells the router to
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create a dynamic access-list called TEST. This named access-list
will ba created when U3 and/or U4 telnet to this router and get
authenti csbed .

R2 (configliint 30/1/0.2%
R2 {config=-subifl#ip access-group 100 in

The above command is applying the access-liat inbound te 20/1/0.25

interfacea.

Lastly the telnet ports must be configured for the dynamic access-
list:

RZ (config-subif)déline wty 0 871
k2 {config-line) #fautecommand access-enable host
RZ (config-line)#login local

Hote the access-enable may not show when & guestion mark is entered,
because it's a hidden command. The “autccommand” command linka the
dynamic access-list to the telnet authentication. It creates an
entry in the dynamic access-list using the scurce IP address of the
host. If the “autccommand” is HOT used, the dynamic entry will net
be arested.

The second line specifies that authentication should be done using

the local user account database.

Verification

Rd#show ip route

Codes: C - connected, 8 - static, R - RIP, M - mobile, B - BGP
D — EIGRP, EX — EIGRP external, © - OSPF, IA - OSPF inter area
Nl - OSPFF NSSA external type 1, N2 - OSPF HSSA external type 2
El - OSPF external type 1, B2 - OSPF external type 2
i = I8=I%, Bu = IS=I% summary, Ll = IS=IZ level=l, LZ = IS=I3 leval=2
ia - IS-I8 inter area, * - candidate default, U - per-user static route
o — ODR, P — periodic downloaded static route

Gateway of last resort is not set

1.0.0.0/24 is subnetted, 1 subnets

[a] 1.1.1.0 [110/67) wvia 10.1.45.5, 00:04:01, FastBthernetd/0
2.0.0.0/24 is subnetted, 1 subnets

[#] 2.2.2.0 [110/66) via 10.1.45.5, 00:04:01, FastEthernet(/0
4.0.0.0/24 is subnetted, 1 subnets

C 4.4.4.0 is directly connected, Loopbackd
5.0.0.0/24 is subnetted, 1 subnets

o 5.5.5.0 [110/2] wvia 10.1.45.5, 00:03:51, FastEthernetd/0
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10.0.0.0/24 is subnetted, 3 subnets

o 10.1.12.0 [l10/66] wia 10.1.45.5, 00:04:01, FastEthernet0/0
o 10.1.25.0 [110/85) wia 10.1.45.5, 00:04:02, FastEthernet0/0
c 10.1.45.0 is directly connected, FastEthernet(/0

Kote the reuting table contains all the networks.

R4 1.1.1.1

Type escape segquence to abort.
Sending 5, 100-byte ICMPF Eches to 1.1.1.1; timecut is 2 seconds:
U.0.U

Success rate is 0 pearcent (0/5)

The ping failed because R4 is not an authenticated user.

In the following steps, R4 will telnet te R2 in erder te get authenticated.
Hote Rd's telnet session is closed right after the authentisation.

Réf#telnet 10.1.25.2

Trying 10.1.25.2 ... Cpen
User Access Verification
Username: —————— Entering the ussrnams U3

Passwongh—————————————— Entaring the passwerd “U3" to get authenticated
[Connection to 10.1.25.2 closed by foreign host]

Hote once the user gets authenticated, the telnet session is closed by
10.1.25.2.

To test connectivity:

R4 1.1.1.1

Type escape sequence to abort.
Sending 5, 100-byte ICHMF Echos to 1.1.1.1, timecut is 2 seconds:

Success rate is 100 percent (5/5) , round-trip minfavg/max = 56/58/60 ms

Rdf#telnet 1.1.1.1

Trying 1.1.1.1 ... Gpen

Usear Access Verification

Fasgword:
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KHote both telnet and ping commands are successful after a successful
authantication.

B2 #show acoess-list

KHote the dynamically created
Extended IF access list 100 ACL
10 permit tcp any host 10.1.25.2 ag telnet (& tches)
20 permit ospf any any (77 matches)
30 permit tcp any any established (10 matches)
40 Dynamic TEST permit ip any any
permit ip hest 10.1.45.4 any (6 matches)

Task2

Clear the dynamically created access-list entry from R2, do not remove and reenter
the access-list to accomplish this task. Configure an idle timeout on R2 for the
dynamic access-list such that if an authenticated user is idle for 2 minutes the entry is
removed.

Hote A password was not entered;, the telnet session expired, but the dynamic

access-list is still on R2 allowing IF to any source going teo any destination.

Fd#telnet 1.1.1.1
Teying 1.1.1.1 ... Open

User Rccess Verification

Password:
% Password: timeout expired!
Fassword:
% Password: timeout expired!
Password:

% Password: timeout expired!
% Bad passwords
[Connection to 1.1.1.1 closed by foreign host)

Check the dynamically created access=list:

B2 #show acocess-list

Extended IF access list 100
10 permit tep any hest 10.1.25.2 &g telnet (60 matches)
20 permit ospf any any (98 matches)
30 permit tocp any any established (13 matches)
40 Dynamic TEST permit ip any any
permit ip hest 10.1.45.4 any (6 matches)
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Configuration

To clear the dynamically created access-list:

Rlf#clear ip access-template 100 TEST hest 10.1.45.4 any

To verify the configuration:

B2 #show ip acoess-list

Extended IP access list 100

10 permit tep any heost 10.1.25.2 eg telnet (60 matches)
20 permit ocepf any any (125 matches)

30 permit tcp any any established (13 matches)

40 Dynamic TEST permit ip any any

Hote the dynamic entry is purged. Enter the following commands to setiup the

requested timscut value

R2 (config)#line vty 0 871
RZ (config-line)#autocommand access—enable host timeocut 2

Tha timecut here defines the idle timecut and it is in minutes

To test the configuration:

Rdltelnet 10.1.25.2

Trying 10.1.25.2 ... Open
User Access Verification
Username: U4

Fassword:

[Connection te 10.1.25.2 closed by foreign hest)

Rd#telnet 1.1.1.1

Terying 1.1.1.1 ... Cpen

User Accesa Verification

Password:
Rl>
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R2¥#sh access-list

Extended IF access list 100
10 permit tep any hest 10.1.25.2 eq telnet (120 matches)
20 permit ospf any any (175 matches)
30 permit tep any any established (26 matches)
40 Dynamic TEST permit ip any any
permit ip host 10.1.45.4 any {1 match) (time left 107}

RZ#sh access-list

Extended IF access list 100

10 permit tcp any hest 10.1.25.2 eq telnet (120 matches)
20 permit cspf any any (176 matches)
30 permit tcp any any established (26 matches)
40 Dynamic TEST permit ip any any
permit ip host 10.1.45.4 any {1 match) {time left %7)

RZ#sh access-list

Extended IP access list 100
10 permit tcp any host 10.1.25.2 eq telnet ({120 matches)
20 permit ospf any any (18% matches)
30 permit tcp any any established (26 matches)
40 Dynamic TEST permit ip any any
permit ip host 10.1.45.4 any (1 match) [(time left 28}

R2#sh access-list

Extended IF access list 100
10 permit tcp any hest 10.1.25.2 eq telnet (120 matches)
20 permit ospf any any (187 matches)
30 permit tcp any any established (26 matches)
40 Dynamic TEST permit ip any any
permit ip host 10.1.45.4 any {1 match) [time left 1}

R2#sh access-list

Extended IF access list 100
10 permit tep any heost 10.1.25.2 &g telnet (120 matches)
20 permit ocspf any any (187 matches)
30 permit top any any established (26 matches)
40 Dynamic TEST permit ip any any
permit ip host 10.1.45.4 any (1 match)

KHote the (time left) counter starts counting down frem 120 seconds and onoce it

reachas Zars, the dynamically orestéed acoass-list is purged.
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Task 3
Re-configure this access-list such that the maximum time limit for each entry
regardless of activity within this dynamic access-list is set to 3 minutes.

Configuration
Complete these steps:

Step1 R2 configuration.

This command removes the acoass-list.
R2 {config) #ne acceass-list 100

This command removas the Yautocommand” command with an idle timscout

value configured

R2 {config) #line vty 0 871
R2 (config-line)#noc autocommand access—enable host timeout 2
B2 (config=-line) #autocommand access-enable host

R2 (config)#access—list 100 permit top any host 10.1.25.2 eq 23

RZ (config)daccess-1list 100 permit ocspf any any

R2 {config) #access=list 100 permit tcp any any established

R2 (config) #access-1list 100 dynamic TEST timesut 3 permit ip any any

This timeocut is the absolute or time to live timeout, which defines
the amsunt of time in minutes a dynamically created access-liat, can
exist.

Sinoe the access-list is alrvesady applied to the 20/1/0.25 sub

interface of R2, there is no nesd to re-apply the access-1ist.

Task 4

After configuring the dynamic access-list you realized that from time to time the
administrator needs to telnet into R2 for trouble shooting and management purposes.
Re-configure R2 such that the administrators can telnet into this router successfully
to perform their day to day management tasks.
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Configuration
Complete these steps:

Step 1 R2 configuration.

R2 {config) #line vty O 870
R2 (config-line) #login local
R2 {config=-line)#autocommand access-enable host

B2 (config)#line wiy 871

R2Z (cenfig-line) #login local

R2 (config-line) #rotary 5

RZ (config-line) #no autocommand access—enable host

Hote only one session is reserved for administration purpeses, more
ports can be used for this purpose. The “rotary 5" command alleows
telnet access to port 3005 instead of 23, this port number should be
allowed in the access-list and therefore, it must be added to the

existing access-list.
R2 {config) #access=1list 100 permit tcp any any egq 3005

Remember that "autocommand” can aAlsc be used for A spacific usar
confiquration by confiquring "usernams. ... autocommand access-enable
host"; therefore, another sclution in configuring this task is to move

the autocommand te the other users and remove it from the vty line.

Sea that telnet to Rl loopback fails without authentication against

R2.

Heote that telnet te the peort 3005 is successful and it allows

administrator to issue commands on R2.

Verification

Riftelnst 1.1.1.1
Tryimg 1.1.1.1 ...
% Destination unreachable; gateway or host down

R4#telnet 10.1.25.2
Teying 10.1.23.2 ... Open

User Rocess Verification

Username: U3
Pagaword:
[Connection to 10.1.25.2 closed by foreign host]
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Rd#telnet 1.1.1.1
Trying 1.1.1.1 ... Cpen

User Access Verification

Pagsword:

[Connection to 1.1.1.1 closed by foreign host)

Ri#telnet 10.1.25.2 3005
Trying 10.1.25.2; 3003 ... Open

User Access Verification

Username: U4
Pagsword:
R2xaxit

[Connection to 10.1.25.2 closed by foreign host)
Ri#

Task 5
Erase the startup config and reload the router before proceeding to the next lab.
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LAB 3.27. Reflexive Access-lists

Based on Lab 2s IP addressing and Topology

10.1.12.0 124
.4 ||: oo Lad
— 10.1.45.0 /24
R4

Task 0: Preconfiguration
» Configure the routers according to LAB 2's IP addressing and topology

» Configure OSPF routing protocol on all routers and advertise every interface in
OSPF Area 0.

» The loopback interfaces should be advertised with their correct mask.

Configuration
Complete these steps:
Step 1 On all routers.

(config) #router ospf 1
{config-routar) énetwerk 0.0.0.0 0.0.0.0 area O
{config-router) fexi

(config) #int lol
(config-if) #ip cspf netwerk peoint-te-point
{config=if) #exi
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Task 1
R1 and R2 belong to Company-A. R4 and R5 belong to Company-B. R2 is the border
router that connects these companies to each other; R2 should be configured such
that it allows the return traffic for the following protocols:

» R2 should allow the return HTTP traffic that is originated locally or by R1.

» R2 should allow the return telnet traffic that is originated locally or by R1.

» R2 should allow the return TFTP traffic that is originated locally or by R1.

» R2 should allow the OSPF traffic into the network.

Configuration
Complete these steps:
Step 1 R2 configuration.
B2 (config) #ip access-list extended cutbound
R2 (config-ext-nacl) #permit tcp any any eg 80 reflect TEST
R2 (config-ext-nacl)ipezmit tcp any any eg 23 reflect TEST

B2 (config-ext-nacl) #permit udp any any eg 65 reflect TEST
R2 (config-ext-nacl) ipermit cspf any any

R2 (config) #ip access-list extended inbound
R2 (config-axt-nacl)éparmit capf any any

B2 (conf ig-ext-nacl) #evaluate TEST
B2 (config)#int 20/1/0.25

R2 (config-subif) #ip acceass-group inbound in
B2 (conf ig-subif) #ip access-group outbound cut

Verification

Ri#ish ip route ocspf
1.0.0.0/24 is subnetted, 1 subnets

o 1.1.1.0 [110/67) via 10.1.45.5, 00:23:24, FastEthernet0/0
2.0.0.0/24 is subnetted, 1 subnets

o 2.2.2.0 [110/66) via 10.1.45.5, 00:23:24, FastEthernet0d/0
5.0.0.0/24 is subnetted, 1 subnets

o 5.5.5.0 [110/2] wvia 10.1.45.5, 00:23:24, FastEthernetd/0
10.0.0.0/24 is subnetted, 3 subnats

o 10.1.12.0 [110/66] wia 10.1.45.5, 00:23:24, FastEthernet(d/0

o 10.1.25.0 [110/65) wia 10.1.45%.5, 00:23:24, FastEthernetd/0
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Hote R4 has netwerk 1.1.1.0 /24 in its routing table, because 0SFF is allowad
through.

Rd 1.1.1.1

Type escape seguence to abort.
Sanding 5, 100-byte ICMP Echeos to 1.1.1.1, timecut is 2 seconds:

U.o.u

Success rate is 0 percent (0/5)

Fdf#telnet 1.1.1.1

Tryimg 1.1.1.1 ...
% Destination unreachable; gateway or host down

KHote even though netwerk 1.1.1.0 /24 is in Rd's reuting table ne traffie is
allawed in that netwerk.

Fl#telnet 4.4.4.4

Teying 4.4.4.4 ... Open

User Access Verification

Password:
Bd>

Kete Fl has established a telnet session with Rd4. Te see the dynamically added
lines in the ACL that allows this traffic to return de not close this

connection and go to Rz:

R2#show access-list
Reflexive IF access list TEST
permit tcp host 4.4.4.4 eq telnet host 10.1.12.1 eq 22887 (28 matches) (time left
287}
Extended IF access list inbound
10 permit ocspf any any (15 matches)
20 evaluate TEST
Extended IF access list outbound
10 permit tcp any any eg www reflect TEST
20 permit tocp any any eg telnet reflect TEST (39 matches)
30 permit udp any any eq tftp reflect TEST
40 permit ocspf any any

Hete an access-list is created dynamically called TEST. This access-list was
created as & result of Rls telnet to Bd's 4.4.4.4 IP address using port 22887 as
the scurce and 23 as the destination port, therefore, this is created sc the return
traffis can be permitted back in.
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Task 2
Re-configure the RACL on R2 using the following parameters:

»

»

w7

hd

R2 should allow the return HTTP traffic that is originated locally or by R1. The
temporary access-list should be set with an idle timeout of 120 seconds.

R2 should allow the return telnet traffic that is originated locally or by R1. The
temporary access-list should be set with an idle timeout of 60 seconds.

R2 should allow the return TFTP traffic that is originated locally or by R1. The
temporary access-list should be set with an idle timeout of 30 seconds.

R2 should allow the return ICMP and DNS traffic that is originated locally or by
R1. The temporary access-list should be set with an idle timeout of 10
seconds.

R2 should allow the OSPF traffic into the network.

Configuration

Complete these steps:
Step 1 R2 configuration.

B2 (config)¥#no ip access-list extended outbound

B2 (config) lip access-list extended cutbound

B2 (conf ig-ext-nacl) fpermit cspf any any

R2 ({config-ext-nacl) ipermit tcp any any eg 80 reflect TEST timeout 120
B2 (conf ig-ext-nacl) ipermit top any any &3 23 reflect TEST timscut 60
R2 (config-ext-nacl) #permit uwdp any any eg 69 reflect TEST timeocut 30
B2 (conf ig-ext-nacl) ipermit iomp any any reflscst TEST timscut 10

B2 (conf ig-ext-nacl) #permit udp any any &g 53 reflect TEST timecut 10

Verification

To generate some ICMP traffic:
Rl 4.4.4.4

Type escape sequence to abort.
Sending 5, l00-byte ICHMF Echos to 4.4.4.4, timecut is 2 seconds:
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it

Success rate is 100 percent (5/5), round-trip minfavg/max = 56/58/60 ms

To see the dynamically created access-list:

R2¥#sh access-list

Raflexive IF access list TEST
parmit icmp host 4. 4.4.4 host 10.1.12.1 (10 matchas) (tima lafe 1)
Extended IF access list inbound

10
20

permit ocspf any any (85 matches)
evaluate TEST

Extended IP access list sutbound

10
20
a0

40
50
&0

permit ocspf any any
permit tcp any any eg www reflect TEST
permit tcp any any eg telnet reflect TEST

permit udp any any eg tftp reflect TEST
permit icmp any any reflect TEST (5 matches)
permit udp any any eg domain reflect TEST

To generate telnet traffic:

Flé#telnet 4.4.4.4

Trying

4.4.4.4 ... Cpen

User Access Verification

Password:

R4 >

To see the dynamically added access-list:

R2¥#5h access-list

Reflexive IP access list TEST
permit tocp host 4.4.4.4 eq telnet host 10.1.12.1 eqg 41142 (33 matches) (time left

54}

Extended IP access list inbound

10
20

permit cspf any any (102 matches)
evaluate TEST

Extended IF access list outbound

10
20
30
40
50
&0

permit ocepf any any

permit tcp any any eg www reflact TEST

permit tcp any any &g telnet reflect TEST (19 matches)
permit udp any any eg tftp reflect TEST

permit icmp any any reflect TEST (5 matches)

permit udp any any &3 domain reflect TEST
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Task 3

Re-configure the timeout parameter of the extended “outbound” access-list such that
all the dynamically created entries have a time to live of 120 seconds, DO NOT use
the timeout argument in the access-list to accomplish this task.

Configuration

Complete these steps:

Step 1

Task 4

R2 configuration.

R2 (config) #no ip access-list extended ocutbound

R2 (config)#ip access-list extended cutbound

B2 (conf ig-ext-nacl) #permit cspf any any

R2 (conf ig-ext-nacl) #permit tcp any any eg 80 reflect TEST
B2 (conf ig-ext-nacl) #permit tcp any any &g 23 reflect TEST
RZ2 (conf ig-ext-nacl) #permit udp any any eg 69 reflect TEST
B2 (conf ig-ext-nacl) iparmit iomp any any reflsst TEST

R2 (conf ig-ext-nacl) #fpermit uwdp any any eg 53 reflect TEST

R2 (config) #ip reflesxive-list timeout 120

The above command specifies the length of time that reflexive acoess
list entries will continue to exist when no packets in the session
Are detacted, Iﬁ" dafault the timscut wvalue i3 sat te 300 seconds
Hote if you have configured a timecut for sach RACL entry and you
have alsc configured the global timecut command, the more specific
oneas that are configured for sach entry will take precedance over

the global command.

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.28. Access-list and Time-range

Based on Lab 2' IP addressing and Topology

10.1.12.0 124
-4|ru.ru Lod
i 10.1.45.0 124
=
R4

Task 0: Preconfiguration
» Configure the routers according to LAB 2's IP addressing and topology

» Configure OSPF routing protocol on all routers and advertise every interface in
OSPF Area 0.

» The loopback interfaces should be advertised with their correct mask.

Configuration
Complete these steps:
Step 1 On all routers.

(config) #router ospf 1
{config-routar) énetwerk 0.0.0.0 0.0.0.0 area O
{config-router) fexi

(config) #int lol
(config-if) #ip cspf netwerk peoint-te-point
{config=if) #exi
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Task 1

Configure R1 to allow its internal users to have the ability to browse the Internet
during the weekdays ONLY. R4 should be configured such that its internal users can
only browse the Internet in weekends. The access-list should be applied outbound on
their FO/0 interface, since this is the interface that connects these routers to the
Internet.

Configuration
Complete these steps:

Step 1 R1 configuration.

Rl (config) #time-rangs WEEFDAYES
Bl (conf ig-time-range) #paricodic weekdays 00:00 to 23:58

Rl {config) baccess-list 100 permit tcp any any o9 80 time-rangs WEEKDATS

Rl (config) #int £0/0
Rl (conf ig-if) #ip access-group 100 out

Step 3 R4 configuration.

Bd (conf ig) #time-rangs WEEFKEHWDS
Rd (conf ig-time-range) #paricdic weakend 00:00 to 23:59

Fd (config) #access-list 100 parmit tcp any any egq 80 time-range WEEFENDS
P4 (config) #int £0/0

Rd (config-if ) #ip accass-group 100 out

The first step in configuring this policy is to configure the time

range and dafine the allowed time range. The second step is to
configqure the acoass-list refareancing the tims-rangs and lastly
applying the access-list using the “access—group’ command to the

interface.
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Task 2
Configure R5 to allow its internal users to browse the Internet using the following
policy:

» This should ONLY be allowed Weekdays (Mon — Fri) between the hours of
2:00 PM and 6:30 PM.

» Because of unusual work load and special projects, this should NOT be
allowed starting July 20™ through Nov 26™ 9:00 AM to 5:00 PM during the
week days.

» The access-list should be applied outbound on their FO/0 interface, since this
is the interface that connects to the Internet.

Configuration
Complete these steps:

Step 1 R5 configuration.

RS (config) #time-rangs ALLOW
BS (conf ig-time-range) dperiodic weekdays 14:00 to 18:30

RS (conf ig) #time-rangs DENHIED
ES (conf ig-time-range) #absclute start 00:00 20 July 2010 end 23:58 26
Hovembar 2010

Hote that the abowve line may be different depends on the year

B5 (conf ig-time-range) fpariodic weekdays 9:00 to 17:00

B5 (conf ig) #acoess-1ist 100 dany top any any &g 80 time-rangs DEHIED
BS (config) #access-list 100 parmit tcp any any eg 80 time-range ALLOW

ES (cenfig) #int £0/0
RS (config-if ) #ip access-group 100 out

Verification

RS5i#sh access-lists

Extended IF access list 100
10 deny top any any &g Wwww time-range DENIED (inactive)
20 permit tep any any eg www time-range RALLOW (inactiwve)

BS5i#sh alock
®)1:168:33.819 UTC Fri Sep 3 2010

RE#clock set 10:00:00 Sep 3 2010
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RS #
¥8Y5-6-CLOCKUFDATE : System clock has been updated from 01:19:35 UTC Fri Sep 3 2010 to
10:00:00 UTC Fri Sep 3 2010, confiqured from console by consocle.

BSi#sh alock
10:00:07.023 UTC Fri Sep 3 2010

FS#sh acceas-lists
Extended IF access list 100
10 deny tcp any any &g www time-range DENIED {actiwve)
20 permit tcp any any eg www time-range ALLOW (inactive)

Task 3
Configure R2 using the following policy:

» Qutgoing telnet traffic should only be denied between the hours of 11:00 AM

and 2:00 PM, Monday to Friday.

» QOutbound HTTP calls should be denied Monday to Friday, between the hours
of 9:00 AM and 2:00 PM starting Feb 19" 2010 to April 24™ 2010.
Any other traffic should be denied. Ensure that the access-list is applied
outbound on their GO/0 interface, since this is the interface that connects to
the Internet.

Y

Con ration
Complete these steps:
Step 1 R2 configuration.

B2 (conf ig) #time-rangs TELHET
R2 (conf ig-time-range) Ipericdic weekdays 11:00 te 14:00

R2 (conf ig) #time-rangs HTTF
B2 (conf ig-time-range) #absolute start 00:00 19 Feb 2010 end 23:59 24 Apr 2010
B2 (conf ig-time-range) §paricdic weekdays 5:00 to 14:00

B2 (config) #access-list 100 deny top any any &g 23 time-range TELHET
R2 (config) lacoess-list 100 permit top any any eq 23

B2 (config) #access-list 100 deny tcp any any =g 80 time-range HTTF
R2 (config) laccess-list 100 permit tcp any any eq 80

R2 (config) #int g0/0
B2 (conf ig=-if) #ip acoess-group 100 out
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Verification

B2 f#sh accass-lists

Extended IF access list 100
10 deny tcp any any eg telnet time-range TELHET (inactiwve)
20 permit tcp any any eg telnet
30 deny top any any e www time-range HTTP (inactive)
40 permit tcp any any eg www

B2 f#ish alock
®(}5:27:20.087 UTC Fri Sep 3 2010

B2f#clock set 10:00:00 May 3 2010
RZ#

¥3Y53-6-CLOCKUFDATE : System clock has been updated from 05:27:4% UTC Fri Sep 3 2010 to
10:00:00 UTC Mon May 3 2010, configured from consocle by console.

R2#sh clock
10:00:04.303 UTC Mon May 3 2010

BEZ2#sh acoess-lists
Extended IF access list 100
10 deny tecp any any =g telnet time-range TELMET (inactiwve)
20 permit tcp any any eg telnet
30 deny tcp any any eq www time-range HTTP (inactiwve)
40 permit tcp any any eg wwWw

The HTTF ACE is inactive becauss the cleck is cut of acope (we should be

beatwean Feb and Apr)

RZ#clock set 10:00:00 Apr 3 2010
$3Y5-6-CLOCKUFLDATE : System clock has been updated from 10:02:30 UTC Mon May 3 2010 to
10:00:00 UTC Sat Apr 3 2010, configured from consocle by conscle.

F2#sh eleck
10:00:02.963 UTC Sat ARpr 3 2010

R2¥#sh access-lists
Extended IF access list 100
10 deny tcp any any eg telnet time-range TELHET (inactive)
20 permit tcp any any eg telnet
30 deny tcp any any e www time-range HTTF (inactive)
40 permit tep any any &g wWW

hgain, the HITTP ACE is inactiwve bacaussa the clock is out of scopae (wea are in
April but the day is Saturday)

E2lclock set 10:00:00 Apr 5 2010
¥3¥53-6-CLOCKUFDATE : System clock has been updated from 10:00:26 UTC Sat Apr 3 2010 to
10:00:00 UTC Mon Apr 3 2010, configured from conscle by console.
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R2#sh clock
10:00:03.967 UTC Men RApr 5 2010

B2 f#sh acoess-lists
Extended IF access list 100
10 deny tep any any &g telnet time-range TELMET (inactiwve)

20 permit tcp any any eg telnet
30 deny tcp any any &g www time-range HTTF (active)
40 permit tcp any any eg wWw

Task 4
Erase the startup config and reload the routers before proceeding to the next lab.

Page 264 of 507



CCIE SECURTY vd Lab Workbook

LAB 3.29. Configuring Basic CBAC

Inside
Network
R
T2 Fn 101.14.024  rondis—=3 .
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Lab Setup
> The FOA interface of R1 and R2's G0/1 interface should be configured in
VLAN 12.

» The F0/0 interface of R1 and R4 should be configured in VLAN 14.
#» Configure RIPv2 on all routers and advertise their directly connected
interfaces in this routing protocol.

IP Addressing

Router Interface IP address

R1 F0/0 10.1.14.1/24
FoN 10.1.12.1/24

R2 GON 10.1.12.2/24

R4 FO/0 10.1.14.4/24

Task 1

Configure R1 to perform a generic TCP, UDP and ICMP inspection, ensure that only
the traffic that was initiated from inside is allowed back in. You should also allow the
appropriate traffic through.
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Configuration
Complete these steps:

Step 1 R1 configuration.

Fl (config) #access-list 100 parmit udp any any eq 520
Rl (config) #access-list 100 dany ip any any log

Rl (config) #ip inspect names FW TCF
Fl (config) #ip inspect names FW UDP
Pl (config) #ip inspect name FW ICHFP

Rl (config) #interface £0/1
Rl (config=if ) #ip access-group 100 in
Fl (config-if ) #ip inspact FW out

Verification

Rd#telnet 10.1.12.2

Trying 10.1.12.2 ... Open

User Rocess Verification

Fassword:
R2>

Blish ip inspect session

Establi shed Sessions
Session 48E194CE (10.1.14.4:11577)=>{10.1,12.2:23} tcp SIS OFEN

HWote this entry was added to the state table for the telnet

Task 2

Erase the startup configuration and reload the routers before proceeding to the next
lab.

SESS1Oon.
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LAB 3.30.

Configuring Advanced CBAC

101.14.0 124
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Lab Setup

» The FO/M interface of R1 and R4's FO/0 interface should be configured in

VLAN 14.

> The FO/O interface of R1, R2 (G0/0), and R5 should be configured in VLAN

125.

» Configure RIPv2 on all routers and advertise their directly connected
interfaces in this routing protocol.

IP Addressing

Router Interface IP address

R1 FO/0 10.1.125.1/24
FoN 10.1.14.1/24

R2 G0/0 10.1.125.2/24
Lo0 2222124

R4 F0/0 10.1.14.4/24

R5 FO/0 10.1.125.5/24
Lo0 5.5.5.5/24
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Task 1
Configure R1 to ONLY allow TCP, UDP and ICMP traffic initiated from the inside
network (10.1.125.0 /24) to access the outside network/s. The traffic initiated from the
outside networks should ONLY be allowed if it's ICMP or telnet destined for host
10.1.125.5/24. Ensure that any other traffic NOT initiated from inside network is
denied.

Configuration
Complete these steps:
Step 1 Inthis case we have two security policies, one from inside to outside
and the second one from outside to inside.
To allow inspection of the traffic from inside to outside:

Rl (config)#ip inspect name OUT teop
Rl {config) #ip inspect name OUT udp
Rl {config)#ip inspect name OUT icmp

The abeve three lines are the rules for inspection. Basieally they
tall the TOS to inspeact the genaria traffis for TCP, UDP and ICHMP.
RFemember that with generic inspection CBAC ONLY performs connecticon
inspection; it also adds new connections to the state table, add
dynamie ACL and checks the sequence numbers in the returning traffie.
With generic inspection, CBAC doeas WOT monitor what actually is
sccurring on the connectisn, such as the commands that are baing
axecuted or if a secondary connection is being negotiated, if these
are required, then a specific inspection of the desired application
can be configured, once this is configured, it will take precedsnce
aver the generic TCP or UDP inspection.

Rl {config) daccess-list 100 permit ip 10.1.125.0 0.0.0.255 any
Rl {config) #access=-list 100 permit udp any any eq rip

The above access-list permits any traffiec frem 10.1.125.0/24 to any

natwork and it alse allows RIF to oparats.
Rl {config) #int £0/0
Rl {config-if}#ip inspect OUT in

Bl {config-if)#ip access-group 100 in

The above commands apply the inspectien rules and the access-lists te

the FO/0 interface (the inside interface) in the ingress direction.

Step 2 For the ingress traffic from outside to inside:
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In this policy talnat and IMP traffic is allowed for host

10.1.125.5/24

Rl {config) #access-1list 101 permit icmp any host 10.1.125.5
Rl {config) #access=list 101 permit tcp any host 10.1.125.5 eg 23
Rl {(config) #access=1ist 101 permit udp any any eq rip

Rl {config)#int £0/1
Rl {config-if)#ip access-group 101 in

Veri n

Réf#talnaet 10.1.128.2
Trying 10.1.125.2 ...
% Destination unreachable; gateway or host down

Hote the telnet is NOT sucoesaful

Rd#telnet 10.1.125.5

Trying 10.1.125.5 ... Open

User Rccess YVerification

Pasaword:
RS>

Hote the telnet is sucoassful .

Eifralnat 10.1.14.4
Trying 10.1.14.4 ... Open

User Access Verification

Pagsword:
Rd >

Rl#sh ip inspect session
Established Sessions
Session 48E154cH (10.1.125.2:35583)=>(10.1.14.4:23) tcp S5I3 OPFEN
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Task 2
Configure R1 based on the following policy:

. R1 should wait 20 seconds for all the TCP connections to be established, if
any of the connections are not established with 20 seconds, they should be
dropped.

. R1 should wait 8 seconds before it removes an entry from its state table when
either the source or the destination begins the tear down process of a TCP

session.

. R1 should maintain an idle TCP connection in its state table for 15 minutes

ONLY.

. R1 should maintain a DNS query connection in its state table for 8 seconds.

. R1 should begin deleting half-open sessions if they reach 800, R1 should stop
deleting these sessions once they fall below 600.

. R1 should be also use the previous two policies for the connection made in
the last one minute.

. The maximum number of half-sessions to a specific host should NOT exceed
80, if this policy is violated, the 10S should delete all half-opened sessions and
block all new connection requests for 8 minutes.

CBAC's global timeouts:
M Ip inspect tcp synwait-time:

This command s pecifies how long the IOS waits for a TCP connection to be

established. The default is 30 seconds, if the connection is not established, it
will be dropped.

Ip inspect tcp finwa it-time:
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This command specifies how long the 105 walts to remove an entry from its
table when the source or the destination begins the teardown process of a TCP
session. The default is § seconds. Basically this is the wait time after receiving

or exchanging the FIN packets.

Ip inspect tcp idle-time:

This command s pecifies how long the |0S maintains an idle TCP connection in
its table. The default is 3600 seconds (1 hour).

Ip inspect udp idle-time:

This command s pecifies how long the |0S maintains an idie UDP connection in
its table. The default is 30 seconds.

Ip inspect dns-timeout:
This command specifies how long the 105 maintains a DN5S query connection in
its state table. The default Is 5 seconds.

Ip inspect max-incomplete high:

Once the number of half-open sessions reaches this threshold, the I0S will start
deleting them. Default is 500

Ip inspect max-incomplete low:
Once the threshold is reached, the 105 will stop deleting the half-open
sessions. Default is 400

Ip inspect one-minute high:
If the number of half-open sessions exceeds the configured threshold, the 105
will begin to delete them. Default is 500 per minute.

Ip inspect one-minute low;
Once it falls below this threshold within a minute, the 10S will stop to delete the
half-open sessions.

Ip inspect tcp max-incomplete host number block-time minutes

The number of existing half-open sessions with the same destination host
address that will cause the IOS to start deleting them. Default is 50.

If the block-time is set to 0 = This is the default, the 10S deletes the oldest
existing half-opened session for the host for every new connection reguest to
the host.
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If the block-time is NOT set to 0 = the 105 deletes all half-opened sessions for
the host and then blocks all new connection requests to the host.

Configuration

Complete these steps:

Step 1

Step 2

Check CBAC configuration.

Rl é#show ip inspect config

Bession audit trail is disabled

Session alert is enabled

one-minute (sampling pericd) thresholds are [unlimited : unlimited]
connect ions

max-incomplete sessions thresholds are [unlimited : unlimited]
max-incomplets tcp connections per host is unlimited. Bleck-time 0 minute.
tcp synwalit—time is 30 sec — tep finwait-time 18 5 sec

top ddle—time is 3600 sec —— udp ldle-time is 30 sec

dns-timecut is 5 sec

Inspection Rule Configuration

Inspection names FW
tcp alert is on audit-trail is off timeocut 3600
udp alert is on audit-trail is off timecut 30
icmp alert is on audit-trail is off timecut 10

R1 configuration.

Rl (config) #ip inspect TCP synwait-time 20

Bl (cenfig) #ip inspect TCP finwait-time 8

Pl (config) #ip inspect TCF idle-time 300

Al (config) #ip inspect DHS-timecut &

Al (config) #ip inspect max-incomplete high 800

%Also resatting low threshold from [unlimited] te [800]

Bl (config) #ip inspect max-incomplete low 600
Fl (config) #ip inspect ocne-minute high &00
%Also resatting low threshold from [unlimited] to [800]

Bl (config) #ip inspect one-minute low 600
Fl (config) #ip inspect TCP max-incomplete host 80 bleck-time &
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Verification

Bl #show ip inspect config

Session audit trail is disabled

Session alert is enabled

one-minute (sampling periecd) thresholds are [600 : 800) connecticns
ma¥-incomplete sessions thresholds are [600 : 800]

max-incomplete top connections per host is 80. Block-time & minutes.

tecp synwait-time is 20 sec -- tcp finwait-time is 8 sec

tep idle-time is 900 sec -- udp idle-time is 30 sec

tecp reassembly queus length 167 timecut 5 sec; memory-limit 1024 kile bytes
dna-timeout is & sec

Inspection Rule Configuration

Inepection nams OUT
top alert is on audit-trail is off timecut 500
udp alert is on audit-trail is off timeout 30
iemp alert is on audit-trail is off timecut 10

Task 3

Enable audit trail logging and real-time alerts to provide a record of network access
through R1, this should include illegitimate access attempts. These should be logged
to the SYSLOG server located at 10.1.1.100

Configuration
Complete these steps:
Step 1 R1 configuration.

Rl {cenfigilip inspect audit-trail
Fl (cenfig)#ne ip inspect alert-off

Rl (cenfig) #legging on
Fl (config) #logging 10.1.1.100

Task 4
Erase the startup configuration and reload the routers before proceeding to the next
lab.
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LAB 3.31. Configuring CBAC & Java
Blocking

The topology and the IP addressing is based on the previous lab

10.1.14.0 124

Task 1
R1 should be configured to ONLY allow the following traffic through its F0/1 (Outside)
interface:

1. SMTP traffic that originates from the inside networks

2. ONLY Java applets from network 4.4.4.0/24 should be downloaded. Ensure
that audit trail logging and real-time alerts are enabled for this inspection.

3. Netmeeting traffic that originated from the inside networks

4. Routing traffic for RIPv2 and ICMP should function properly
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Remember the following:

L

N

The access-list for the Java applels must be slan dard

If the access-list does nof exisi, all Java appleis from all addresses will be blocked
CBAC does nof detect or block encapsulated Java applets such as applets in “.zip”
format.

CBAC DOES NOT detect or block applets loaded via FTP, Gopher or HTTP on a non-
standard portf

Configuration

Complete these steps:

Step 1

Task 2

R1 configuration.

Rl (config)#access-list 1 permit 4.4.4.0 0.0.0.288

Rl (config) #access-list 100 pearmit icmp any any
Rl {config)daccess-list 100 permit udp any any eg 520

Bl (config)#ip inspect name FW http java-list 1 alert on audit-trail
on

Rl {cenfig)#ip inspect name FW SMTF

Rl (config) #ip inspect name FW H323

Rl (config)#int FO /1
Rl (config-if ) #ip inspect FW out
Bl (config-if ) #ip access-group 100 in

Erase the startup configuration and reload the routers before proceeding to the next

lab.
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LAB 3.32. Configuring PAM

ﬂ-h‘ Outside
ANY Network

Fl.'lml.1

10.1.1.0 /24

Task 1

There are three web servers connected to the FO/0 interface of R1. Configure R1
such that it can inspect the traffic for these web servers using the ports identified in
the above diagram.

Confiquration

Complete these steps:
Step 1 Before this change, you should display the default port
mapping:

Rlé#sh ip port-map http

Dafault mapping: http tcp port 80 system defined

Step 2 R1 configuration.
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Fl (config) #ip port-map HTTF port 8000 list 1
Rl (config)#access-list 1 permit 10.1.1.3

Rl (config) #ip port-map HTIF port 8080 list 2

Fl (config) #access-list 2 permit 10.1.1.4

Verification

Flé#sh ip pert-map http

Default mapping: http tcp port B8O system defined
Host specific: http tep port 8000 4in list 1 usar defined
Host specific: http tcp port 8080 in list 2 user defined
Task 2
Erase the startup configuration and reload the routers before proceeding to the next

lab.
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LAB 3.33. Zone Based Policy Firewall

(ZFW)
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Lab Setup

» Configure the rack according to the diagram
» Use the IP addressing chart below for IP addressing scheme
» Run RIPv2 on the routers and advertise their directly connected networks.

IP addressing

Router Interface IP addressing

R1 F0/0 10.1.12.1/24

R2 G0/0 10.1.12.2/24
Gon 10.1.25.2/24
S50/1/0.24 131.1.1.2/24

R4 S0/0/0.42 131.1.1.4/24

R5 F0/0 10.1.25.5/24
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A previous version of 105 firewall was called Class-based Access Control
{CBAC in short) and was offered interface-based firewall service only. What
does it mean “interface-based”?

It means that traffic entering or leaving a particular interface i's inspected for
service conformance; if traffic matches requirements, the return traffic is
allowed back through the firewall.

The CBAC inspection was sufficient for a small network with edge router with
only two interfaces. However, multiple inspection policies and ACLs on several
interfaces in a router make it difficult to correlate the policies that will be
applied to traffic between multiple interfaces. As CBAC relies too heavily on
ACLs itis notvery flexible and has limited inspection granularity.

In addition to that, all traffic through a given interface was subjected to the
same inspection. This was enough to start thinking about a new I0S firewall
solution which gives more flexibility and can meet today's users expectations.
A Zone-Based Policy Firewall has been developed which uses completely
different firewall configuration model. Instead relying on interfaces and ACLs it
brings a term of ZONE. What is a zone? A zone defines a boundary where traffic
is subjected to policy restrictions.,

To make migration off of CBAC easier, we can configure ZFW and CBAC

concurrently on the same router but not on the same interface.

ZFW configuration

First of all we need to configure zones. This is accomplished in router's global
config mode by using command of “zone security <zone name>".

After creating the Zones, we need to configure something called a zone-pair,
which is a pair of two zones where one zone is a source and second zone is a
destination. Be careful because order of zones in the zone-pair is important
and will dictate router the packet flow direction which will be subjected to
inspection.

For example, if we want to inspect traffic from the Inside to the Qutside the
Inside must be source zone and the Outside must be a destination. However, for
traffic originated on the outside zone, the Outside-Zone must be a source zone.
Firewall policies are unidirectional and this must be considered at the
beginning of zones creation.

Next is a policy creation process described in more details below.

The last step is making router interfaces members of an appropriate zone. This
should be done as a very last step because if we could assign interface to the
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zone before creating policy — all traffic will be denied by default. So it is much
better to first create zones and policy and then assign the policy to the zone-
pair and assign interface to the zone. This will effectively enable ZFW on the
router.

ZFW basic rules
A pdlicy applied between zones is Unidirec tional. The ZFW is a stateful firewall

which means all returning traffic will be allowed automatically on the returning
interface. There is no need for ACL. However, if we want to allow traffic to flow
in opposite direction we will need a new zone-pair to be created and a new
policy attached to it.

The default policy for traffic between zones is DENY ALL. Once we create zones
and zone-pair, the traffic stops going thru the router. This is because there is no
policy attached to the zone-pair and NO POLICY equals DENY ALL. Only traffic
explicitly allowed can be passed thru the router.

Also, remember to attach zones to the appropriate interface at the very last
step. Do not assign interface to the zone before configuring policy as it will
effectively drop a legitimate traffic because traffic will never go between two
interfaces where one of them is not in the zone.

The same s true if two interfaces are in two different zone but there is no policy

attached to that zone-pair. The traffic is blocked in this case as well.

ZFW Puolicy
A Policy building process uses 3 simple steps which are based on Modwar QoS

CLI framework (MQC in short). Here, it is called C3PL which basically uses
“type inspect” components to build the policy. Nothing morell!

First step is to configure a “class-map"” to specify interesting traffic. This is not
regular class map but “inspection type” class map. We configure it using a
command of “class-map type inspect match-all {for match-any) plus the class-
name.,

Second step is to assoclate an action to the previously “classified” traffic. How
to do that? Exactly in the same way as it was in MQC - using policy map, again
“type inspect”.

And finally, third step is to apply policy map to the zone-pair. How to do that?
Again, nothing new - using ,, service-policy type inspect” command.

ZFW Class-maps
As you already know there are two different logical gualifiers available: match-

all fwhich is a default) and match-any:
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Match-all - introduces AND logie; traffic must match ALL filters; exit on first
NON-match;
Match-any — introduces OR logic; traffic must match at least one filter; exit on
first match
We can match traffic using three types of match statements:
=  match protocol <protocol-name> - it determines which service match the
class-map, and how the traffic will be inspected. This is so important
because if the policy-map applies the inspectaction; the traffic will be
expected to behave as the specified service if the traffic matches the
protocol filter in the class-map
= match access-group <number| name> - matches using an access-list.
*»  match class <class-map-name> - whic h nesting other class-map and

allows defining of more flexible matching criteria.

Let's take a closer look at match protocol filter. What does it do and how it
works? Basically speaking it matches the port/protocol in the packet headers
against the specified protocol:

» ForLayer 4 protocols - match protocol <tcp | udp | icmp=

* ForLayer¥ protocols - match protocol <http | smtp | telnet|...>
In case of L7 protocols, the ports associated with the protocol are dictated by
the existing Port-to-Application-Mapping {(PAM) database entry.
For example, ‘match protocol http' will match packets bound for port 8080 {in
addition to port 80) if the router has “ip port-map htip port 8080 configured.
There is no NBAR used for that matching!!!

ZFW Actions
We have matched our interesting traffic. Now it's time to perform some actions
on that traffic. And again, we have 3 options under policy-map type inspect:
= Inspect-which basically speaking opens a hole for returning traffic.
However it is stateful inspection, so that more information about packet
are used like for example sequence numbers, ports, messages,
methods, etc.
=  Drop - which is self-explanatory
* Pass- this action does not have any stateful capability, so that it won't
apen any dynamic heles for returning traffic. Is it useful, someone could
ask? Yes it is — for example in the policy for traffic destined or
criginated from the router.
If a stateful firewall is not enough for us we can still add additional control
using ACLs. However itis worth noticing that inbound ACL is applied before
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ZFW and outbound ACL is applied after ZFW. This needs to be considered
during ACL design. For example, what is a value in the outbound ACL blocking
FTP if ZFW policy does not allow that traffic?

L34 vs. LT

There are two types of class-map and policy-map L3/L4 and LT. L3/L4 matches
and applies actions to traffic up to Layer 4 level based on available information.
LT class/policy-maps are protocol specific; the options appearing under them
depend on the protocol and the capabilities of the existing application
inspection module. As the inspection engines of individual protocols are
enhanced, more options will be added by Cisco to the corresponding L7
class/policy-maps to provision the new functionality.

As of now, L7 policies can be configured for the following protocols: HTTP,
SMTP, POP3, IMAP, IM {AOL, ICQ, MSN, YAHOQ), P2P (eDonkey, FastTrack,
Gnutella, kazaa2), Voice traffic (SIP, H323), and Sun RPC.

The LT policy-map Is attached to the top-level (L3/L4) policy using the “service-
policy <protocol-name <policy-name>* command. The class in the top-level
policy for which an LT policy-map is configured MUST have a “match protocol”
filter. This protocol and the LT policy-map protocol must be the same. If only
‘match access-group’ filters are present in the class-map, L7 policy cannot be
configured for that class!

Two things must be remembered:

First: you can only apply L3/L4 policy map to the zone-pair, not L7. LT policy-
maps are applied under L3/L4 policy-maps only.

Second: L3/L4 class map must be configured with ,,match protocol” statement
in order to apply LT policy map to that traffic.

SELF Zone

There is also a special zone called SELF. This zone represents a router itself
and every interface is a member of that zone by default. The zone is useful
when we want to control traffic destined to the router or originated from the
router. Then we just put a SELF zone in a zone-pair as a source {if we want to
control traffic originated from the router) or as a destination (if we want to
control traffic destined to the router).

Unfortunately there are some caveats in this solution. Frst, we can only Iinspect
TCP, UDP, ICMP and H323 packets and second, we can't use ZFW policing
when SELF zone is involved.

ZFW DoS Protection
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The , parameter maps” are used to specify inspection behavior and prevent
Denial-of-Service attacks. They are also used to define matc hing criteria in the
class map in more flexible way — using regex. There are a couple of parameter
map types but only three of them are really useful in ZFW. The ,inspect” type
where we configure some anti-DOS stuff and logging, the , regex” type for
configuring regex expressions finally used in the class map and ,, urlfpolicy™
which is useful in URL Filtering.

Verification

After successful implementation we should check if everything is OK and our
configuration works the way we wanted. There are a couple of s how commands
avalilable.

Most powerful command for checking almost all things is: “show policy-map
type inspect zone-pair”. We can specify a zone-pair name to narrow the
command output. Anyway, this command displays the policy and counters for
our inspected traffic.

If we configured Deep packet inspection, a8 useful command would be ,,show
policy-map type inspect <protocol-name>" where LT policy for specified
protocol is displayed.

To see our zones and policies attached to the zone-pairs use: “show zone

security™ and ,,show zone-pair security” commands.

Configure R2 using the following policy:

» Permit all TCP, UDP and ICMP traffic that is initiated on the inside network to
access the DMZ and the outside network. Traffic that is not initiated from the
inside should be denied

» Ensure that ONLY ICMP and HTTP traffic that is initiated from the outside is
allowed to access the hosts on the DMZ.
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Configuration

Complete these steps:
Step 1 R2 configuration.

First let's cenfigure class-map fer traffic from the inside and feor

traffiac from the outside.

R2 (config)#class—map type inspect match-any cmInside
RZ (config=-cmap) #match protocol top
R2 (config—emap) #match protocel udp
R2 (config-cmap) #match protocol icmp

RZ (config-cmap) #class-map type inspect match-any cmiutside
R2 {config=cmap) #match protocel http
R2 (config=-cmap) ématch protocol iomp

RHaxt we need to configure policy-map for aach flow direction

RZ (config) #policy-map type inspect pmInsideZCutside

R2 {config-pmap) #class cmInside

RZ (config-pmap-c) #inspect

R2 {conf ig=-pmap-c) #policy-map type inspect pmInside2DME
R2 (config-pmap) #class cminside

R2 {config-pmap-c) #inspect

k2 (config-pmap—<) #pelicy-map type inspect pmOutsidelDMZ
R2 {config-pmap) #class cmoutaide

RZ (config-pmap—c) #inspect

Haxt we need to define security gsones, assign the zones to the

interfaces and sat the policy batweean eaach zone pair.

RZ (config)¥zone security inside
R2 {config-sec-zone) #zone security outsids
B2 (config-sec-zone) #zone security DMZ

R (config)#int g0/0

RZ (config=if}#zone-member security inside
R2 (config-if)é#int go/l

R2 (config-if)#zone-member security DME

RZ (config-if)é#int s0/1/0.24

R2 (config-if}#zone-member security cutside

RZ (config)#zone-pair security zIO source inside destination outside

R2 {config-sec-zone-pair)#service-policy type inspect pmInside2Cutside

RZ (config-sec-zone-pair)#zone-pair security zID scurce inside destination DMZ
R2 {config-sec-zone-pair)#service-policy type inspect pmInside2DME

R2 (config-sec-zone—pair)#zone-pair security z08 source outside destination
OME

R2 (config-sec-zone—palr) #service—policy type inspect pmOutside?DMI
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R2 {config=-sec-zone-pair)#exi

Verification

Lat's try to ping and telnet from R1 to R4 and RS.

Rldping 10.1.25.5

Type ascape seguence to abort.

Sending 5, 100-byte ICMP Echos to 10.1.25.5, timeout is 2 seconds:
1

Success rate is 100 percent (5/5), round-trip minfavg/max = 1/2/4 ms

Rliping 131.1.1.4

Type escape sSequence to abort.
Sending 5, 100-byte ICMP Echos to 131.1.1.4, timeout is £ seconds:

1
Success rate is 100 percent (5/5), round-trip minfavg/max = 1/3/4 ms

Blitsel 131.1.1.4
Trying 131.1.1.4 ... Open

User Rccess Verification

Password:
Rd»exi

[Connection to 131.1.1.4 closed by foreign host)

Rli#tel 10.1.25. 5
Trying 10.1.25.5 ... Open

User Rocess Verification

Password:
RSrexi

[Connection to 10.1.25.5% closed by foreign host)
R1#

BE2i#sh policy-map type inspect sone-pair gID

pelicy exists on zp zID
Zone-pair: zID
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Class-map: cmIinside (match-any)

Match: protocel top

1 packets, 24 bytes

30 second rate 0 bps
Match: protocel udp

0 packets, 0 bytes

30 second rate 0 bps
Match: protocol icmp

1 packets, 80 bytes

30 second rate 0 bps

Inspect

CCIE SECURTY vd Lab Workbook

Packet inspection statisticse [process switch: fast switch)

top packets: [0:41)
ilemp packets: [0:10)

Session creations since subsystem startup or last reset 2
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1]

Last session created 00:00:27
Last statistic reset never
Last sgession creation rate 1
HMaxever session creation rate 1
Last half-open session total O

Class-map: clasas-default (match-any)
Match: any
Drop
0 packets, 0 bytes

Succass! How let's try to ping and belnet from R4 to Rl

Rddping 10.1.12.1

Type escape sequence to abort.

Sanding 5, 100-byte ICMP Echeos te 10.1.12.1, timeout is 2 seconds:

Success rate is 0 percent (0/5)

Fd#ping 10.1.25.5

Type escape seguence to abort.

Sending 5, l00-byte ICHMF Echos to 10.1.25.5, timecut is 2 seconds:

Success rate is 100 percent (5/5), round-trip min/avg/max

Fd#tel 10.1.12.1

Teying 10.1.12.1 ...
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% Connecticn timed out; remote host not responding

Bd#tel 10.1.25.5
Trying 10.1.25.5 ...
% Connection timed out; remote host not responding

hs axpscted only ping batwesn Cutsids and DME works. Lat's try HTTP. To do that

you nesd to anable HTTP sarver on RS (and Rl for tast)

On R1 and RS

Bl (config) #ip http sarver
BS (config)#ip http server

Verification (cont’d

Bd#tel 10.1.12.1 80
Trying 10.1.12.1, 80 ...
% Connection timed out; remote host not responding

Rd#tal 10.1.35.5 8O

Trying 10.1.25.5, 80 ... Open

GET %

HTTP/1.1 400 Bad Reguest

Date: Fri, 03 Sep 2010 12:08:33 GMT

Sarver: clace-I0S
Accept-Ranges ! none

400 Bad Reguest

[Connection te 10.1.25.5 closed by foreign hest)

Cnly HTTF betwean Outside and DHME 15 allowed!

R2i¥sh zone-pair security

Zone-palr name zIO
Socurce-Zone inside Destination—Zone ocutside
gervice-policy pmInside2outside

Zone-pair name =zID
Source-gone inside Destination-Eone DME
sarvice-policy pmIinside2DMZ

Zone-palr name TOS
Spurce-Zone cutside Destination-Eone DME

service-policy pmiutside2DME

B2 #sh policy-map type inspect Zone-pair z0S

policy exiats on zp z0OS
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Zone-pair: zoS
Service-policy inspect : pmiutsidelDME

Class-map: cmOoutside (match-any)
Match: protocel http
1 packets, 24 bytes
30 second rate 0 bps
Match: protocel icmp
1 packets, 80 bytes
30 second rate 0 bps

Inspect
Packet inspection statistice [procese switch: fast switch]
tcp packets: [0:19]
ilcmp packets: [0:10])

Seasion creations since subsystem startup or last reset 2
Current session counts {(estab/half-open/terminating} [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1]
Last session created 00:03:29

Last statistic reset never

Last session creation rate 0

Maxever session creation rate 1

Last half-open session total O

Class-map: class-default (match-any)
Match: any
Drop
4 packets, %6 bytes

Task 2
Configure R2 based on the following policy:
= R2 should wait 3 seconds for all the TCP connections to be established, if any
of the connections are not established with 3 seconds, they should be
dropped.
» R2 should wait 10 seconds before it removes an entry from its state table
when either the source or the destination begins the tear down process of a
TCP session.
» R2 should begin deleting half-open sessions if they reach 800, R2 should stop

deleting these sessions once they fall below 500.
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=  The maximum number of half-sessions to a specific host should NOT exceed
50, if this policy is violated, the 10S should delete all half-opened sessions and
block all new connection requests for 5 minutes.

Configuration
Complete these steps:

Step 1 R2 configuration.

The parameters in ZFW are very similar to those configured using
CBAC. All parametars have besen described in more details in the CBAC
confiquration task.

The only difference is the way of configuratien. In EFW we use
“parameter-map type inspect® which is then applied as an argument to
the "inspedt” action under L3/L4 policy-map. This allows us to

confiqure different paramesters to sach sone-pair.

R2 {config) #parameter-map type inspect PRRAM

R2 (config-profile} #max-incomplete low 500

RZ (config=-profile}#max-incomplete high 800

R2 (config-profile)dtcep idle-time 10

R2 {config-profile) #tcp synwait-time 3

RZ (config-profile) #tcp max-incomplete host 50 block-time 5
R2 {config-profile) fexi

B2 (config)ipolicy-map type inspect pmOutaideZDME
R2 (config-pmap) #class type inspect cmOutside

RZ (config-pmap-c) #inspect PRRAM

A2 (config-pmap-c) #exi

RZ (config-pmap) #exi

R2 (config) #policy-map type inspect pmInsidelDMD
R2 (config-pmap) #class type inspect cmInside
R2 (config-pmap—<) #inspect FPRARAM

RZ (config-pmap-c) #exi
RZ (config-pmap) #exi

k2 (config) #policy-map type inspect pmInsidelCutside
R2 (config-pmap) #class type inspect cmInside

R2 {config-pmap-c) #inspect PARAM

R2Z (config-pmap-c) #exi

R2 (config-pmap) #exi
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Verification

B2 #sh policy-map type inspect zone-pair
Zone-pair: zIO

Service-policy inspect : pmInsidelCutside

Class-map: cmInside (match-any)

HMatch: protocel tcp
1 packets, 24 bytes
30 second rate 0 bps
Match: protocoel udp
0 packets, 0 bytes
30 second rate 0 bps
Match: protocel icmp
1 packets, 80 bytes
30 second rate 0 bps
Inspect
Packet inspection statistice [process switch: fast switch])
tcp packets: [0:41]
icmp packeta: [0:10)

Seasion creations since subsystem startup or last reset 2
Current session counts {estab/half-open/terminating)} [0:0:0)
Maxever session counts (estab/half-open/terminating) [1:1:1)

Last session created 00:18:41
Last statistic reset never
lLast session creation rate 0
Maxever session creation rate 2
Last half-open session total O

Class-map: class-default (match-any)
Match: any
Drop (default action)
114 packets, 0 bytes
Zone-palr: zID

Service-policy inspect : pmInsidelDMI

Class-map: cmInside (match-any)
Match: protocol top
1 packets, Z4 bytes
30 second rate 0 bps
Match: protocel udp
0 packets, 0 bytes
30 second rate 0 bps
Match: protocol icmp
1 packets, 80 bytes
30 second rate 0 bps
Inspect

Packet inspection statistics [process switch: fast switch)
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top packets: [0:42)
icmp packets: [2:7]

Session creations since subsystem startup or last reset 2
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1)
Last segsion created 00:18:32

Last statistic reset newver

Last session creation rate 0

Mazever session creation rate 1

Last half-open session total 0

Class-map: class—default [(match-any)
Match: any
Drop (default action)
114 packets, 0 bytes
Zone-pair: zoS

Sarvice-policy inspect : pmiutsidelDMZ

Class-map: cmOoutside {(match-any)
Match: pretocol http
1 packets, 24 bytes
30 second rate 0 bps
Match: protocol icmp
1 packets, 80 bytes
30 second rate 0 bps
Inspact
Packet inspection statistics [process switch: fast switch])
tocp packets: [0:18)
icmp packets: [0:10]

Session creations since subsystem startup or last reset 2
Current session counts (estab/half-open/terminating) [0:0:0)
Maxever session counts [estab/half-open/terminating) [1:1:1]
Last session created 00:14:01

Last statistic reset never

Last sgegsion creation rate 0

Maxever session creation rate 1

Last half-open session total O

Class—map: class—default [(match-any)
Match: any
Drop (default actien)
118 packets, 96 bytes
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Task 3

Configure R2 so that it will send TCP Reset packets to the inside hosts trying to
connect to the following addresses on the outside network:

* mail.google.com

* mail.yahoo.com
This event should be logged to the local buffer on R2.

Configuration

Complete these steps:

Step 1

R2 configuration.

In order to match !t!l.‘].l‘l.g! in the HTTF headar we nesd L7 class map
when we use regex matching for those strings. Then that L7 class map
migt be used under L7 policy map whers action of “"resat® and “log®

is configured.

RZ [config) §parameter-map type regex DeniedSites
RZ (config-profile}dpattern .*mail.google.com

R2 (config-profile)#pattern .*mail.yahoo.com

R2 (config-profile)#exi

RZ (config) #class—map type inspect cmL3Websites
RZ (config-cmap) imatch protocel http
R2 (config-cmap) #exi

RZ {config) #class-map type inspect http cmlTWebsites
RZ (config-cmap) imatch reg-resp header host regex DeniedsSites
R2 (config-cmap) $#exi

RZ (config)#policy-map type inspect http pmL7Websites
R2 (config-pmap) #class cmlTWebsites

R2 [config-pmap-c) #reset

R2 (config-pmap—c) #log

RZ (config-pmap-c) #exi
RZ (config-pmap) #exi

The L7 pelicy map must be nested under ocur L3/L4 peolicy map for
Inside to Cutside zone pair. However, we need to be careful here as
there is already class map under that policy matching TCF traffie.

Thus, our HITF packets will be treated as TCP traffic and not like

'
HTTF traffic. To configure it correctly we nesd to move ocur L7
policy at the beginning of the list 50 that it will be esnforoed

first.

R2 (config) #policy-map type inspect pmInsideiCutside
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Veri

R2 {config=-pmap) #no class type inspect cmInside

B2 {config-pmap) #class type inspect cmLiWebsites

R2 [config-pmap-c) #inspect

R2 (config-pmap-c) ¥aervice-policy http pmL7Websites

R2 {conf ig=-pmap-c) #exi

R2 {config-pmap) #class type inspect cmInside

R2 [config-pmap-c) #inspect PARAM
R2 {config-pmap-c) #exi
RZ {config-pmap) #exi

k2 {config) #logg buffered 7
B2 (config)#logg on

R2lish policy-map type inspect zone-pair =IO

Zone-palr: zIO

Sarvice-policy inaspect : pmInsidelCutside

Class-map: cml3Websites (match-all)
Match: pretecel http
Inspect

Packet inspection statistics [process switch: fast switch])

tep packets: [1:17]
http packets: [0:7]

Seasion creations since subsystem startup or last reset 1
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1)

Last session created 00:00:25

Last statistic reset never

Last session creation rate 1

Maxever session creation rate 1

Last half-open session total 0
Deep packet inspection

Policy: http pmLTWebsites

0 packets, 0 bytes

Ho HTTF packets have been matched so far.

Class-map: cmIinside (match-any)
Match: protocol top
0 packets, 0 bytes
30 second rate 0 bps
Match: protocel udp

Page 293 of 507



CCIE SECURTY vd Lab Workbook

B ozt rorean . B

Bl Edt Fomat Wes Hep

0 packets, 0 bytes
30 seccnd rate 0 bps

Match: protocel icmp

0 packets, 0 bytes
30 second rate O bpe

Inspect

Session creations since subsystem startup or last reset 0
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts [estab/half-open/terminating) [0:0:0]
Last session created never

Last statistic reset never

Last session creation rate 0

Maxever session creation rate 0

Last half-open session total O

Class-map: class-default (match-any)
Match: any
Drop (default action)

1064 packets, 0 bytes

Te verify put the ACS or PC in VLAN 12, change the IF address of this computer
te 10.1.12.200/24 and default geteway to 10.1.12.2. Then make a change in the
hosts file logated in o \windows\system3i2\drivers\ets and add the following

line:

[F copyright o) 18Bi-1%98 Microsoft carp. =]
I
¥ This 15 a sanple HOSTS e used by MICrosoft TORCSIP For Winoaws.

#

# This Tl concaine The mappings of TP ado-esses TO MOST pales, Each

‘;cerrtr'%r shauld be kegt on an individual 19ne, The IPF addrass shauld
pla

The 1P address and The hosc name should separated by at Jeast one
spaca.

additionally, <omserms dsuch as Thesed may be frsertad on fnclvidual
Tres or 'FDHIJI

For edanple:

FH TR ETrErET %%

ced in the first column followed by the corresponding hast name.

owing tha machine name denotaed by a '#° sywbol.

102, 54 .04 .97 rhino. scme, can # =ou-ce Tervar
38256510 X, adme, con # % Client host

.1 Tocalhoet
4q mail, google, con

4

Bun web browser and enter the following URL in the address bar:
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3 Cannok find server - Miorosolt Inbermet Explorer _.,IDJ_EI
e Edt Wew Favrkes Iods Heb -
@imk = 3 < (2] @ cn SSeach i Pavakes £ 0w L o
A raras I.HJ htep el goocls con ﬂ G Links &
=
i] The page cannot be displayed
The page you are kaking for is currently unavailzble, The web
=ite might be sxpenencing techricsl dificulbss, or Fou may need
to adjust your browser settings,
Flassa try tha follorng:
= Clicls thes E‘Rﬂfr:sh bukton, or try again laker,
» [f pou typed the page address in the Address bar, make
sura that it is spalled corracty,
# Tocheck your connection settings, cick the Tools meny,
and then dick Imbernet Optisns, On the Cannections
tab, click Settings. The cettinge chould mateh thasa
prowided by vouwr lopal area netwerk (LAN] administrazor or
[riernet sarvice orovidar (ISP, — I .ﬂ
] Dore: [ [ [ trierrat P

The web page shouldn't be reached.

R2#sh logg

Syslog logging: enabled (12 messages dropped, 2 messages rate-limited,
0 flushes, 0 overruns, xml disabled, filtering disabled)

Ho Rctive Message Discriminator.

Ho Inactive Message Discriminator.

conscle logging: disabled

Monitor legging: lewvel debugging, 0 messages logged, xml disabled,

filtering disabled

Buffer logging: lewvel debugging, 2 messages logged, xml disabled,

filtering disabled

Logging Exception size (4096 bytes)

Count and timestamp legging messages: disabled

Farsistent logging: disabled
Ko active filter modules.
ESM: 0 messages dropped

Trap loegging: level informational, 380%8 message lines logged
Log Buffer {40%& bytes):

*Sep 24 14:25:1%.488: ¥5Y¥Y5-5-CONFIG I: Configured from conscle by

{~ [Hh] [Dc] [88] [Tt] : . *mail.google. com) matched - resetting session

consola
*Sep 24 14:25:20.120: WAFFFW-4-HTTF_HDR_FIELD REGEX MATCHED: Header field
10.1.12.200:2928

131.1.1.4:80 on zone-pair zIO class cmLiWebsites appl-class cmlTWebsites
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A SYSLOO meassage has bean generated on R2

R2#sh policy-map type inspect zcne-pair =IO
Zone-palr: zIO

Sarvice-policy inaspect : pmInsidelCutside

Class-map: cmL3Websites (match-alll)
Match: protocel http

Inspect

Packet inspection statistics [process switch: fast switch])

tep packets: [3:23]
http packets: [0:%]

Seasion creations since subsystem startup or last reset 3

Current session counts (estab/half-open/terminating) [0:0:0]
Maxever sesslon counts (estab/half-open/terminating)

Last session created 00:00:11

Last statistic reset never

Last session creation rate 2

Maxever session creation rate 2

Last half-open session total 0
Deep packet inspection

Policy: http pmLiWebaites

B packets, 216 bytes

How, HTTP packets has beaan matched and poelicy anforosd

Class-map: cmIinside (match-any)
HMatch: protocel tcp
0 packets, 0 bytes
30 second rate 0 bps
Match: protocel udp
0 packets, 0 bytes
30 second rate 0 bps
HMatch: protocel icmp
0 packets, 0 bytes
30 second rate 0 bps
Inspect

Session creations since subsystem startup or last reset 0
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [0:0:0]

Last session created never
Last statistic reset never
Last session creation rate 0
Maxewver session creation rate 0
Last half-open session total 0

Class-map: class-default (match-any)
Match: any
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Drop (default actien)
1064 packets, 0 bytes

Task 4

Configure Zone-Based Policy Firewall on R2 so that there is only Telnet traffic
possible to the router from every network. Ensure that RIP updates are not affected
by this change.

Configuration
Complete these steps:

Step 1 R2 configuration.

Since there is RIP routing protocol enabled on B2 on every directly
connected netwerk enabling pelicy for traffiec destined te the router
may drop that traffic. Hence, we nesd to match and allow two types of
traffic: RIF nad TELNET. Since, there is no “match protocel rip®

command we can use an access list to do that.
R2Z (config)#access—-list 120 permit udp any any eq 520

k2 (config) #class—map type inspect match-any cmL3TelnetRIP
R2 {config-cmap) #match protocol telnet

k2 (config-cmap) #match access-group 120

RZ (config=-cmap) #exi

B2 (config) #policy-map type inspect pmToSelf
R2 {config-pmap) #class cmlL3TelnetRIP

R2 (config-pmap—<c) #pass

“pass® is enough heare as we do not expect to open a dynamic hole for
raturni g packets .

R2 (config-pmap-c) #exi
RZ (config-pmap) $exi

B2 {config) #zone-pair security zpInsidelSelf scurce inside destination self
B2 (config-sec—zone-pair)#service-policy type inspect pmToSelf
R2 {config-sec-zone-pair)#exi

R2 (config)¥zone-palr security zrpOutsidelsSelf source cutside deatination self
R2 (config-sec-zone—palr) #service—policy type inspect pmToSelf

RZ (config-sec-zone-pair) #exi

RZ (config) $exi
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R2 {config) #zone-pair security zpDMZ23elf source DME destination self

R2 [config-sec-zone-pair) #service-policy type inspect pmToSelf
R2 (config-sec-zone-pair) #exi
R2 {config) $exi

Verification

R2dping 10.1.12.1

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.12.1, timecut is 2 seconds:

Success rate is 0 percent (0/5)
R2i#tel 10.1.12.1
Trying 10.1.12.1 ...

% Connection timed out; remote host not responding

Redping 131.1.1.4

Type escape segquence to abort.
Sending 5, 100-byte ICHP Echos to 131.1.1.4, timecut is 2 seconds:

Success rate is 0 percent (0/5)

Hote that enabling SELF zone and configuring unidirectional zone pairs will
affect traffic originated from the R2.

B2 §sh ip route

Codes: € - connected, 5 - static, R - RIF, M - mocbile, B - BGF
D — EIGRP, EX — EIGRF external, © — OSFF, IA - OSFF inter area
Hl - OSPF HSSA external type 1, M2 - OSPF HSSA external type 2
El - QSPFF external type 1, E2 — OSFF external type 2
i - I8-1I8, su - IS-I2 pummary, L1 - IS-I2 lewvel-l, L2 - IS-I3 lavel-2
ia — I8-I8 inter area, * — candidate default, U - per-user static route
¢ = ODR, P = pericdic downloaded static route

Gateway of last resort is not set

5.0.0.0/32 is subnetted, 1 subnets

R 5.5.5.5 [120/1] wia 10.1.25.5, 00:00:03, GigabitEthernet(/1
10.0.0,0/24 is subnetted, 2 subnets

c 10.1.12.0 is directly connected, GigabitEthernetd/0

c 10.1.25.0 is directly connected, GigabitEthernet(/1
131.1.0.0/24 is subnetted, 1 subnets

c 131.1.1.0 is directly connected, Serial0d/1/0.24

Ssams that RIF is still working.
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R2¥#sh policy-map typs inspect zone-pair zplnside2Salf
Zone-palr: zpInsideZsslf

Service-policy inapect : pmToSelf

Clags-map: cmL3TelnetRIP (match-any)
Match: protocel telnet
0 packets, 0 bytes
30 second rate 0 bps
HMatch: access-group 120
0 packets, 0 bytes
30 second rate 0 bps
Fass

0 packets, 0 bytes

Class=-map: class=-default {(match-any)
Match: any
Drop (default action)
102 packets, 556 bytes

RZ#sh policy-map type inspect zone-pair spQutsidelself
Zone-palr: zpOutside2self

Service-policy inaspect : pmToSelf

Clags-map: cmL3TelnetRIP (match-any)
Match: protocel telnet
0 packets, 0 bytes
30 second rate 0 bps
HMatch: access—-group 120
0 packets, 0 bytes
30 second rate 0 bps
Fass

0 packets, 0 bytes

Class-map: class—default (match-any)
Match: any
Drop (default actiecn)
495 packets, 400 bytes

F2i#sh pelicy-map type inspect Zone-pair zpDMEZ2Self
Zone-pair: zpDMZ2Self

Service-policy inspect : pmToSelf

Class=map: cmL3iTelnetRIF (match-any)
Match: protocol telnet
0 packets, 0 bytes
30 second rate 0 bps
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Match: access=-group 120
0 packets, 0 bytes
30 second rate 0 bps
Fass

0 packets, O bytes

Clags-map: class-default (match-any)
Match: any
Drop (default actien)
30 packets, 0 bytes

Bl#tel 10.1.12.2
Trying 10.1.12.2 ... Open

User Accesa Verification

Fassword:
R2rexit

[Connection to 10.1.12.2 closad by foreign hest]

TELHET traffic destined to R2 works. ICHP doas HOT!

Rliping 10.1.12.2

Type escape seguence to abort.
Sending 5, 100=-byte ICMP Echeos toe 10.1.12.2, timeout is 2 seconds:

Success rate is 0 percent (0/5)

Rlish ip route

Codes: € - connected; 5 - static, R - RIF; M - mobile, B - BGF
D = EIGRP, EX - EIGRP external, O = OSPF, IR - OSPF inter area
Nl - OSEF H33A external type 1, M2 - CSPF M3SA external type 2
El - OSPF external type 1, E2 - OSFF external type 2
i=-I158-1I53, su - I3-I5 summary, L1 - IS-I3 lewvel-1, L2 - IS-I3 level-2
ia - IS-I5 inter area, * - candidate default, U - per-user static route
o = ODR, P = pericdic downloaded static route

Gateway of last resort is 10.1.12.2 to network 0.0.0.0

5.0.0.0/32 is subnetted, 1 subnets

R 5.5.5.5 [120/2] wia 10.1.12.2, 00:00:12, FastEthernet0/0
10.0.0.0/24 is subnetted, 2 subnets

¢ 10.1.12.0 is directly connected, FastEtherneto/d

R 10.1.25.0 [120/1] wia 10.1.12.2, 00:00:12, FastEthernet(/0
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131.1.0.0/24 is subnetted, 1 subnets
R 131.1.1.0 [120/1] wia 10.1.12.2, 00:00:12, FastEthernet0/0
g% 0.0.0.0/0 [1/0) via 10.1.12.2

There are some RIP prefixes in the routing table on Rl. To test if RIP still
works we can clear those prefixes and update the table again.

Flé#cle ip route #

Fl#sh ip route

Codes: € - connected; 5 - static, R - RIF; M - mobile, B - BGF
0 = EIGRF, EX - EIGRF external, O = OSPFF, IA - OSPFF inter area
H1 - OSPF NSSA external type 1, H2Z - OSPF HSSA external type 2
El - OSFF external type 1, EZ - OSFF external type 2
i = I8-1I5, su - I5-15 summary, Ll - I5-I5 level-l, LZ - I5-I5 level-2
ia - IS-IS inter area, * - candidate default, U - per-user static route
o = ODR, P = pericdic downloaded static route

Gateway of last resort is 10.1.12.2 to network 0.0.0.0

5.0.0.0/32 is subnetted, 1 subnets

R 5.5.5.5 [120/2] wia 10.1.12.2, 00:00:07, FastEthernet0/0
10.0.0.0/24 is subnetted, 2 subnets

c 10.1.12.0 is directly connected, FastEthernet0/0

R 10.1.25.0 [120/1] via 10.1.12.2, 00:00:07, FastEthernet0/o
131.1.0.0/24 is subnetted, 1 subnets

R 131.1.1.0 [120/1) wia 10.1.12.2, 00:00:07, FastEthernst0/0

8% 0.0.0.0/0 [1/0] wia 10.1.12.2

RL#

RIF works fine. Rl got all RIF prefixes from R2.

RZ#sh policy-map typs inspect zone-pair splinsidelSalf
Zone-pair: zpInsidelself

Service-policy inspect : pmToSelf

Class=map: cmL3TelnetRIP (match-any)
Match: protocel telnet
22 packets, 487 bytes
30 second rate 0 bps
Match: access-group 120
0 packets, 0 bytes
30 second rate 0 bps
Pass
22 packets, 487 bytes

Class=-map: class=-default {(match-any)
Match: any
Drop {default action)
107 packets, 956 bytes
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Why thare are 0 packets for RIP? Tjis is becausse R2 sends cut its routing tabla
information to Rl using UDP which is connection-less. This mesns Rl gets the

update. This counter would be incremented if Rl sends any RIF updates to R2

Task 5

Enable URL filtering function on R2 so that when HTTP request originated form the
inside network is going towards outside network the router first consults Websense
server at IP address of 10.1.12.200 on port 2030 before allowing that connection. Set
the maximum number of outstanding requests for Websense server that can exist at
any given time to 500.

Configuration
Complete these steps:

Step 1 R2 configuration.

There is the same URL FPiltering feature as it is for CBAC socenarios.
We can use axternal Websense URL filtering server to consult bafore
anabl ing the traffic go out

In EFW we use special type of parameter-map to do that

R2 (config) #parameter-map type urlfilter URL-Sarver

R2 (config-profile) #server vendor websense 10.1.12.200 port 2030
RZ (config-profile) #max-request 500

R2 {config-profile) fexi

R2 {config) #policy-map type inspect pmInside2cutside
R2 (config-pmap) #class type inspect cmlIWebsites

R2 (config-pmap-c) #urlfilter URL-Server

RZ (config-pmap-c) #exit

R2 (config-pmap) #exit

Veri n

R2i#sh parameter-map type urlfilter
parameter-map type urlfilter URL=-Server

server vendor websense 10.1.12,200 port 2030 retrans 2 timeout &
urlf-server-log off

audit-trail off

alert on
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max=-requeast 500

max-resp-pak 200
source-interface default
allow-mode off

truncate script-parameters off
truncate hostname off

cache 5000

R2#sh policy-map type inspect zcne-pair =IO

Zone-pair: zIO

Service-policy inspect : pmInside2Cutside

Class-map: cmlL3Websites (match-all)

HMatch: protocel http
Inapect

Packet inspection statistics [process switch: fast switch])

tep packets: [4:28)
http packets: [0:10])

Session creations since subsystem startup or last reset 4
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1)

Last session created 04:2
Last statistic reset newve

3:38
r

Last session creation rate 0

Maxever session creation

rate 2

Last half-open sessiocn total 0O

Deep packet inspection
Policy: http pmLTWebsites
11 packets, 300 bytes

Urifilter
Websense URL Filtering is

This is because there is no Websanse

Current regquests count: 0

DISABLED

Current packet buffer count(in use): 0

Current cache entry count

Maxever regquest count: 0

HI ]

Maxever packet buffer count: 0

Maxever cache antry count

Total requests sent to URL Filter Server :0

HI ]

sarvar anabled in the network

Total responses received from URL Filter Server :0

Total requests allowed: O
Total requests bleocked: O

Class-map: cmInside (match-any)
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R2§

Task 6

Class-map: class—default

Match: protocel tcp
0 packets, 0 bytes
30 second rate 0 bps
HMatch: protocol udp
0 packets, O bytes
30 second rate 0 bps
Match: protocoel icmp
0 packets, 0 bytes
30 second rate 0 bps
Inspect
Session creations since subsystem startup or last reset 0
Current session counts (estab/half-open/terminating) [0:0:0]
HMaxever session counts (estab/half-open/terminating) [0:0:0]
Last session created never
Last statistic reset never
Last session creation rate 0
Maxever session creation rate 0
Laat half-open session total O

(mat ch—any)
Match: any
Drop (default action)

1109 packeta, 0 bytes

Configure R2 so that all JAVA applets are blocked from |IP address of 10.1.25.5 for
clients accessing this router from the inside network. Other hosts in DMZ network
should not be affected.

Configuration
Complete these steps:

Step 1 R2 configuration.

Wa nead to match twe things:

(1} HTTF traffic destined to IF 10.1.25.58 on port 80

{2) HTTP traffic consisting of JAVA applets
Hota that first t-l'l.‘...l'l.q Fequires ::3,-":4“- informaticon and second t-l'l.‘...l'l.g
requires L7 information. Henos, we need to use two methods of matching.
R2 (config) #access—1list 130 permit top any host 10.1.25.5 eq BO

R2 (config) #class-map type inspect http match-all cmL7BleckJdava
R2 {config-cmap) #match response body java-applet
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R2 {config=cmap) #exi

R2 {(config)#class-map type inspect match-all cmlL3BlockJava
R2Z {config-cmap) #match protocel http

R2 (config-cmap) ématch access-group 130

B2 {config-cmap) #exi

R2 {config) #policy-map type inspect http pml7JavaPolicy
R2Z (config-pmap) #class type inspect http cmL7BlockJava
RZ {config-pmap-c) #reset

RZ (config-pmap-c) #log

R2 {conf ig=-pmap-c) #exit

R2 (config-pmap) #exi

Hare we have conflict as there is already enabled inspection for TCP
traffic. This would be enforoed instead of our HTTP JAVA
classification sc that we need te move ocur specific requirement at the

beginning of the list.

B2 (config) #policy-map type inspect pmInsidelDMZ
R2 {config-pmap) #no class type inspect cmInside

R2 (config-pmep) #clasa type inspect cmlL3BlockJava

B2 {[config-pmap-c) #inspect

R2 (config-pmap-c) ¥service-policy http pmL7JavaPolicy
R2 (config-pmap-<) $exi

R2 {config-pmap) #class type inspect cmInside

R2 (config-pmap-c} #inspect PRREAM
R2 {config-pmap-c) #exi
RZ (config-pmap) $exi

Verification

RZ#sh policy-map typs inspect zone-pair zID
Zone—pair: zID

Service-policy inspect : pmInsidelDMZ

Class-map: cmL3BlockJava (match—all)
Match: protocol http
HMatch: access—-group 130
Inspect
Session creations since subsystem startup or last reset 0
Current session counts (estab/half-open/terminating) [0:0:0]
HMaxever session counts (estab/half-open/terminating) [0:0:0]
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Last session created never

Last statistic reset never

Last sesslion creation rate 0

Maxever session creation rate 0

Last half-open session total O
Deep packet inspection

Policy: http pmL7JavaPolicy

0 packets, 0 bytes

He packets for JAVA blocking so far

Class=-map: cmIinside (match=-any)

Match: protocel tcp
0 packets, 0 bytes
30 second rate 0 bps

Match: protocol udp
0 packets, 0 bytes
30 second rate 0 bps

Match: protocol icmp
0 packets, 0 bytes
30 second rate 0 bps

Inspect
Session creations since subsystem startup of last reset 0
Current session counts [(estab/half-cpen/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [0:0:0]
Last session created never
Last statistic reset never
Last session creation rate 0
Maxever session creation rate 0
Last half-open session total 0

Class=-map: class=-default {(match-any)
HMatch: any
Drop (default action)
174 packets, 0 bytas

Lat's tast by connecting from ACS or PC located in VLAN 12 to the RS wia web
browser = the 3D should be loaded on this router
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£ - {101,255 - Microsollt Bternet Enplaver ‘]:IEI}

Cisco Router and Security Device Manager (SDM)

Cisea Bvgrems
COpATIghE S PIOD - 2008 CEoo Syekme, ne
Al rights reserved

Loading Cisch S0. Please wail ... &

=] e, bk with eriors on page. i et =l

The page is not loaded correctly as there are JAVA applets bloacked by our

poliay.

B2 f#sh policy-map type inspect Zone-pair zID
Zone—pair: zID

Service-policy inspect : pmInsidelDME

Class-map: cmL3iBleckJava {(match-all)
Match: protecel http
Match: access-group 130
Inspect
Packet inspection statistice [process switch: fast switch)
tep packets: [30:717)
http packets: [0:424)

Session creations since subsystem startup or last reset 30
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever gession counts ([estab/half-open/terminating) [2:2:1)
lLast session created 00:02:13
Last statistic reset never
Last session creation rate 0
Maxever session creation rate 30
Last half-open session total O
Deep packet inspection
Policy: http pmLiJavaPolicy
89 packets, 2492 bytes

Packet counter indicates that some JAVA has bean matched.

Class-map: cmInside (match-any)
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Match: protocel tcp
0 packets, 0 bytes
30 second rate O bps
Match: protocol udp
0 packets, O bytes
30 second rate 0 bps
Match: protocel icmp
0 packets, 0 bytes
30 second rate 0 bps
Inspect
Session creations since subsystem startup or last reset 0
Current session counts (estab/half-open/terminating) [0:0:0]
HMaxever session counts (estab/half-open/terminating) [0:0:0]
Last session created never
Last statistic reset never
Last session creation rate 0
Maxever session creation rate 0
Last half-open session total O

Class-map: class—default (match-any)
Match: any
Drop (default actiocn)
474 packets, 0 bytes
RZ#

RZ#sh ip route

Codes: C = connected, 5 = static, R = RIP, M - mobile, B = BGP
I - EIGRP, EX - EIGRP extarnal, O - OSFF, IA - OSFF inter area
Nl - CSPF N33R external type 1, H2 - OSPF HSSR external type 2
El - OSPF external type 1, EZ - OSPF external type 2
i - I8-18, su - I5-15 summary, Ll - I5-I5 level-l, LZ - I5-I5 level-2
ia = IS=I3 inter area, * = candidate default, U - per-user static route
¢ - ODR, P - pericdic downleaded static route

Gateway of last resort is not set

5.0.0.0/32 is subnetted, 1 subnets

R 5.5.5.5 [120/1] wia 10.1.25.5, 00:00:24, GigabitEthernet0/1
10.0.0.0/24 is subnetted, 2 subnets

c 10.1.12.0 is directly connected, GigabitEthernet/0

c 10.1.25.0 is directly connected, GigabitEthernet0/1
131.1.0.0/24 is subnetted, 1 subnets

c 131.1.1.0 is directly connected, Serial0d/1/0.24

There is alss 5.5.5.5 address known in the network =0 that you ocan check and
connect to that address via web browser. Since this address is not in the ACL

for Java blodking it should be allowed.
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S is acomssible wvia 5.5.5.5 address. JAVA is not blooked for this address.

Task 7
You have been requested to configure ZFW on R2 so that it does not allow more
than 1Mbps traffic destined to DMZ from the outside networks. You may use burst of

100KB.

ration
Complete these steps:
Step 1 R2 configuration.

B2 (conf ig) #policy-map type inspect pmOutsidealDE
R2 (coenfig-pmap) # class type inspect cmiutside

B2 (conf ig-pmap-a) §police rate 1000000 burst 100000
R2 (conf ig-pmap—c) #exi

B2 (conf ig-pmap) bexi

Verification

B2 f§sh polioy-map type inspect Zone-pair =08
Zone-pair: zoS
Folice
rate 1000000 bps, 100000 limit
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conformed 0 packets, 0 bytes; actions: transmit
excesded 0 packets, 0 bytes; actions: drop
conformed 0 bps, excead 0 bps

Rate limiting is enabled and no packets have been limited so far.

Service-policy inaspect : pmiutsidelDME

Class-map: cmOutside [(match-any)
Match: protocel http
1 packets, 24 bytes
30 second rate 0 bps
Match: protocel icmp
1 packets, 80 bytes
30 second rate 0 bps
Inspect
Packet inspection statistics [process switch: fast switch])
tep packets: [0:18)
icmp packets: [0:10])

Session creations since subsystem startup or last reset 2
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1)
Last session created 16:50:08

Last statistic reset never

Last session creation rate 0

Maxever session creation rate 1

Last half-open sessiocn total 0O

Class-map: class-default {(match-any)
Match: any
Drop (default actien)
587 packets, 96 bytes

Let's ping RS from the ocutside network with no timeout configured so that the
packet rate should ba high

Rddping 10.1.25.5 size 1000 rep 100 timecut 0

Type escape segquence to abort.
Sending 100, 1000-byte ICMF Echos to 10.1.25.5, timeocut is 0 seconds:

Success rate is 0 percent (0/100)
Ra#

B2 f#sh policy-map type inspect Zone-pair z0S
Zone-pair: =z0S
Police
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rate 1000000 bps, 100000 limit

conformed 136 packets, 137194 bytes; actions: transmit
exceaded 13 packets, 13112 bytes:; actions: drop
conformed 0 bps, excesd 0 bps

There are some packets matched.

In a real world we often hawve Qof policies applied on the interface. The
difference between interface service policy and inter-zone security policy is
in the traffic aggregation: the interface service policy works on traffic
classes entering or leaving a single interface and the inter-zone pelicy works
on aggregate traffic betwean zones, including the return traffic if you'wve used
the inspect command te cenfigure stateful inspection of the traffic elass.

service-policy inspect : pmoutsidelDMEZ

Class-map: cmoutside (match-any)
Match: protocel http
1 packets, 24 bytes
30 second rate 0 bps
Match: protecel icmp
2 packets, 1060 bytes
30 second rate 0 bps
Inspect
Facket inspection statistics [process switch: fast switch]
tcp packets: [0:18]
icmp packets: [0:146]

Session creations since subsystem startup or last reset 3
Current session counts (estab/half-open/terminating) [0:0:0]
Maxever session counts (estab/half-open/terminating) [1:1:1)
Last session created 00:00:23

Last statistic reset never

Last session creation rate 1

Maxever session creation rate 1

Last half-open session total 0

Class-map: class-default (match-any)
Match: any
Drop (default action)
587 packets, 5%& bytes
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LAB 3.34. Implementing security RFCs

| Internal Network |

10.1.12.0/24

GO 2

T

4 | FOD Leb  122.1.24.0124

P

| Outside Network |

Lab Setup
» Configure the routers with the following IP addressing:
Router Interface IP address
R1 FO/0 10.1.12.1/24
R2 G0/ 10.1.12.2/24
GOAM 122.1.24.2124
R4 Fo/0 122.1.24.4/24
LoD 44.4.4/24

» Configure static default routing on R1 and R4 pointing to R2 and R2 pointing to

R4

Task 1

Protect Internal Network by implementing access list blocking RFC 1918 and RFC
3330 IP addresses coming from the outside network. There is a requirement that in

the near future your Internet Service Provider will deploy new outside connection
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using BGP as a routing protocol (BGP peer will be at R4's FO/0 IP address). Ensure
this requirement is addressed in your solution.
Use RFC 2827 as a guideline for configuring access list.

There are three RFCs useful when you want to configure anti-spoofing access

list:

RFC 1918 — defines IPv4 reserved address space that is not a valid source

address on the Internet - this traffic should never be seen as source at your

Internet edge.

RFC 3330 - defines IPv4 special use addresses that might require filtering like:

0.0.0.0/0 — “this"” network
127.0.0.0/8 - Loopback
169.254.0.0/16 - Link Local
192.0.2.0/24 - Test-Net
224.0.0.0/4 - Multicast

RFC 2827 - provides ingress fitering guidelines.

Configuration

Complete these steps:
Step 1 R2 configuration.

Bleck FFC 1918 addresses:

R2 {config) #access=-list 110 deny ip 10.0.0.0 0.255.255.255 any
RZ [config) $access-1list 110 deny ip 172.16.0.0 0.15.255.255 any
R2 {config) #access-1ist 110 deny ip 1%2.168.0.0 0.0.255.255 any

Block BFC 3330 addressas:

RZ (config) baccess-1list 110 deny ip host 0.0.0.0 any

B2 (config) #access-list 110 deny ip 127.0.0.0 0.255.255.255 any
R2 (config) #access-list 110 deny ip 163.254.0.0 0.0.255.255 any
R2 (config) #access=list 110 deny ip 192.0.2.0 0.0.0.255 any

RZ (config) #access-list 110 deny ip 224.0.0.0 31.255.255.255 any

Allow BGF connections from ISF peer in the future:

B2 (config) #access-list 110 permit tcp hest 122.1.24.4 host 122.1.24.2 eqg bgp
R2 {config) daccess-list 110 permit tep host 122.1.24.4 aq bgp host 122.1.24.2

Block your public IF address ascheme Az A source (only BGP connedation
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Verification

is allewed) - this is per BFFC 2827 guidelines which state you should
filter out your internal IF address bleck at the network edge. As
internal netwerk is 10.1.12.0/24 it is already blocked by RFC 1918
filters, but your external IF address scheme should alsc be filtered

RZ (config) #access=list 110 deny ip 122.1.24.0 0.0.0.255 any

Parmit all other IF traffic.

B2 {config) $access-list 110 permit ip any any

This newly constructed ACL mast be applied inbound on all ingress

interfaces.

R2 (configl#int g/l
R2 {config=-if)#ip access-group 110 in

B4 10.1.12.1

Type escape seguence to abort,
Sending 5, 100-byte ICMF Echos to 10.1.12.1, timeout is 2 seconds:

u.u.u

Success rate is 0 percent (0/5)

The ping is unsuccessful as it is blocked by ACL (sourced from 122.1.24.0/24

natwork) .

R2#sh access-list

Extended IP access list 110

10
20
30
40
50
&0
To
a0
0

deny ip 10.0.0.0 0,255.255.255 any
deny ip 172.16.0.0 0.15.255.255 any

deny ip 192.168.0.0 0.0.255.255% any

deny ip host 0.0.0.0 any

deny ip 127.0.0.0 0.255.255.255 any

deny ip 169.254.0.0 0.0.255.255 any

deny ip 192.0.2.0 0.0.0.255 any

deny ip 224.0.0.0 31.2535.2535.255 any

permit tep host 122.1.24.4 host 122.1.24.2 eg bgp

100 permit tcp host 122.1.24.4 eg bgp host 122.1.24.2
110 deny ip 122.1.24.0 0.0.0.255 any (5 matches)
120 permit ip any any

Howavar , chanhging sourcs result ifh sUucoass .
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Ridp 10.1.12.1 so led

Type escape seguence to abort.

Sending 5, l00-byte ICHMF Echos to 10.1.12.1, timecut is 2 seconds:
Packet sent with & source address of 4.4.4.4

Success rate is 100 percent (5/5), round-trip minfavg/max = 4/41/80 ms

Fotential pit fails:

- blecking Multicast you will block ocut dynamic routing protecols
o ICHP will ba filtersed cut even for ping destined to the host en the ocutside

network becaise ICMP echo-reply will be blocked

Sarvices accessible from the ocutside network will be blocked as whole

“axternal® subnet is il tered

Task 2

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.35. Using MQC as a filtering tool

10.1.12.0 124

I:H
Rl
A |F it

4 || gip  Le? Led  fpp

| 5 S
o 10.1.45.0 /24 e 0.5
e =
R4 RS

Lab Setup
» R1 and R2's GO/0 interface should be configured in VLAN 12

» R2and R5's 50/1/0 interface should be configured in a frame-relay point-to-
point manner.

» R5 and R4's FO/0 interface should be configured in VLAN 45

» Configure telnet on all routers using password “cisco”

> Run RIPv2 on the routers and advertise their directly connected networks

IP Addressing

Router Interface IP address

R1 Lo0 1.1.1.1/24
FO/0 10.1.12.1/24

R2 Lo0 222224
G0/0 10.1.12.2/24
S0/1/0.25 10.1.25.2/24

R4 Lo0 4.44.4/24
FO/0 10.1.45.4/24

R5 Lo0 5.5.5.5/24
FO/0 10.1.45.5/24
S0/M1/0.52 10.1.25.5/24
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Task 1
Configure R1 to perform classification and marking. This router should mark all
egress telnet traffic with IP precedence of 1.

Configuration
Complete these steps:
Step 1 R1 configuration.

Bl {config) laccess-list 100 permit top any any &3 23

Bl (config) #fclass-map TELHET
Bl (conf ig—cmap) fmatch acocess-group 100

Bl (conf ig) #policy -map TST
Fl {conf ig-pmap) #class TELHET

Bl (conf ig-pmap-c) #set ip precedence 1

Rl {conf ig-pmap-c) #int £0,/0
Bl (conf ig=-if) #service-policy ocutput TET

Verification

Rl#sh class-map TELHET

Class Map match-all TELHET (id 1}
Match access—group 100

Rlé#sh policy-map TST
Policy Map TST
Class TELHET
set ip precedence 1

Te generate telnet traffic

Bl #telnet 10.1.45.4
Trying 10.1.45.4 ... Open

User Access Verification
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Password:
Rd»exi

[Connection to 10.1.45.4 closed by foreign host)

To varify the marking of the traffio:

Fl#sh policy-map interface £0/0

FastEthernstl/0
Sarvice-policy output: TST

Class-map: TELMET (match-all)
23 packets, 1468 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: access=-group 100
Qos et
precedence 1
Fackets marked 23

Class-map: class—default (match-any)
15 packets, 1804 bytea
5 minute offered rate 0 bps, drop rate 0 bps
Match: any

Task 2
Configure R5 to block all IP Precedence 1 packets coming from S0/0/0.52 interface.
You must use MQC to accomplish this task.

Configuration
Complete these steps:

Step 1 R5 configuration.

RS (config) #class-map IF-Frec
RE (conf ig-cmap) dmatch ip precedence 1

RS {conf ig) #policy -map TEST
BS (conf ig-pmap) #class IP-Frec

RE (conf ig-pmap=c) #drop

RS (conf ig-pmap) #int 50/1/0.52
BS (conf ig-subif) # service-policy input TEST
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Verification

Fl#telnet 10.1.45.4
Trying 10.1.45.4 ...
% Connecticn timed out; remote host not responding

Hote the telnet sasssion failed.

BS5#sh policy-map interface =0/1/0.52

Serial0/1/0. 52

Service-policy input: TEST

Class-map: IP-Frec (match-all)
4 packets, 152 bytes
5 minute offered rate 0 bps, drep rate 0 bps
Match: ip precedence 1

drop

Class-map: class—default [(match-any)
2 packets, 192 bytes
5 minute ocffered rate O bps, drop rate 0 bps
Match: any

Task 3
Remove the configuration from the previous task (Task 2) and perform the same task
using correct DSCP value instead of IP Precedence 1.

Configuration

Complete these steps:
Step 1 R5 configuration.

BS (conf ig-pmap) #int 20,/1/0.52
RE (conf ig-subif) #no service-policy input TEST

RS {cenfig) #class-map DECF
RS (conf ig-cmap) ématch ip DESCP CB1

RE (conf ig) #policy -map PWM-DECP
BS (conf ig-pmap) #class DSCP

RS {conf ig-pmap-c) #drop

RS (conf ig-pmap) #int 20,/1/0.52
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EBS (conf ig-subif) # service-policy input PM-DECPF

Verification

Flé#telnet 10.1.45.4
Teying 10.1.45.4 ...

% Connection timed out; remote host not responding

BES#sh policy-map intarface 80/1/0.52

Serial 0/1/0.52

Service-policy input: PM-DSCP

Class-map: DSCP (match-all)
4 packets, 192 bytes
5 minute offered rate O bps, drop rate 0 bps
Match: ip dscp csl1 (8)
drep

Class—map: class—default [(match-any)
& packets, 576 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: any

Task 4
Configure R2 so that it will limit packet rate to 8000 bps for all ICMP packets leaving
serial interface. You must use MQC to accomplish this task.

Configuration
Complete these steps:

Step 1 R2 configuration.

B2 (config) bclass-map ICHWE
F2 (conf ig—cmap) fmatch protocel iomp

R (conf ig-cmap) #policy -map FM-ICHF

R2 (conf ig-pmap) #class ICMP

B2 {conf ig-pmap-a) #police 8000 1000 conform-action transmit axcesd-
action drop

B2 (conf ig-pmap-c-police) #int =20/1/0.25
B2 (conf ig=-subif) § servi ce-poliay output PM=-ICMP
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Verification

B2 #sh policy-map interface =0/1/0.25

Serial 0/1/0.25

Sarvice-policy output: PM-ICMP

Class-map: ICMP [(match-all)
0 packets, 0 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: protocel icmp
police:
cir 8000 bps, bc 1000 bytes, be 1500 bytes
conformed 0 packets, 0 bytes; actions:
transmit
axcesded 0 packets, 0 bytes; actions:
drop
vioclated 0 packets, 0 bytes; actions:
drop
conformed O bps, exceed 0 bps, viclate 0 bps

Class-map: class-default {match-any)
0 packets, 0 bytes
5 minute offered rate O bps, drop rate 0 bps
HMatch: any

R2dping 10.1.25.5 rep 20

Type escape segquence to abort.
Sending 20, 100-byte ICHMP Echos to 10.1.25.5, timeout is 2 seconds:
IR IR NN

Siuccess rate is 95 percent (19/20), round-trip min/avg/max = 1/24/100 ms

R2#sh policy-map intexrface s0/1/0.25

Seriald/1/0.25

Service-policy output: PM-ICMF

Class-map: ICMP (match-all)
20 packets, 2000 bytes
5 minute ocffered rate 1000 bps, drop rate 0 bps
Match: protecel icmp
police:
cir 8000 bps, bc 1000 Lytes, be 1500 bytes
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conformed 19 packets, 1576 bytes; actionas:
transmit

exceeded 1 packets, 104 bytes; actions:
drop

vioclated 0 packets, 0 bytes; actions:

drop
conformed 1000 bps, excead 0 bps, vielate 0 bps

Class-map: class—default [(match-any)
2 packets, 672 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: any
R2#

Task 5
Erase the startup config and reload the routers before proceeding to the next lab.

Page 322 of 507



CCIE SECURTY vd Lab Workbook

LAB 3.36. Blackhole routing using PBR

Based on the previous Lab's IP addressing, topology and Lab setup

10.1.12.0 124
.4 ||: oo Lad
— 10.1.45.0 /24

Task 1

R2 is seeing a lot of ICMP packets coming from frame-relay cloud. You have
discovered that those packets are 250-320 bytes in size. Configure policy routing at
R2 serial interface to block ICMP packets of size in range 250-320 destined to R1
and going through the router.

Configuration

Complete these steps:

Step 1

R2 configuration.

R2 (config) #faccess-list 120 pearmit icmp any any
B2 (config)#

B2 (conf ig) #route-map BLACKHOLE permit 10

R2 (conf ig=-route-map) # match ip address 120

B2 (conf ig-route-map) # match length 250 320

B2 (conf ig-roeute-map) # set interface HullD
#Warning:Use P2P interface for routemap sat

interface clause

R2 (conf ig-reute-map) #

B2 {conf ig-route-map) broute-map BLACKHOLE permit 20
R2 (conf ig-reute-map) #

R2 {conf ig-route-map) #int s0/1/0.25
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B2 (conf ig-subif)§# ip peolicy route-map BLACKHOLE

Verification

R2#sh route-map
route-map BLACKHOLE, permit, sequence 10
Match clauses:
ip address [access—lists): 120
length 250 320
Sat clausas:
interface Hulll
Policy routing matches: 0 packets, 0 bytes
route-map BLACKHOLE, permit, segquence 20
Match clauses:
Set clauses:
Policy routing matches: 0 packets, 0 bytes

RS#p 10.1.25.2

Type ascape segquence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.25.2, timeout is 2 seconds:

Success rate is 100 percent (5/5), round-trip minfavg/max = 4/25/84 ms
RS#p 10.1.12.1

Type ascape seguence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.12.1, timeout is & seconds:

1
Success rate is 100 percent (5/5), round-trip minfavg/max = 1/42/100 ms

RS5#p 10.1.12.1 size 300

Type ascape seguence to abort.
Sanding 5, 300-byte ICMP Eches to 10.1.12.1, timeout is 2 seconds:

Success rate is 0 percent (0/5)
RS #

RZ#sh routa-map
route-map BLACKHOLE, permit, segquence 10

Match clauses:
ip address (access-lists): 120
length 250 320

Set clauses:
interface Wulld
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Policy routing matches: 5 packets, 1520 bytes
route-map BLACKHOLE, permit, sequence 20

Match clauses:

Set clauses:

Policy routing matches: 5 packets, 520 bytes

Task 2
There is a Web server configured on R4’s loopback0. On R4 drop all traffic destined
to the Web server except the traffic coming from 1.1.1.1 using PBR.

Con ration
Complete these steps:
Step 1 R4 configuration.

Bd (conf ig) #ip http searver

Bd (conf ig) #acoess-1ist 110 dany top host 4.4.4.4 &g www host
1.1.1.1
Bd (config) #access-1ist 110 parmit top host 4.4.4.4 &g www any

Bd (conf ig) #route-map WWW_ACCESS parmit 10

Rd (conf ig-route-map) # match ip address 110

Bd (conf ig-route-map) § set interface Mulll

Warning:Use F2F interface for routemap set
interface clause

Rd (conf ig-route-map) #route-map WWW_ACCESS permit 20
Bd (sonf ig-route-map) #ip local policy route-map WRW_ACCESS

Verification

Flé#tel 4.4.4.4 80 /scurce-interface lol
Trying 4.4.4.4, 80 ...
% Connecticn timed out; remote host not responding

BElitel 4.4.4.4 80 /source-interface lel
Trying 4.4.4.4, 80 ... Cpen

GET /

HTTF/1.1 400 Bad Reguest

Date: Sun, 13 Sep 2009 Z22:44:58 GMT
Sarver: cisco-I0S

Cennection: close
Accept-Ranges: none
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400 Bad Reguest

[Connection to 4.4.4.4 closed by foreign host)

Blitel 4.4.4.4 80

Trying 4.4.4.4, 80 ...
% Connection timed out; remote host not responding

Fd#sh ip lecal pelicy
Local policy routing is enabled; using route map WWW_RCCESS
route-map WWW_RACCESS, permit, seguence 10
HMatch clauses:
ip address (access-lists): 110
Set clauses:
interface Hulld
Policy routing matches: 7 packets, 408 bytes
route-map WWW_ACCESS, permit, seguence 20
Match clauses:
Set clauses:
Policy routing matches: 35 packets, 24553 bytes

Task 3
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.37. Configuring NAT

Based on the previous Lab's IP addressing, topology and Lab setup

Led

10.1.12.0 124
Alran Lot 10.1.45.0 /24
R4

Task 1
Configure NAT so that R1's loopback is always translated to 10.1.25.1 when
connecting to R5 or R4,

Configuration
Complete these steps:
Step 1 R2 configuration.

B2 (config)#ip nat inside source static 1.1.1.1 10.1.25.1

B2 (config) #

WL INEFROTO-5 -UFDOWH: Line protocol on Interface WVIO, changed state
to up

B2 (config) #int g0 /0

R2 {config-if ) #ip nat inside

R2 (config-if ) #int =0/1/0.25

R2 (conf ig-subif) #ip nat outside
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Verification

Blitel 4.4.4.4 /o lod
Trying 4.4.4.4 ... Cpen

User Access Verification

Fassword:

Rd>»sh users

Line Usar Host (s) Idle Location
0 con O idle 00:00:26
® 2 wky 0O idle 00:z00:00 10.1.25.1
Interface User Hode Idle Pear RAddress
F2#sh ip nat translations
Fro Inside global Inside local Outside leocal cutside global
top 10.1.25.1:43346 1.1.1.1:433486 4.4.4.4:23 q.4.4.4:23
-—= 10.1.253.1 1.1.1.1 —— —
Rd#tel 10.1.25.1
Trying 10.1.25.1 ... Open
User Access Verification
Password:
Rl>sh users
Line User Hoat (=) Idle Location
0 con O idle 00:00:12
®= 2wty O idle 00:00:00 10.1.45.4
Interface User Mode Idle Peer Rddress
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Task 2

On R2 configure NAT so that R5 and R4 can use IP address of 10.1.25.11 to connect
to R1's f0/0 interface using TELNET port 2323 only.

Configuration
Complete these steps:

Step1 R2 configuration.

R2 (config)#ip nat inside source static top 10.1.12.1 23 10.1.25.11 2323

Verification
F2#sh ip nat translations
Fro Inside global Inside local Qutside local Cutside global
tecp 10.1.25.1:23 1.1.1.1:23 10.1.45.4:3%061 10.1.45.4:3%061
tep 10.1.25.1:43346 1.1.1.1:43346 4.4.4.4:23 4.4.4.4:23
-—= 10.1.25.1 1.1.1.1 - —

tcp 10.1.25.11:2323 10.1.12.1:23 ———

Rddtsl 10.1.235.11
Trying 10.1.25.11 ...
% Connection refused by remote host

Rddtel 10.1.25.11 2323
Trying 10.1.25.11, 2323 ... Open

User Access Verification

Fassword:
Rl>sh users
Line Usar Hoat (8)
0 con O idle
® 2 wbty O idle
Intarface User Moda

Idle Location
00:05:24
00:00:00 10.1.45.4

Idla Pear Address
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Task 3

Add the following new interfaces on R1:
- loopback11-11.11.11.1/24
- loopback111 —111.111.111.1/24

Configure R1 so that it translates both networks to the IP address range of

10.1.12.10-10.1.12.100.

Configuration

Complete these steps:

Step 1

Verification

R1 configuration.

Fl (config) #int loll

Fl (config-if )#ip add 11.11.11.1 255.255.255.0
Rl {cenfig-if ) #int lelll

Rl {config-if)#ip add 111.111.111.1 255.255.255.0

Bl (sonfig-if) faccess-1ist 1 parmit 11.11.11.0 0.0.0.255

Rl (conf ig-if ) #access-list 1 permit 111.111.111.0 0.0.0.288

Rl (config)#ip nat peool KWAT POOL 10.1.12.10 10.1.12.100 netmask
255,255 .255.0

Bl {config)#ip nat inside source list 1 pool HAT POOL

Rl (config)#int £0/0
Fl (conf ig-if ) #ip nat cutside

Fl#tel 4.4.4.4 /source-interface loll

Trying 4.4.4.4 ... Cpen

User Access Verification

Pasaword:
Rd>sh usars
Line

0 con O

= 2wty 0

Inter face
Bd>axit

User Host (s) Idle Location
idle 00:29:19
idle 00:00:00 10.1.12.10
Usar Hode Idle Pear Rddress
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[Connection to 4.4.4.4 cleosed by foreign host)

Bli#tel 4.4.4.4 /source-interface 1lolll

Trying 4.4.4.4 ...

User Acocess
Fassword:

R4»sh users
Line

0 con O

= 2wty 0

Inter face

Rdxexit

[Connection

Cpent
Verification
Usar Host (s5) Idle Location
idla 00:30:01
idle 00:00:00 10.1.12.11
User Hode Idle Fear Rddress

to 4.4.4.4 closed by foreign host]

Fl#sh ip nat translations

Fre Inside global

tep 10.1.12.
—- 10.1.12.
tep 10.1.12,
-—- 10.1.12.

Task 4

10:48787
10
11:63566
11

Inside local Cutside local
11.11.11.1:48787 d.4.4.4:23
11.11.11.1 _—
111.111.111.1:63566 4.4.4.4:23
111.111.111.1 -

Cutside global
q4.4.4.4:23

4.4.4.4:23

On R2 perform dynamic address translation for all IP addresses in subnet
10.1.12.0/24 to use |IP address of R2's s0/1/0.25 interface when going towards R5

and R4.

Configuration

Complete these steps:
Step 1 R2 configuration.

R2 (config) #access-list 1 permit 10.1.12.0 0.0.0,255
B2 (config) #ip nat inside socuree list 1 interface 20/1/0.25 overload
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Verification

Bl #telnet 5.5.5.5

Trying 5.5.5.5 ... Cpen

User Access Verification

Fassword:
RS5>»sh users

Line Usar Host (s) Idle Location
0 con O idle 00:00:07
& 2wty O idle O0:00:00 10.1.25.2
Interface User Hode Idle Pear RAddress

F2#sh ip nat translations

Fro Inside global Inside local Outside leocal cutside global

=== 10.1.25.1 1.1.1.1 - ———

tep 10.1.25.11:2323 10.1.12.1:23 10.1.45.4:63341 10.1.45.4:63341

top 10.1.25,11:2323 10.1.12.1:23 -— —-—-

tep 10.1.25.2:54334 10.1.12.1:54334 5.5.5.5:23 5.5.5.5:23
Task 5

Configure network address translation on R2 so that it limits NAT translations to 2 for
host 1.1.1.1 Set timeout for dynamic translations of TCP and ICMP to 10 and 5
respectively.

Configuration
Complete these steps:
Step 1 R2 configuration.
B2 (config) #ip nat translation max-sentries hest 1.1.1.1 2

B2 (config) #ip nat translation tcp-timecut 10
B2 (config)#ip nat translation icmp-timecut 5
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Verification

B2#sh ip nat statistios
Total active translations: 4 (2 static, 2 dynamic; 3 extended)
Peak translations: 4, occurred 00:06:42 ago
Cutside interfaces:

Barialldf1l/0.25
Inside interfaces:

GigabitEthernet0 /0
Hits: 232 Misses: 0
CEF Translated packets: 232, CEF Punted packets: 0
Expired translations: 2
Dynamic mappings:

== Inside Source
[Id: 1] access-list 1 interface Serial(0/1/0.25 refcount 1

Appl doors: 0
KHormal doors: O

nat-limit statistics:
host 1.1.1.1: max allowed 2, used 0, missed 0
Cueued Packets: 0

B2 f§clear ip nat translation +

Fl#tel 10.1.45.4 /so lod
Trying 10.1.45.4 ... Open

User Access Verification

Pagsword:
Rd>
Rd»exi

Blitel 4.4.4.4 /0 lod
Trying 4.4.4.4 ... Cpen

User Access Verification

Password:
Rd»exi

Blftel 5.5.5.5 /so lod
Trying 5.5.5.5 ...
% Connection timed out; remote host not responding

R1#
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FZ#sh ip nat statistics
Total active translations: 4 (2 static, 2 dynamics 3 extended)
Peak translations: 4, occurred 00:10:36 ago
Cutside interfaces:
Serialld/Ll/0.25%
Inside interfaces:
GigabitEthe rnet /0
Hits: 348 Misses: 0
CEF Translated packets: 348, CEF Punted packets: 3
Expired translatieons: 2
Dynamic mappings:
== Inside Scurce
[Id: 1] access-list 1 interface Seriald/1/0.25 refeount 0
Appl doors: 0
Hormal doors: O
nat-limit statistics:
host 1.1.1.1: max allowed 2, used 2, missed &
fueued Packets: 0

FZ#sh ip nat translations ver

Fre Inside global Inside local Cutside local cutside global
tep 10.1.25.1:24784 1.1.1.1:24784 d.4.4.4:23 q.4.4.4:23
create 00:00:50, use 00:00:47 timecut:10000, left O00:00:12,
flags:
extended, timing-out, limited, use_count: 0, entry-id: 10, lc entries: 0
top 10.1.25.1:37445 1.1.1.1:37445 10.1.45.4:23 10.1.45.4:23
create 00:01:03, use 00:00:52 timeout:10000, laft 00:00:07,
flags:
extended, timing-out, limited, use count: 0, entry-id: %, lc_entries: 0
=== 10.1.25.1 1.1.1.1 -— —
create 00:13:23, use 00:00:13 timeocut:0,
flags:

static, use count: 2, entry-id: 1, lc_entries: 0

tep 10.1.25.11:2323 10.1.12.1:23 _— —_—
create 00:10:52, use 00:01:22 timeout:0,
flags:

static, extended, extendable, use count: 0, entry=id: 4, lec entries: 0

Task 5

Configure NAT on R5 so that when R4 connects to 10.1.25.1 (R1's loopback0
translated interface) using its loopback0 IP address it will be translated to 10.1.25.4.
However if R4 uses its fO/0 interface as a source and connects to 10.1.25.11:2323

(R1’s fO/0 translated interface), it will be translated to 10.1.25.44.
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Configuration

Complete these steps:

Step 1

Verification

R5 configuration.

RS (config) #ip access-list extended Rd_leO-te-Rl_lo0

RS (conf ig-ext-nacl) fpermit ip host 4.4.4.4 host 10.1.25.1

RS (config-ext-nacl) #ip access-list extendad Rd_fal-to-Rl_fald

RS (config-ext-nacl) #permit top host 10.1.45.4 hest 10.1.25.11 eg 2323
RS (conf ig-ext-nacl) #exi

RS (conf ig) #route-map R4_lo0=-to-R1_lo0

RS (conf ig-route-map) fmatch ip address Rd_loO-to-Rl_lo0

RS (conf ig-route-map) #route-map R4_fad-to-R1_fal

RS (conf ig-route-map) #match ip address Rd fa0-to-R1l fal

BS (conf ig-route-map) fexi

RS (config) #ip nat inside scurce static 4.4.4.4 10.1.25.4 route-map Rd_lo0-
to-R1_1o0

RS (config) #ip nat inside source static 10.1.45.4 10.1.25.44 route-map
Rd_fa0-to-Rl_fal

RS (config) #int £0/0

RS {config-if) #ip nat inside

RE (config-if)#int =0/1/0.52

RS (conf ig-subif) #ip nat cutaida

BS¥sh ip nat translations

Fro Inside glebal Ingide local Cutside local cutside global
—= 10.1.25.4 4.4.4.4 _— —_—
=== 10.1.25. 44 10.1.45.4 =-—— ——

FS#sh ip nat translations wve

Fre Inside global Inside local Cutside local cutside global
—=10.1.25.4 4.4.4.4 - —_—
create 00:00:34, use 00:00:34 timecut:0, Map-Id(In}: 0,
flags:
static, route-map-static, use count: 0, entry-id: 1, lc_entries: 0
—= 10,1.25.44 10.1.45.4 - _—
create 00:00:34, use 00:00:34 timeout:0, Map=-Id(Imn)}: 0O,
flags:
static, route-map-static, use count: 0, entry-id: 2, 1lc_entries: 0

RS5ish route-map
route-map R4_lo0-to-R1l_lol, permit, sequence 10

Match clauses:
ip address {access-lists)}: R4_leO-to-R1_1lol
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Set clauses:

Policy routing matches: 0 packets, 0 bytes
route-map R4 fal-to-Rl_fal, permit, seguence 10

Match clauses:

ip address (access-lists}: Rd_fal-to-R1l_fal

Set clauses:

Policy routing matches: 0 packets, 0 bytes

Rédtel 10.1.25.1 /so led
Trying 10.1.25.1 ... Open

User Access Verification

Fassword:

Rl»sh users

Line Usar Host (8)
0 con O idle
® 2 wky 0O idle
Interface User Hode

BS5#sh ip nat translations
Fro Inside global Inside local

top 10.1.25. 4:60841 4.4.4.4:60841
=== 10.1.25.4 4.4.4.4
=== 10.1.25.44 10.1.45.4

Bd#tel 10.1.25.11 2323

Trying 10.1.25.11, 2323 ... Open
User Access Verification
Fassword:
Rl>
Rl
Rl>sh users
Line Usar Hoat (8)
0 con O idle
® 2wty O idle
Interface Usar Mode

BS#sh ip nat translations

Fre Inside global Inside local
toep 10.1.25. 4:60841 4.4.4.4:680841
tep 10.1.25. 44:63024 10.1.45.4: 63024
=== 10.1.25.4 4.4.4.4

=== 10.1.25. 44 10.1.45.4

Idla
00:36: 40

Locatieon

00:00:00 10.1.25.4

Idle

Cutside local
10.1.25.1:23

Idle
00:51:17

Pear RAddress

Cutside global
10.1.25.1:23

Location

00:00:00 10.1.25.44

Idla

Cutside local
10.1.25.1:23

10.1.25.11: 2323

Pear Address

Cutside global
10.1.25.1:23
10.1.25.11:2323
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LAB 3.38.

NAT with overlapping networks

Loo

Lo®

SITE-A
10.1.1.0 124

SITE-B
10.1.1.0 124

» R1 and R2's GO/0 interface should be configured in VLAN 12
» R2and R5's 50/1/0 interface should be configured in a frame-relay point-to-

point manner.

» R5 and R4's FO/0 interface should be configured in VLAN 45
» Configure telnet on all routers using password “cisco”

IP Addressin

Router Interface IP address

R1 Lo0 1.1.1.1/24
Fo/o 10.1.1.1/24

R2 Lo0 2222124
G0/0 10.1.1.2/24
S0/1/0.25 10.1.25.2/24

R4 Lo0 444424
FO/0 10.1.1.1/24

R5 Lo0 5.5.5.5/24
Fo/0 10.1.1.5/24
S0/1/0.52 10.1.25.5/24
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Task 1

R1 and R4 have the same IP address of 10.1.1.1/24. Configure R2 so that those
routers can communicate using static translated addresses of 10.1.25.65 and
10.1.25.129 respectively.

You can configure static default routes on R1 and R4 to establish full connectivity.

Configuration
Complete these steps:

Step 1 R1 configuration.

Bl (config) #ip route 0.0.0.0 0.0.0.0 10.1.1.2

Step 2 R4 configuration.

Bd (config)#ip route 0.0.0.0 0.0.0.0 10.1.1.5

Step 3 R2 configuration.

R2 (config) #ip nat inside source static 10.1.1.1 10.1.25.85
B2 (config) #ip nat ocutside scurce statiec 10.1.1.1 10.1.25.128

R2 {config)#int go/o

R2 (config-if ) #ip nat inside

B2 (config-if ) #int =0,/1/0.25

B2 (conf ig-subif) #ip nat cutsids

Verification

BEZfsh ip nat tra

Fro Inside glebal Ingide local Cutside local cutside global
—_—— - - 10.1.25.129 10.1.1.1

=== 10.1.25.65 10.1.1.1 =-—— ——

Fli#tel 10.1.25.128
Trying 10.1.25.129 ... Cpen

User Access Verification

Pasgsword:

B2 fdeb ip nat detailed
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IF HAT detailed debugging is omn

R2#

Apr 5 13:57:53.767: MAT: i: tep (10.1.1.1, 52217} -»> (10.1.25.12%, 23) [34538)
Apr 5 13:57:53.767: MAT: s=10.1.1.1->10.1.25.65, d=10.1.25.129 [34536]

Apr 5 13:57:53.767: BAT: 8=10.1.25.65, d=10.1.25.129->10.1.1.1 [345338)

Apr 5 13:57:53.77%: HAT*: o: tcp (10.1.1.1, 23} =»> {10.1.25.65, 52217) [6962]
Apr 5 13:57:53.779: MAT*: g=10.1.1.1->10.1.25.129, d=10.1.25.65 [6982)

Apr 5 13:57:53.779: HAT*: 5=10.1.25.12%, d=10.1.25.65->10.1.1.1 [8982]

<snip>

F2f#sh ip nat tra

Fre Inside global Inside local Cutside local cutside global
—_—— - - 10.1.25.12%9 ig.1.1.1

tep 10.1.25. 65:532217 10.1.1.1:52217 10.1.25.129:23 10.1.1.1:23
=== 10.1.25. 65 10.1.1.1 - —_——

Rddtel 10.1.25.65
Trying 10.1.25.85 ... Open

User Access Verification

Password:

Rl>

B2fdeb ip nat detailed
IF HAT detailed debugging is om

B2

Apr 5 14:00:09.595: MAT*: o: tcp (10.1.1.1, 26584) -> (10.1.25.65, 23} [7007)
Apr 5 14:00:09.595: HAT*: o: tcp (10.1.1.1, 26584) -> (10.1.25.65, 23) [7007]
Apr 5 14:00:09.595: MAT*: 5=10.1.1.1=->10.1.25.129, d=10.1.25.65 [7007]

Apr 5 14:00:09.595: HAT*: s=10.1.25.129%, d=10.1.25.65->10.1.1.1 [7007]

Rpr 5 14:00:08.59%: MAT: i: tep (10.1.1.1, 23) -5 ({10.1.25.128, 26584} [37%02)
RApr 5 14:00:09.5959: HAT: s=10.1.1.1->10.1.25.65, 4=10.1.25.129% [37502]

Apr 5 14:00:09.59%9: MAT: s=10.1.25.85%, d=10.1.25.125->10.1.1.1 [37502)

F2#sh ip nat tra

Fro Inside global Inside local outside local cuteside global
— — 10.1.25.129 10.1.1.1
tep 10.1.25. 65:23 10.1.1.1:23 10.1.25.125:26584 10.1.1.1:26584
=== 10.1.25.65 10.1.1.1 - -

Task 2

Reconfigure R2 so that it will translate dynamically SITE-A subnet between R1 and
R2 and allow connections to R4. SITE-A subnet should use range of 10.1.25.64/26

for translation and R4 should be translated to the IP address of 10.1.25.129.
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Configuration
Complete these steps:

Step 1 R2 configuration.

B2 (config) #ne ip nat inside scurce statie 10.1.1.1 10.1.25.85
B2 (config) #ip nat poel SITE-A 10.1.25.65 10.1.25.126 prefix-length 26
B2 (config) #access-list 1 permit 10.1.1.0 0.0.0.255

B2 (config) #ip nat inside source list 1 pool SITE-A

B2 (config) #ip nat outside source static 10.1.1.1 10.1.25.129

Verification
BEZfsh ip nat tra
Fro Inside global Inside local Outside local Outside global
— == =5 10.1.25.12% 10.1.1.1

B2 f#deb ip nat detail
IF HAT detailed debugging is omn

Rlitel 10.1.25 129
Trying 10.1.25.12% ... COpen

User Rocess Verification

Fassword:

Rd»sh users

Line User Host (8) Idle Location
0 con O idle 00:27:59
2 wky O idle OO:00:00 10.1.25.65

RZ#
Apr 5 14:03:40.522: mapping pointer available mapping:0
Apr 5 14:03:40.522: MAT: setting up outside mapping 10.1.25.125->10.1.1.1, with
mapping-id 0
Apr 5 14:03:40.522: MAT: i: tep (10.1.1.1, 53267} -»> (10.1.25.12%, 23) [62883)
Apr 5 14:03:40.522: MHAT: 5=10.1.1.1=->10.1.25.65, 4=10.1.25.12% [62883)
Apr 5 14:03:40.522: MAT: s=10.1.25.65, d=10.1.25.1259->10.1.1.1 [&628H3)
5 14:03:40.522: HAT: installing alias for address 10.1.25.65
Apr 5 14:03:40.534: MAT*: o: top (10.1.1.1, 23} —= [10.1.25.65, 53287} [E65278]
5 14:03:40.534: HAT*: 5=10.1.1.1->10.1.25.125, d=10.1.25.65 [652748]
5 14:03:40.534: HAT*: s=10.1.25.129, d=10,1.25.65->10.1.1.1 [&5278]
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R2¥#sh ip nat tra

Fro Inside global
top 10.1.25%. 65: 53287
m—= 10.1.25. 65

Inside local

10.1.1.1:53267
10.1.1.1

Outside local
10.1.25.12%
10.1.25.129:23

outside global
10.1.1.1
10.1.1.1:23

Session initializing from Fd4 is not possible as there is no translation:

RZ#cle ip nat tra *

Fdf#tel 10.1.25.65

Trying 10.1.23.65 ...

% Connection timed out; remote host not responding

Howaver, if seassion

sessien from R4:

Riftel 10.1.25.12%

Trying 10.1.25.129 ...

cpen

Uzser Accesa Verification

Pasaword:

R2#sh ip nat tra
Fro Inside global

top 10.1.25.66:12416
=== 10.1.25. 66

Bd#tel 10.1.25.66

Trying 10.1.25.66 ...

Inside local

10.1.1.1:12416
10.1.1.1

open

User RAccess Verification

Fassword:

Rl>

RZ#

Apr 5 14:0%:11.330:
Apr 5 14:09:11.330:
Rpr 5 14:09:11.330:
Apr 5 14:0%:11.330:
RApr 5 14:09:11.330:
Apr 5 14:0%:11.330:
Apr 5 14:09:11.330:

HAT*: o: top (10.1.1.1, 18348}
HAT®*: o: tcp (10.1.1.1, 18348}

is establ ished from R1,

Outside local
10.1.25.12%
10.1.25.129:23

NAT*: 8=10.1.1.1->10.1.25.129%, d=10

HAT*: 5=10.1.25.12%, d=10.1.25.

it is possible to initialize new

Cutside global
10.1.1.1
10.1.1.1:23

=> {10.1.25.86, 23) [30380]
=> {10.1.25.66, 23) [30380]
.1.25.66 [30580])
66=>10.1.1.1 [30580]

WAT: i: tep (10.1.1.1, 23} => (10.1.25.12%, 1B348) [26100]
HAT: 5=10.1.1.1=->10.1.25.66, 4=10.1.25.125% [26100]
HAT: s=10.1.2%.66, d=10.1.25.129=>10.1.1.1 [26100])

Page 341 of 507



CCIE SECURTY vd Lab Workbook

<snip>

BZf#sh ip nat tra

Fre Inside global Inside local Cutside local
—— —_— 10.1.25.129
tecp 10.1.25. 66:23 10.1.1.1:23 10.1.25.129:18348
tep 10.1.25. 66212418 10.1.1.1:12416 10.1.25.129:23
=== 10.1.25. 66 10.1.1.1 ===

Task 3

Cutside global
10.1.1.1
10.1.1.1:18348
10.1.1.1:23

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.39. NAT TCP load balancing

|  Ouside |

— > _
101.12.0 124 —_—110.1.245.0 124
FOM1 GoM GOD/o
4 ﬁ""’m -
FO/0 R4

Lab Setup
» R1's FO/1 and R2's G0/1 interface should be configured in VLAN 12.

» R2's G0/0, R4, and R5’s F0/0 should be configured in VLAN 245,
» Configure telnet on all routers using password “cisco”

IP Addressing
Router Interface IP address
R1 FON 10.1.12.1/24
R2 GoNn 10.1.12.2/24
G0/0 10.1.245.2/24
R4 F0/0 10.1.245.4/24
R5 F0/0 10.1.245.5/24
Task 1

Configure R2 so that it translates connections from R1 to the IP address of
10.1.34.34 to two real IP addresses (R5 and R4 f0/0 interfaces’ IP addresses) in
round-robin fashion. Use static default routes on R1, R5 and R5 to achieve full
network reachability.
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Configuration
Complete these steps:

Step 1 R1 configuration.

Al (cenfig)#ip reute 0.0.0.0 0.0.0.0 10.1.12.2

Step 2 R4 and R5 configuration.

(oenfig)#ip route 0.0.0.0 0.0.0.0 10.1.245.2

Step 3 R2 configuration.

B2 {config) #ip nat pool REAL-HOSTS 10.1.245.4 10.1.245.5 prefix-length 24 type

FoEAFY
B2 (config) laccess-list 2 permit 10.1.34.34

B2 (config) #ip nat inside destination list 2 pool REAL-HOSTS

RZ (conf ig) #int g0 /0
R2 (config-if ) #ip nat inside
B2 (config-if) #int g0/1

RZ (config-if)#ip nat outsida

Veri n

Rlétel 10.1.34.34
Teying 10.1.34.34 ... Open

User Access Verification

Password:

R3>sh users

Line Usar Hosat (8) Idle
0 con O idle 00:00:29
=514 vty O idle Q0:00: 00
Interface User Mode Idle
R3>exi

[Cennection to 10.1.34.34 clesed by foreign host]

Flétel 10.1.34.34
Trying 10.1.34.34 ... Open

Location

10.1.12.1

Peer Rddress
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User Access Verification

Password:

R4>sh users

Line User

0 con O
#8514 vty 0

Inter face User

R4

Bijdeb ip nat det

Hoat (=) Idle Location

idle 00:z01:16

idle 00:00:00 10.1.12.1
Mode Idle Feaer Rddress

IF MAT detailed debugging is on

*Sep 3 10:18:30.
#*Z3ap 3 10:18:30.
*Sep 3 10:18:30.
*Sep 3 10:18:30.
<snip>

*Sep 3 10:15:08
*Z3ep 3 10:19:08
*Sep 3 10:15:08
#Z3ep 3 10:19:08
<anip>

RZ#sh ip nat tra

Fro Inside gleobal
tep 10.1.34.34:23
top 10.1.34.34:23

Task 2

671
B71:
675:
673

.123:
L123:
12T
127

HAT®:
HNAT*:
HAT*®:
HAT*:

o: tep {10.1.12.1, 31110) => (10.1.34.34, 23) [54420]
8=10.1.12.1, @=10.1. 34 34=>10.1 245,58 [54420]
i: tep {10.1.245.5, 23} -»> (10.1.12.1, 31110} [8122]
5=10.1.245.5->10.1.34.34, &=10.1.12.1 [6122]

oo tep (10.1.12.1, 61341} -> (10.1.34.34, 23} [5528]
HAT*:
HAT*:

8=10.1.12.1, d=10.1.34.34->10.1.245.4 [5928)
i: tep (10.1.245.4, 23) -> (10.1.12.1, 61341} [42103]
8=10.1.245.4=>10.1.34.34, d=10.1.12.1 [42103)

Ingide local Cutside local cutside global
10.1.245.4:23 10.1.12.1:61341 10.1.12.1:61341
10.1.245.5:23 10.1.12.1:31110 10.1.12.1:31110

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.40. Stateful High Availability NAT
Foi| 5
10.1.125.0 /24
A | Fon
Lab Setup

» R1,R2(G0/1) and R5's FO/1 interface should be configured in VLAN 125
» R2 (G0/0), R4 and R5’s FO/0 interface should be configured in VLAN 245
» Configure telnet on all routers using password “cisco”

» Use only static routing.

IP Addressing

Device Interface IP address

R1 FOM 10.1.125.1/24
G0/0 10.1.245.2/24

Ao G0A 10.1.125.2/24

R4 FO/0 10.1.245.4/24

RS FO/O 10.1.245.5/24
FOM 10.1.125.5/24
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Task 1

Configure R2 and R5 routers to be seen under one IP address of 10.1.125.254 from
R1's perspective and IP address of 10.1.245.254 from R4 (configure correct default
routes pointing to the VIP address). Both routers should statically translate IP
address of R1's f0/1 interface to the IP address of 10.1.245.1. NAT should notice
HSRP state change.

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config) #int go/1

R2 (config-if)#standby 1 ip 10.1.125.254
2 (config-if) #standby 1 name HA_ Inside
R2 (config-if) #standby 1 preempt

B2 (config-if ) #standby 1 prierity 105
R2 (config-if ) standby 1 track go0/0

R2 (config-if) #int go/0

R2 {config-if)lstandby 2 ip 10.1.245.254
R2 (config-if) #standby 2 name HA Outside
RZ (config-if)#standby 2 preempt

B2 (config-if ) #standby 2 prierity 105
B2 {config-if)#standby 2 track g0/l

Step 2 R5 configuration.

R5 (config) #int £0/1

B5 (config-if ) #standby 1 ip 10.1.125.254
RS (config-if)#standby 1 name HA Inside
BS (conf ig=-if) #standby 1 preampt

BS (config-if ) #standby 1 track £0/0

RS {config-if ) #int £0,/0
RS {config-if)lstandby 2 ip 10.1.245.254
RS (config-if ) #standby 2 name HA_Outside
BE (config-if ) Bstandby 2 preespt

RS {config-if)#standby 2 track £0/1

As dynamic routing is not allowed, configure statioc default routes on

Fl and R4 pointing to appropriate VIP (Virtual IP) address

Step 3 R1 configuration.
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ip route 0.0.0.0 0.0.0.0 10.1.125.254

Step 4 R4 configuration.

ip route 0.0.0.0 0.0.0.0 10.1.245.254

Step 5 R2 configuration.

B2 (config) #ip nat inside scurce statie 10.1.125.1 10.1.245.1 redundancy
HA_Tnside

R2 (config) #int g0/1

B2 (config-if ) #ip nat insids
R2 (config-if ) #int g0/0

B2 (conf ig=-if) #ip nat outside

Step 6 R5 configuration.

RS (config) #ip nat inside source static 10.1.125.1 10.1.245.1 redundancy
HA_Inside

RS (config) #int £0,/1
RS (config-if) #ip nat inside
B5 (config-if)#int £0/0

RS (config-if ) #ip nat cutside

Verification

BE2¥sh standby
GigabitEthernetd/0 - Group 2
State is Active
2 state changes, last state change 00:03:34
Virtual IP address is 10.1.245.254
Rotive wirtual MAC address is 0000.0c07.ac02
Local virtual MAC address is 0000. 0c07.acd2 (vl default)
Hello time 3 sec, hold time 10 sec
KHext hello sent in 1.968 secs
Preemption enabled
Active router is local
Standby router is 10.1.245.5, priority 100 (expires in 9.792 sec)
Priority 105 (confiqured 105)
Track interface GigabitEthernet()/l state Up decrement 10
Group neme is "HA Cutside™ (cfgd)
GigabitEthernetl/l - Group 1
State is Rctive
2 state changes, last state change 00:03:34
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Virtual IF address is 10.1.125.254
Active wvirtual MAC address is 0000.0c07.ac0l

Local wirtual MAC address is 0000. 0c07.ac0l (vl default)
Hello time 3 sec, hold time 10 sec

Kext hello sent in 2.128 secs
Freemption enabled
Active router is local
Standby router is 10.1.125.5, priecrity 100 (expires in 11.29%8 =ec)
Priority 105 (configured 105}

Track interface GigabitEthernetd/0 state Up decrement 10
Group name is "HA Inside™ (cfgd)

RS5#sh standby
FastEthernet0/0 - Group 2
State is Standby
1 state change, last state change 00:03:11
Virtual IP address is 10.1.245.254
Active wirtual MAC address is 0000.0c07.aci2
Local virtual MAC address is 0000, 0c07.acd2 (vl default)
Hello time 3 sec, hold time 10 zec
KHext hello sent in 1.744 secs
Preemption enabled
Active router is 10.1.245.2, prierity 105 {expires in 5.104 sec)
sStandby router is local
Priority 100 (default 100}
Track interface FastEthernet0/1 state Up decrement 10
Group nama is "HA Cutside" (cfgd)
FastEthernet0/1 - Group 1
State is Standby
1 state change, last state change 00:03:12
Virtual IF address is 10.1.125.254
Active wvirtual MAC address is 0000.0c07.ac0l
Local wirtual MAC address is 0000. 0c07.ac0l (vl default)
Hello time 3 sec, hold time 10 sec
Kext hello sent in 0.848 secs
Freemption enabled
Retive router is 10.1.125.2, priority 105 (expires in 10.512 sec)
Standby router is local
Pricrity 100 (default 100)
Track interface FastEthernet0d/0 state Up decrement 10
Group name is "HA Inside™ (cfgd)
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Bl#tel 10.1.245.4
Trying 10.1.245.4 ... Open

User Access Verification

Fassword:

Rd>»sh users

Line Usar Host (s) Idle Location
0 con O idle 00:05: 31
#514 wity O idle O0:00:00 10.1.245.1
Interface User Hode Idle Pear RAddress

Rd>

BEZffsh ip nat tran

Fre Inside global Inside local Cutside local cutside global
tcp 10.1.245.1:36809 10.1.125.1:36809 10.1.245.4:23 10.1.245.4:23
—= 10.1.245.1 10.1.125.1 - —_—

FS#sh ip nat tran

Pro Inside global Inside local Cutside local Cutside global
== 10.1.245.1 10.1.125.1 -— ——
How, shutdown the interface on R2 and check if translation still works

F2#deb ip nat deta
IF HAT detalled debugging is on

R2lconf t

Enter configuration commands, one per line. End with CHNTL/Z.

R2 {configliint go/1

B2 {config=if)#shut

R2 [config-if)#

WTRACKING-5-STATE: 2 interface Gi0/1 line-protocel Up->Down
tHSRF-3-STATECHRNGE: GigabitEthernet0/l Grp 1 state Active -> Init
HAT: redundancy update: Actiwve->Init grp:HR_Inside, Rddress:10.1.245.1
tHESRFP-5-STATECHANGE: GigabitEthernetd/0 Grp 2 state Active -> Speak

SLINE-5-CHANGED: Interface GigabitEthernst0/1, changed state to administratively down
YLINEFROTO-5-UPDOWH: Line protocol on Inter face GigabitBthernet(/1, changed state to

down
YHSRP-5-STATECHANGE: GigabitEthernet(/0 Grp 2 state Speak -»> Standby

ES#sh ip nat tran

Fro Inside global Inside local COutside local ctutaside global
top 10.1.245.1:36809 10,1.125.1:3680% 10.1.245.4: 23 10.1.245.4:23
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mme 10.1.245.1 10.1.125.1 === -

Task 2
Disable static NAT translation configured in the previous task.

Both routers should now dynamically translate IP addresses from 10.125.0/24 subnet
to the pool of IP address of 10.1.245.10-100. Enable high availability for NAT so that
state table is sent over to the backup router in case of link failure.

Con ration
Complete these steps:
Step 1 R2 configuration.

B2 (config) #ne ip nat inside source statie 10.1.125.1 10.1.245.1 redundancy
HA_Inside

F2 (config) #ip nat Stateful id 1

B2 (conf ig-ipnat-snat) #primary 10.1.125.2
B2 (conf ig-ipnat-snat-pri)#pear 10.1.125.5
B2 (conf ig-ipnat-snat-pri) imapping=-id 10
B2 (config-ipnat-snat-pri) fexit

B2 (config) #ip nat Stateful id 1

R2 (conf ig-ipnat-snat) #redundancy HA Inside

B2 (conf ig-ipnat-snat-red) #fprotecal tep

TCF is deprecated, switching to UDF protocel by default
B2 (conf ig-ipnat-snat-red) imapping-id 10

R2 (conf ig-ipnat-snat-red) fexit

R2 (config) #ip nat pool HAT POOL 10.1.245.10 10.1.245.100 prefix-langth 24
B2 (conf ig) #acoess-list 1 permit 10.1.125.0 0.0.0.2558
R2 (config) #ip nat inside scurce list 1 pool KAT_ POCL mapping-id 10

Step 2 RS5 configuration.

RS (conf ig) #ne ip nat inside source statis 10.1.125.1 10.1.245.1 redundanay
HA_Inside

RS (config) #ip nat Stateful id 1
R5 (conf ig=-ipnat-snat) #backup 10.1.125.5
RE (conf ig-ipnat-snat-bkp) #pear 10.1.125.2

RS {conf ig-ipnat-snat-bkp) #mapping-id 10
RS (conf ig-ipnat-snat-bkp) #
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Veri

YSHAT-5-FROCESS: Id 1, System starts converging
BHAT-5-FROCESS: Id 1, System fully converged

RS (config-ipnat-snat-bkp) #exit

RS (config) #ip nat Stateful id 1

RS (conf ig-ipnat-snat) § redundancy HA Insids
RS (conf ig-ipnat-snat-red) #fprotocel udp

RS (conf ig-ipnat-snat-red) #mapping-id 10

BS (conf ig-ipnat-snat-red) #exit

YSHAT-5-FROCESS: Id 1, System starts converging
WESHAT-5-FROCESS: Id 1, System fully converged

RS (config) #ip nat pool HAT POOL 10.1.245.10 10.1.245.100 prefix-length 24
B2 (conf ig) #acoess-1ist 1 permit 10.1.125.0 0.0.0.255
RS (config) #ip nat inside source list 1 pool NAT_ POOL mapping-id 10

BE2¥sh standby
GigabitEthernetld/0 - Group 2
State is Active
5 ptate changes, last state change 00:00:55
Wirtual IP address is 10.1.245.254
Rctive virtual MAC address is 0000,0c07.ac02
Local wirtwal MAC address is 0000. 0c07.ac02 (vl default)
Hello time 3 sec, hold time 10 sec
KHext hello sent in 0.384 secs
Preemption enabled
Aotive router is local
Standby router is 10.1.245.5, priocrity 100 (expires in 9.200 sec)
Priority 105 (confiqured 105)
Track interface GigabitEthernet(/l state Up decrement 10
Group neme is "HA Cutside™ (cfgd)
GigabitEthernet(/1 - Group 1
State is Rctive
5 state changes, last state change 00:00:27
Virtual IP address is 10.1.125.254
Active wirtual MAC address is 0000.0c07.ac0l
Local wirtual MAC address is 0000. 0c07.acOl (vl default)
Hello time 3 gec, hold time 10 sec
Hext hello sent in 0.864 secs
Preemption enabled
Active router is local
standby router is 10.1.125.5, priority 100 (expires in 8.832 sec)
Priority 105 (configured 105)
Track interface GigabitEthernet(/0 state Up decrement 10
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Group name is "HA Inside™ (cfgd)

R2é#sh ip nat statistics

Total active translations: 0 (0 static, O dynamic; 0 extended)

Peak translations: 2, occurred 01:18:06 ago

Ccuteide interfaces:
GigabitEthernetd /0

Inside interfaces:
GigabitEtherneti/1

Hits: 192 Misses: 0

CEF Translated packets:

Expired translatiens: 2

Dynamic mapplngs:

-— Inside Source

[Id: 2] access-list 1 pool HAT POOL refcount O

152, CEF Punted packets: 0

pool HAT POOL: petmask 255.255.255.0
gtart 10.1.245.10 end 10.1.245.100

type generic, total addresses %1, allocated 0 (0%), misses 0

Appl deors: 0
Hormal doors: 0O

Cueusd Packets: 0

F2#sh ip nat tra

Fl#tel 10.1.245.4
Trying 10.1.245.4 ...

Open

User Access Verification

Password:

Rd>sh users

Line User Host (5) Idle Loecation

0 con O idle 01:03:11
=514 viy 0 idle 00:00:00 10.1.245.10

Interface User Mode Idle Peer RAddress
Rd>»
R2#
R2#
*Sep 3 11:37:48.639: mapping pointer available mapping:10
*Sep 3 11:37:48.659: SHAT (Add node): Rllocated database distributed-id 1
*Sep 3 11:37:48.663: SHAT (Add node): Init RTree for distributed-id 1
*Zep 3 11:37:48.663: SHAT (Add node): RAllocate Mode for nat-id 4, Reuter-id 1
*Sep 3 11:37:48.663: SHAT (Add node): Allocate Mode for nat-id 5, Router-id 1
*Sep 3 11:37:48.663: MAT: i: tcp (10.1.125.1, 11281) -> (10.1.245.4, 23) [38740)]
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3 11:37:48.663:
3 11:37:48.663:
3 11:37:48.663:

*Sep
*Jap
*Sep
R2#

*Sep

i 883

3 11:37:48.663;

R2#sh ip nat tra
Fre Inside global
tep 10.1.245.10:11281

Inside local
10.1.125.1:11281

=== 10.1.245.10 10.1.125.1

RE#sh ip nat tra

FPro Inside global Inside local

tep 10.1.245.10:11281 10.1.125.1:11281

=== 10.1.245.10 10.1.125.1
Hote that the sams HAT information
HAT.

RZ2#conf t

8=10.1.125.1=>10.1.245.10, d=10.1.245.4 [38740]
installing alias for address 10.1.245.10
o: tep (10.1.245.4, 23} -> (10.1.245.10, 11281) ([42380]

8=10.1.245.4, d=10.1.245,10->10.1,125.1 [42980)

Outside local
10.1.245.4:23

Cutside global
10.1.245.4:23

Outside leocal
10.1.245.4:23

cutside global
10.1.245.4:23

iz on both routars.

Enter configuration commands, one per line. End with CNTL/Z.

RZ (config)l#int g0/1
R2 (config-if ) #shut

SHAT: interface GigabitEthernet(/1 with address 10.1.125.2 is down

B2 (config-if ) #

*Sep 3 11:38:20.73%:
*Sep 3 11:38:20.743:
Init
*Sep
=Zep

R HSRP= 5=-3TATECHANGE

3 11:38:20.743:
F 11:38:20,743:

$TRACKING-5-STATE: 2 interface Gi0/1 line-protocol Up->Down

: GigabitEthernet0/l Grp 1 state Active =>

¥ SHAT-5-FROCESS: Id 1, System starts conwverging
%IP-4-DUPADDR: Duplicate address 10.1.245.10 on

GigabitEthernetd/0, sourced by 0012.8031.d118

*Sep 3 11:38:20.743: HAT: deleting alias
*Z3ep 3 11:38:20.743: $%SHAT-5-PROCESS: Id

from redundancy list for 10.1.245.10
1, System fully converged

*Sep 3 11:38:21.435: %8VS-5-OONFIG I: Configured from console by console

*Sep 3 11:38:22.727: ¥LINK-5-CHARNGED:
administratively down

*Sep 3 11:38:23.031: %HSRP=-5-STATECHRNGE
Spaak

*Zep 3 11:38:23.727: RLINEPROTO-S-UPDOWN:

GigabitEthernet(/1, changed state to down
R2#

*Sep 3 11:38:33.11%: RHSRP=53-STATECHANGE:

Standby

B2# sh nat tra

Pro Inside global Inside local

Interface GigabitEthernet(/1l, changed state to

: GigabitEthernet(/0 Grp 2 state Active =>

Line protecol on Interface

GigabitEthernet0/0 Grp 2 state Speak =>

Outside lecal Cutside global
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tep 10.1.245.10:11281  10.1.125.1:112581 10.1.245.4:23 10.1.245.4:23

—= 10.1.245.10 10.1.125.1 _— —_—

R2#

RS #

Sap 3 le:16:34.830: YHSRP-5-STATECHANGE: FastEthernet(/1 Grp 1 state Standby -> Rotive
Sep 3 16:16:34.630: RSHAT-5-PROCESS: Id 1, System starts converging

Sep 3 16:16:34.634: RSHAT-5-FROCESS: Id 1, System fully converged

RS #

Sep 3 16:16:34.642:
sourced by 0011.53&88.
RS#

SBep 3 16:16:36.530:

ES#sh ip nat tra

$IF-4-DUFRDDR: Duplicate address 10.1.245.10 on FastEthernet(/0,
8270

YHERP-5-STATECHRNGE: FastEthernetd/0 Grp 2 state Standby -> Rctiwve

Pro Inside global Ingide local outside local cuteside global
tecp 10.1.245.10:11281 10.1.125.1:11281 10.1.245.4:23 10.1.245.4:23
-—= 10.1.245.10 10.1.125.1 -_— —_—

Task3

Erase the startup config and reload the routers before proceeding to the next lab.

Page 355 of 507



CCIE SECURTY vd Lab Workbook

LAB 3.41. NAT Virtual Interface

10.1.12.0 124

I:H
Rl
A |F it

4 || gip  Le? Led  fpp

| 5 S
o 10.1.45.0 /24 e 0.5
e =
R4 RS

Lab Setup
» R1 and R2's GO/0 interface should be configured in VLAN 12

» R2and R5's 50/1/0 interface should be configured in a frame-relay point-to-
point manner.

» R5 and R4's FO/0 interface should be configured in VLAN 45

» Configure telnet on all routers using password “cisco”

> Run RIPv2 on the routers and advertise their directly connected networks

IP Addressing

Router Interface IP address

R1 Lo0 1.1.1.1/24
FO/0 10.1.12.1/24

R2 Lo0 222224
G0/0 10.1.12.2/24
S0/1/0.25 10.1.25.2/24

R4 Lo0 4.44.4/24
FO/0 10.1.45.4/24

R5 Lo0 5.5.5.5/24
FO/0 10.1.45.5/24
S0/M1/0.52 10.1.25.5/24
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Task 1
Configure R2 so that it will translate all IP addresses from 10.1.12.0/24 and
10.1.45.0/24 subnet to the IP range from 10.1.25.10 to 10.1.25.100. Do not specify

direction for this translation.

The NAT Virtual Interface (NV]) feature removes the requirement to configure an
interface as either Network Address Translation (NAT) inside or NAT outside.
An interface can be configured to use NAT or not use NAT.

A NAT table is maintained per interface for better performance and scalability.
However, route maps are not supported in NVl scenarios.

Configuration
Complete these steps:

Step1 R2 configuration.

R2 (config) #ip nat pool HAT POOL 10.1.25.10 10.1.25.100 netmask 255.255.255.0
R2 (config) #

%L INEFROTO-5-UFDOWH: Line protoceol on Interface WVIOD, changed state to up
R2 (config) #ip nat source list 1 pool HAT POOL

B2 (conf ig) #acoess-1ist 1 permit 10.1.12.0 0.0.0.255
B2 (config) #access-list 1 permit 10.1.45.0 0.0.0.255

B2 (config) #int g0/0

A2 (config-if ) #ip nat enable

R2 (conf ig-if)#int =0/1/0.25

R2 (conf ig-subif) #ip nat snabls

Verification

F2#sh ip nat nvi statistics
Total active translations: 0 (0 static, 0 dynamic; 0 extended)
HAT Enabled interfaces:
GigabitEthernet0/0, Seriald/1/0.25
Hits: 0 Misses: 0

CEF Translated packets: 0, CEF Punted packets: 0
Expired translationa: 0
Dynamic mappings:
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== Spurce [Id: 3] access=-list 1 pool NAT POOL refcount O
poel HAT POOL: netmask 255.255.255.0
start 10.1.25.10 end 10.1.25.100

type generic, total addresses 91, allocated 0 (0%}, misses O

TEST 1: Telnet from R1 to R4

Blitel 4.4.4.4

Trying 4.4.4.4 ... Cpen

User Accesa Verification

Pasaword:

R4»sh users

Line Usar Host (s) Idle Location

0 con O idle 00:07:33
=514 wviy 0 idle 00:00:00 10.1.25.10

Inter face Usar Hode Idle Fear Rddress
Rd>
RZ#
*Sep 3 11:54:52.067: HAT®*: i: tcp (10.1.12.1, 56140} => (4.4.4.4, 23) [15533]
*SJep 3 11:54:52.067: HAT*: s=10.1.12.1->10.1.25.10, d=4.4.4.4 [15933]
*Sep 3 11:54:52.067: HAT: installing alias for address 10.1.25.10
*Sep 3 11:54:52.079: MAT: i: tcp (4.4.4.4; 23} -> (10.1.25.10, 56140) [32209]
*Sep 3 11:54:52.079%: HAT: s=4.4.4.4, d=10,1.25.10->10.1.12.1 [3920%9]

F2#sh ip nat nvi translations

Fro Source global

Source local

Destin local

top 10.1.25.10:56140 10.1.12,1: 56140 4.4.4.4:23
=== 10.1.25. 10 10.1.12.1 -
TEST 2: Telnet from R4 to R1

Rd#tel 1.1.1.1

Teying 1.1.1.1 ... Cpen

User Access Verification

Password:

Rl>sh users
Line User Hosat (=) Idle
0 con O 4.4.4.4 00:00: 31

*514 vty 0 idle

Destin  global
4.4.4.4:23
Location

00:00:00 10.1.25.11
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Inter face Usar Mode Idle Fear Rddress
Rl>
#2ep 3 11:55:23.671: MAT*: i: tep (10.1.45.4, 38513) == (1.1.1.1, 23) [55125)
*Sep 3 11:55:23.671: HAT*: s=10.1.45.4-510.1.25.11, 4=1.1.1.1 [55125]
*Sep 3 11:55:23.671: HAT: installing alias for address 10.1.25.11
*Sep 3 11:55:23.675: HAT: i: tcp (1.1.1.1, 23} =»= (10.1.25.11, 33512} [51323]
*Sep 3 11:55:23.675: HAT: s=1.1.1.1, d=10.1.25.11=->10.1.45.4 [51323]

E2#sh ip nat nwi translations

Fre Source global Source local Destin local
tep 10.1.25.10:56140 10.1.12.1: 56140 q4.4.4.4:23
=== 10.1.25.10 10.1.12.1 ===
tep 10.1.25.11:38512 10.1.45.4: 39512 1.1.1.1:23
-—= 10.1.25.11 10.1.45.4 =-——

Task 2

Destin glebal
d.4.4.4:23

1.1.1.1:23

R5's loopback0 IP address should be translated to R2's g0/0 interface IP address
when R5 connects to R1. Do not specify direction for this translation.

Configuration
Complete these steps:
Step1 R2 configuration.

R2 (config)#ip nat source static 5.5.5.5 interface g0/0

Verification

B2 ffclear ip nat nvi tran +

BZfish ip nat nvi translations

Fro Source global Spurce local Destin local
-—=10.1.12.2 5.5.5.5 _—

Destin global
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TEST 1: Telnet from RS to R1

BS#tel 1.1.1.1 fso lod
Trying 1.1.1.1 ... Cpen

User Access Verification

Fassword:
Rl»sh users
Line User Host (5] Idle Location
0 con O idle 00:00:34
#514 wity O idle 00:00:00 10.1.12.2
Interface User Hode Idle Pear RAddress
Rl>
RZ#

*Sep 3 12:08:18,111: MAT*: i: top (5.5.5.5, 56459) —# (1.1.1.1, 23} [21824]
*3ep 3 12:08:18.111: NAT*: 8=5.5.5.5-310.1.12.2, d=1.1.1.1 [21824]
*Sep 3 12:08:18,.115: MAT: i: tep (1.1.1.1, 23} -> (10.1.12.2, 58453} [10218]
*Zep 3 12:08:18.115: WAT: s=1.1.1.1, d=10.1.12.2->5.5.5.5 [1031&)

BE2fsh ip nat nvi translations

Fro Scurce gleobal Spurce local Destin local Destin global
tep 10.1.12. 2:56459 5.5.5.5:56459 1.1.1.1:23 1.1.1.1:23
-—= 10.1.12.2 5.5.5.5 -—— ——

TEST2:T from R1 to R

Bli#tel 5.5.5.5 /fsa lod
Trying 5.5.5.5 ...
% Connection timed out; remote host not responding

RZ#

*Zep 3 12:12:31.375: HAT*: Can't create new inside entry - forced punt flags: 0
*Sep 3 12:12:31.387: HAT*: i: top (5.5.5.5: 23) > (1.1.1.1, 51480} [34459]
*Sep 3 12:12:31.387: HAT*: 8=5.5.5.5%>10.1.12.2, d=1.1.1.1 [3445%)

*Sep 3 12:12:31.391: MAT: i: tcp (1.1.1.1, 514%0) -»> (10.1.12.2, 23) [51546)
#Zep 3 12:12:31.391: HAT: s=l.1.1.1, d=l0.1.12.2=>5.5.5.5 [515346]

Hote that telnet from R1 to RS does not work. This is becaise static entry
autcmatically translates “"Scurce local” to “Scurce gleobal®” for returning traffic
from R5. Henoe, the flow is as follows:

o Rl sends telnet from 1.1.1.1 to 5§.5.5.5

. R2 doas not perform translation since it has no static or dynamic

translation defined for that flow
. RE replies to Rl from 5.5.5.8 to 1.1.1.1
ol R2 translates 5.5.5.5 te its f0/0 interface IF address (10.1.12.2)
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. Rl silently drops returning packets as they are coming from “unknown®
BOUroe
Here's the “dab ip PﬁGK&t detail®™ &'thp'l.lt from R1 It sands out STH pncket to

E.E.BE.E and receives SYTH/ACK from 10.1.12.2

IP: s=1.1.1.1 (lecal), d=5.5.5.5 (FastEthernet0/0)}, len 44, sending full packet

TCP sro=38831, dst=23, seq=3487002752, ack=0, win=4128 5¥H

IF: 5=10.1.12.2 (FastEthernetd/0), 4=1.1.1.1, len 44, input feature

TCP src=23, dst=38831, seqg=15934155983, ack=3487002753, win=4128 RCK S¥N, MCI check(&d),
rtype 0, forus FALSE, sendself FALSE, mtu 0, fwdchk FRLSE

FIBipv{-packet-proc: route packet from FastEthernet0/0 src 10.1.12.2 dst 1.1.1.1
FIBfwd-proc: Default:1.1.1.1/32 receive antry

FIBipvi-packet-proc: packet routing failed

Task 3
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.42. TCP Intercept
10.1.12.0/24
G| 2
4 | Fon 10.1.24.0124
=
Lab Setup:
» Configure the routers with the following IP addressing:
Router Interface IP address
R1 FO/O 10.1.12.1/24
R2 GO0/0 10.1.12.2/24
GOoN 10.1.24.2/24
R4 FO/0 10.1.24.4/24

# Configure static default routing on R1 and R4 pointing to R2 and R2 pointing to

R4

Task 1

R4's FO/0 interface is getting overwhelmed by SYN packets coming to the TELNET
port. R2 should watch the traffic and if it does not complete the TCP handshake in 20

seconds, it should drop the packets.
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Configuration
Complete these steps:

Step 1 R2 configuration.

B2 (conf ig) #access-list 100 parmit tcp any hest 10.1.24.4 eq 23
B2 (config) #ip top intercept list 100

R2 (configl#ip top intercept mode watch
B2 (config) #ip tep intercept watch-timeocut 20

Verification

Rlitel 10.1.24.4
Teying 10.1.24.4 ... Open

User Access Verification

Fassword:

Rd>exit

[Cennection to 10.1.24.4 closed by foreign host]

E2ldeb ip tep intercept

TCP intercept debugging is on

RZ#

INTERCEPT: new connection (10.1.12.1:57487 S¥YN => 10.1.24.4:23}
INTERCEPFT: (10.1.12.1:57467 <- ACK+SYN 10.1.24.4:23)

INTERCEPT: (10.1.12.1:57487 ACK —> 10.1.24.4:23)

BE2¥sh tcp intercept statistics
Watching new connections using acecess-list 100
0 incomplete, 0 established connecticons (total 0)

1 connection regquests per minute

TEST 1: Telnet from R1 to R4 when R4 has ACL on the VTY.

Bd {config) #access-1ist 1 permit 1.1.1.1
R4 {configl#line viy 0 4

R4 (config-line) #access—class 1 in

R4 [config-line) $exi

Flé#tel 10.1.24.4
Terying 10.1.24.4 ...
% Connection refused by remote host
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B2 #
INTERCEPT: new connection (10.1.12.1:17456 S¥YN -> 10.1.24.4:23)
INTERCEPT: in synsent watch (10.1.12.1:17456 <- RST 10.1.24.4:23)

Hote that when there is ACL on the VIT the router sends BRST back.

TEST 2: Telnet from R1 to R4 when R4 is not responding (ACL on the f0/0
interface)

R4 (config) #access—1list 140 deny top any any
Rd (config)#int £0/0

R4 {config-if)#ip access-group 140 in

Bd (config-if ) Hexi

Elideb ip icmp
ICHMF packet debugging is on

Fl#tel 10.1.24.4

Teying 10.1.24.4 ...

% Destination unreacheable; gateway or host down

ICMP: dst (10.1.12.1) administratively prohibited unreachable rov from 10.1.24.4

Hote that Rl suddenly dreps the connecticon. This ia due te IOMP
haministratively Prohibited message sent back by Rd. Thera is no TCF BST as it

was in previcus test.

B2 ¥
*Sep 3 12:40:15.575: INTERCEPT: hew cohnection (10.1.12.1:59833 S¥N > 10.1.24.4:23}

*ZSep 3 12:40:35.575: INTERCEPT: SYHSENT timing out (10.1.12.1:59833 <> 10.1.24.4:23)
*Sep 3 12:40:35.575: INTERCEPT(*): (10.1.12.1:59833 RST -> 10.1.24.4:23)

Hote that after 20 saconds B2 sands RET back ko RL!

Task 2

R2 should start deleting half open connection to R4 if the number reaches 1500. It
should stop deleting half open connection if they fall to 1200. Set the one-minute high
to 1000 and the one-minute low to 800. Additionally, configure R2 so that it randomly
drops partial connection.
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Configuration

Complete these steps:

Step 1

R2 configuration.

B2 (config) #ip top intercept max-incomplete low 1200 high 1500
R2 (configl#ip top intercept one-minute low 800 high 1000

R2 (configl#ip top intercept drop-mode random
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LAB 3.43. Configuring NBAR

Based on the previous Lab's IP addressing, topology and Lab setup

10.1.12.0/24

Gom| .2

Goi1| 2
4 | Fon 10.1.24.0124
i
-
R4

Task 1
R4 is experiencing a DoS attack against a web server located on interface F0/0. You
have discovered that there are lots of URLs in web server's logs with the following
strings:

* cmd.exe

= root.exe
Configure R2 to secure that web server by dropping HTTP packets containing the
above strings in HTTP header.

Configuration
Complete these steps:
Step 1 R2 configuration.

B2 (config) #ip caf
B2 (conf ig) #class-map match-any URL

R2 (conf ig-cmap) ématch protocol http url "*omd.axe®"
B2 (conf ig-cmap) Imatch protocol http url "éroot.exe®"
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B2 (conf ig-cmap) fpolicy-map ATTACK
R2 (conf ig-pmap) #class URL
B2 { conf ig-pmap-a) #drop

B2 (conf ig-pmap—a) #int g0/0
B2 (conf ig-if ) #service-policy input ATTACK

Verification

R2#sh policy-map interface g0./0
Gigabi tEthe rnet0/ 0

Service-policy input: ATTACK

Class-map: URL (match-any)
0 packets, 0 bytes
7 minute offered rate 0 bps, drop rate 0 bps
Match: protocol http url "#*omd.exe®®
0 packets, 0 bytes
5 minute rate 0 bps
Match: protocel http url "* root.exe®*"
0 packets, 0 bytes
5 minute rate 0 bps
drop

Class-map: class—default (match-any)
0 packets, 0 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: any

Task 2

You are wondering on what application protocols are operating on the network
between R1 and R2. That information will be used in the future so that appropriate
quality of service (QoS) features can be applied. Display top 3 protocol used.

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config) #int g0 /0
B2 (config-if) dip nbar protoscsl-discovery
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Verification

Blitel 10.1.24.4
Trying 10.1.24.4 ... Open

User Access Verification

Fassword:
Bd»exit

[Connection to 10.1.24.4 closed by foreign host)

E2f#sh ip nbar protocol-discovery top-n 3

GigabitEthe rnetd/0

Last clearing of "show ip nbar protocol-discovery™ counters 00:00:39

Input

Protocol Packet Count
Byte Count
Smin BEit Rate (bps)
Smin Max Bit Rate (bps)

output

Packet Count

Byte Count

Smin Bit Rate ([bps}
Smin Max Bit Rate (bps)

telnet 24

1449

1]

o
bap 1]

[i]

o]

1]
bittorrent o]

o

o

[i]
Wk oW o

1]

o

1]
Total 24

1445

o

1]

20
1170

o o o o o o o Qo o o> o o D o

5]
(=]

1170
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Task 3

There is a business application running on R4 which listens on TCP ports 8888 and
9999. Configure R4 so that it will NOT allow connections to that application from R2's
fO/0 interface IP address using NBAR. NBAR should recognize that application. To
avoid memory issues when using NBAR, change the system link age to 20 seconds,
the initial memory to 100 kilobytes, and the expanded memory to 50 kilobytes. Also,
set the link age for your custom protocol to 180 seconds.

Configuration
Complete these steps:

Step 1 R4 configuration.

Rd (config)#ip cef
R4 (config) #ip nbar custom MY_AFF destination tcp 8888 9999

Fd (config) #ip access-list extended ACL MY AFF
Bd (conf ig-ext-nacl) ipermit top host 10.1.12.2 host 10.1.24 .4

Bd (conf ig) #class-map CM-MY=-APP
Fd (conf ig-cmap) #match protocel MI_AFP
Bd (conf ig-cmap) #match access-group name ACL MY APP

Rd (conf ig-cmap) #policy-map HBAR
Fd (conf ig-pmap) #class OM-MY -AFF

R4 (conf ig-pmap—c) #drop

Rd (config)#int £0,/0
Bd (conf ig=if) #service-policy input HBAR

Bd (config) #ip nbar rescurces system 20 100 50
Fd (config) #ip nbar rescurces protocol 180 MI_AFP

Fd (conf ig-if ) #ip http server
Rd (config) #ip http port 8888

Veri n

Rl¥tel 10.1.24.4 BE8E

Trying 10.1.24.4, B888 ... Open
GET /

HTTE/1.1 400 Bad Reguest
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Date: Sat, 04 Sep 2010 05:59:02 GMT

Sarver: cisco-I0S8
Connection: close

RAccept-Ranges: none

400 Bad Reguest

[Connection to 10.1.24.4 closed by foreign hest)

F2#tel 10.1.24.4 BEEE

Trying 10.1.24.4, 8885 ... Open
GET /

HTTP/1.1 400 Bad Reguest

Date: Sat, 04 Sep 2010 05:59:13 GMT

Sarver: cisco-I0S8
Connection: close
Accept=-Ranges: none

400 Bad Regquest

[Connection te 10.1.24.4 closed by foreign hest)

R2f#tel 10.1.24.4 BEEE /so g0/0
Trying 10.1.24.4, 8888 ...

% Connecticn timed out; remote host not responding

Rd#sh pelicy-map intarface £0./0

FastEthernetd/0

Service-policy input: HBRR

Class-map: CM-MY-AFPF (match-all)

4 packets, 240 bytes

5 minute offered rate 0 bps, drop rate 0 bps

Match: protocol MY_AFP

Match: access-group name ACL MY AFFP

drop

Class-map: class-default (match-any)

22 packets, 1320 bytes

5 minute offered rate 0 bps, drop rate 0 bps

Match: any

Ré#sh ip nbar port-map MY AFF
port-map MY APE

Fd#sh ip nbar rescurces

tcp BBEE 3933

MBAR memory usage for tracking Stateful sessions
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System link age
Initial memory

Max initial memory
Hemery expansion

Max memory expansion :
: 99 KBytes

: 17792 KEytes
HI ]

HI: =

Memory in use

Max memory Allowed
Active links
Total links

: 20 secs

: 100 KBytes
: BB96 KBytes
: 50 KBytes

112 KBvtes
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LAB 3.44. Configuring NetFlow

Based on the previous Lab's IP addressing, topology and Lab setup

10.1.12.0/24

Gom| .2

Goi1| 2
4 | Fon 10.1.24.0124
i
-
R4

Task 1

Configure NetFlow version 5 on R2 so that it gathers traffic flows between R1 and R4
and sends them to the management station on IP address 10.1.12.100 on UDP port
9991.

Configuration
Complete these steps:
Step 1 R2 configuration.

B2 (conf ig) #ip flow-axport wversion 5
B2 (config)#ip flow-export destination 10.1.12.100 99581 udp

B2 (config) #int g0/0

R2 (config-if ) #ip flow ingress
B2 (config-if ) #int g0/1

B2 {config-if)#ip flow egress
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Verification

Blitel 10.1.24.4
Trying 10.1.24.4 ... Open

User Access Verification

Fassword:
Bd»exit

[Connection to 10.1.24.4 closed by foreign host)

B2 #show ip flow export
Flow axport v5 is enabled for main cache
Export source and destination details :
VRF ID : Default
Destination(l} 10.1.12.100 (9951}
Yersion 3 flow records
2 flows exported in 1 udp datagrams
0 flows failed dus to lack of export packet
0 export packets were sent up to process lewvel

0 export packets were dropped due to no fib

0 export packets were dropped due to adjacency issues

0 export packets were dropped due to fragmentation failures

0 axport packets were dropped dues to encapsulation fixup failures

Task 2

Use the NetFlow Layer 2 and Security Monitoring Exports feature to find out that your
network is being attacked by ICMP traffic. The following L2 and L3 values should be
captured:

Time-to-live (TTL) field

Packet length field

ICMP type and code fields

Fragment offset

Source and Destination MAC address
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The Layer 2 and Layer 3 fields supported by the NetFlow Layer 2 and Security

Monitoring Exports feature increase the amount of information that can be

obtained by NetHow.

Configuration

Complete these steps:
Step 1 R2 configuration.

B2 (config) #lip flow-capture fragment-offset
R2 (config) #ip flow-capture packet-lsngth
B2 (config) #ip flow-capture ttl

B2 (config) #ip flow-capture icmp

B2 (config) lip flow-capture mac-addresses

Verification

Fléping 10.1.24.4 rep 10

Type ascape sequence to abort.
Sending 10, 100-byte ICHMP Echos to 10.1.24.4, timeout is 2 seconds:

Success rate is 100 percent (10/10), round-trip min/avg/max = 1/2/4 ms

Fléping 10.1.24.4 rep 10 size 1000

Type escape segquence to abort.
Sending 10, 1000-byte ICHMF Echos to 10.1.24.4, timecut is 2 seconds:

Success rate is 100 percent ([10/10), round-trip minfavg/max = 1/2/4 ms

Rliping 10.1 .24 .4 rep 10 size 2000

Type escape seguence to abort.

Sending 10, 2000-byte ICMF Echos to 10.1.24.4, timecut is 2 seconds:
1LInnnnn

Success rate is 100 percent (10/10), round-trip minfavg/max = 4/4/8

R2#sh ip cache verbose £low
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IF packet size distributien (124
1-32 64 96 128 1s0 182
L0000 354 .000 .16l 000 000

224
. D00

256
. D00

512
000

544
161

576 1024 1536 2048 2560
L0000 L1561 L1661 000 . 000

3072
L 000

IF Flow Switching Cache, 278544 bytes
4 active, 4092 inactive, & added
68 ager polls, 0 flow alloc failures
Active flows timecut in 30 minutes
Inactive flows timecut in 15 saconds
IF Sub Flow Cache, 34056 bytes
12 active, 1012 inactiwve, 14 added,
0 allec failures, 0 force free
1 chunk, 1 chunk added
last clearing of statistics never

Protocol Total Flows

-------- Flows / sec /Flow
TCP-Talnet 2 0.0 22
Total: 2 0.0 22
Speclf SrcIPaddress DetIf

Port Msk A3 Port Msk A3
GLO/SD 10.1.12.1 GLO/1%
o000 fZ4 0 000 f24 0
FFlags: 01

MAC: 001b.d518. 3c50

Min plen: 520

Min TTL: 255

ICMF type: 0

FO: 185

GLOSD 10.1.12.1 G0/l

oooo f24 0 oooo f24 0
MAC: 001lb.d318. 3¢50

Min plen: 520

Min TTL: 255

ICMF type: 0

FO: 185

GLOSD 10.1.12.1 GLO/1*
o000 f24 0 0800 f24 0
FFlags: 01

MAC: 001b.d518. 3c50

Min plen: 100

SrcIif SrcIPaddress DetIf

Port Mak RS Port Mak RS
Min TTL: 255

ICMP type: 8

total packets):

288
L0000 000 .00
ased
. 000

4096 480
L0000

& added to flow

320 352

g4 41s 448
-000 000 000

480

] . D00

-]
i}

Packets BEytes Packets Active (Sac) Idle (3ac)

/Pt /sec /Flow JFlow
42 0.0 3.3 1.6
42 0.0 3.5 1.6
DetIPaddress Pr TOS Flgas Pkta
HextHop B/Pk Active
10.1.24.4 01 00 o0 10
10.1.24.4 320 0.0
001b.d504. 528
Max plen: 520
Max TTL: 255
ICHF code: o
10.1.24.4 01 00 o0 1l
10.1.24.4 320 0.0
001k.d504. 52e8
Max plen: S20
Max TTL: 255
ICMF code: 1]
10.1.24.4 o1 00 10 30
10.1.24.4 111 8.0
001b.d504. 52e8
Max plen: 1500
DetIPaddrass Fr TS Flgs Fkts
HextHop B/Pk RActive
Max TTL: 255
ICHFP code: o
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GLO/D

oooo f24 0
MAC:

Min plen:
Min TTL:
ICMP type:

10.1.12.1

001lb.d518.3c20
100
255

g

GLi0/1 10.1.24.4 oL 00 10 a0
oE00 f24 0 10.1.24.4 BEE B.0
001k.d504.52e8
Max plen: 1500
Max TTL: 255
ICHMF code: o]
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LAB 3.45. Configuring IOS IPS

10.1.14.0 124

101.12.0 /24

Lab Setup
» The FOA interface of R1 and R4's FO/0 should be configured in VLAN 14

» The FO0/0 interface of R1 and R2's G0/0 should be configured in VLAN 12
» Configure RIPv2 on all routers and advertise their directly connected
interfaces in this routing protocol.

IP A in

Router Interface IP address

R1 F0/0 10.1.12.1/24
FoN 10.1.14.1/24

R2 G0/0 10.1.12.2/24

R4 FO/0 10.1.14.4/24

Task 1

Configure 10S Intrusion Prevention System (IPS) to monitor inbound traffic on R1's
FO/0 interface. IPS event should be logged to the syslog server located at
10.1.12.100. Store all IPS configuration in the folder MYIPS on the flash. You can
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use signature pack file (PKG) and crypto key file (realm-cisco.pub.key.txt) located on
the flash to accomplish this task.

IPS on a router must load signatures from the PKG file first as there are no
default signatures in the |0S. The file is loaded into memory when you assign
IPS instance to the interface.

By default most of the signatures are disabled or their action is set to Alarm.

Configuration
Complete these steps:

Step 1 R1 configuration.

Rlé#mkdir flash:MYIPS
Create directory filename [MYIFS]?
Created dir flash:MIIFS

Rl#conf t

Enter configuration commands, one par line. End with CNTL/Z.
Rl {configl#ip ips name MYIFS

Rl (configl#ip ips notify leg

Rl {config)#loggin 10.1.12.100

Rl (config) #loggin on

Rl (configl#ip ips config location flash:MYIFS

Rl {config)#int £0/0
Rl {config-if}#ip ips MYIPS in

Hote that you have assigned MYIPS to the interface but it is not

working since there are no signatures.

Step 2 Import crypto keys.

The appropriate crypte key needs to be imported first. The crypte key
is used te verify the digital signature feor the master signature file
(sigdaf-dafault.xml) whose contents are signed by a Cisco private key
to guarantes its authenticity and integrity at every relesse. The key
is stored on the flash in the file realm—cisco.pub.key.txt. You can
display the content of the file, copy it and paste as a regqular IOS
command. The signature pack and erypte key can be found en

http: / www.cisco.comfogi -bin/ tablebuild pl/ios=-vEsigup .
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Step 3

Display files on the flash:

Blé

sh flash

System flash directory:
File Length Hame/status

1

=1 B Es Wk

]
[&5
153

6503441 I05-5355-CLI.pkg

T04 MIIPS/Rl=-sigdef-default.xml
255 MYIPS/Rl-sigdef-delta. sl
6632 MIIFS/Rl-sigdef-typedef.zml
27118 MYIFS/Rl-sigdef-category.xml
257 MIIFS/Rl-seap-delta.xml

451 MY IPS/Rl=gseap~-typedef. zml
805 realm-cisco. pub.key. txt

39356 bytes used, 9713588 available, 16252824 total]
B4K bytes of processor board System flash ({Read/Write)

Display contents of realm-cisco.pub.key.txt file where crypte key is
stoped

Rlimore flash:realm-cisco.pub.key.txt

crypto key pubkey-chain rsa

named=key realm-cisco.pub signature
key=-string

a0ezolzz

{-. output omitted.)

Copy and paste the output from the previous command to create arypto
kay :

Rl {config) #crypte key pubkey-chain rsa

Rl {config-pubkey-chain) #named-key realm-cisco.pub signature
®1 {config-pubkey-key) #key-string

Enter a public key as a hexidecimal number ....

/1 {config-pubkey) # 30820122 {...output omitted)

Rl {config-pubkey) # quit

Rl (config-pubkey-key)# exit

Rl (config-pubkey-chain)# exit

Enable signatures.

IOS IPS with Cisco 5.x format signatures operates with signature
categories, just like Cisco IFS appliances do. All signatures are pre-
grouped into categories and the categories are hierarchical . This is
sc to help classifying signatures for easy grouping and tuning.

The "all" signature category contains ALL the signatures in a
signature release. Since I0Z IFS cannct compile and use all the
signatures contained in a signature releasse at one time, DO HOT

UNRETIFE the "all" categery, otherwise the router will run sut of
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Verification

MEmory .
Whan cenfiguring I08 IFS2, it is required to FIRST RETIRE all the
signatures in the "all" category, and then UHRETIRE salectad signaturs

categqoriaes.

Rl {config) #ip ips signature-category

Rl (cenfig-ips-categery) #category all

Rl {config-ips-category-action) #retired true

Rl {config-ips-category-action) $exit

Rl {config-ips-category) #category ics_ips basic
Rl (config-ips-category-action)#retired false
Rl {config=-ips=-category=-action) #exit

Rl (config-ips—category) $exit

Do you want to accept these changes? [confirm]

The IFS signatures for I0S scftware release 12.4(15)T3 and later are fully
compatible with applisance IPS 5.x signatures. This means, the format is exactly
the same and the signature package should be in =.FEG file.

If you are unsure if you need to use EDF or PEG file enter the following
sommard

Fl#show subsys name ips

Hame
ips

Class Yersion
Frotocol 3.001. 002

Hote: the wvarsion 3.x mesans thers is new signature format needed [PEG) , wversion

2. x means it is old format (SDF).

The appropriate signature package file is located on the flash (note the numbar
inside the file nams can be different for latest signature relesases), so you

can easily load it inte router’'s memory:

Rl #copy flash:I0S-3350-CLI.pkg idoonf

$IPS=6=ENGINE BUILDS STRRTED: 02:12:01 UTC Mar 1 2002
%IPS-6—ENGINE_BUILDING: multi-string — 11 signatures — 1 of 13 engines
$IP3-6-ENGINE _READY: multi-string - build time 36 ms - packets for this engine will be

scanmed

$IPS-G-ENGINE_BUILDING: service-http - 649 signatures - 2 of 13 engines
%IPS-6-ENGINE_RERDY: service-http - build time 8141 ms - packets for this engine will
be scanned

$IPS-6-ENGINE _BUILDING: string-tep - 1127 signatures - 3 of 13 engines
tIPS—E-ENGINE_RERDY: string-tep — build time 26419 ms — packets for this engine will be

scanned
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YIPS=6-ENGINE BUILDING: string-udp = 75 signatures - 4 of 13 engines
$IPS-6-ENGINE_RERDY: string-udp - build time 737 ms - packets for this engine will be
scanned

RIPS-6-ENGINE_BUILDING: state - 31 signatures - 5 of 13 engines

%IPS-6-ENGINE READY: state - build time 76 ms - packets for this engine will be scanned
YIPS=G6-ENGINE _BUILDING: atomic-ip = 304 signatures - & of 13 engines
$IP3=G6=ENGINE_READY: atomic=ip = build time 1166 ms - packets for this engine will be
scanned

$IPS-6-ENGINE_BUILDING: string-icmp - 3 signatures - 7 of 13 engines

YIPS-E-ENGINE _READY: string-icmp - build time 44 ms - packets for this engine will be
scanmed

YIPS=-6-ENGINE BUILDING: service-ftp = 3 signatures - 8 of 13 engines

RIPS-6-ENGINE _READY: service-fip - build time 4 ms - packets for this engine will be
scanned

$IPS-6-ENGINE BUILDING: service-rpc - 7% signatures - 9 of 13 engines

$IPS-6-ENGINE RERADY: service-rpc - build time 333 ms - packets for this engine will be
scanned

$IP3-6-ENGINE BUILDING: service-dns - 38 aignaturea - 10 of 123 engines
YIPS-6-ENGINE_READY: service-dns - build time 60 ms - packets for this engine will be
scanmed

YIPS-G6-ENGINE _BUILDING: normalizer - % signatures - 11 of 13 engines

To werify, start HTTP server on R4 and try to trigger well know signature no.
5081 which checks URI fiald of HTTF packet to ensure there is no
feystem3i2 fomd. exe string. This attack was performed against Microsoft IIZ &
coupla years ago.

R4 {config) #ip http server

R2#talnat 4.4.4.4 80

Trying 4.4.4.4, 80 ... Open
GET /system32/cmd. exe

Hote that the following massage is genarated on R1:

RLM
RIPS-4-3IGHATURE: Sig:3081 Subsig:0 Sev:100 WWW WinNT cmd.exe Access [10.1.12.2:11002 -
> 4.4.4.4:80] RiskRating:100

Check the IFS configuration to see if all required features are configured

Flé#sh ip ips conf

IFS Signature File Configuration Status
Configured Config Locations: flash:MYIPS/
Last signature default load time: 02:12:39 UTC Mar 1 2002
Last signature delta load time: 02:0%:41 UTC Mar 1 2002
Last event action (SERF) load time: -none-
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IPS

IFS

IFS

IPS

IFS

Task2

General SERP Config:

Global Deny Timecut: 3600 seconds
Global Cverrides Status: Enabled
Global Filters Status: Enabled

Rute Update is not currently cenfigured

Sysleg and SDEE Meotification Status
Event notification through sysleg is enabled
Event notification through SDEE is disabled

sSignature Status
Total Roctive S ilgnatures: 338

Total Inactive Signatures: Z037

Packet Scanning and Interface Status
IPS Rule Configuration

IFS name MYIES
IFS fail closed is disabled
IFS deny-action ips-interface is false
Interface Configuration

Interface FastEthernet(/0

Inbound IFS rule is MYIPS

Cutgeing IPS rule is not set

Category CLI Configuration:
Category all:

Retire: True
Category ics ips basic:

Retire: False

Reconfigure the signature triggered in the previous task to Reset Connection and
generate an Alarm.

By default most of signatures are just generate an Alarm. The IOS software

12.4{15)T3 and later allows signature tuning in the meaning of changing severity

level, action taken or enabling/disabling.
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Configuration

Complete these steps:
Step 1 Check signature 5081 configuration on R1.

Rl¥ sh ip ips sign | inc SOB1|8igID

SigID:SubID En Cmp  RAction Sev  Trait EC AI GET SI SM SW SFR Rel
5081: 0 T I R HIGH o 1 [ 0 0 FA N 100 85109

Hete that the default actien for signature 5081 is Alarm.

Step 2 Reconfigure signature.

Rl {config) #ip ips signature-dafinition
Rl {config-sigdef) #signature 5081
R1 {config-sigdef-sig) #engine

Rl (config-sigdef-sig-engine) #event-acticn reset-tcp-connection produce-alert

Rl (config-sigdef-sig-engine) #exit

Rl (config-sigdef-sig) #exit

Rl (config-sigdef) #exit

Do you want to accept these changes? [confirm]

%I PS—6-ENGINE_BUILDS STRRTED: 02:32:15% UTC Mar 1 2002

%1 PS-6-ENGINE_BUILDING: service-htip - 649 signatures - 1 of 13 engines
%I PS—6-ENGINE RERDY: service-http - build time B854 ms - packets for this
engine will be scanned

%I PS—6—ALL_ENGINE BUILDS COMFLETE: elapsed time 2298 ms

Rl (config)#

Tou need te confirm changes before exit. Note that signature is re-

compiled te apply the changes.

Verification

Te verify perform the same attack type as it was in the previocus task.

Flé#sh ip ips sign | inc 5081
5081: 0 Y ¥ AR HIGH 0 1 o 0 0 FA N 100 5109
RL#

Hote that signature 5081 is now generating an Alarm (A) and sends TCP Rasat
(R} .

E2#telnet 4.4.4.4 80

Trying 4.4.4.4, 80 ... Cpen
GET /system32/cmd. exe

[Connection to 4.4.4.4 closed by foreign hest])
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Hote that the connection is suddenly closed and Alarm has baan generated on the

consola.

R1#
$IPS-4-SIGHRATURE: Sig:5081 Subsig:0 Sav:100 WWW WinNT omd.exe Recess [10.1.12.2:11005 -
= 4.4.4.4:80] RiskRating:100

Task 3

Reconfigure R1 to perform transparent bridging between R2 and R4. This new
network segment should have IP address of 10.1.24.0/24. Configure 10S IPS to
transparently monitor this segment on the R1's f0/0 interface.

105 software 124 and above allows using Transparent IPS which can be useful
M when customers want to protect their network via a typical Cisco 105 IPS device

and can NOT readdress each of the statically defined devices on the trusted

network,

This feature works in conjunction with Integrated Routed Bridging (IRB), which

allows a device to bridge on some interfaces while a Layer 3 Bridged Virtual

Interface (BVI) is presented for routing

Configuration
Complete these steps:

Step 1 R1 bridging configuration.

Rl (config) ibridge 1 protocol isee

Fl (config) #int £0/0

Rl (config-if ) ibridge-group 1

Bl (conf ig-if) #int £0/1

Rl (config-if ) #bridge-group 1

Bl (oonf ig=1if) fexit

Bl (config) #bridge irbk

IRE: genarating 'bridge 1 route ip' configuration command
Rl (config) #int bvil

Rl (config-if)#ip add 10.1.24.1 255.255.2585.0
Fl (config-if ) #nc sh

Step 2 R2 reconfiguration.
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Step 3

Step 4

Step 5

B2 (config) #int g0/0
R2 (config-if)#ip add 10.1.24.2 255,255 ,2858.0

R4 reconfiguration.

P4 (config) #int £0/1
R4 (config-if ) #ip add 10.1.24.4 255,.258,2588.0

Connectivity check.
A quick verification if we still have connectivity.

Rijping 10.1.24.4
Type ascape seguence to abort.

Sending 5, 100-byte ICMP Echos to 10.1.24.4, timecut is 2 seconds:

Success rate is 100 percent (5/53), round-trip minfavg/max = 52/133/272 ms
RZ i

R2fping 10.1.24.1
Type escape seguence to abort.

Sending 5, 100-byte ICMP Echos to 10.1.24.1, timeout is 2 seconds:

Success rate is 80 percent (4/5), round-trip min/avg/max = 92/401/1260 ms
R2#

IPS configuration.

Bince the IFE configuration remained from the previous tasks, the only

thing to do is to assign IPS with Rl's £0/0 interface and load the
signature package into routers memory (as it flushes when IFS is

disablead) .

Rl (config) #int £0,/0

Al (config-if ) #ip ips MYIFS in

Rl (config-1£)#

%I P5-6-ENGINE_BUILDS STARTED: 03:01:10 UTC Mar 1 2002

$IPS-6—ENGINE BUILDING: atomic-ip — 3 signatures — 1 of 13 engines

I P5-6-ENGINE_READY: atomic-ip - build time 20 ms - packets for this engine
will be scanned

%I PS-6-ALL_ENGINE_BUILDS COMFLETE: elapsed time 20 ms
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verification

Blfeopy flash:IoS-2359-CLI.pkg ideonf

SYIPS-3-IFS_FILE OFPEN_ERROR: flash:MYIFPS/Rl-sigdef-typedef.xml - Device in exclusiwve use
%IFS-3-IFS_FILE OFEN_ERROR: flash:MYIFS/Rl-sigdef-category.mml - Device in exclusive
usea

$IPS-6-ENGINE BUILDS STARTED: 03:06:45 UTC Mar 1 2002

$IPS3-6-ENGINE BUILDING: multi-string - 11 signatures - 1 of 13 engines
%IPS-6-ENGINE_READY: multi-string - build time 56 ms - packets for this engine will be
scanned

RIPS-6-ENGINE_BUILDING: service-http - 649 signatures - Z of 13 engines

$IP3-6-ENGINE _READY: service-http - build time 13919 ms - packets for this engine will
ba scanned

$IPS-6-ENGINE BUILDING: string-tep = 1127 signatures - 3 of 13 engines
WIPS-6-ENGINE_READY: string-tcp - build time 46352 ms - packets for this engine will be
scanned

YIP3-G6-ENGINE BUILDING: string-udp - 75 signatures - 4 of 13 engines
$IPS-6-ENGINE_READY: string-udp - build time 1238 ms - packets for this engine will be
scanned

%I PS-6-ENGINE_BUILDING: state - 31 signatures - 3 of 13 engines

$IPS-G-ENGINE READY: state = build time 128 ms - packets for this engine will be
scanned

$IPS-G6-ENGINE BUILDING: atomic-ip - 304 signatures - & of 13 engines

WIPS-E-ENGINE READY: atomic-ip = build time 183% ms - packets for this engine will be
scanned

YIPS=G6-ENGINE BUILDING: string-icmp = 3 signatures = 7 of 13 engines
%IPS—E-ENGINE_RERDY: string-icmp — build time B8l ms - packets for this engine will be
scanned

%IFS-6-ENGINE_BUILDING: service—ftp — 3 signatures — 8 of 13 engines

%IPS-6-ENGINE READY: service-ftp - build time 28 ms - packets for this engine will be
scanned

$IP3-G-ENGINE BUILDING: service-rpe = 75 signatures = 5 of 13 engines
YIPS-6-ENGINE_READY: service-rpc - build time 7%3 ms - packets for this engine will be
scanned

YIPS-G-ENGINE_BUILDING: service-dns - 38 signatures - 10 of 13 engines
$IPS-6-ENGINE_READY: service-dns - build time 188 ms - packets for this engine will be
scanned

%IPS-6-ENGINE_BUILDING: normalizer — 9 signatures — 11 of 13 engines
YIPS-6-ENGINE_READY: normalizer - build time 0 ms - packets for this engine will be
scanned

%IPS-G-ENGINE_BUILDING: service-smb-advanced - 43 signatures = 12 of 13 engines
tIFS—-E-ENGINE_RERDY: service-smb—advanced — build time 108 ms - packets for this engine
will be scanned

YIPS-6-ENGINE BUILDING: service-msrpc - 27 signatures - 13 of 13 engines

$IP3-G-ENGINE READY: service-msrpc - build time 81 ms - packets for this engine will be
sca nned

$IPS-6-ALL_ENGINE BUILDS COMFLETE: elapsed time 65123 ms

To verify perform the same attack type as it was in the previous task.

R2itel 4.4.4.4 80
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Trying 4.4.4.4, 80 ... COpen
GET /system3d2/omd. exe

The signature has besn triggered as sxpected
RL1#

$IP3=4=-SIGHATURE: Sig:5081 Subsig:0 Sev:100 WWW WinNT cmd.exe Reocess [10.1.24.2:11010 =
> 4.4.4.4:80] RiskRating:100
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LAB 3.46. CPU protection mechanisms

10.1.12.0 124

I:H
Rl
A |F it

4 || gip  Le? Led  fpp

| 5 S
o 10.1.45.0 /24 e 0.5
e =
R4 RS

Lab Setup
» R1 and R2's GO/0 interface should be configured in VLAN 12

» R2and R5's 50/1/0 interface should be configured in a frame-relay point-to-
point manner.

» R5 and R4's FO/0 interface should be configured in VLAN 45

» Configure telnet on all routers using password “cisco”

> Run RIPv2 on the routers and advertise their directly connected networks

IP Addressing

Router Interface IP address

R1 Lo0 1.1.1.1/24
FO/0 10.1.12.1/24

R2 Lo0 222224
G0/0 10.1.12.2/24
S0/1/0.25 10.1.25.2/24

R4 Lo0 4.44.4/24
FO/0 10.1.45.4/24

R5 Lo0 5.5.5.5/24
FO/0 10.1.45.5/24
S0/M1/0.52 10.1.25.5/24

Page 391 of 507



CCIE SECURTY vd Lab Workbook

Task 1

Configure R2 so that it will drop traffic from R1's loopback0 interface coming towards
R4's loopback0 interface. Enable logging of dropped traffic. Ensure that only 5
packets per second will be process-switched and no more than 10 syslog messages

per second can be generated except level 4 messages and lower.
No ICMP unreachable messages should be sent back to the source.

M

ACL logging can be CPU intensive and can negatively affect other functions of
the network device. There are two primary factors that contribute to the CPU
load increase from ACL logging:
= process switching of packets that match log-enabled access control
entries
= generation and transmission of log messages
To mitigate that issue you can increase logging interval and rate limit
generation of messages.
In real life there are guite common issues related to high CPU on routers and
switches which are usually caused by the following:
= Packet with TTL=1 came to the router/switch
* Fragmented packets
=  ARP (when router/switch must resolve ARP for the traffic going
through it)
=  ACL with logging

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config) #ip access-list extended Rl-to-R4
R2 (config-ext-nacl)d#deny ip host 1.1.1.1 host 4.4.4.4 log
R2 {config=-ext-nacl)#permit ip any any

R2 (config-ext-nacl)#int go/o0
B2 (config-ifl#ip access-group Rl-to-R4 in
R2 {config=-if)#no ip unreachables

Logging interval limits log-inducted process switching to one packet

per specified time. 8o, if you specify 200 it means there will be 1
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packet per 200ms process switched, resulting 5 packets per 1 second.

R2 (configl #ip access-list leogging interwval 200

Logging rate limiter limits log generation to specified number of logs
per second. Exception means that specified leg levels will KOT be
limited. Hote that when you specify level 4 it sontains lewels 0,1,2,3

as well.

R2 {config) #logging rate-limit 10 except warnings

ver n

Rlfping 4.4.4.4 80 lo0 rep 50

Type escape segquence to abort.

Sending 50, 100-byte ICHMP Echos to 4.4.4.4, timeout is 2 seconds:
Packet sent with a scurce address of 1.1.1.1

Success rate is 0 percent (0/50}

#3EC-6-IPRCCESSLOGDF: list Rl-to-Rd denied icmp 1.1.1.1 -> 4.4.4.4 (0/0), 5 packets

Task 2

On R5 enable IP packets debugging with details for only ICMP and TCP packets
between R2 and R5 loopback0 interfaces. Logging should be disabled on the
console and all debug messages should be directed to the memory buffer without
timestamp information.

Debugging is a high priority and high CPU utilization process that can render
m your device unusable. Use debug commands only to troubleshoot specific

problems. The best times to run debugging are during periods of low network

traffic and using specified ACL to “fifter” debug messages. Debugs should be

also destined to the memory buffer, not the console.

Configuration
Complete these steps:
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Step 1 R5 configuration.

RS (config)léne logging console
B3 (config)#logging buffered 7
R3 (config)l#no service timestamps

RS (config)#access-1list 199 permit icmp host 2.2.2.2 hest 5.5.5.5
RS (config) #access-1ist 19%% permit tep host 2.2.2.2 host 5.5.5.5

BSldesbug ip packet detail 199
IF packet debugging is on (detailed) for access list 15%

Verification

FS#clear legging
Clear logging buffer [confirm]

RE2dp 5.5.5.5 so loO rep 1

Type escape sequence to abort.

Sending 1, 100-byte ICHF Echos to 5.5.5.5, timeout is 2 seconds:
Packet gent with a8 source address of 2.2.2.2

!

Success rate is 100 percent (1/1), round-trip minfavg/max = 5&/56/56 ms

RS#sh legging
Syslog logging: enabled (0 messages dropped, 3 messages rate-limited,

0 flushes, 0 owverruns, zml disabled, filtering disabled)

Ko Actiwve Message Discriminater.

Ko Inactive Message Discriminator.

Consocle legging: disabled

Meniter logging: level debugging, 0 messages logged, xml disabled,
filtering disabled

Buffer logging: level debugging, 15 messages logged, =ml disabled,
filtering disabled

Logging Excepticon size (4096 bytes)

Count and timestamp logging messages: disabled

Persistent logging: disabled
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Ho active filter modules.

ESM: 0 messages dropped
Trap loegging: level informational, 46 message lines logged
Log Buffer (4096 bytes):

IP: 5=2.2.2.2 (Serial0/1/0.52), d4=5.5.5.5, len 100, input feature

ICMFP type=8, code=0, MCI Check(6d4), rtype 0, forus FALSE, sendself FALSE, mt
u 0, fwdchk FALSE
FIRipvi-packet-proc: route packet from Serial0/1/0.52 src 2.2.2.2 dst 5.5.5.5
FIBfwd-proc: Default:5.5.5.5/32 receive entry
FIEipwvd-packet-proc: packet routing failed
IF: tableid=0, s=2.2.2.2 (Serial0d/1/0.52), d4=5.5.5.% (Loopback0), routed via RIE
IP: g=2.2.2.2 (Seriald/1/0.52), d=5.5.5.5, len 100, rowd 4

ICMP type=8, code=0
IP: g=2.2.2.2 (8erisld/1/0.5%2), 4=5.5.5.5%, len 100, stop process pak for forus p
acket

ICMP type=8, code=0

Task3

You will terminate IPSec VPN on the R4 in a near future using onboard hardware
accelerator. To ensure this will not affect router's performance disable hardware
failover to the software crypto engine.

For those situations in which the amount of IPSec traffic is more than can be
handled by hardware accelerator, the failover to the software can affect CPU
performance.

Configuration
Complete these steps:
Step 1 R4 configuration.

Bd (conf ig) #no arypto engine software ipssc
iCR‘IPIﬂ-E-IEHM_UH_DI‘I‘: ISAKMP is OFF
SCRYPTO-6—GDOI_ON_OFF: GDOI is OFF
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Verification

Ri#sh ory eli

Hardware Encryptien : ACTIVE

Humber of hardware crypto engines

CryptoBngine HETGX details:

Capabi lity

IPSec-Session @

IPPCF, DES, 3DES,

0 active,

]
-

state = Active

2400 max,

Fd#sh crypte engine accelarator statistic

Device:
Location: Cnboard: 0

HET&EL

RES, IPwE, GDOI,

0 failed

FRILCLOSE

:Statistics for encryption device since the last clear
of counters 317% seconds ago

o]

L = = I = R = = I = = = = = - - =]

=
=

packets in

bytes in

paks/sec in

¥bits/sec in

packets decrypted
bytes bafore decrypt
bytes decrypted
packets decompressed
bytes before decomp
bytes after decomp
packets bypass decompr
bytes bypass decompres
packets not decompress
bytes not decompressed
compression ratio

Last 5 minutes:

pkts dropped:
fw failure:
ownership err:
fw gs filled:
tx_hi_drops:

packets in
paks/sec in
bits/sec in

bytes decrypted
¥bits/sec decrypted
compression ratio

invalid flow:
null data:

o o o o

[=]

pak too_big:

pak mp length spec fault: 0
Intarrupts: Hotify = 0, Reflected = 0, Spuricus = 0

ring limit:&d

wait session gqueuea:

0 mag

fw_rescurce lock: 0

Lo == = = R = S = = D = =~ I = R = B = =]

packets out

bytes ocut

paks/sec out

Ebits/sec ocut

packets encrypted
bytes encrypted

bytes after encrypt
packets compressed
bytes before comp
bytes after comp
packets bypass compres
bytes bypass compressi
packets not compressed
bytes not compressed

overall

packets ocut
paks/sec out
bits/sec ocut

bytes encrypted
¥bits/sec encrypted
overall

netgx sessions: o

reqld mismatch: 1]

current desc used: 0 current ring index: 0
seagsion buf gueus: 1024
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LAB 3.47. Disabling unnecessary services

Based on the previous Lab's IP addressing, topology and Lab setup

Led

104.12.0 124
Alrag Lot 10.1.45.0 |24
'h-?.- - -
R4

k1

Tas
On R2 disable the following unnecessary services in the global configuration mode:

CDP

TCP and UDP Small Servers

Finger

Web Server and Secure Web Server
BootP Server

DHCP Server

disable all services that you are not using. This is because a service could be

m It is highly recommended to manually or automatically {with AutoSecure)

disabled by default in the previous I0OS release and it might be enabled by
default in the new release. Hence, disabling all services protect you from this
kind of issues.
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Configuration
Complete these steps:

Step 1 R2 configuration.

B2 (cenfig) #ne odp run

B2 (conf ig) #no service top-small-servers
R2 (config) #nc service udp-small-servers
R2 (configli#no ip http server

R2 (config)#no ip http secure-server

R2 (config)#no ip bootp server

B2 (conf ig) #no service dhop

Task 2
On R5 use automatic script to secure and lock the router's management plane.

The auto secure command allows a user to disable common IP services that
can be exploited during network attacks by using a single CLI command. This
command eliminates the complexity of securing a router both by automating
the configuration of security features and by disabling certain features that are
enabled by default and that could be exploited for security holes,

Configuration
Complete these steps:

Step 1 R5 configuration.

RS #aute secure management
-== putoSecure Configuration ---

*#** AutoSecure configuration enhances the security of
the router, but it will not make it absclutely resistant
te all security attacks ==+

RutcSecure will modify the configuration of your device.

Rll configuration changes will be shown. For a detailed
explanation of how the configuration changes enhance security
and any possible side effecta, plemse refer to Claco.com for
Autosecure documentation.

At any prompt you may enter '?' for help.
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Use ctrl=c to abort this session at any prompt.

Gathering information about the router for RAutoSecure

Iz this router connected to internet? [no] :

Securing Management plane gervices...

Disabling service finger

Disabling service pad

Disabling uwdp & tcp small servers
Enabling service password encryption
Enabling service tcp-kKeepalives-in
Enabling service tcp-keepalives-out
Disabling the cdp protocol

Digabling the bootp server
Diszabling the http searver
Disabling the finger service
Disabling scurce routing
Digsabling gratuitous arp

Here iz a sample Security Banner te be shown
at every access to device. Modify it to suit your
enterprise requirements.

Ruthori zed Rccess only
This syatem is the property of So-&-So-Enterprisa.
UNAUTHORIZED RCCESS TO THIS DEVICE IS PRCOHIBITED.
You must have explicit permission to access this
device. Rll activities performed on this device
are logged. Any wviclations of access policy will result
in disciplinary action.

Enter the security banner [Put the banner betwesn

k and k, where k is any character}:

K

Authori zed Reccess only
This system is the property of So-&-So-Enterprise.
UNAUTHCORIZED RCCESS TO THIS DEVICE IS PRCHIBITED.
You must have explicit permission to access this
device. Rll activities performed on this device
are logged. Any wvieclations of access policy will result
in disciplinary action.

k

Enable secret is either not configured or

is the same as enable password

Enter the new snable secret:

Confirm the enable secret :

Enter the new enable password:

Confirm the enable pasaword:
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Configuration of local user database

Enter the username: plotr

Enter the password:

Confirm the password:

Configuring ARA local authentication

Configuring Console, Aux and VIT lines for

local authentication, exec-timecut, and transport
Securing device against Login Attacks

Configure the following parameters

Blocking Periecd when Login Attack detected: 10

Maximum Login failures with the dewvice: 3

Maximum time period for crossing the failed login attempts: 1

Configure S8H serwver? ([yes]:
Enter the domain-name: MicronicsTraining.com

Configuring interface specific AutoSecure services
Disabling the following ip services on all interfaces:

no ip redirects

ne ip proxy-arp

ne ip unreachables

no ip directed-broadcast

no ip mask-reply
Diszabling mop on Ethernet interfaces

This is the configuration generated:
sarvice finger

gervice pad
sarvice udp-small-servers

g 8 8

no service top-small-servers

service password-encryption

gervice tcop-keepalives-=in

sarvice tcp-keepaliwves-out

no ocdp run

ne ip bootp server

no ip http server

no ip finger

ne ip source-route

no ip gratultous-arps

ne ip identd

banner motd “C°C

sacurity passwords min=-length &

gecurity authentication failure rate 10 log
enable secret 5 515Bu/MSZbE21c¥K1idhvT . wOLRHT.
enable password 7 045802150C2E0Z 1FSEBAR
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username piotr password 7 031452041210701E1D
aaa new-model
aaa authentication legin local auth lecal

line con O

login authentication local auth
exec-timscut 5 0

transport output telnsat

line aux 0

login authentication local_auth
exec-timecut 10 0

transport cutput telnet

line vty 0 4

leogin authentication local _auth
transport input telnet

line tty 1

login authentication local auth
exec-timsocut 15 0

login b
ip doma
crypto
ip ash
ip ssh
line vt
t ransp
service
service
logging
logging
service
logging
logging
interfa
ne ip
no ip
ne ip
no ip
noe ip
no mop
interfa
no ip
no ip
noe ip
no ip
ne ip
no mop
interfa
no ip
no ip
no ip
no ip
no ip

lock-for 10 attempts 3 within 1
in=name MicronicsTraining.com
key generate rsa general-keys modulus 1024
time=-out 60
authentication-retries 2
¥y od
ort input ssh telnet

timestamps debug datetime msec localtime show-timezone
timsstamps log datetime msec localtime show-timeszone
facility local2

trap debugging
sequence-numbe rs

console critical

buffeced
ce FastEthernet0/0

redirects
Proxy-arp

unreachabl as
directed-broadcast

mask-reply

enabled

ce FastEthernet0/1

redirects

prozy-arp

unreachables
directed-broadcast

mask-reply

enabled

ce Seriald/0/0

redirects

pProxy-=-arp

unreachables
directed-broadcast

mask-reply
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Task3

interface Seriald/0/1

noe ip redirects

no ip proxy-arp

noe ip unreachables

no ip directed-broadcast
no ip mask=-reply
interface Seriald/1/0

no ip redirects

ne ip proxy-arp

no ip unreachables

ne ip directed-broadcast
no ip mask=-reply
interface Serial0/1/0.52
no ip redirects

ne ip proxy-arp

no ip unreachables

no ip directed=-broadcast
no ip mask-reply
interface Seriald/2/0

ne ip redirects

no ip proxy-arp

ne ip unreachables

no ip directed-broadcast
no ip mask-reply

and

Apply this configuration to running-config? [yes]:

Applying the coenfig generated to running-config

The name for the keys will be: R5.MicronicsTraining.com

% The key modulus size is 1024 bits
% Generating 1024 bit RSA keys,

RS

keys will be non-exportable...[CK]

WAUTCSEC-1-MODIFIED: AutocSecure configuration has been Medified on this device

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.48. Configuring SNMP

Based on the previous Lab's IP addressing, topology and Lab setup

Led

10.1.12.0 124
.4 ||: oo Lad
— 10.1.45.0 /24
R4

Task 1
On R1 configure SNMP version 2 so that it can be managed remotely only from the
NMS (Network Management System) at IP address of 172.16.1.254.
Use the following configuration:

Read-Only Community name: SNMP-RO

Read-Write Community name: SNMP-RW

SNMP Location: Los Angeles, CA
SNMP Contact: Micronics Training Inc.
SNMP Chassis ID: 6786239AC

In addition to that, configure R1 to send out SNMP Traps to the same NMS station
using version 2c and community string of SNMP-TRAPS. Those traps must be
sourced from R1's loopback0 interface.

Configuration
Complete these steps:
Step 1 R1 configuration.
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Fl (conf ig) #access-list
Rl (conf ig) #ésnmp-sarver
Rl {conf ig) #znmp-sarver
Rl (conf ig) ésnmp-server
Bl (conf ig) #anmp-sarver
Rl (conf ig) #anmp-sarver
Rl (conf ig) #znmp-sarver
Fl (conf ig) #anmp-server
Rl (conf ig) ésnmp-server

Verification

Fl#sh somp heost

79 parmit 172.16.1.254

community SHMF-FO ro 99

community SHMP-BW rw 99

location Los Angeles, CA

contact Miocronias Training Ina.

chassis-id 67T86238AC

enable traps snmp authentisation linkdown linkup
host 172.16.1. 254 version 2c SHMP-TRAFS
source-interface traps lo

Hotification host: 172.16.1.254 udpport: 162  type: trap

user: SHMP-TRRAFS gecurity

Rlé#sh snmp commndty

Communi ty name: ILMI

Community Index: ciscod
Commini ty SecurityName: ILMI
storage—-type: read—only active

Community name: SHMP-RO
Community Index: ciscel
Commni ty SecurityMame: SHMP-RD

storage-type: nonvolatile

Community name: SHMP-RW
Communi ty Index: ciscol
Community SecurityMame: SNMP-RW
storage-type: nonvolatile

Community name: SHMP-TRAFS
Commnity Index: cliscol

model : v2e

active access-list: 59

active access-list: 99

Communi ty SecurityHame: SHMF-TRAFS

storage-type: nonvolatile

Rlé#sh snmp chassis
&7 BEZ3IAC

Rl#sh snmp contact

active
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Micronics Training Inc.

Flé#sh sonmp location

Loz Angeles, CR

Task 2

On R2 configure SNMP version 3 with a group of GR_SNMPv3 and a user named
SNMPuser with a secure password of “cisco123". Allow the NMS station from IP
address of 172.16.1.254 to access the router and authenticate using SNMPuser's

credentials.

Configuration

Complete these steps:

Step 1

Verification

R2 configuration.

RZ (config) #snmp-server group GR_SWMPv3 v3 auth
R2 (config) #snmp-server user SHMFuser OF_SHMFvI v3 auth mdS ciscol23

Configuring snmpv3 USM user, persisting sompEngineBoots. Flsase Wait...

R2 (config) #ésnmp-server host 172.16.1.254 version 3 auth SHMFuser

B2 §sh snmp host
Hotification host: 172.16.1.254 udp-port: 162 type: trap

user: SHMPuser security model: w3 auth

RZ#sh snmp user

User name: SHMFuser

Engine ID: BO0000090300001819F33D50
storage-type: nonvolatile active
Authentication Protocol: MDS

Privacy Protocol: Hone

Group-name: GR_SHMEPvi
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EZ#sh snmp group
groupname: ILMI
readview : #*ilmi

security model :vwl
writeview: #ilmi

notifywiew: <no notifywiew specified>

row status: active

groupname: ILMI
readview : *ilmi

security model :vie
writewview: *ilmi

notifiywiew: <no notifyview specified>

row status: active

groupname: GR_SHMPV3
readview : vildefault

security model :w3 auth
writeview: <ne writeview specified>

notifyview: *tv.FFFFFFFF.FFFFFFFF.FFFFFFFF.F

row status: active

B2 §ash snmp view

*ilmi system - included permanent actiwe
*ilmi atmPferumlni - included permanent active
vldefault ise - included permanent actiwve

vldefault internet.6.3.15
videfault internet.6.3.16
wldefault internet.6.3.18
wvidefault ciscoMgmt.3%4 -
vildefault ciscoMgmt.3ss -
videfault ciscoMgmt.3%% =
vidafault ciscoMgmt.d400 -

= axcluded permanent active
= excluded permanent active
= axcluded permanent actiwve
excluded permanent actiwve
excluded permanent active
excluded permanent active
excluded permanent actiwve

*tv.FFFFFFFF. FFFFFFFF.FFFFFFFF.FFFFFFFFOF ieeefl2dotll - included wolatile actiwve

*tw.FFFFFFFF. FFFFFFFF.FFFFFFFF.FFFFFFFFOF internet - included wolatile actiwve

Task3

Your company’s helpdesk support needs an access to R2 router via SNMP to
perform basic troubleshooting. You are asked to configure the router with the

following options:

SNMP version: 3

SNMP user name: U_HELP1 (no password)
SNMP user permissions: read all system and interfaces MIBs, no write permissions
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Configuration

Complete these steps:
Step 1 R2 configuration.

R2 (config) #anmp-server group GR_HELFl v3 noauth read V_HELFL
B2 (conf ig) #snmp-server user U HELP1 GR_HELF1 w3

R2 (config) #snmp-server view V_HELFl system included

R2 (config) #snmp-server view V_HELFl interfaces included

Verification

E2ish snmp user

User name: U_HELF1

Engine ID: 8000000503000016813F33D50
storage-type: nonvolatile active
Ruthentication Protocel: Hene

FPrivacy Protocol: Hone

Group-name: GR_HELFL

User name: SHMPuser

Engine ID: BO00000S5030000181%F33D50
storage—-type: nonvolatile active
Authentication Protocol: MDS

Frivacy Frotocol: Hone

Group=name: GR_SNMPv3

R2#sh snmp group
groupname: ILMI
readview @ *ilmi

netifyview: <noe notifyview specified:

row status: active

groupname: ILMI
readview : *ilmi
notifyview: <no notifyview specified>

row status: active

groupname: GR_HELFL
readview : V_HELFL
notifyview: <no notifyview specified>
row status: active

groupname: GR_SHMFV3
readview : vildefault

security model jvl
writeview: *ilmi

security model :v2c
writewiew: *ilmi

security model :v3 noauth
writeview: <no writeview speci fied>

security model :v3 auth
writeview: <no writeview specified>
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notifyview: *tv.FFFFFFFF.FFFFFFFF.FFFFFFFF.F

row status: active

R2§sh snmp view

#*ilmi system - included permanent actiwve

#11lmi atmForumini - included permanent actiwve
¥_HELFl system - included nonwvolatile active
¥_HELPl interfaces - included nonvolatile active

videfault
widefault
widefault
wldefault
widefault
widefault
videfault
widefault

ise = included permanent actiwve

internet .6.3.15 - excluded permanent active
internet.6.3.16 - excluded permanent actiwve
internet .6.3.18 - excluded permanent active
clscoMgmt, 354 - excluded permanent actiwve
ciscoMgmt. 395 - excluded permanent active
clscoMgmt. 399 - excluded permanent active
ciscoMgmt. 400 = excluded permanent actiwve

*tv.FFFFFFFF. FFFFFFFF.FFFFFFFF.FFFFFFFFOF ieeafl2dotll - included wolatile actiwve

“tv.FFFFFFFF. FFFFFFFF.FFFFFFFF.FFFFFFFFOF internet - included weolatile actiwve

Task 2

You company’s 3rd line network support needs access to R5 router to perform
troubleshooting and secure management via SNMP version 3.
Configure R5 so that it allows secure SNMPv3 connections using username of

“U_PRIVATE" with a password of “cisco123". The connection must be secured using
AES 256 encryption algorithm with a key of “cisco456".

The user must have read-write access to all system, interfaces and ip MIBs. The
NMS station is at 172.16.1.254.

Configuration

Complete these steps:

Step 1

R5 configuration.

RS (config) #snmp-server group GR_PRIVATE v3 priv write V_FRIVATE

RS (config) #snmp-server user U FRIVATE GR _FRIVATE v3 auth mdS ciscelld priv
ass 256 aciscod5e

RS (config) #

Configuring snmpv3 USM usar, parsisting snmpEngineBocts. Pleasse Wait. ..

RS (config) #snmp-server view V FRIVATE system included
RS (config) #snmp-server view V_FRIVATE interfaces included
RS (conf ig) #snmp-server view V_FRIVATE ip included
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Veri n

RS (config) #anmp-server host 172.16.1.254 version 3 priv U_FRIVATE

RE#sh snmp host
Hotification heost: 172.16.1.254 udp-port: 162 type: trap
user: U_FRIVATE security model: v3 priv

BS#sh snmp user

Uzer name: U FRIVATE
Engine ID: 800000050300001B0515R1 60
storage-type: nonvolatile active

Authentication Protocel: MDS
Privacy Protocol: RES256
Group-name: GR_FRIVATE

RE#sh snmp group

gEGUpnAmE:
readview :

ILMI security model :wl
®§Imi writeview: ®*ilmi

notifyview: <no notifyview specified>

row status: active

groupnams:
readview :

ILMI seacurity model :w2c
=ilmi writeview: ®*ilmi

notifyview: <no notifyview specified»>

row status: active

g OUPTIAmeS :
readview :

GR_FRIVATE security model :vw3 priwv
videfault writeview: V_PRIVATE

notifyview: *tw.FFFFFFFF.FFFFFFFF.FFFFFFFF.F
row status: active

BES#sh snmp view
*ilmi system - included permanent active
#i1lmi atmForumini - included permanent actiwve

¥_FRIVATE
¥V_PRIVATE
V_FRIVATE
videfault
videfault
videfault
vidafault
videfault
widefault
videfault

System - included nonvelatile active
interfaces - included nonvolatile active
ip - included nonweolatile active

iso - included permanent actiwve
internet.6.3.15% - excluded permanent actiwve
internet.6.3.16 - excluded permanent active
internet.6.3.18 - axcluded permanent actiwve
ciscoMgmt.3%4 - excluded permanent active
ciscoMgmt. 335 - excluded permanent actiwve
cliscoMgmt, 399 - excluded permanent active
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vldefault ciscoMgmt.400 - excluded permanent actiwve
*tv.FFFFFFFF. FFFFFFFF.FFFFFFFF.FPFFFFFFOF ieeaB02dotll - included wolatile active
#tv.FFFFFFFF. FFFFFFFF.FFFFFFFF.FFFFFFFFOF internet - included wolatile actiwve
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LAB 3.49. Configuring SYSLOG

Based on the previous Lab's IP addressing, topology and Lab setup

Led

10.1.12.0 124
.4 ||: oo Lad
e 10.1.45.0 124
R4

Task 1

On R1 configure system logging so that the router sends SYSLOG messages to the
server at 172.16.1.254 using its loopback0 interface as a source.

All system messages must have time and date attached to the message. The
console should be configured to display system messages up to Critical severity

level.
Configuration

Complete these steps:
Step 1 R1 configuration.

Rl (config) #logging host 172.16.1.254

Bl (config) #service timestamps log datetime
Pl (config) #logging console critical

Rl {config) #logging source-interface 1o0

Page 411 of 507



CCIE SECURTY vd Lab Workbook

Verification

Rli#sh logging
Syslog logging: enabled (0 messages dropped, 3 messages rate-limited,
0 flushes, 0 overruns, ¥ml disabled, filtering disabled)

He Active Message Discriminater.

Ko Inactive Message Discriminator.

Consele leogging: level critical, 27 messages logged, xml disabled,
filtering disabled

Moniter legging: level debugging, 0 messages logged, xml disabled,
filtering disabled

Buffer logging: disabled, xml disabled,
filtering disabled

Logging Exception size (4096 bytes)

Count and timestamp logging messages: disabled

Persistent logging: disabled

Ko active filter modules.
ESM: 0 messages dropped

Trap legging: lewvel informaticnal, 31 message lines logged
Logging to 172.16.1.254 (udp pert 514, audit disabled,

authentication disabled, encryption disasbled, link up),
2 message lines logged,
0 message lines rate-limited,
0 message lines dropped-by-MD,
zml disabled, sequence number disabled
filtering disabled

Task 2

SYSLOG server administrator noticed you that you must send all SYSLOG
messages to the server using facility name of “local7 to be correctly processed by
the server.

In addition to that enable logging of user info on privileged mode enabling and rate
limit SYSLOG messages sent to the console to 2 messages per second. Do not rate
limit messages with a severity level of Critical or higher.
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Configuration
Complete these steps:

Step 1 R1 configuration.

Fl (cenfig) #logging facility leealT
Bl (conf ig) #logging rate-limit console 2 axcept 2
Fl (cenf ig) #legging userinfo

Task 3

On R2 enable configuration change archiving so that the router sends its
configuration on TFTP server at 172.16.1.254 in the “backups” directory. The
archiving process should notice SYSLOG server at 172.16.1.254. Ensure that no
passwords are visible in the archived copy and the router writes its configuration
every time before archiving.

Configuration
Complete these steps:

Step 1 R2 configuration.

R2 (config) #archive
B2 (config-archive) #path tftp://172.16.1.254 /backups/
F2 (conf ig-archive ) fwri te-memory

R2 (conf ig-archive)#log config
R2 (conf ig-archive-log-cfg) #logging enable
B2 ({conf ig-archive -leg-cfg) #hidekays

R2 (conf ig-archive-log-cfg) #notify syslog

R2 (config)¥logging host 172.16.1.254
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Verification

R2ish logging
Syslog logging: enabled (0 messages dropped, 0 messages rate-limited,
0 flushes, 0 overruns, ¥ml disabled, filtering disabled)

He Active Message Discriminater.

Ko Inactive Message Discriminator.

Console logging: lewvel debugging, 36 messages logged, xml disabled,
filtering disabled

Moniter legging: level debugging, 0 messages logged, xml disabled,
filtering disabled

Buffer logging: lewvel debugging, 36 messages logged, =ml disabled,
filtering disabled

Logging Exception size (8192 bytes)

Count and timestamp logging messages: disabled

Parsistent logging: disabled

Ko active filter modules.
ESM: 0 messages dropped

Trap legging: level informaticnal, 40 message lines logged
Logging to 172.16.1.254 (udp pert 514, audit disabled,

authentication disabled, encryption disasbled, link up),
13 message lines logged,
0 message lines rate-limited,
0 message lines dropped-by-MD,
zml disabled, sequence number disabled
filtering disabled

Log Buffer (8192 bytes):

R2i#sh archive
The maximmm archive configurations allowed is 14.

The next archive file will be named tftp://172.16.1.254/backups /-0
Archive § HName

1

m =1 ot E Ww k
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]

10
R2 bwr
Building cenfiguration...
[oK] !'!

R2#sh archive

The maximim archive configurations allowed is 14.

The next archive file will be named tftp://172.16.1.254/backups/-1
Archive # HName

tftp://172.16.1. 254/backups/=0 <- Most Recent

oo = 3y U W W R

[+]

-
-
=)
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LAB 3.50. Configuring NTP

Based on the previous Lab's IP addressing, topology and Lab setup

Led

10.1.12.0 124
Alran Lot 10.1.45.0 /24
R4

Task 1
On R1 and R4 configure NTP server with Stratum 5 and server authentication using
MD5 key of “cisco123". The R1 can be synced with an IP address of 4.4.4.4 and give
out time to R2 only.

Allow only R2's loopback0 interface to get time from this server and configure R2 as
a client to that server.

This lab ilustrates structured NTP configuration with verification. Hence, the
M final configuration is divided to a few parts.

First, configure basic NTP server without any authentication or filtering.

Configure R2 as a client to that server and see if it gets the time.

Con ration
Complete these steps:
Step 1 R1 configuration — NTP Server.
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Fl (config)#ntp master 5

Rl (config)#ntp access-group sarve-only 5
Bl (conf ig) #acoess-1list 5 permit 2.2.2.2

Rl (config) éntp access-group peer 1
Bl (config) #acoess-1list 1 permit 4.4.4.4
Fl (config)éntp peer 4.4.4.4

Step 2 R2 configuration = NTP client.
B2 (conf ig) intp source lod
R2 (config)i¥ntp server 1.1.1.1
Step 3 R4 configuration — NTP Server.

Bd (config)#ntp master 5
Fd (config)#ntp sourcas lod

Quick verification

Rl#sh ntp asscciations

address ref clock Bt when pell reach delay offset disp

"~127.127.1.1 .LOCL. 4 15 18 377 0.000 O.000 0.237

~4.4.4.4 127.127.1.1 5 40 21 357 0.000 -21637% 5.681
* sys.peer, # selected, + candidate, - ocutlyer, = falseticker, ~ configured

Rlish ntp status
Clock is synchronized, stratum 5,

refarence is 127.127.1.1

nominal freq is 250.0000 Hz, actual freq is 250, 0000 Hz, precision is 2*+24
reference time is DOZDCES3.322CSEAS (08:07:47.19%5 UTC Sun Sep 5 2010)

clock offset is 0.0000 msec, root delay is 0,00 msec

root dispersion is 0.00 msec, peer dispersion is 0.00 msec

loopfilter satate is "CTRL'

(Hormal Controlled Loop), drift is 0.000000000 s/=

gystem poll interval is 16, last update was 3 sec ago.

Flé#sh ntp asscciations detail

127.127.1.1 configured, our master, sane, valid, stratum 4

raf ID .LOCL., time DO2DCE43.322BD3DS

(08:07:31.155 UTC Sun Sep 5 2010}

cur mode active, peer mode passive, our poll intvl 16, peer poll intwvl 16

root delay 0.00 msec, root disp 0.00, reach 377,
delay 0.00 msec, offset 0.0000 msec, dispersion 0.23
precision 2#*24, wersion {
org time DO2DCE43. 322BD3DS
rec time DOZDCE4{3. 322CT7ETH
=mt time DOZDCE43. 322B5862

filtdelay = 0. 00

{(08:07:31.195 UTC Sun Sep
(08:07:31.15%5 UTC Sun Sep

.00 .00 0.00 .00

sync dist 0.00

5 2010}
5 2010)

(08:07:31.155 UTC Sun Sep 5 2010}

0. 00
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filtoffset = 0.00 .00 .00 0.00 0.00 0.00 .00 .00
filterror = 0.00 .00 .00 0.00 0.00 0.00 .00 0.00

minpell = 4, maxpeoll = 4

4.4.4.4 configured, insane, invalid, stratum 5

ref ID 127.127.1.1 , time DOZDCELE.BFA4656C (08:06:46.748 UTC Sun Sep 5 2010}
our mode active, pesr mode passive, our pall intvl 64, peer pell intvl &4
root delay 0.00 msec, root disp 0.38, reach 357, sync dist 156.57

dalay 0.00 msec, offset -216375.3748 msec, dispersion 5.68

precision 2%%24, wversion 4

org time DOZDCEZL.BFB3ECE3 [08:06:57.748 UTC Sun Sep 5 2010)

rec time DO2DCEZE. 055B3AG3 (08:07:07.020 UTC Sun Sep 5 2010)

#mt time DOZDCE2Z, 322C1D02F (08:06:58.195 UTC Sun Sep 5 2010)

filtdelay = G.01 G.01 .01 0.01 G.01 G.01 G.01 .01
filtoffset = -3.,26 -9.26 -9.26 -9,26 -216.38 -Z16,38 -216.37 -Z16. 37
filterror = 0. 00 0. 00 0. 00 0.00 0.00 0. 00 0. 00 0. 00
minpoll = 6, mazpell = 10

Féd#sh ntp status

Clock is synchronized, stratum 5, reference is 127.127.1.1

nominal freq is 250.0000 Hz, actual freq is 250. 0000 Hz, precision is 2%%24
reference time is DOZDCESY.BFB43T77D (0B:07:53.748 UTC Sun Sep 5 2010}

cleck offset is 0.0000 msec, reot delay is 0.00 msec

root dispersion is 0.00 msec, peer dispersion is 0.00 msec

loopfilter state is '"CTRL' (Hormal Controlled Loop), drift is 0.000000000 s/s
system poll interval is 16, last update was 15 sec ago.

Rid#sh ntp asscciaticns detail

10.1.12.1 dynamic, insane, invalid, stratum 5

raf ID 127.127.1.1 , time DOZDCES3.322C5EAS (08:07:47.19%5 UTC Sun Sep 5 2010)
our mode passive, pesar mode active, ocur poll intvl 64, peer poll intwvl 64
root delay 0,00 msec, root disp 0.44, reach 376, sync dist 189.08

delay 0.00 msec, offset 216380.7571 msec, dispersion 5.68

precision 2**24, wversicn 4

org time DOZDCEGL. 3Z2CZRA3A (08:08:01.15%5 UTC Sun Sep 3 Z010)

rec time DOZDCEST.FO24178D (08:07:51.938 UTC Sun Sep 5 2010)

xmt time DOZDCEGL.BF83SFFD (08:08:01.748 UTC Sun Sep 5 2010)

filtdelay = 0.01 0.01 [ 0.01 .01 207.13 0.01 g.01
filtoffaet = 9.26 9.26 9.26 9.26 9.26 112.82 216.38 216.37
filterror = 0. 00 0. 00 0.00 0.00 0.00 0. 00 0. 00 0.00
minpoll = 6, mazpell = 17

127.127.1.1 configured, our master, sane, valid, stratum 4

raf ID .LOCL., time DOZDCEGS.BFO3BODO (08:08:09.748 UTC Sun Sep 3 2010}
our mode active, peer mode passive, our poll intvl 16, peer poll intvl 16
root delay 0.00 msec, root disp 0.00, reach 377, sync dist 0.00

delay 0.00 meec, offset 0.0000 msec, dispersion 0.23

precision 2%%24, wersion 4

org time DOZDCEGS.BFE3IBODD (08:08:09.748 UTC Sun Sep 5 2010)
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Con

rec time DOZDCEGS.BFI464BC (08:08:09.748 UTC Sun Sep 5 2010)
=mt time DOZDCE&S.BFE3LDDD (08:08:09.748 UTC Sun Sep 5 2010)

filtdelay = 0. 00 0. 00 0. 00 0.00 0.00 0. 00 0. 00 .00
filtoffset = 0. 00 0.00 .00 0.00 0.00 0. 00 0.00 0.00
filterror = 0.00 .00 0. 00 0.00 0.00 0.00 .00 .00

minpoll = 4, mazpell = 4

R2#sh ntp associations detail

1.1.1.1 configured, ocur_master, sane, wvalid, stratum 35

ref ID 127.127.1.1 ¢ time DOZDCEGS.3ZZCLIADD (08:08:05.19%5 UTC Sun Sep 5 Z010)
our mede client, pear mode server, ocur pell intvl 64, peer pell intwl 64

root delay 0.00 msec, root disp 0.42, reach 377, sync dist 0.00

delay 0.00 meec, offset 12.4633 msec, dispersion 3.27

precision 2**24, version 4

org time DOZDCETL. 481565RF (08:08:17.281 UTC Sun Sep 5 2010)

rec time DO2DCETL. 44BDF376 (08:08:17.268 UTC Sun Sep 5 2010)

zmt time DOZ2DCETL. 445R8560 [08:08:17.267 UTC Sun Sep 5 2010)

filtdelay = 0. 00 .00 .00 0.00 0.00 0. 00 .00 0. 00
filtoffset = 0.0L .01 .01 0.01 0.0L1 0.0L .01 .01
filterror = 0.00 .00 .00 0.00 0.00 0.00 .00 .00

minpoll = 6, maxpoll = 10

BE2f#sh ntp status

Cleck is synchronized, stratum 6, reference is 1.1.1.1

nominal freg is 250.0000 Hz, actual freg is 249.999%9% Hz, precision is 2%%#24
rafarance time is DOZDCD2F.43EZEE63 (08:02:55.265 UTC Sun Sep 5 2010)

clock offset is 0.0124 msec, root delay is 0.00 msec

root dispersion is 0.02 msec, peer dispersion is 0.00 msec
loopfilter state is "CTRL' (Mormal Controlled Loop), drift is 0.000000091 s/s
system poll interval is 64, last update was 358 sec ago.

Configure authentication on Rl and R2.

ration
Complete these steps:
Step 4 R1 NTP authentication.
Fl (config)#intp authentication-key 1 md5 ciscel2d

Rl (config) intp authenticate
Fl (config) #ntp trusted-key 1

Step 5 R2 NTP authentication.

R2 (config)intp authentication-key 1 mdiS ciscol23d
R2 (config)#ntp authanticate
B2 (config)ntp trusted-key 1
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Verification

B2 f#sh ntp associations

address raf clock Bt when poll reach delay offaet diap
*~1.1.1.1 127.127.1.1 5 53 64 17 0,000 19.670 238.40
* gys.peer, W selected, + candidate, - outlyer, x falseticker, -~ configured

F2#sh ntp asscciations datail

1.1.1.1 configured, cur_master, sane, valid, stratum 5

ref ID 127.127.1.1 , time DO20D16D.322887E1 (08:21:01.1%5 UTC Sun Sep 5 2010}
our mode client, pesr mode server, ocur pell intvl &4, peer poll intwl 64

root delay 0.00 mesec, root disp 0.45, reach 17, sync dist 0.94

dalay 0.00 msec, offset 19.6706 msec, dispersion 538.40

precision 2##24, wversion {

org time DO2DD17C. 4B1B6GRE (08:21:16.293 UTC Sun Sep 5 2010)

rec time DOZ2DD1T7C. 464RAZRADZ (08:21:16.274 UTC Sun Sep 5 2010)

mt time DO20D1T7C. 43C30437 (08:21:16.272 UTC Sun Sep 5 2010)

filtdelay = 0. 00 0. 00 0. 00 0.00 0.00 0. 00 .00 .00
filtoffsat = 0.01 .01 .01 0.01 0.00 0. 00 .00 .00
filterror = 0. 00 .00 .00 0.00 16.00 16. 00 16.00 16.00

minpoll = &, mazpell = 10

BZf#sh ntp status

Cleck is synchronized, stratum 6, reference is 1.1.1.1

nominal freq is 250.0000 Hz, actual freq is 250. 0000 Hz, precision is 2%#=324
raference time is DO2DD17C.464A2ZAD2 (08:21:16.274 UTC Sun Sep 3 2010)

clock offset is 0.0196 msec, root delay ia 0.00 msec

root dispersicon is 0.96 msec, peear dispersion is 0.9%3 msec
loopfilter state is "CTRL' (Mormal Controlled Loop), drift is 0.000000000 =/2
system poll interval is 64, last update was 30 sec ago.
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LAB 3.51. Protocol authentication and

route filtering

Based on the previous Lab’s IP addressing, topology and Lab setup

Led

N

Eum| zﬁiunm.zs

10.1.12.0 124

1

1

1 L1250 24
\

10.1.45.0 124 Led Fum| 5 M

Task0-P nfiquration:
# Initially, do NOT run any routing dynamic protocol.

Task 1
Run RIPv2 between R1 and R2 on the following directly connected networks:
* R1-10/0,loD
= R2-G0/0
Configure MD5 authentication for RIPv2 updates with a key string of “cisco123”.

Configuration
Complete these steps:

Step1 R1 configuration.

Rl (conf ig) #router rip

Bl (cenf ig-routar) $version 2

fl (conf ig-reuter) #nc aute-summary
Bl (conf ig-router) §network 10.0.0.0
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Bl (conf ig-router) #netwerk 1.0.0.0

Rl (config) #key chain RIP
Pl (conf ig-keychain) #key 1
Bl (conf ig-keychain-key) fkey-string ciscolll

Rl (conf ig) #int £0,/0
Fl (config-if ) #ip rip authentication modsa mdS
Pl (config-if ) #ip rip authentication key-chain RIF

Step 2 R2 configuration.

B2 (conf ig) #router rip

B2 (conf ig-router) #version 2

B2 (conf ig-router) #nc auto-summary

R2 (conf ig-router) fnetwork 10.0.0.0

B2 (conf ig-router) §passive-interface default
R2 (conf ig=-router) #no passive-interface g0/0

R2 {config) #key chain RIP
B2 (conf ig-keychain) fkey 1
R2 (conf ig-keychain-key) #key-string ciscol23

R2 (conf ig-keychain-key) #int g0,/0
B2 (config-if) #ip rip authentication mods mdS
R2 (config-if ) #ip rip authentication key-chain RIF

Verification

Rli¥sh ip protocols

Routing Frotocel is “rip"
outgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set
Sending updates every 30 seconds, next due in 20 seconds
Invalid after 180 seconds, hold down 180, flushed after 240
Redistributing: rip
Default wversion control: send version 2, receiwve wversion 2

Interface Sand Recv Triggered RIF HKey-chain
FastEthe rnetd/0 4 Zz RIF
Loopback 0 2 2

Rutomatic netwerk summarization is not in effect
Maximum path: 4
Reuting for Metworks:

1.0.0.0
10.0.0.0
Routing Informatisn Sources:
Gateway Distance Last Update
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10.1.12.2 120 Oo:00:11
Distance: (default is 120}

Flé#sh ip route

Codes: C - connected, 85 - static, R - RIP, M - mobile, B - BGP
0D = EIGRP, EX = EIGRF external, O = OSPF, IA - O3SFF inter area
Nl = OSPF NSSA external type 1, M2 = CSPF MNSSA external type 2
El - OSPF external type 1, E2 - OSPF external type 2
i - 18-1I8, su - I58-18 summary, Ll - I5-I5 lewel-1l, LZ - I5-I5 level-2
ia = IS-IS3 inter area, * - candidate default, U - per-user static route
o = ODR; F - pericdic downloaded static route

Gateway of last resort is not set

1.0.0.0/24 is subnetted, 1 subnets

C 1.1.1.0 is directly connected, Loopback0
10.0.0.0/24 is subnetted, 2 subnets
C 10.1.12.0 is directly connected, FastEthernetd/0
B 10.1.25.0 [120/1) wia 10.1.12.2, 00:00:00, FastEthernetO/0

R2#sh ip protocols

Routing Protocol is "rip"
tutgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set
Sending updates every 30 seconds, next due in 15 seconds
Invalid after 180 seconds, hold down 180, flushed after 240
Redistributing: rip
Default wersion control: send version 2, receive version 2

Interface Send Recv Triggered RIF Key-chain

GigabitEthernetl/ 0 2 2 RIF
ARutomatic network summarization is not in effect
Maximum path: 4
Routing for Wetworks:

10.0.0.0
Pagsive Interface(s):

GigabitEthernetd/1

Seriald/1/0

Berial0/1/0.25

Seriald/2/0

FastEthe rnetl/0

FastEthernetl/1

FastEthernetl/2

FastEthe rnetl/3

FastEthernetl/d
Passive Interface(s):

FastEthernetl/5

FastEthernetl/e

FastEthe rnetl/7

FastEthernetl/8

FastEthernetl/S

Page 423 of 507



CCIE SECURTY vd Lab Workbook

FastEthernetl/10
FastEthernetl/11
FastEthernetl/12
FastEthernetl/13
FastEthernetl/ 14
FastEthernetl/15
vlanl

LoopbackD

VoI F-Hulld

Routing Information Sources:

Gat eway Distance
10.1.12.1 120

Distance: (default is 120}

R2#sh ip route
Codes: C = connected, 8§ = static,

Gateway of last resort is not set

0

Last Update
00:00:20

R = RIP, M - mohile, B - BGP

D - EIGRP, EX - EIGRP external, O - OSPF, IR - OSPF inter area

H1l - OSPF NSSA external type 1, N2 - OSPF H3SSA external type 2

El - OSEF external type 1,

E2 - QOSFF external type 2

i=-I58-153, su - I3-I5 summary, L1 - IS-I3 lewvel-1, LZ - IS-IS lewvel-2
ia - IS-I8 inter area, * - candidate default, U - per-user static route
& - ODR, P - pericdic downloaded static route

1.0.0.0/24 iz subnetted, 1 subnets

1.1.1.0 [120/1] wia 10.1.

12.1, 00:00:22, GigabitBthernetd/0

2.0.0.0/24 is subnetted, 1 subnets
2.2.2.0 is directly connected, Loopback(

10.0.0,0/24 is subnetted, 2

subnets

10.1.12.0 is directly connected, GigabitEthernetd/0
10.1.25.0 is directly connected, Serial0d/1/0.25

R2jdeb ip rip

RIF
B2

RIF:
RIF:

RZ#

protocel debugging is on

sending w2 update to 224.0.0.% via GigabitBthernet(/0 (10.1.12.2)

build update entries

10.1.25.0/24 via 0.0.0.0, metric 1, tag 0

RIP: received packet with MD5 authentication
RIP: received v2 update from 10.1.12.1 on GigabitEthernet0/0
1.1.1.0/24 wia 0.0.0.0 in 1 hops
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Task 2

R1 receives prefix for 10.1.25.0/24 subnet. Configure route filtering on R2 so that it
will NOT send this network prefix to R1. You are not allowed to use ACL to
accomplish this task.

Configuration
Complete these steps:
Step 1 R2 configuration.

R2 (config)#ip prefix-list TO Rl deny 10.1.25.0/24
B2 (config) #ip prefix-list TO Rl permit 0.0.0.0/0 le 32

B2 (conf ig) #router rip
RZ (config-router) #distribute-list prafix TC_Rl out

Verification

Fz#deb ip ri
RIF protocel debugging is eon

R2#

RIF:
RIF:

RIF:
RIF:

raceived packet with MD5 authentication
received v2 update from 10.1.12.1 on GigabitEthernet0/0
1.1.1.0/24 wia 0.0.0.0 in 1 hops

sending V2 update to 224.0.0.9 via GigabitBthernet(/0 (10.1.12.2)
build update entries — suppressing null update

Flé#sh ip route
Codes: € - connected, 5 - static, R - RIF, M - mobile, B - BGF

b - EIGRP, EX - EIGRP external, © - CSPF, IA - OSPF inter area

N1l - OSPF NSSA external type 1, M2 - OSPF HSSA external type 2

El — OSPF external type 1, EZ — OSFF external type 2

i - I8-18, su - I5-I8 summary, Ll - I5-I5 level-l, LZ - I5-I5 lavel-2
ia — IS-IS inter area, * - candidate default, U - per-user static route
o = ODR, F - pericdic downloaded static route

Gateway of last resort is not set

1.0.0.0/24 is subnetted, 1 subnsts

1.1.1.0 is directly coennected, Loopback0d
10.0.0.0/24 is subnetted, 1 subnets

10.1.12.0 is directly connected, FastEthernet(/0

Page 425 of 507



CCIE SECURTY vd Lab Workbook

Task 3
Configure EIGRP AS 45 between R4 and R5. The following directly connected
networks should participate in EIGRP process:
= R4 -10/0,lo0
= R5-10/0
Configure MD5 authentication for EIGRP updates with a key string of “cisco456".

Configuration
Complete these steps:

Step 1 R5 configuration.

RS (config) #router eigrp 45
ES (conf ig-router) #no aute-summary
8 (conf ig-router) #netwerk 10.1.45.5 0.0.0.0

RS (config) #key chain EIGRF
B5 (conf ig-keychain) fkey 1
ES (conf ig-keychain-key) #key-string ciscod5s6

EBS (conf ig-keychain-key) #int £0,/0
BS (conf ig=-if ) #ip authentication mode eigrp 45 md5
BS (conf ig-if ) #ip authenticatien key-chain eigrp 45 EIGRP

Step 2 R4 configuration.

Fd (config) #router eigrp 45

Rd (conf ig-routar) #no auto-summary

Fd (conf ig-router) #netwerk 10.1.45.4 0.0.0.0
R4 (conf ig-routar) fnetwork 4.4.4.4 0.0.0.0

Rd (config) #key chain EIGRF
Bd (conf ig-keychain) fkey 1
R4 (conf ig-keychain-key) #key-string ciscodSé

Fd (conf ig-keychain-key) #int £0/0
Bd (conf ig-if ) #ip authentication mode eigrp 45 md5
Fd (conf ig-if ) #ip authentication key-chain eigrp 45 EIGRF

RADUAL~-5-NERCHANGE : IP-EIGRE (0} 45: Heighbor 10.1.45.5
{FastEthernet(/0) is up: new adjacency
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Verification

Rd#sh ip protocols
Routing Protocol is "eigrp 45"
tutgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set
Default networks flagged in ocutgoing updates
Default networks accepted from incoming updates
EIGRF metric weight Kl=1, Kz=0, K3=l1, K4=0, K53=0
EIGRP maximm hopcoount 100
EIGRF maximum metric wvariance 1
Redistributing: eigrp 45
EIGRF NSF-aware route hold timer is 240s

Automatic network summarization is not in effect
Maximum path: 4
Routing for Metworks:

4.4.4.4/32
10.1.45. 4/32
Routing Information Sourceas:
Gat eway Distance Last Update

Distance: internal 90 external 170

Fid#sh ip eigrp interfaces detail
IP-EIGRP interfaces for process 45

Emit Cueus  Mean Facing Time Multicast
Interface Pears Un/Reliable SRTT Un/Reliable Flow Timer

Fal/0 1 /0 8 0/1 50
Hello interval is 5 sec
Hext xmit serial <none>
Un/reliable measte: 071 Un/relisble ucasts: 4/3
Mcast exceptions: 1 CR packets: 1 ACHs suppressed: 0
Retransmissions sent: 0 Out-of-sequence rowd: 0
Authentication mode is md5, key-chain is "EIGRE™
Use multicast

Lol 1] /0 o /1 o]
Helloe interval is 5 sec
Hext xmit serial <nones
Un/reliable mcasts: 0/0 Un/reliable ucasts: 0/0
Mcast exceptions: 0 CR packets: 0 RACKs suppressed: 0
Retransmissions sent: 0 oOut-of-sequence rowd: 0
Authentication mode 12 not set
Use multicast

Rd#sh ip route
Codes: C - connected, 8§ - static, R - RIF, M - mobila, B - BGP

D — EIGRP, EX — EIGRP external, O — OSPF, IA - OSFF inter area
Hl - OSPF NS3A external type 1, H2 - OSPF H33A external type 2

El - QSFF external type 1, EZ - QSPF external type 2

Panding
Routes

Page 427 of 507



CCIE SECURTY vd Lab Workbook

i = I3=1I53, su = I3=I5 summary, L1 = IS=I3 lewvel=1, LZ = IS=-I3 lewvel=-2
ia - IS-I8 inter area, * - candidate default, U - per-user static route
o = ODR, P - pericdic downloaded static route

Gateway of last resort is not set

4.0.0.0/24 is subnetted, 1 subnets

c 4.4.4.0 is directly connected, Loopback(

10.0.0.0/24 is subnetted, 1 subnets

c 10.1.45.0 is directly connected, FastEthernst(/0

RS#sh ip protocols
Reuting FProtocol is "eigrp 45"

outgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set
Default networks flagged in sutgoing updates

Default networks accepted from incoming updates

EIGRF metric weight Kl=1, Kz=0, K3=l1, K4=0, K53=0

EIGRF maximum hopcount 100
EIGRP maximum metric variance 1
Redistributing: eigrp 45

EIGRF HSF-aware route hold timer is 240s

Automatic network summarization is not in effect

HMaximum path: 4

Routing for Metworks:
10.1.45. 5/32

Routing Information Sourceas:

Gateway Distance Last Update

10.1.45.4 20 00:01:22

Distance: internal %0 external 170

RS#sh ip eigrp interfaces detail
IP-EIGRP interfaces for process 45

¥mit Queus Mean

Interface Pears Un/Reliable SRTT

Fal/0 i /0 5
Hello interval is 5 sec
Hext xmit serial <none>

Pacing Time Multicast
tn/Reliable Flow Timer
0/1 50

Un/reliable mcasts: 072 Un/reliable ucasts: 1/3
Mcast exceptions: 1 CR packets: 1 RACHKs suppressed: 0
Retransmissions sent: 0 Out-of-sequence rovd: 0
Authentication mode is md5, key-chain is "EIGRP"

Use multicast

RS#sh ip route
Codes: C - connected, 8 - static, R - RIP,

M = mobile, B - BGP

Panding
Routes
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0 = EIGRP, EX = EIGRF external, © = OSPF, IA - O3SFF inter area

Hl - OSPF HSSA external type 1, N2 - OSPF MHS5SA external type 2

El - OSPF external type 1, E2 - OSPF external type 2

i - 18-1I8, su - I58-1I8 summary, Ll - I5-I5 lewel-1l, LZ - I5-I5 level-2
ia = IS-IS inter area, * - candidate default, U - per-user static route
o = ODR, P = pericdic downloaded static route

Gateway of last resort is not set

4.0.0.0/24 is subnetted, 1 subnsts

D 4.4.4.0 [90/156160] wia 10.1.45.4, 00:01:34, FastEthernet(/0
5.0.0.0/24 is subnetted, 1 subnets
e 5.5.5.0 is directly connected, Loopback(
10.0.0.0/24 18 subnetted, 2 subnets
c 10,1.25.0 is directly connected, Serial0/1/0,52
C 10.1.45.0 is directly connected, FastEthernetd/0
Task 4

Configure OSPF Area 0 between R2 and R5 with interface authentication using MD5
and a key of “cisco789". The following interfaces should in Area 0:

R2 —-s0/0.25, o0

R5 -s0/0.52, lo0

Configure mutual redistribution to achieve full connectivity in the network.

Configuration
Complete these steps:
Step 1 R2 configuration.

B2 (conf ig) #router cspf 1

R2 (conf ig-routar) fnetwork 10.1.25.2 0.0.0.0 area O
B2 {conf ig-router) fnetwork 2.2.2.2 0.0.0.0 area 0
R2 (conf ig-router) #redistribute rip subnets

R2 (conf ig-router) drouter rip
B2 (conf ig-router) fredistribute ospf 1 metria 2

B2 (config)#int =0/1/0.25

B2 (conf ig-subif) #ip cspf authentication message-digest
R2 (config-subif) #ip ospf message-digest-key 1 mdS ciscoT8S

Step 2 R5 configuration.
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BS (config) #router cepf 1

RE (conf ig-router) #network 10.1.25.5 0.0.0.0 area ©
BS5 (conf ig-router) fnetweork 5.5.5.5 0.0.0.0 area 0
RS (config-router) #redistribute eigrp 45 subnets

ES (conf ig-router) #router eigrp 45
B5 (conf ig-router) #redistribute ospf 1 metris 100000 O 255 1 1500

RS (config) #int s0/1/0.52
BS (conf ig-subif) #ip cspf authentication message-digest
RS (config-subif) #ip ospf message-digest-key 1 md5 ciscoT8%

Verification

F2#sh ip capf interface =0,/1/0.25
Seriald/1/0.25 is up, line protocol is up
Internet Address 10.1.25.2/24, Area 0
Process ID 1, Router ID 2.2.2.2, Metwork Type POINT_TO POINT, Cost: &4
Trensmit Delay is 1 sec, State POINT_TO POINT
Timer intervals coenfigured, Hello 10, Dead 40, Wait 40, Retransmit 5
oob-resync timeout 40
Hello due in 00:00:0%
Supports Link-local Signaling (LLS)
Cisco NSF helper support enabled
IETF MSF helper support enabled
Index 1/1, floocd gueue length 0O
Bext 0x0(0) /0x0{0)
Last flood scan length is 1, maximum is 1

Last flood scan time is 0 msec, maximum is 0 msec
Heighbor Count is 1, Adjacent neighbor count is 1
hdjacent with neighbor 5.5.5.5
Suppress hells for 0 neighbor(s)
Message digest authentication enabled
Toungest key id is 1

BF2#sh ip protocels | begin "ecspf 1"

Routing Protocol is "eospf 1™
Outgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set
Router ID 2.2.2.2
It is an autonomous system boundary router
Redistributing External Routes from,

rip, includes subnets in redistributicn

Wumber of areas in this router is 1. 1 normal 0 stub O nssa
Maximum path: 4
Reouting for Networks:
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2.2.2.2 0.0.
10.1.25.2 0.

0.0 area 0

0.0.0 area 0

Reference bandwidth unit is 100 mbps
Routing Information Sources:

Gateway
5.5.5.5

Distance Last Update
110 00:02:55

Distance: (default is 110}

Ri#sh ip route

Codes: C - connected; 5 - static, R - RIF; M - mobile; B - BGF

D = EIGRP, EX - EIGRP external, © - OSPF, IA - OSPF inter area
Hl - OSPF HSSA external type 1, HZ - OSPF HS5A external tiype 2

El - OSFF external type 1, EZ - OSFF external type 2
i - I8-18, su - I5-1I8 summary, Ll - IS-I5 level-l, LZ - IS-I5 level-2
ia - IS-I3 inter area, * - candidate default, U - per-user static route

o = ODR,

Gateway of last

1.0.0.0/24
R 1.1.1.0
2.0.0.0/24
c 2.2.2.0
4.0.0.0/24
Q 4.4.4.0
5.0.0.0/32
L&) 5.5.5.5

F = pericdic downleaded static route

resort is not set

is subnetted, 1 subnets

[120/1] wia 10.1.12.1, 00:00:26, GigabitEthernet(d/0
is subnetted, 1 subnets

is directly connected, Loopback(

is subnetted, 1 subnets

[110/20] wvia 10.1.25.5, 00:03:01, Seriald/1/0.25
is subnetted, 1 subnets

[110/65) wia 10.1.25.5, 00:03:01, Sarial0/1/0.25

10.0.0.0/24 is subnetted, 3 subnets

[ 10.1.12.
c 10.1.25.
O EZ2 10.1.45.

0 is directly connected, GigabitEthernetd/o
0 is directly connected, Seriald/1/0.25
0 [110/20] wia 10.1.25.5, 00:03:02, Serial0/1/0.25

RS#sh ip ospf interface s0/1/0.52

Seriald/1/0.52 is up, line protocel is up
Internet Address 10.1.25.5/24, Area 0

Process ID 1,

Router ID 5.5.5.5, Metwork Type POINT_TO POINT, Cost:

Transmit Delay is 1 sec, State POINT_TO_POINT

Timer intervals configured, Helle 10, Dead 40, Wait 40, Retransmit 5

cob=-resync timecut 40
Helle due in 00:00:03
Supports Link=local Signaling (LLS)
Cisco MSF helper support enabled
IETF HSF helper support enabled
Index 1/1, flood queue length 0
Kext 0x0(0)/0x0{0)
Last flood scan length is 1, maximum is 1
Last flood scan time is 0 meec, maximum iz 0 mesec
Heighbor Count is 1, Adjacent neighbor count is 1
Adjacent with neighbor 2.2.2.2

&4
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Suppress hells for 0 neighboris)
Message digest authentication enabled
Toungest key id is 1

ES#sh ip protecols | begin "capf 1"
Reuting Protocel is "ospf 1Y

Outgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is not set

Router ID 5.5.5.5

It is an autonomous system boundary router

Redistributing External Routes from,

eigrp 45, includes subnets in redistribution

Humber of areas in this router is 1.
HMaximum path: 4
Routing for Metworks:

5.5.5.% 0.0.0.0 area 0

10.1.25.5% 0.0.0.0 arsa 0
Referance bandwidth unit is 100 mbps
Routing Information Sources:

1 normal 0 stub 0 n=ssa

Gateway Distance Last Update
2.2.2.2 110 00:03:25
Digtance: (default is 110)

RS#sh ip route

Codes: C - connected, 8 - static, R - RIP,

M = mobile, B - BGP

D - EIGRP, EX - EIGRP axternal, O - OSPF, IA - OSPF inter area
Hl - OSPF HSSA external type 1, HZ2 - OSPF HSSA external type 2

El - OSPF external type 1, E2 - OSPF external type 2

i - 18-115,
ia = IS=I3 inter area,
o — ODR, P - pericdic downloaded

Gateway of last resort is not set

su - IS5-I5 summary, L1 - I5-I5 level-1l, L2 - I5-1I5 level-2
* = candidate default, U - per=-user static route

static route

.4, 00:10:0%, PastEthernet0)/0

1.0.0.0/24 is subnetted, 1 subnets
o E2 1.1.1.0 [110/20] wia 10.1.25.2, 00:03:30, Serial0/1/0.52
2.0.0.0/32 is subnetted, 1 subnets
e 2.2.2.2 [110/65] wia 10.1.25.2, 00:03:30, Serial0d/1/0.52
4.0.0.0/24 is subnetted, 1 subnets
D 4.4.4.0 [90/156160] wia 10.1.45
5.0.0.0/24 is subnetted, 1 subnets
c 5.5.5.0 is directly connected, Loopback(
10.0.0.0/24 iz subnetted, 3 subnets
=] 10,.1.12.0 [110/20]1 wia 10.1.25.2, 00:03:30, Serialdfl/0.52
[+ 10.1.25.0 ia directly connected, Serial0d/1/0.52
c 10.1.45.0 is directly connected, FastEthernet0/0
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Fléping 4.4.4.4 so lod

Type escape seguence to abort.

Sending 5, l00-byte ICHMF Echos to 4.4.4.4, timecut is 2 seconds:

Packet sent with & scurce address of 1.1.1.1

1

Success rate is 100 percent (5/5), round-trip minfavg/max = 16/17/20 ms

Task 5
R4 should NOT install route prefixes for 2.2.2.0/24 and 5.5.5.0/24. Use ACL to
accomplish this task.

Configuration
Complete these steps:
Step 1 R4 configuration.

R (config)#ip access-list standard TO_Rd
Fd (config-ext-nacl)f#deny 2.2.2.0 0.0.0.255
R4 (config-ext-nacl) #deny 5.5.5.0 0.0.0.255
Fd (conf ig-ext-nacl) #permit any

Bl (conf ig) #router eigrp 45
R4 (conf ig-router) #distribute-list TO R4 in

RDUAL-5-NERCHAMGE : IP-EIGRF (0} 45: Meighber 10.1.45.5
(FastEthernet(/0} is resync: route configuration changed

Verification

Ril¥sh ip protocols
Routing Protocol is "eigrp 45"
futgoing update filter list for all interfaces is not set
Incoming update filter list for all interfaces is TO Rd
Default networks flagged in cutgoing updates
Default networks accepted from incoming updates
EIGRF metric weight Kl=1, K2=0, K3=1, Ki4=0, K5=0
EIGRF maximm hopcount 100
EIGRF maximum metric variance 1
Redistributing: eigrp 45
EIGRF HNSF-aware route hold timer is 240s

Rutomatic network summarization is not in effect
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Maximum path: 4
Routing for Hetworks:
d.4.4.4/32
10.1.45.4/32
Routing Information Sourceas:
Gateway Distance Last Update
10.1.45.5 a0 00:00:38
Distance: internal %0 external 170

Ri#sh ip route

Codes: C = connected, 8§ - static, R - RIF, M - mcbilae, B - BGPF
D - BEIGRP, EX - EIGRF external, O - COSPFF, IA - COSPF inter area
Hl - OSPF NSSA external type 1, M2 - OSPF HSSA external type 2
El - OSFF external type 1, E2 - QOSFF external type 2
i - 1818, su - IS-I5 summary, Ll - IS-IS lewvel-1l, LZ - IS-IS level-2
ia = IS=I3 inter area, ®* = candidate default, U - per=-user static route
o - OOR, P - pericdic downloaded static route

Gateway of last resort is not set

1.0.0.0/24 is subnetted, 1 subnets
D EX 1.1.1.0 [170/28160] wia 10.1.45.5, 00:00:44, FastEthernst(/0
4.0.0.0/24 is subnetted, 1 subnets
c 4.4.4.0 is directly connected, Loopbackd
10.0.0.0/24 is subnetted, 3 subnets
EX 10.1.12.0 [170/28160] via 10.1.45.5, 00:00:44, FastEthernst0/0
EX 10.1.25.0 [170/28160] wia 10.1.45.5, 00:00:44, FastEtharnst0/0
10.1.45.0 is directly connected, FastEthernetd/0

i I = R ]

Fd#sh access-list

Standard IP access list TO_R4
10 deny 2.2.2.0, wildcard bits 0.0.0.255% (23 matches)
20 deny 5.5.5.0, wildcard bits 0.0.0.255 (3 matches)
30 permit any (3 matches)

Rddping 1.1.1.1 so lob

Type escape segquence to abort.

Sending 5, l00-byte ICWMF Echos to 1.1.1.1; timecut is 2 seconds:

Packet sent with a socurce address of 4.4.4.4

1

Success rate is 100 percent (5/5), round-trip minfavg/max = 16/17/20 ms

Task 6

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.52. Control Plane Policy (CoPP)

10.1.12.01/24

Lab Setup
» The F0/0 interface of R1 and R2 should be configured in VLAN 12

» Configure RIPv2 on all routers and advertise their directly connected
interfaces in this routing protocol
» Enable VTY logging on both devices

IP Addressing

Router Interface IP address

R1 F0/0 10.1.12.1/24
Lo0 1.1.1.1/8

R2 G0/0 10.1.12.2/24

Task 1

On R2 configure policing for ICMP echo request messages to rate limit it up to
50kbps using Control Plane Policy.

The Control Plane Policing feature allows to configure a quality of service {QoS)

M filter that manages the traffic flow of control plane packets to protect the control
plane of Cisco 108 routers and switches against reconnaissance and denial-of-
service (DoS) attacks. Control Plane is responsible for handling traffic like
routing protocols, management protocols, event sending, authentication

requests, efc. destined to or originated from the router.
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Configuration
Complete these steps:

Step 1 R2 configuration.

Create ACL that will match the traffic
R2 (config)#access—1list 120 permit icmp any any echo
Match interesting traffic using class map

R2 {config) #class-map ICHP
R2 (config-cmap) #match access—group 120
R2 {config=cmap) #exit

Create policy map and assign previcusly created class map. Folice
{rate limit) will drop the traffic which exceeded 50k.

R2 (config) #policy-map CPP-IN

R2 (config-pmap) #class ICHP

R2 {(config-pmap-c) #police 50000 conform transmit exceed drop
R2 {config-pmap-c-police) fexit

R2 {config-pmap-c) #exit

RZ (config-pmap) #exit

Assign policy to the Control Flane in the inbound direction.

R2 (config) #control-plane

RZ (config-cp) #service-policy input CPP-IN

%CP-5-FERATURE: Control-plane Poelicing feature enabled on Control plane
aggregate path

R2 {config-cp)#exi

Verification

Tou can verify this feature by issuing large ping from Rl towards R2 and see if
the traffis is limd ted.

B2 lshow policy-map control-plane
Contrel Flane

Sarvice-policy input: CPP-IN

Class-map: ICMP (match-all)
0 packets, 0 bytes
5 minute offered rate 0 bps, drop rate 0 bps
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Match: access=-group 120
police:
cir 50000 bps, bc 1562 bytes
conformed 0 packets, 0 bytes; actions:
transmit
exceaded 0 packets, 0 bytes; actions:
drop
conformed O bpa, exceed 0 bps

Class-map: class-default {(match-any)

0 packets, 0 bytes
5 minute ocffered rate O bps, drop rate 0 bps

Match: any

Fl#ping 10.1.12.2 size 1500

Type escape segquence to abort.

Sending 5, 1500-byte ICMP Eches to 10.1.12.2, timesut iz 2 seconds:
R

Success rate is 40 percent (2/5), round-trip min/avg/max = 1/1/1 ms

Hote that only 2 pings are successful. The balow command clearly shows that
that teaffis has been rate limited.

B2 §show policoy-map control-plane
Contrel Plane

Sarvice-policy input: CPP-IN

Class-map: ICMP (match-all)
4 packets, 6036 bytes
5 minute offered rate 0 bps, drop rate 0 bps
HMatch: access—group 120
police:
cir 50000 bps, bc 1562 bytes
conformed 2 packets, 3028 bytes; actions:
transmit
exceeded 2 packets, 3028 bytes; acticns:
drop
conformed 0 bps, exceed O bps

Class-map: class-default (match-any)
2 packets, 451 bytes
5 minute cffered rate 0 bps, drop rate 0 bps
Match: any

Hote that the first ICHMF packet has missed becausse the router tried to resolve

ARFP first.
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Task 2
Configure R2 so that it allows telnet connections only to the IP address of 1.1.1.1. Do
not use ACL on any of router's interfaces or VTY lines configuration.

This can be done using Control Plane Policing. Note that wording of this task
does not mention Control Plane.

Confiquration

Complete these steps:
Step1 R2 configuration.

Create ACL that will match TELHET traffic from any routers interface

te any hest but 1.1.1.1

R2 (config) #access-1list 130 deny tep any host 1.1.1.1 eq telnet
R2 {config) #access-list 130 permit tcp any any egq telnet

Match interesting traffic using class map

B2 (config) #class-map TELMET
R2 {config-cmap) #match access-group 130
B2 (config-cmap) #exit

Create policy map and assign previously created class map. This policy

map should b= applied on the COUTEOUND directiocn

B2 (config) #policy-map CPP-OUT
RZ (config-pmap) #class TELNET
R (config-pmap-c) #drop

RZ (config-pmap-c) #exit

B2 (config-pmap) exit

Apply the policy map

R2 (config) #control-plane
R2 {config-cp)#service-policy ocutput CEP-OUT
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Verification

To warify initiasate telnet connection from RZ2 towards Rl's IP addressaes and

check the counters for the policy map

RE2#show policy-map control-plane out
Controel Flane

Service-policy cutput: CFFP-OUT

Class-map: TELHET (match-all)
0 packeta, 0 bytes

5 minute offered rate O bps, drop rate 0 bps

Match: access-group 130
drop

Class-map: class-default {(match-any)
10 packets, 834 bytes

5 minute offered rate O bps, drop rate 0 bps

HMatch: any

F2ftel 1.1.1.1

Trying 1.1.1.1 ... Cpen

User Access Verification

Fassword:

Rl>exit

[Connection te 1.1.1.1 closed by foreign host)

F2#show pelicy-map contrel-plane ocut
Control Plane

Service-policy output: CFFP-OUT

Class-map : TELHET (match-all)
0 packets, 0 bytes

5 minute offered rate 0 bps, drop rate 0 bps

Match: access-group 130
drop

Class-map: class-default {(match-any)
36 packets, 2463 bytes

5 minute ocffered rate O bps, drop rate 0 bps

Match: any
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RF2étel 10.1.12.1
Trying 10.1.12.1 ...
% Connection timed out; remote host not responding

RZ#show policy-map control-plane out
Centrsl Plane

Service-policy output: CEP-OUT

Class-map: TELHET {match-all)
4 packets, 240 bytes
5 minute offered rate 0 bps, drop rate 0 bps
Match: access-group 130
drep

Class=-map: class=-default {(match-any)

11 packets, 3057 bytes
5 minute offered rate O bps, drop rate 0 bps

Match: any

Task 3
On R2 enable Control Plane logging feature for all dropped packets.

By default Control Plane Policing silently performs all configured operations.
However a good security administrator should be aware what is going on in his
network, so logging is always recommended.

Configuration
Complete these steps:
Step1 R2 configuration.

Craate A special class map type and match all dropped packats.

R2 (config) #class-map type logging match-any TEST
R2 {config=-cmap) #match packets dropped
RZ (config-cmap) #exit

Create a special policy map type and assign previocusly created class
map . Enable legging of all packets matched that pelicy.
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R2 [config) #policy-map type logging CPP-LOG
B2 {config-pmap) #class TEST
R2 [config-pmap-c) #log

R2 {(config-pmap-c) #exit
R2 {config=-pmap) #exit

Assign the policy map toe the Control Plane

R2 {config) #control-plane

R2 (config-cpl#service-policy type logging input CPP-LOG
WCP=-5=-FEATURE: Control=-plane Logging feature enabled on Control plane

aggregate path

To wvearify parform the btest from Task 1 and ses if it generates the log message.

Rléping 10.1.12.2 size 1500

Type ascapes segquence to abort.

Sending 5, 1500-byte ICMP Eches to 10.1.12.2, timecut is 2 seconds:
1.1.1

Success rate is &0 percent (3/5%), round-trip min/avg/max = 1/1/1 ms

B2
RCP-6-IF: DROPF Control-plane Policing 10.1.12.1 -»> 10.1.12.2 icmp
jzeed ]
RCP-6-IF: DROF Control-plane Policing 10.1.12.1 =-> 10.1.12.2 icmp

Hote Two drops have been logged as twoe ICHMP echo messages have bean dropped
To see what featiures on the Control Plane are confiqured, use the following

command :

RZ#show control-plane features

Total 2 features configured

Control plane aggregate path features :
Centroel-plane Logging activated Mar 01 2002 00:4
Control-plane Policing activated Mar 01 2002 00:2

Task 4
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.53. Protecting against

fragmentation attacks

4 | Foo Goin| 2
_ag— e~
_-1..; " E
Lab Setup
» Configure the routers with the following IP addressing:
Router Interface IP address
R1 F0/0 10.1.124.1/24
R2 G0/0 10.1.124.2/24
R4 F0/0 10.1.124 4/24

# Al routers’ 0/0 interfaces are in VLAN 124

Task 1

R1 is sending a lot of fragmented IP packets towards R2. Configure it to drop all

ICMP fragmented packets when they come to R2's G0/0.

Configuration
Complete these steps:

Step 1 R2 configuration.

RZ (config)#ip access-list extended NON_FRAGMENTS
B2 (config-ext-nacl)¥ deny icmp any host 10.1.124.2 fragments log
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Veri

B2 {config-ext-nacl)# permit ip any any
R2 (config-ext-nacl)$axi

The “HOH FRAGMENTS" acoess-list is intended te drop
fragmented ICMP packets directed towards 10.1.124.2 (R2's
&0/0). The ACL permits any remaining IP packets.

HZ (config)#int g0/0
B2 {config-if ) #ip access-group WON_FRAGMENTS in
B2 {config=if)#exi

Rliping 10.1.124.2 size 1500

Type escape sequence to abort,
Sanding 5, 1500=-byte ICHMF Echeos teo 10.1.124.2, timecut is 2 seconds:

Success rate is 80 percent (4/5), round-trip min/awg/max = 1/1/1 ms

Packets of size lass or equal 1500 (a dafault IF MIU for Ethernat interfaces)

bytes have not been fragmented. Hote that loss of first packet has been caused
by ARF address resslution (not by YHOHN_ FRAGMENTSY ACL) .

Fl#ping 10.1.124.2 size 1501

Type escape segquence to abort.
Sending 5, 1501-byte ICHMP Echos to 10.1.124.2, timecut is 2 seconds:

Success rate is 0 percent (D/5)

On R2:

$SEC-6- IPACCESSLOGDP: list NON_FRAGMENTS denied icmp 10.1.124.1 -»> 10.1.124.2 (0/0), 1

packet

Packets of size greater than 1500 bytes have been fragmented by the I0S. ACL
YHON FRAGMENTY placed ocn R2‘'s G0/0 interface has drop fragmented pieces of IP

packets. Hote that “log” keywerd in the ACE generates log message for first

hit.
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Task 2

Configure R4 so that it tracks all fragmented packets coming into FO/0 interface. The
router should use maximum of 2 fragments per reassembly with a timeout of 2
seconds.

Virtual Fragmentation Reassembly (VFR) feature was designed work with any
features that requires IP fragment reassembly to work properly. VFR assembles
fragmented IP pac ket to enable further processing of whole IP packet. (to match
the packet with firewall access control rules or to extract information relevant to
network protocols from layers higher than third 1ISO/0SI layer). The I0S features
such as NAT or Cisco 105 Frewall {CBAC or IPS) use VFR. Configuring of the
feature that requires VFR enables “ip virtual-reassembly” on the interface
automatically. When more than one features enabled on the interface requires
VFR than I0OS maintains the counter which references number of features that
use VFR. If this counter is equal to 0 then VFR Is automatically disabled. VFR
might be enabled at any time when required even if there is no features that
requires this feature to run. This command might be used for control the flow of
fragmented packets through the router to protect the network from detected
fragmented attacks such as: tiny fragment attack, overlapping fragment attack,
buffer overflow attack {when security flaw exists in IP stack code).

Configuration
Complete these steps:

Step 1 R4 configuration.

R4 (config) #int £0/0
Rd (config-iflé#ip wvirtual-reassembly max-fragments 2 timeocut 2

This command enables VFR on the Fal/0 and allows for processing of
fragmented IF packets that consist of twe or less fragments (default
32). VFR requires that all fragments mist be received and assembled in
spacifiaed amount of time (default 3 seconds) . If not, all the
fragments and IF datagram will be dropped. This command also allows
spacifying the maximm number of fragments that can be assembled at

any given time.
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Verification

Elfping 10.1.124.4 size 1501

Type escape segquence to abort.
Sanding 5, 1501-byte ICHMF Eches teo 10.1.124.4, timecut is 2 seconds:

D001
Success rate is 80 percent (4/5), round-trip min/awg/max = 4/4/4 ms

The packet of 1501 bytes has besen fragmented to twe chunks (original IP
datagram and the one fragment that is the remaining part of IF packat). VFR

configured on Rd's POS0 permits this flow through the router.

Rifping 10.1.124.4 size 5000

Type escape segquence to abort.
Sanding 5, 5000-byte ICHMF Echeos to 10.1.124.4, timecut is 2 seconds:

Succesgs rate is 0 percent (0/5)

on Rd:
RIP_VFR-4-TOO_MANY FRAGMENTS: FastEthernet0/0: Too many fragments per datagram (more
than 2} - sent by 10.1.124.1, destined to 10.1.124.4

The packet of size 5000 bytes has been fragmented into more than two fragments.
Thus, VFR configured on F4's Fal0/0 has blecked the ICMF fragmented packets.
Hote that log messages have appesared. This has been caused by dafined max-
fragments optien (if max-fragment walue is exceeded then IP VFR-4-

TOO _MANY FRAGMENTE log message is generated)

Ri#fsh ip wirtual-reassembly

FastEthernet 0,/0:
Virtual Fragment Reassembly (VFR) is EMRBLED. ..
Concurrent reassemblies {(maxz-reassemblies): 16
Fragments per reassembly (max-fragments): 2
Reassembly timecut (timecut): 2 seconds
Drop fragments: OFF

Current reassembly count: 0
Current fragment count:0

Total reassembly count:d

Total reassembly timesut count:5’

This show command displays VFR configuration along with statistics. Hote that
concurrent reassemblies (max-reassemblies) is set to the default wvalue of 16.
This parameter defines the number of IP packets that can be reassembled at any
given time. “Drop fragments” indicates that VFR option “drop-fragments® is
disabled (it is a default setting) . “drop-fragments®” enables the VFR to drop

all fragments that arrive on the configured interface
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Task 3
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.54. Protecting against malicious IP

option usage

Based on the previous Lab’s IP addressing, topology and Lab setu

Task 1

S

.1 [Folo
10.1.124 0124

Goo| 2

Configure R1 so that it will drop and log packets containing the following IP Options:
» Loose Source Route,
= Strict Source Routing,
= Base Security.

M

In real scenario source routing may be used for conducting various network
attacks, therefore it is blocked by many routers across the Internet. Source
routing enables the sender of a packet to partially (LSR) or completely (SSR)
specify the route the packet takes through the network. Base Security IP option
enables the sender of the packet to send security, compartmentation, handling
restrictions, and TCC (closed user group) parameters. The flow of IP packet
with IP options enabled may be controlled selectively by using access-list along
with “option" parameter or by enabling global 10S configuration option: ip
options which enables the router to drop all packets with ip options {ip
options drop) or processing them as though IP options are not enabled in the
packet (ip option ignore).
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Configuration
Complete these steps:

Step 1 R1 configuration.

Rl {config)#ip access-list extended IP_OPFTICHS

Rl (config-ext-nacl)ideny ip any any option lsr log

Rl {config-ext-nacl)#deny ip any any option ssr leqg

Rl (config-ext-nacl)#deny ip any any option security log
Rl {config=-ext-nacl)#permit ip any any

Rl {config-ext-nacl) #int £0/0
Rl (config-if)#ip access—group IF_CPTIONS in

The ACL that denies L3R, 35R and security option has been created and
enabled on the Rl's Fal/0. When packet matches ACE pattern then log
message is generated for first hit and subsegquent hits in accordance
with I02 options which define logging intervals, threshelds or rate

limiting settings for access list logging.

Verification

Rzdping
Protocel [ipl:
Target IP address: 10.1.124.1
Repeat count [5]:
Datagram size [100]:
Timecut in seconds [2]:
Extended commands [n): v
Source address or interface: gigabitethernet0/0
Type of service [0]:
Set DF bit in IP header? [no):
Validate reply data? [no]:
Data pattern [OXABCD]:
Loose, Strict, Record, Timestamp, Yerbose[nonel: L
Source route: 10.1.124.4
Logse, Strict, Record, Timestamp, Yerbose[LV]:
Sweep range of sizes [n):
Type escapes sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.124.1, timeout is 2 seconds:
Packet sent with a source address of 10.1.124.2
Packet has IF opticns: Total option bytes= 7, padded length=8
Loose source route: <*>
{10.1.124.4)

Request 0 timed cut
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threachable from 10.1.124.1. Received packet has options
Total option bytes= 7, padded length=8
Looge source route: <=

{10.1.124.4)

Unreachable from 10.1.124.1. Received packet has options
Total option bytes= 7, padded length=#
Loose source route: <%»

{10.1.124.4)

Unreachable from 10.1.124.1. Received packet has options
Total option bytes= 7, padded length=8
Lotse source route: <%

(10.1.124 .4}

Unreachable from 10.1.124.1. Received packet has options
Total option bytes= 7, padded length=8
Locse source route: <%

{10.1.124.4)

Success rate is 0 percent (0/5)

RZ2 (sourae: 10.1.124.2) has pingad Bl (daestination:

10.1.124.1) but ICMP

packets have besn directed through R4 (forwarder: 10.1.124.4) due to Loose

Scource Routing enabled. Hote that Rl has replied with IOMP destination

unreachable (ICHMF type 3 - Destination Unreachable, ICHMF code 13 -

Communication Administratively Prohibited) bacause of Y"ip unreachables” anabled

by default on the router interface. This configuration setting is responsible

for sending ICMP 3/13 packets when inbound packet has been denied by the ACE.

R1#

¥3EC-6=-IPRCCESSLOGDF: list IF OFTIONS denied icmp 10.1.124.2 => 10.1.124.1 (0/0), 1

packet

Fl: The packet sent from RZ has been denied and leg message has been generated

due to log paramster anabled in ACE.

Task 2

On R2 configure an access list allows TCP packets only if the TCP flags ACK and
SYN are set and the FIN flag is not set. Additionally, permit only IP packets with TTL
between 254 and 255 and drop the rest with logging Layer 2 information.
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Apart from well-known features the extended access control list enables to
create an ACE whic h may define the following parameters:

= [P options
* TCP flags
*  Noncontiguous ports
* TTL value

for permitting or denying the packets flowing through the router.

Configuration
Complete these steps:
Step 1 R2 configuration.

R2 (config)¥ip acceas-list extended TCP_FLAGS

B2 (config—ext-nacl)dpermit tcp any any match-all +ack 4syn -fin
R2 (config-ext-nacl)ipermit ip any any ttl range 254 255%

R2 (config-ext-nacl) §deny ip any any log-input

R2 (config-ext-nacl) #int g0/ 0
R2 (config-if}#ip access—group TCP_FLAGE in

The ACL that permits TCF packets with STH/ACK flags enabled and FIN
flag disabled and permits any ip packet with TTL walue in the range
from 254 to 255. “log=input® in dany ip any any ACE will add the nams
and the MAC address of the router interface.

Verification

R2#sh ip access-lists

Extended IF access list TCF_FLAGS
10 permit tcp any any match=-all #ack =fin +syn
20 permit ip any any ttl range 254 255
30 deny ip any any log-input

F2#tel 10.1.124.1
Trying 10.1.124.1 ... Open

User Access Verification

Password:

Rl=axi
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[Connection to 10.1.124.1 closed by foreign host]

B2fish ip acoess-lists

Extended IF access list TCP_FLAGS
10 permit tep any any match=all +ack =fin +syn (1 mateh)
20 permit ip any any ttl range 254 255 (40 matches)
30 deny ip any any log-input

The TCF session from R2 to Rl has been established successfully. It has been
pessible by second ACE. Keote that first ACE matches the second packet which has
bean esxchanged during TCF handshake.

Rl#cenf t

Enter configuration commands, one per line. End with CNTL/E.
Rl {config)#ip route 10.1.124.2 255.255.255.255 10.1.124.4

Rl (config) #exit

R1#

ESY5-5-0ONFIG_I: Configured from conscle by conscle

Adding the routing from Rl towards R2 through R4 will cause of decrsase of TTL
value balow the walue dafined in second ACE of the ascess-list.

EL#
Fl#ping 10.1.124.2

Type ascapa sequence to abort.

Sending 5, 100-byte ICMP Echos to 10.1.124.2, timeout is 2 seconds:
u.w.uo

Success rate is 0 percent (0/5)

R2#
%5EC-6-IFRCCESSLOGDP: list TCP _FLAGS denied icmp 10.1.124.1 (GigabitEthernet0/0
0018,737a.a3e8) -> 10.1.124.2 {8/0), 1 packst

The ICMF packets have been blecked by the ACL. Hote that “leg-input® in last
deny ip any any statement has added name and MAC address of the interface.

RZ#sh ip access-lists

Extended IF access list TCPF_FLAGS
10 permit tep any any match-all +ack -fin +syn {1 match)
20 permit ip any any ttl range 254 255 (45 matches)
30 deny ip any any log-input (5 matches)

Kete that five IOMP packets have bean blecked by the acecess-list
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Task 3
Configure R4 so that it will drop all packets with any IP Option set. You are allowed to
use only one command to accomplish this task.

Configuration
Complete these steps:

Step 1 R4 configuration.

R4 {[config) #ip opticns drop

% Warning: RSVFP and other protocols that use IF Options packets may not
function as expected.

This command will result of dropping all the IF packets with IF
options enabled. Ramembar that several protocoels such as REVE, MPLS

TE will not work if this option is enabled on the router.

Verification

R2iping 10.1.124.4

Type escape segquence to abort.

sending 5, 100-byte ICMP Echos to 10.1.124.4, timesut is 2 seconds:
i

Success rate is 100 percent (5/5), round-trip minfavg/max = 1/1/4 ms

Finging the Rd Fal/0 interface without IF options set is sucoessful.

R2iping

Protocol [ip]):

Target IF address: 10.1.124.4

Repeat count [5): 1

Datagram size [100]:

Timeout in seconds [2]:

Extended commands [n]: y

Seurce address or interface: gigabitethernetd/0
Type of service [0]:

Set DF bit in IP header? [no]:

validate reply data? [no]:

Data pattern [OxRBCD]:

Loose, Strict, Record, Timestamp, Verbose[none): ST
Source route: 10.1.124.4

Loose, Strict, Record, Timestamp, Verbose[sV]:
Sweep range of sizes [n):
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Type escape segquence to abort.

Sending 1, l00-byte ICHMF Eches to 10.1.124.4, timecut is 2 seconds:

Packet sent with a source address of 10.1.124.2

Facket has IF options: Total option bytes= 7, padded length=8

Strict source route: «<=>»
(10.1.124. 4)

Reguest 0 timed ocut
Success rate is 0 percent (0/1)

Finging the R4 Fal/0 interface with LER

is unsuccassful

“ip options drop® has

bBlosked all ICHMP packaets with Strick Source Route option anabled.

Task 4

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.55. Protecting against network
mapping

Based on the previous Lab’s IP addressing, topology and Lab setu

S

.1 |Fo/o

10.1.124 0124

Goo| 2

Task 1
Configure R4 not to leak any useful information via ICMP.

Configuration
Complete these steps:

Step 1 R4 configuration.

Rd (configl#int £0/0
R4 (config-ifl# no ip unreachables

This option prevents the router from sending the ICMF Destination
Unreachable packets in case of network error occcurrence or when
packet is blocked by the ACL. This command changes deafault router
behavior (ip unreachables is enabled on all the interfaces by
default) .
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Verification

Bd#sh ip int £0/0

FastEthernst0/0 is up, line protocol is up
Internet address is 10.1.124.4/24
Broadcast address is 255.255.255.255
Address determined by setup command
MIU is 1500 bytes
Helper address is not set
Directed broadcast forwarding is disabled
tutgoing access list is not set
Inbound access list is not sat
Fromy ARF is enabled
Local Proxy ARP is disabled
Security lewvel is default
Split horizon is enabled
ICMP rediracts are always sent

IMF unreachables are never sent ganding ICMF packets of code 3 is disabled on
Fal/0

ICHMF mask replies are never sent

IP fast awitching iz enabled

IF fast switching on the same interface is disabled

IF Flow switching is disabled

IF CEF switching is enabled

IP CEF switching turbo wvector

IF multicast fast switching is enabled

IF milticast distributed fast switching is disabled

IF route-cache flags are Fast, CEF

Router Discovery is disabled

IP cutput packet accounting is disabled

IF access viclation accounting is disabled

TCP/IP header compression is disabled

RATF/IP header compression is disabled

Pelicy routing is disabled

Hetwork address translation is disabled

BGP Policy Mapping is disabled

Input features: Virtual Fragment Reassembly, Virtual Fragment Reassembly After IFSec
Decryption, MCI Check

WCCP Redirect outbound is disabled

WCCF Redirect inbound is disabled

WCCF Redirect exclude is dissbled

El#conf t
Enter configuration commands, one per line. End with CNTL/E.
Rl {config)l#ip route 4.4.4.4 255.255.255.255 10.1.124.4

The route to non-axisting netwerk through R4 has bean set.

Kl (config) #do ping 4.4.4.4
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Type escape segquence to abort.
Sending 5, l00-byte ICHMF Echos to 4.4.4.4, timeocut is 2 seconds:

Success rate is 0 percent ([0/5)

The ping is unsuccosssful that is obvious but note that there is ne “U®

indicsating that ICHMP unreachable packet has bsan obtained as the reply.

Task 2

Configure R2 to enable ICMP rate limit so that the router can send 1 ICMP
unreachable (code=1) packet per 5 seconds and only 1 ICMP unreachable (code=4)

packet per 3 seconds.

Configuration
Complete these steps:
Step 1 R2 configuration.

R2 {config) #ip icmp rate-limit unreachabla 5000
R2 (config)#ip icmp rate-limit unreachable DF 3000

Tha icmp ratea-limit has bean changed. By default the router sends

ene ICHP unreachable packet per 500 milliseconds. Femembar that the

value set by this configuration command is expressed in

milliseconds.

Veri n

Rl {cenfigl#ip reute 2.2.2.2 255.255.255.255 10.1.124.2

The route to nen-existing netwerk through R4 has been set

Bliping 2.2.2.2 rep 10

Type ascape seguence to abort.
Sending 10, 100-byte ICHMF Echeos te 2.2.2.2, timeout is 2 seconds:
L P i i}

Success rate is 0 percent (0/10)

Hote that unreachables appear but some of them have bean suppressed.

B2fsh ip iemp rate-limit g0/0
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Interval {(millisecond)

Interface

GlgabitEthernet0/0

This command shows

limi ting.

DF bit unreachableas
2000

# DF bit unreachables

1]

All other unreachables
SO00

# All other unreachables

2

setting and statistics relevant to IOMF unreachables rate
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LAB 3.56. Protecting Against DoS Attacks
using CAR

Based on the previous Lab’s IP addressing, topology and Lab setup

10.1.124 0124

.1 |[Fo/o
A | Foo Goo| 2
Task 1

You have discovered that R1 is sending a lot of ICMP packets towards R4. That
traffic causes performance degradation and high bandwidth utilization on the router.
Use Committed Access Rate (CAR) feature to limit the traffic to 8 kbps coming into
the f0/0 interface. Use 2 KB and 4 KB for normal and excess burst values.

Configuration
Complete these steps:

Step 1 R4 configuration.

R4 (config) #access-1list 130 permit icmp any any

R4 (config) #int £0/0

R4 (config-if}#rate-limit input access-group 130 8000 2000 4000 cenform-action
transmit exceed-action drep
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Verification

Ridp 10.1.124.4 rep 100 time 1

Type ascape seguence to abort.
Sanding 100, 100=byte ICMF Echos to 10.1.124.4, timecut is 1 seconds:
S R N N N N NN RN RN RN
BRRn RppERRR R RRnRRREEE nnnid

Success rate is 91 percent (91/100), round-trip minfavg/max = 1/1/4 ms

Hote that soma of the packets that have been sent toward R4, are blocked (drop
action has bean sat for the traffics that has axceadsd the normal limit) by CAR

feature enabled on Rd4's Fald/ 0

Rd#sh int £0/0 rate-limit
FastEthernet0/0

Input
matches: access—group 130
params: 8000 bps, 2000 limit, 4000 extended limit
conformed 21 packets, 10374 bytes; action: transmit
excesded 8 packets, 912 bytes: action: drop
last packet: 14632ms ago, current burst: 2140 bytes
last cleared 00:00:41 ago, conformed 2000 bps, exceeded 0 bps

Hote that 91 packets over limit of B kbps have bean transmitted due to conform

action defined and 8 packets have been dropped due to axcesd-action

Task 2

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.57. Preventing port redirection
attacks

Based on the previous Lab’s IP addressing, topology and Lab setup

S

.1 [Fow

10.1.124 0124

Goo| 2

Task 1
On R4's f0/0 interface disable the service that instructs an end node to use another
and more efficient path to a particular destination.

Configuration
Complete these steps:
Step 1 R4 configuration.

R4 (config)#int £0/0
R4 (config)#no ip redirects

Verification

Rl {config)#ip route 10.1.124.2 255.2535.255.255 10.1.124.4
Baefore disabling ICHMP Redirect

Bl #deb ie
ICHMF packet debugging is on
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Bliping 10.1.124.2 rep 2

Type escape seguence to abort.

Sanding 2, 100=byte ICMF Echos to 10.1.124.2, timeout is 2 seconds:
N

Success rate is 50 percent (1/2), round-trip min/avg/maxz = 1/1/1 m=s
Rl#

ICHMP: redirect rovd from 10.1.124.4- for 10.1.124.2 use gw 10.1.124.2
ICHMF: echo reply rovd, src 10.1.124.2, dst 10.1.124.1

Hote that R4 has peinted Rl to R2 which is the best router for 10.1.124.2/32

After disabling ICHF redirects:

Fl#deb arp
RRP packet debugging i= on

Rlé#cle ip redirect

Rliping 10.1 124 .2 rap 2

Type escape seguence to abort.
Sending 2, l00-byte ICHMF Echeos to 10.1.124.2; timecut is 2 seconds:

IF ARF: sent req src 10.1.124.1 000a.b819.c8al,
dat 10.1.124.4 0000.0000.0000 FastEthernetd/0
IP ARP: rowd rep src 10.1.124.4 0018.737a.a3e8, dst 10.1.124.1 FastEthernet0/o
|
Success rate is 50 percent (1/2), round=-trip min/awg/max = 1/1/1 ms
RL#
ICHP: echo reply rowd, src 10.1.124.2, dst 10.1.124.1

Hote that Rl has requested the MAC address of 10.1.124.4 that has bean redquired
for sending the ICMF echo reguast to the next hop (R4) Tha ARF reply has bean
recaived thus Rl has sant ICHMP packet towards B2 trough Rd as the next hop. The

IMP echo reply has bean receiwved

Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.58. Protecting against Smurf
attacks

Based on the previous Lab’s IP addressing, topology and Lab setu

S

.1 |Fo/o

10.1.124 0124

Goo| 2

Task 1
You are worried about Smurf attacks coming from the network. Configure R4 to block
DoS Smurf attacks coming from Ethernet segment to its loopback0 interface (create

a new Loopback interface with |P address of 4.4.4.4/24). You should use an access-
list to accomplish this task.

Smurf attack occurs when a large number of ICMP packets are sent to a router's
m subnet broadcast address with a spoofed source IP address of a host within

that subnet. Post 105 12.0 the routers are default with the “no ip directed-

broadcast” command which prevents this kind of attacks. But if the “ip

direc ted-broadcast” is enabled for whatever reason, then, the access-list will

block these types of attacks.

Configuration
Complete these steps:
Step 1 R4 configuration.

Rd (config)#int lol
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R4 (config=-if)#ip add 4.4.4.4 255.255. 255.0

Rd (config) baccess-1list 100 deny icmp any hest 4.4.4.255 leg
R4 (config) #access—-list 100 permit ip any any

R4 (config) #int £0/0

Rd (config=if}i#ip directed-broadcast

R4 {config-if)#ip accesa-group 100 in

Verification

Rl (configl#ip route 4.4.4.0 255.255.255.0 10.1.124.4

Rliping 4.4.4.255

Type escape seguence to abort.

Sending 5, 100-byte ICMP Echos to 4.4.4.255, timeout is 2 seconds:

v.u.u
Success rate is 0 percent (0/5)

R4

$3EC-6-IFACCESSLOGDR: list 100 dendied icmp 10.1.124.1 -> 4.4.4.255 {0/0), 1 packet

The traffic sent towards broadcast of 4.4.4.0/24 has been blocked by the

access=-1ist.
Rd#sh ip access-lists
Extended IF access list 100

10 deny icmp any host 4.4.4.255 leg {5 matches)

20 permit ip any any

The ACE has matched the IOMP packets sent to broadcast address.

Rdldsh ip int £0,/0

FastEthernet0/0 is up, line protocol is up
Internet address is 10.1.124.4/24
Broadcast address is 255.255.255,.255%
Address determined by setup command
MIU is 1500 bytes
Helper address is not set
Directed broadcast forwarding is enabled

dutgoing access list is not set
Inbound access list is 100
Froxy ARF is enabled

Local Proxy RRP is disabled
Security lewel is default

Split horizen is enabled

Directed broadcast has been enabled [(the
dafault setting has been changed)
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ICHMF redirects are newver sent

ICHMF unreachables are always sent

ICMP mask replies are never sent

IF fast switching is snabled

IP fast switching on the same interface is disabled
IF Flow switching is disabled

IP CEF switching is enabled

IF CEF switching turbo wector

IF multicast fast switching is enabled

IF multicast distributed fast switching is disabled
IF route-cache flags are Fast, CEF

Router Discovery is disabled

IF ocutput packet accounting is disabled

IF access viclation accounting is disabled
TCF/IFP header compressicon is disabled
RTE/IP header compression is disabled
Policy routing is disabled

Hetwork address translation is disabled

BGPF Policy Mapping is disabled

Input features: Rccess List, CAR, MCI Check
Post encapsulation features: CAR

WOCF Redirect ocutbound is disabled

WCCP Redirect inbound iz disabled

WOCF Redirect esclude is disabled

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.59. Port Security

Based on the previous Lab's IP addressing, topology and Lab setup

10.1.124 0124

Goo| 2

Task 1

Configure SWH ports so that only R2 and R4 can connect to ports F0/2 (or G0/2
depending on your rack topology) and F0/4 respectively. Configure their MAC
addresses on those ports and ensure that ports will shut down and send SNMP Trap

if some other device tries to communicate on that ports. You can configure static
MAC addresses on R2 and R4.

Configuration
Complete these steps:
Step1 R2 configuration.

R2 (config) #int g0/0
B2 (config-if ) # mac-address 0022.0022. 0022

Step 2 R4 configuration.

Fd (config) #int £0,/0
Bd (conf ig=-if)# mac-address 0044.0044. 0044

Tha MAC addresses have bean set on the R2's and R's intercfaces
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Step 3 Switchport where R2 and R4 are connected to.

SWl{config)#interface GigabitEthernet(/2

W1 (config-if)#switchport mode access
SW1(config-if)#éswitchport access vlan 124

W1 (config=-if)#switchport port=-security vioclation shutdown
W1 (config-if)#switchport port-security mac 0022.0022.0022
sWl{config-if)é#switchport port-security

SWl({config-ifj#interface FastEthernet(/4

Wl {config-if)#switchport mode access
SWl({config-if)deawitchport access vlan 124
8W1{config-if)#switchport port-security wviclation shutdown
SW1l{config-if}#switchport port-gsecurity mac 0044 .0044.0044
SW1 (config-if)#switchport port-security

W1 {config-if)#exi

Verification

Fort security has been enabled on switch ports. Remember that apart
from shutdown action which result of sending the SHMP trap (4if SHMP
server is defined) and shut the switch peort down, there are two
remaining violation actions: protect (packets with unknown source MAC
address will be dropped until a sufficient numbaer of secure MAC
addressas are removed bto drop balow the maximm value and the port
will net be shut dewn. SHMP trap will not be sent and Security
Viclation Counter will not be incremented) and restrict (the same as
proetect vielation actien but in addition Security Vielatien Counter is
incremented and SHMF Trap will bse sant. The port will not be shut
down) . Remember that “shutdown” wvieclation action will put switch port
in arr-disable state immediately when wiclation of port security rules

SOouUrs.

B2 10.1.124.4

Type escape sequence to abort.
Sending 3, 100-byte ICMP Eches to 10.1.124.4, timecut is 2 seconds:

Success rate is 80 percent (4/5), round-trip min/avg/max = 1/1/1 ms

R is able to send the traffic and port security has not blocked R2.

R2§sh arp

Frotocol Rddress Age (min) Hardware Rddr Type Interface

Internet 10.1.124.2 =  DO22. 0022, 0022 RARPAR  GigabitEthernst0/0
Internet 10.1.124.4 1] 0044, 0044, 0044 ARPA  GigabitEthernetd/0
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EWl#sh mac address-table interface gO/2

Mac Rddress Table

124 0022. 0022, 0022

DYNRAMIC Gin/z2

Total Mac Addresses for this criterion: 1

SWlksh mac address-table intecface £0,/4

Mac Rddress Table

Wlan Mac Rddress

124 0044. 0044, 0044

Typa Ports

CY NAMIC Fal/4

Total Mac Addresses for this criterion: 1

ARF cache and MAC address table entries displayed. Note that R2's and Rd's

conf iquraed MAC addrasses Are visible.

SWl#sh port-security interface g0/2

Fort Security
Port Status
Yiglation Mode
Rging Time
Aging Type

SecureStatic Rddress Aging

Maximmm MAC Addresses
Total MAC Addresses
Configured MAC Rddresses
Sticky MAC RAddresses
Last Source Rddress:Vlan
Security Viclation Count

Enabled
Secure-up
Shut down
0 mins
Absolute
Disabled
1

1

1]

o

002z . 0022, 0022 :124
0

EWl#sh port-security interface £0/4

Port Security
Fort Status
Yiglation Mode
Rging Time
Rging Type

SecureStatic RAddress Aging

Maximmm MAC Addresses
Total MAC Addresses
Configured MAC Rddresses
Sticky MAC Addresses
Last Source Rddress:vlan

Enabled
Secure-up
Shutdown
0 mins
Abeolute
Disabled
1

1

1

1]

0044 . 0044 . 0044 :124
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Sacurity Viclation Count : 0

Port sscurity sattings displayed. Hote that Maximim MAC Addresses has wvaluse of

1l which is a default

Task 2

Configure FO/1 and F0/4 as an access ports in VLAN 124 on SW1. Enable Port
security for these ports such that only 1 MAC address can be connected to them.
The switch should learn MAC addresses dynamically and store it as secure address
in memory.

Configuration
Complete these steps:

Step1 SWA configuration.

SW1l(config) #interface range £0/1 , £0/4
SW1l(config-if-range)#switchport mode access

W1 (config-if-range)#switchport access wvlan 124
SWl{config-if-range)#switchport port—security mac sticky
SW1l(config=-if-range)#switchport port-security

W1 {con fig-if-range) $exi

“switchport port-security mac sticky” enables the switch to lsarn
secure MAC addresses until Maximum MAC addresses parameter is not

axcesded. Isarnt MAC addresses will ba put into the running-config

Verification

Flfpi 10.1.124.4

Type escape sequence to abort.
Sending 5, l00-byte ICHMF Echos to 10.1.124.4, timecut is 2 seconds:

Success rate is 80 percent (4/5), round-trip min/avg/max = 1/1/4 ms

FPing is successiul - the traffic has not bean blocked by the port-security

featurs.
Fl#sh arp
Protocel Address Age (min) Hardware Addr Type Interface
Internet 10.1.124.1 - 000a. k819, cBalB RRFR FastEthernetd /0
Internet 10.1.124.4 1] 0044. 0044. 0044 ARFAR FastEthernet (/0
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MAC address of Rl has bean dynamically lsarnt by the switch

sWillsh port-security interface £0/1

Port Security

Fort Status

vislation Mode

Aging Time

Aging Type

SecureStatic Address Aging
Maximim MAC Addresses
Total MAC Addresses
Configured MAC Addresses
Sticky MAC Rddresses
Last Source Rddress:¥Ylan
Security Violation Count

Enabled
Secu re=up
Shutdown
0 mins
Abselute
Disabled
1

1

0

1
000a.b8l9.cBal 124
1]

Hota that “2ticsky MAC Addressas® counter has bean incremented.

SWlksh port-security intecface £0/4

Port Security

Fort Status

viaslation Mode

Aging Time

Rging Type

SecuraStatic Rddress Aging
Maximmm MAC Rddresses
Total MAC Addresses
Configured MAC Rddresses
Sticky MAC Addresses
Last Source Rddress:¥lan
Sacurity Vioclation Count

Enabled
Secure—up
Shut down
0 mins
Absolute
Disabled

oo R e

0044.0044.0044:124
1]

Tast: Change MAC address on R4

R4 (configl#int £0/0

Bd (config=-1if)d#no mac-address 0044.0044.0044

R4 {config-if)#exi

Fl#pd 10.1.124.4

Type escape segquence to abort.
Sending 5, l00-byte ICHMF Eches to 10.1.124.4, timeocut is 2 seconds:

Success rate is 0 percent (0/5)

SWll

#PM-4-ERR_DISABLE: psecure-viclation error detected on Fald/d, putting Fald/4 in err-

di sable state
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YFPORT_SECURITY=-2=-PSECURE VIOLATION: Security wiolation occurred, caused by MAC address
0018.737a.a3e8 on port FastEthernet(/4.

SLINEFROTO-5-UPDOWH: Line protocol on Interface FastEthernetd/d, changed state to down
RLINKE-3-UFDOWN: Interface FastEthernet0/4, changed state to down

Kote that SWl's Fal,/4 has been put inte err-disable state due te configured

shutdown wviolation action

sWillsh port-security interface £0/4

Port Security : Enabled

Fort Status : Secure-shutdown
Violation Mode : Shutdown

Aging Time : 0 mins

Aging Type : Rbsolute
SecureStatic RAddress Aging : Disabled
Maximmm MAC Addresses HE

Total MAC Addresses : 1

Configured MAC Rddresses = 0

Sticky MAC Addresses : 1

Last Source Rddress:¥Ylan : 00LE.T737a.aled 124
Security Vioclation Count 1

Hotea that Y"Poart Status” is Sacurse-shutdown duse to violatioh OOOUE P .

Security Viclation Count has bean incremsntad

Task 3

You use two computers in your office: desktop (MAC: 0055.0055.0055) and laptop
(MAC: 0066.0066.0066). Both of them are connected to port FO/3 on SW1. Configure
VLAN 20 on that port and enable Port Security so that only 2 MAC address can be
connected on that port. Configure restriction so that if someone else tries to connect
to the port SNMP Trap will be sent and port doesn't shut down.

Configuration
Complete these steps:

Step 1 SW1 configuration.

SW1{config)#interface FastEthernetl/3

SW1l(config-1if)#ewitchport mode access

aWl{config-if)#switchport access vlan 20

% Access VLAN does not exist. Creating wlan 20

SW1 (config-if) #switchport port-security maximmm 2

W1l (config-1f)#ewitchport port-security mac-address 0035.0055.0055
W1l (config-if)#switchport port-security mac-address 0066.0066.0066
aWl{config-if)#switchport port-security viclation restrict
SW1(config=-if)#switchport port-security
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W1l ({config=-if)#exi

“port-security maximmm” enables to add more than one secure MAC

addrass

Verification

BWl#sh port-security interface £0/3

Fort Security
Fort Status
Vigplation Mode
Aging Time
Rging Type

SecureStatic Rddress RAging :

Maximmm MAC Addresses
Total MAC Rddresses
Configured MAC Addresses
Sticky MAC Addresses
Last Source Rddress:Vlan
Security Viclation Count

: Enabled

: Secure-down
: Rastrict

: 0 mins

: Absoclute

H
t 2
H-
: 0

Disabled

: 0000, 0000.0000:0

HEN

SWlksh port-security intecrface £0/3 address

Secure Mac Rddress Table

20 0055, 0055, 0055
20 00EE . D0EE. 006E

Ports Remaining Age
{mins}

Fal/3 -

Fal/3 -

Total Addresses: 2

Both HMAC addresses

Task 4

have been added

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.60. Preventing VLAN Hoping
Attacks

Based on the previous Lab’s IP addressing, topology and Lab setu

10.1.124 0124

-1 [Fon
4 | Foo Goo| 2
Task1

Configure FO/7 on SW1 in VLAN 40. Make sure devices connected to this port are
prevented from conducting the VLAN Hoping attack.

Configuration
Complete these steps:

Step1 SWA configuration.

SWl{config)i#vlan 40

sWl{config-vlian)#interface FastEthernetd/7
Wl {cenfig-if)#switchport mode access
SWl(cenfig-if)#switchport access vlan 40
8W 1 {config-if)#switchport nonegotiate
SW1l(config-if)#exi

“switchport nonegotiate” specifies that Dynamic Trunking Protocol
(DTF) negotiation packets are not sent froem switch interface.
“awitchport mode acoess” disables trunking on the interface and
causes that snly nen-tagged frames will be sent and received. Statie

access port may be assigned only to one VIAN.
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Verification

SWild#sh interf £0/7 switchport

Hame: Fal/7

Switchport: Enabled

Bdministrative Mode: static access

Cperational Mode: down

Administrative Trunking Encapsulation: negotiate
Hegotiation of Trunking: Off

Access Mode VIAN: 40 (VLANOO40)

Trunking Hative Mode VLAM: 1 (default)

Administrative Hatiwve VLAN tagging: enabled

Volce VLAMN: none

Administrative private-vlan host-asscciation: none
Administrative private-vlan mapping: none
Administrative private-wvlan trunk natiwve VLAN: none

Administrative private-wlan trunk Hative VLAN tagging: enabled

Rdministrative private-vlan trunk encapsulation: dotlg
Administrative private-vlan trunk normal VLANHs: none
Rdministrative private-vlan trunk associations: none
Administrative private-vlan trunk mappings: none
Cperational private-vlan: none

Trunking VLANs Enabled: ALL

Fruning VILAN= Enabled: 2-1001

Capture Mode Disabled

Capture VLANs Rllowed: RALL

Frotected: false

Unknown unicast blocked: disabled
Unknown multicast blocked: disabled
Appliance trust: none

Task 2
You plan to connect Cisco IP Phone to port f0/8 on SWA.
following information:
= Data VLAN 40
= Voice VLAN 44
» Encapsulation 802.1Q
Ensure that you prevent VLAN hoping attack on this port.

Reconfigure it using the

Page 475 of 507



CCIE SECURTY vd Lab Workbook

Configuration
Complete these steps:

Step 1

SWH1 configuration.

aWl{cenfig)#vlan 44

awl({config-vlan)#inter face FastEthernet0d/8

SW1 (config-if) #switchport
8W1 {con fig-if) #switchport
SW1l(config-if)#switchport
8W 1 (con fig-if) #switchport
SW1(config-if)é#switchport

trunk encapsulation dotlg
mode trunk

trunk native wvlan 40
trunk allowed vlan 40,44
access vlan 40

wvolca wvlan 44
nonegotiate

SW1 (config-if) #switchport
SW1l{config-if)é#switchport
W1l (config-if)#exi

VLAN hepping on this interface is ensured by: disabled DTP
dafinition of allowed VLANs, dafinition of VLAN for the
data and for the Voiocs traffic, dafinition of native VLAN for untagged

negotiation,

frames, dafining trunk encapsulation protecol.

Verification

swi#sh interf £0/8 switchpert
Hame: Fal/g

Switchport: Enabled
Rdministrative Mede: trunk
COperational Mode: down
Administrative Trunking Encapsulation: deotlgiswitchport
Hegotiation of Trunking: Off

Access Mode VLAN: 40 (VLANGO40)

Trunking Mative Mode VLAM: 40 (VLANOD40)
Administrative Hative VLAN tagging: enabled
Volice VLAM: 44 (VLRMOO44)
Administrative private-wvlan

({switchport mode trunk)

trunk encapsulatien detlgq)
{awitchport nonegotiate)
(switchport access wlan 40)
(switchport trunk native vlan 40)
(switchport trunk native vlan 40)
(switchport voice wlan 44)

host-association: none

Administrative
Administrative
Administrative
Administrative
RBdministrative
Administrative
Administrative

private—vlan
private-vlan
private—vlan
private-vlan
private-vlan
private-vlan
private-vlan

mApPing: none
trunk
trunk
trunk
trunk
trunk
trunk

Operational private—vlan: nonhe
Trunking VLANs Enabled: 40,44
Fruning VIANs Enabled: 2-1001
Capture Mode Disabled

native VLAN: none
Hative VLAN tagging: enabled
encapsulation: dotlg
normal VLEMs: none
asgociations: none
mappings: none

({switchport

trunk allowed wvlan 40,44)
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Capture VLANs Allowed: ALL

Protected: false
Unknown unicast blocked: disabled
Unknown multicast blocked: disabled

Appliance trust: none
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LAB 3.61. VLAN access list

Based on the previous Lab's IP addressing, topology and Lab setup

10.1.124 0124

Goo| 2

Task 1
Configure the following policy for VLAN 124 on the switch:
= Hosts in VLAN 124 should not have access to a web server located at R4,
= There is a TELNET server running on R1. Only R4 should be able to access it,
* R2is trying to attack VLAN 124. It uses MAC address of 0022.0022.0022
(configure it statically). Block this MAC address from accessing any device on
VLAN 124,
= Block PPPoE packets (EtherType 0x8863 and 0x8864) coming into VLAN
124.
Do not apply any access lists on any of the routers’ interfaces.

Configuration
Complete these steps:

Step1 SW1 configuration.

SWl{config)#access-list 110 permit tcp any host 10.1.124.4 eg 80
SW1(config) #access-1ist 120 permit tep host 10.1.124.2 hest 10.1.124.1 eg 23

SWl{config)#mac access-list extended Elock R2 MAC
SWl(config-ext-macl)¥ permit host 0022.0022.0022 any
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Verification

SW1l{config-ext-macl)#mac access~-list extended Block FFPoE
awl{cenfig-ext-macl)# permit any any 0x8863 O
SW1l(config-ext-macl)¥ permit any any Ox8864 O

SW1l(config-ext-macl)évlian access-map BLOCK 10
W1l (config-access-map) # action drop
W1l (config-access-map) # match ip address 110

5W1 (con fig-access-map) #vlan access-map BLOCK 20
W1l (config-access-map) # action drop
aWl({config-access-map) # match ip address 120

aW1l(config-access-map) #vlan access-map BLOCK 30
W1l (config-access-map) # action drop
W1 ({config-access-map) # match mac address Block RZ_MAC

5W1 (config-access-map) #vlan access-map BLOCK 40
W1l (config-access-map) # action drop

SW1l{config-access-map) # match mac address BElock_ FPFPoE

W1l (config-access-map) #vlan access-map BLOCK 100

aWl{config-access-map) # action forward
Thé last sequence of VLAN accass-map has action “forwardY to parmit
other traffic that is not chosan by patterns configured in priocr VLAH

ACCEeSS-MAD SeqUences .

SW1(config-access-map) #vlan filter BLOCK wlan-list 124

Swid#sh wvlan access-map

vlan accesa-map "BLOCK®™ 10
Match clauses:
ip address: 110

Action:
drop

vlan accesa-map "BLOCK®™ 20
Match clauses:
ip address: 120

Action:
drop

¥lan access-map "BLOCK™ 30
Match clauses:
mac address: Elock_ _R2 MAC

Retion:
drop
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¥lan access-map "BLOCK™ 40
Match clauses:
mac address: Block PPPoE
Action:
drop
¥lan access-map "BLOCK™ 100
Match clauses:
Action:
forward

HZ (config)#int g0/ 0
B2 {config=if)d#mac-address 0022.0022.0022
R2 (config-if) #exi

R4 (config)l#ip http server

Checkliat

1. Hosts in VLAN 124 should not have Access Lo A wab saerver located At R4,

Rlé#tel 10.1.124.4 80
Trying 10.1.124.4, 80 ...
% Connection timed ocut; remote host not responding

R2#tel 10.1.124.4 B8O
Trying 10.1.124.4, BO ...
% Connection timed out; remote host not responding

Rd#tal 10.1.124.4 80

Trying 10.1.124.4, 80 ... Open

GET %,

HTTE/1l.1 400 Bad Reguest

Date: Sun, 05 Sep 2010 11:50:08 GMT
Server: cisco-I0S

Accept-Ranges : none

400 Bad Reguest

[Connection te 10.1.124.4 closed by foreign host]

2. Thare iz a TELHET sarver running on Rl. Only Rd should be able to acoess it,

F2é#tel 10.1.124.1

Trying 10.1.124.1 ...
% Connection timed out; remote host noet responding

Ré#tel 10.1.124.1
Trying 10.1.124.1 ... Open

User Access Verification
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Password:
Rl>exit

[Connection to 10.1.124.1 closed by foreign host]
3 Ri is trying to attack VLAN 124. It uses MAC address of 002%.002Z.00Z2
([configurae it statically) . Block this MAC address from acoassing any davioa on

VLAN 124,

E2#ping 10.1.124.1

Type escape segquence to abort.
Sending 5, l00-byte ICMF Eches to 10.1.124.1, timecut is 2 seconds:

Success rate is 0 percent (0/5)

E2ftel 10.1.124.4 80
Trying 10.1.124.4, &0 ...
% Connectien timed ocut; remote host net responding

R2fping 10.1.124.4

Type escape sequence to abort.
Sending 5, l00-byte ICHMF Echeos to 10.1.124.4, timecut is 2 seconds:

Success rate is 0 parcent (0/5)

Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.62. DHCP Snooping and Dynamic
ARP Inspection

Based on the previous Lab’s IP addressing, topology and Lab setup

S

.1 |Fofo
10.1.124.0/24
Goo| 2
Task 1
Configure DHCP Snooping on SWA to build MAC<->IP mapping database for ports in
VLAN 124.
Configuration
Complete these steps:

Step1 SWA configuration.

SWl(config)d¥ip dhep snooping
aWwl({cenfig)#ip dhep snooping vlan 124

Remember that toe enable the dhop anecping in the given VLAN, the “ip
dhep snooping® global command mist be issued before. Enabling the IP
DHCF Snoocping only in the VLAN will causs that DHCF snooping will

not work
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Task 2

Reconfigure all routers (R1, R2, R4) to be DHCP clients in VLAN 124. Enable DHCP
server on R5 with IP address of 10.1.124.5/24 and give out a pool of 10.1.124.0/24.
Make sure switch does not insert Option 82 into DHCP requests. Configure VLAN
124 on port FO/5 and enable DHCP trusting. Control the number of DHCP packets on
this port to 10 requests per second.

Configuration
Complete these steps:

Step 1 RS5 configuration.

Router {config) $#hostname RS

RS (config)#int £0/0

RS (config-if)#ip add 10.1.124.5 255.255.255.0
RS (config-if)éno shut

RS (config-ifl#exit

RS {config) #ip dbhcp pool VLAN-124

RS (dhep-config) #énetwork 10.1.124.0 /24
R5 (dhep-config) #exi

Step 2 R1 configuration.

Rl (config)#int £0/0
Rl {config-if}#ip address dhcp
Rl {config-if) #exi

Step 3 R2 configuration.

R2 (config)#int g0/0
R2 (config-if)#ip addreas dhcp
R2 (config=if)#exi

Step 4 R4 configuration.

R4 (config) #int £0/0
R4 {config-if)#ip address dhcp
Rd (config-if)dexi

Step 5 SWA configuration.
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SWl({config)#no ip dhcp sneoping information opticon

This command disables insarting Option B2 inte DHCP requasts.

SWl{configléint £0/5
SW1(config=-if)#switchport mode access
SWl(config=-1if)#ewitchport accesas vlan 124
8W1l{config-if)#ip dhcp snooping trust
5W1{config-if)#ip dhcp snooping limit rate 10
SW1l{config-if)#exi

vip dhep snoocping trust” causes that DHCP Server is able to werk. DHCP
offar will not be blocked by switch. Remember that this command mast
ba anabled on trunk port if DHCP client and DHCP sarver Are ocohhecbed
toe different switches and ip dhcp snooping is enabled. “ip dheop
snooping limit rate 107 limits the number of DHCP messages that can be
received per second.

Verification

Fl#sh int £0/0
FastEthernet (/0 is up, line protocel is up
Hardware is MV36340 Ethernet, address is 000a.b86b.a3f0d {(bia 000a.bi86b.a3fl)
Internet address is 10.1.124.2/24
MTU 1500 bytes, BW 100000 Ebit/sec, DLY 100 usecs,
reliability 255/255, txlead 1/255, rxload 1/255
Encapsulation ARFA, loopback not set
Keepalive set (10 sec)
Full-duplex, 100Mb/s, 100BaseTX/FX
ARF type: ARPFA, ARF Timecut 04:00:00
Last input 00:00:21, cutput 00:00:02, ocutput hang never
Last clearing of "show interface"™ counters newver
Input gueue: 0/75/0/0 (size/max/drops/flushes); Total cutput drops: 0
Queneing strategy: fifo
output guewe: 0740 (size/max)
5 minute input rate 0 bits/sec, 0 packets/sec
5 minute output rate 0 bits/sec, 0 packets/sec
241 packets input, &0000 bytes
Received 107 broadcasts, 0 runts, 0 giants, 0 throttles
0 input errors, 0 CRC, 0 frame, 0 owerrun, 0 ignored
0 watchdog
0 input packets with dribble condition detected
639 packets ocutput, 109725 bytes, 0 underruns
0 cutput errors, 0 collisions, 1 interface resets
14 unkneown protocol drops
0 babbles, 0 late collision, 0 deferred
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0 lost carrier, 0 no carrier

0 output buffer failures, 0 output buffers swapped ocut

BZ#sh int god/0
GigabitEthernet0d/0 is up, line protocol is up
Hardware is BCM1125 Internal MAC, address is 0022.0022.0022 (bia 0017.%527.ba00)
Internet address is 10.1.124.1/24
MTU 1500 bytes, BW 1000000 Ebit/sec, DLY 10 usec,
reliability 255/255, t=zlcad 1/255, rxload 1/255
Encapsulation ARFR; loopback not set
Keepalive set (10 sec)
Full-duplex, l000Mb/s, link type is autonegotiation, media type is 85X
output flow-contrel is XOW, input flow-control is XON
ARF type: ARFA, ARF Timeocut 04:00:00
Last input 00:00:33, output 00:00:08, sutput hang never
Last clearing of "show interface"™ counters never
Input gueue: 0/75/0/0 (size/max/drops/flushes); Total sutput dropas: 0
fueueing strategy: fifo
tutput queue: 0/40 (size/max)
5 minute input rate 0 bits/sec, 0 packets/sec
5 minute cutput rate 0 bits/sec, 0 packets/sec
81 packets input, 38413 bytes, 0 no buffer
Received 68 breadcasts, 0 runts, 0 giants, 0 throttles
0 input errors, 0 CRC, 0 frame, 0 owerrun, 0 ignored
0 watchdeg, 1390 multicast, 0 pause input
0 input packets with dribble condition detected
503 packets cutput, 88720 bytes, 0 underruns
2 output errors, 0 collisions, 1 interface resets
0 unknown protocol drops
0 babbles, 0 late collision, 0 deferred
2 lost carrier, 0 no carrier, 0 pause output
0 cutput buffer failures, 0 ocutput buffers swapped ocut

Ré#sh int £0/0
FastEthernet(0/0 is up, line protocel is up
Hardware is MW956340 Ethernet, address is 000a.b81%.c520 (bia 000a.b819.c%20)
Internet address is 10.1.124.3/24
MIU 1500 bytes, BW 100000 HKbit/sec, DLY 100 usec,
reliability 255/255, txlead 1/255, rxload 1/255
Encapsulation ARFA, loopback not set
Kespalive set (10 sec)
Full-duplex, 100Mb/s, 100BaseTH/FX
ARF type: ARFA, RARF Timeocut 04:00:00
Last input 00:00:3%, output 00:00:01, sutput hang never
Last clearing of "show interface"™ counters never
Input gueue: 0/75/0/0 (size/max/drops/flushes); Total sutput drops: 0
fueueing strategy: fifo
cutput queue: 0/40 {(size/max)
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5 minute input rate 0 bits/sec, 0 packets/sec
5 minute cutput rate 0 bits/sec, 0 packets/sec
168 packets input, 43948 bytes
Received 6% breoadcasts, 0 runts, 0 giants, 0 throttles
0 input errors, 0 CRC, 0 frame, O owverrun, 0 ignored
0 watchdog
0 input packets with dribble condition detected
596 packets ocutput, 54886 bytes, 0 underruns
0 cutput errors, 0 collisions, 1 interface resets
unknown preotocel drops
babbles, 0 late collision, 0 deferred

lost carrier, 0 no carrier

L= = = R = |

output buffer failures, 0 ocutput buffers swapped ocut

BS5#sh ip dhop binding

Bindings from all pools not asscciated with VRF:

IP address Cclient-ID/ Lease expiration
Hardware address/

Usar name

10.1.124.1 0063.6973.636£.2d30. Sep 0% 2009 04:32 AM

3032.322e.3030.3232,
2e30.3032,.3224.4769.
I0ZE.30

10.1.124.2 0063.6973.636L.2d30. Bep 09 2009 04:33 AM

3030.612e.6238,. 3662,
2e61.3366.302d.4661.
302£.30

10.1.124.3 0063.6973.636F. 2d30. Bep 09 2008 04:33 AM

3030.612e.6238.3135.
2863,3932.302d. 4661,
302£.30

Rl, R2 and Bd have got their IP addresses by DHCP from R5.

RS#sh ip dhcp server statistics

Memory usage 23708
Address pools
Database agents
Automatic bindings
Manual bindings
Expired bindings
HMalformed messages

(=T = = -

Sscure Arp entries

Me gsage Received
BOOTREQUEST 1]
DHCPFDIS COVER

DHCFREQUEST

L=J L

DHCFLECLINE

Automatic

Automatic
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CHCFRELERSE
CHCPINFORM

Ha ssage Sant
BOOTREELY
DHCPOFFER
DHCERCK

(= L -]

DHCPRRE

SWld#sh ip dhe snecping

Switch DHCF snooping is enabled

CHCP snooping is configured on following VLAMNs:

124

DHCF snooping is operational on following VLIAMNE:

124

CHCP snooping is configured on the following L3 Interfaces:

Ingertion of option B2 is disabled (i ip dhep snooping informatisn
cptiecn)
circuit-id format: vlan-mod-port
remote-id format: MAC
Cption 82 on untrusted port is not allowed
Varification of hwaddr field is snsblad
Verification of giaddr field is enabled
DHCP snooping trust/rate is configured on the following Interfaces:

FastEtherneti/5 yes 10 ([ip dhop snooping limit rate 10)

SWlksh ip dhop snooping binding

Machddress IpAddress Leasa(sec) Type YLAN Interface
O0:22:00:22:00:22 10.1.124.1 85710 dhep-snooping 124
GligabitEthernet/2

00:0R:BB:6B:A3:FO 10.1.1249.2 B5716 dhep-snooping 124 FastEthernet0/1
00:0R:B8:19:C9:20 10.1.124.3 85728 dhep-snooping 124 FastEthernetd/q

Total number of bindings: 3

DHCF snecping database has been displayed

Task 3
Configure SW1 to dynamically verify MAC<->IP mappings against the DHCP

Snooping database for VLAN 124. Unmatched packets should be dropped. Validate
an IP address inside each ARP packet.
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Configuration
Complete these steps:

Step 1 SW1 configuration.

SWl(config)#ip arp inspection wlan 124
SWl{config)#ip arp inspection walidate ip

Remember that in DHCF-environment Dyvnamic ARFP Inspection feature
uses DHCF Snooping binding database fer the list of the walid IP-to-
HMAC mapping, therefore ip dhop snooping mist be enabled prior DAI is
anabled. In non-DHCP environment ARP ACL must be oconfigured to
provide DAI with valid IF-to-MAC mapping.

SW1{config)#int £0/5
SWl{config-if)¥ip arp inspecticn trust
8W1l{config-if)#exi

By default all the interfaces are untrusted se¢ DAI is inspecting ARP
packets on all interfaces. Making the interface trusted causes that
DAI will net perfoerm ARF inspection on that interface. Famember that
confiquring interfaces as untristed when they should be tristed can
result in A loss of tﬁlﬁ.ﬁ&ttlvlt‘f. ¥ou should considar mnfxgurxng

interfaces as trusted especially on inter-switch links but remember

that DAI is ingress feature only.

Verification

SWlksh ip arp inspection interfaces

Interface Trust State Rate (pps) Burst Interval
Fal/1 Untrusted 15 i
Fal/2 Untrusted 15 1
Fal/3 Untrusted 15 1
Fa0/4 Untrusted 15 1
Fal/5 Trusted Hene H/R
Fal/& Untrusted 15 1
Fal/7 Untrusted 15 1
Fad/8 Untrusted 15 1
Fa0/9 Untrusted 15 1
Fa0/10 Untrusted 15 1
Fal/11 Untrusted 15 1
Fald/1l2 Untrusted 15 1
Fa0/13 Untrusted 15 1
Fal/14 Untrusted 15 1
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Fal/15 Untrusted 15 1
Fal/l& Untrusted 15 1
Fal/17 Untrusted 15 1
Fa0/18 Untrusted 15 1
Fal/l% Untrusted 15 1
Fal/20 Untrusted 15 1
Interface Trust State Rate (pps) Burst Interval
Fal/21 Untrusted 15 1
Fal/22 Untrusted 15 1
Fal/23 Untrusted 15 1
Fal/24 Untrusted 15 1
Gi0/1 Untrusted 15 i
Gi0/2 Untrusted 15 1

Keote that default value of rate limit set on untrusted interfaces as 15

insoming ARP packet

par aasond is visible

SWlksh ip arp inspection vlan 124

Source Mac Validation : Disabled
Dastination Mac Validation : Disabled
IPF Address Validation : Enabled
¥lan Configuration Opsration  ACL Match Static ACL
124 Enabled Active >
¥lan ACL Logging DHCP Logging Probe Logging
124 Deny Dany ;;;mm
sWllsh ip arp inspection stat
¥lan Forwarded Dropped DHCF Drops ACL Drops
124 [i] 1] o] - :
¥lan LDHCF Permits ACL Permits Probe Permits Source MAC Failures
124 i} 1] o] o]
Vlan Dest MAC Failures  IP Validation Failures  Inwvalid Protecol Data
124 o 0 o

Dynamic ARF Inspection settings and statistics displayed.
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Hote that
ping R2 fr
Ft

R2 {config)

RZ has MAC address of 0022.0022.0022. Change it to something else and try to

om any @ther router

#int g0/0

R2 (config-if)#noe mac-address

Rédping 10

1.124.1

Type ascape seguence to abort.

Sanding 5,

100-byte ICMP Echos to 10.1.124.1, timeosut is 2 seconds:

Success rate is 0 percent (0/5)

sWl#

*Mar 1 04:
124. {[0017.
*Mar 1 04:
1z24. ([@017.
*Mar 1 04:
1z4. ([0017.
*Mar 1 04:
124. {[0017.
#=Mar 1 04:
124. ([00O17.

57:37.735: RaW_DATI-4-DHCP SHOOPING DENY: 1 Inwvalid ARPs
9527.ba00/10.1.124.1/000a.b819.c520/10.1.124.3/04:57:37
57:39,.748: %SW_DAI-{-DHCP SWOOPING DENY: 1 Invalid ARPs
9527.ba00/10.1.124.1/000a.b819.c320/10.1.124.3/04:57:39
57:41.761l: %SW _DAI-{-DHCP SNOOPING DENY: 1 Invalid RARPs
9527.ba00/10.1.124.1/000a.b819.2320/10.1.124.3/04:57:41
57:43.775: %5W_DAI-4-DHCF SHOOPING DEWY: 1 Invalid RARPs
3527.ba00/10.1.124.1/000a.b815.c520/10.1.124.3/04:57:43
57:45%.788: %SW _DAI-{-DHCP SWOOPING DENY: 1 Invalid ARPs
9527.ba00/10.1.124.1/000a.bA19.c520/10.1.124.3/04:57:45

({Res) on Gi0/2, wvlan
UTC Mon Mar 1 1953])
(Res} on GLO/2, wlan
UTC Mon Mar 1 1993])
(Res} on GLO/2, wlan
UTC Mon Mar 1 1553])
(Res} on GLO/2, wlan
UTC Mon Mar 1 199%3])
(Res} on GLO/2, wlan
UTC HMon Mar 1 155%3])

Fing has been unsuccesaful and leg message has been generated informing that

invalid ARF reguest (IF address resclution) has beean denied

Task 4

Configure static MAC address on R4 to 0044.0044.0044 and IP address of
10.1.124.44/24. Configure static ARP access list for this host's IPIMAC address pair.
This ARP ACL should be applied to VLAN 124. Log any matches for the ACL within
VLAN 124 and validate an IP address inside ARP packets.

Configuration

Complete these steps:

Step 1

R4 configuration.

R4 (config) #int £0/0

Rd (config-if)#mac-address 0044.0044.0044

R4 (config-if)#ip add 10.1.124.44 255,255.255.0
R4 (config-if) #exi
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Step 2 SWA1 configuration.

SWl({config)#ip arp inspection wlan 124 legging acl-match matchlog
aWwl{cenfig)#ip arp inspection validate ip

SWl{cenfig)#arp access—list ARFl24
SWl({config-arp-nacl}# permit ip host 10.1.124.44 mac host 0044.0044. 0044 log

SW1l(config-arp-nacll#ip arp inspection filter ARF124 wlan 124

ARF acocess-list creates static IF-toe-MAC mapping for DAL

Verification

SWl#sh ip dhop snooping binding

Machddress IpAddress Leasa(sec) Type YLAN Interface
O0:22:00:22:00:22 10.1.124.1 83883 dhep-snooping 124
GigabitEthernet(/2

00:0R:BB:6B:R3I:FO 10.1.1249.2 g3888 dhep-snooping 124 FastEthernet0/1
00:0R:ER:19: CB:20 10.1.124.3 3900 dhep=snooping 124 FastEthernet0/d4

Total number of bindings: 3

SWlf#cle ip dheop snoocping binding interface £0/4

All entries of Fa0/4 interface, that have bsen learnt dynamically, have besan

Ll P

SWlksh ip dhop snooping binding

Machddress IpAddress Leasa(sec) Type YLAN Interface

00 :22:00:22: 00:22 10.1.124.1 83858 dhecp-snooping 124
GligabitEthernet(/2

00:0R:BE:6B: A3:FO 10.1.124.2 83863 dhep=-snooping 124 FastEthernet(/1

Total number of bindings: 2

Hote that there is no DHCP Snooping binding for R4.

SWilkip dhcp snooping binding 0044.0044.0044 vlan 124 10.1.124.44 interface £0/4 expiry
86400

Static binding has been oreated

SWl#sh ip dhop snooping binding
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Machddress IpAddress Leasa(sec) Type YLAN Interface
00:22:00:22:00:22 10.1.124.1 83534 dhecp-snooping 124
GligabitEthernet(/2

00:44:00:44:00:44 10.1.124.44 86372 dhep=-snooping 124 FastEthernet(/4
00 :OR:BE:EBIAZFD 10.1.124.2 B3539 dhep-snooping 124 FastEthe rnetd /1

Total number of bindings: 3

Flépi 10.1.124.44

Type ascape segquence to abort.

Sending 5, 100-byte ICMP Eches to 10.1.124.44, timecut is 2 seconds:
RN

Success rate is 80 percent (4/5), round-trip min/avg/max = 1/1/4 ms

swid

“Mar 1 05:23:37.605: WSW_DAI-6-ACL PERMIT: 1 ARPs (Res}) on Fald/4, wlan

124. ([0044.0044.0044/10.1.124. 44/ 000a. 86k, a3£0/10.1.124.2/05:23:36 UTC Mon Mar 1

1993]}
Hote that ping is successful. DAI has permitted the ARF request (address
resolution) and this activity has bean logged due to enabling the logging of
every ARF ACL match

Task 5

Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.63. IP Source Guard

Based on the previous Lab's IP addressing, topology and Lab setup

Task 1

10.1.124 0124

Goo| 2

Configure static IP <-> MAC <-> Port <-> VLAN binding for R2's IP (10.1.124.2/24)
and MAC (0022.0022.0022) addresses on SWH1. Enable IP source guard on port
F0/2. Configure protection against MAC address spoofing along with IP source

guard.

M

IP Source Guard is a feature which enables to prevent IP spoofing attacks in
LAN. IP Source Guard feature relies on DHCP Snooping binding database or
static |P-to-MAC-to-Port-and-to-VLAN mapping. When IP Source Guard is
enabled on switch port then all traffic except DHPC requests is Blocked until
valid mapping is entered dynamically into DHCP Snooping binding database or
ip source binding is configured statically. Afterwards per-port and VLAN
Access Control List (PVACL) is put on the port which permits legitimate traffic
only (with valid IP source). Remember that if IP source guard is enabled in IP
and MAC filtering mode, the DHCP snooping option 82 must be enabled to
ensure that the DHCP protocol works properly.
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Configuration
Complete these steps:

Step 1 R2 configuration.

B2 (config) #int gl/0
R2 (config-if}#mac-address 0022.0022.0022
R2 (config-if}#exi

Step 2 SWA configuration.

Wl (config) #ip dhep snooping
SWl({config)#ip dhcp snooping vlan 124

SWl(cenfig)#ip source binding 0022.0022.0022 wvlan 124 10.1.124.2 interface

go/z

Static binding has bean created because R: IP address 18 static

SWl(config)¥int £0/2

SWl{coenfig-if)#ip verify source port—security
SW1{config-if) éswitchport mode access
SW1(config-if)#switchport access wlan 124

W1l (config-1if)#eswitchport port-security
SW1l{config-if)#exi

Verification

EWllsh ip scurce binding

Machddress Iphddress Lease(|sec) Type VLAN Interface
00:22:00:22: 00:22 10.1.124.2 infinite static 124
GigabitEthernst(/2

Total number of bindings: 1

Hote that the entry is type of “static®

gWlksh ip dhop snooping

Switch DHCP snooping is enabled

CHCF snooping is configured on following VLANs:

124

CHCP snooping is operational on following VLIANE:

124

CHCP snooping is configured on the following L3 Interfaces:

Ingertion of option 82 is enabled
circuit-id format: vlan-mod-port
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remote=-id format: MAC
Option 82 on untrusted port is not allowed
Verification of hwaddr field is enabled
Verification of giaddr field is enabled
DHCFP snooping trust/rate is configured on the following Interfaces:

Interface Trusted Rate limit (pps)

DHCF Snocping settings has been displayed. DHCF Snoocping has been enabled for
vlan 124.

SWl# show ip verify socurce interface g0/2
Interface Filter-type Filter-mode IP-address Mac-address vian

GLO/2 ip-mac active 10.1.124.2 00:22:00:22:00:22 124

IP Source Guard is sacuring R2 IP address on pork @102

Rlé#pi 10.1.124.2

Type escape seguence to abort.

Sending 5, 100-byte ICMP Echos to 10,.1.124.2, timesut is 2 seconds:
RERN

Succesgs rate is 80 percent (4/5%), round-trip min/avg/max = 1/1/4 ms

Rote that ping is suococessful because PVACL conditions are met basing on mapping
that created.

B2 {config)#int go/o

R2 {(config-if) #no mac-address

R1 10.1.124.2

Type escape segquence to abort.
Sending 5, l00-byte ICMF Echos to 10.1.124.2, timecut is I seconds:

Success rate is 0 percent (0/5)

When MAC address has been reverted te real value the traffic has been blecked

by IF Socurce Guard features.

R2 {cenfigléint gd/0
B2 (config-if)imac-address 0022.0022.0022

Flépi 10.1.124.2

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.124.2, timeout is 2 seconds:
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1
Success rate is 40 percent (2/5), round-trip min/avg/max = 1/1/1 ms

Fing is successful when MAC address has been reverted to the wvalue configured

in static mapping

R2 (config)#int g0/ 0
R2 {config-if) #ip add 10.1.124.22 255.255.255.0

Flépi 10.1.124.22

Type ascape segquence to abort.
Sending 5, 100-byte ICMP Echos to 10.1.124. 22, timeout is 2 seconds:

Success rate is 0 percent (0/5)

Changing IF address causes that FVACL has blocked the traffic (conditions are

ot mek)

Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.64. Protecting Against Broadcast
Storms

Based on the previous Lab’s IP addressing, topology and Lab setu

10.1.124 0124

-1 [Fon
4 | Foo Goo| 2
Task1

Ensure SW1 so that no more than 10% of broadcast traffic could be accepted from
the R1 and R2 no more than 1Mbps of broadcast could be accepted from R2. Also,
limit unicast packets to no more that 1M packets per second on the switch port where
R4 is connected to.

Storm control prevents traffic on a LAN from being disrupted by a broadcast, a

m multicast, or a unicast storm on the interface. Storm control feature measures
the traffic in one-second intervals and blocks the traffic if one of the following
parameters is exceeded:

* configured percentage of bandwidth available on the interface that can
be utilized before storm-control will suppress excessive broadcast,
multicast or unicast traffic,

* configured rate of packets per seconds that can be transmitted through
the interface before storm-control will suppress excessive broadcast,

multicast or unicast traffic.
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Configuration

Complete these steps:
Step 1 SW1 configuration.

8W1l({config)#int £0/1

W1 (config-1if)#storm-control broadcast level 10.00

W1l (config-if)#exi

5W1({config)#int g0/2

SWl(cenfig-if)#storm—centroel broadeast level bps 1lm

W1l (config-1if)dexi

SWl{config)iint £0/4

W1 (config=-if)#storm-control unicast level pps 1lm

SW1l(config-1if)dexi

Verification

EWl#sh storm-control broadoast

Interface Filter State Upper Lower Current

Fal/l Forwarding 10. 00k 10. 008 0. 00k

GLO/2 Forwarding im bps 1lm bps 0 bps

SWllsh storm=-control unicest

Interface Filter State Upper Lowe & Current

Fal/4 Forwarding im pps im pps 0 pps
Storm control sattings have bean displayed for broadoast and unicastk
separatel .

Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.65. Protecting Spanning-Tree
Protocol

Based on the previous Lab’s IP addressing, topology and Lab setup

S

.1 [Fow

10.1.124 0124

Goo| 2

Task 1

Configure SWA to be the STP Root for VLAN 124 and make sure that nobody else
can claim itself as root.

Also, ensure that SW1 does not send or receive any BPDUs toffrom R1 and put
interface in err-disable state when receive BPDU from R4. Configure SWA to
automatically clear error-disabled ports (triggered by the BPDU Guard) after 2
minutes.

Configuration
Complete these steps:

Step1 SW1 configuration.

W1l (config)#int ran £0/1% - 24
SW1l(config-1if-range)#sw trunk encap dotl
W1l (config-if-range)#sw mo trunk

W1 (config-1if-range)dexi

SW1l(config)#epanning-tree vlan 124 root primary

SW1(cenfig)#int range £0/19 - 24
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Verification

BWl#sh

W1l (config=-if-rangel# spanning-tree guard root

%5 FANTREE-2-ROOTGUARD _CONFIG CHAMNGE: Root guard enabled on port
FastEthernet0/15.

%5 FANTREE-2-ROOTGURRD CONFIG CHANGE: Root guard enabled on port
FastEthernet0/20.

ismn-z-mmn_muns_m: Root guard enabled on port
FastEthernet0/21.

ismmn-z-mm_muns_m: Root guard enabled on port
FastEthernet0/22.

ismrnn-z-nmmmn_murls_m: Root guard enabled on port
FastEthernet0/23.

ismn-z-mmm_murli;_mm: Root guard enabled on port
FastEthernet0/24.

$SPANTREE-2-ROOTGUARD BLOCK: Root guard blecking port FastEthernet(/21 on
VLANOODL.

%3 FRNTREE-2-ROOTGUARD BLOCK: Root guard blocking port FastEthernet(/1% on
VLANOOODL.

8W1l{config-if-range)#int £0/1

% Command exited ocut of interface range and its sub-modes.
Hot ezecuting the command for second and later interfaces

aWl({config-if)#spanning-tree bpdufilter enable

W1 {config-if)#int £0/4
SWl{config-if)#spanning-tree bpduguard enable

W1 {config-if)#exi

SW1l(config)#errdisablea recovery causa bpduguard
SW1l(config) derrdisable recowvery interwval 120

intarfaces trunk

Fort

Fal/1%
Fal/20
Fal/21
Fa0/22
Fal/23
Fa0/24

Fort

Fal/1%9
Fal/2z0
Fa0/21
Fal/22

Mode Encapsulation Status Hative vlan
on 802. 1g trunking 1
on B2, 1q trunking 1
on 802. 1g trunking 1
on 802, 1gq trunking 1
on BOZ. 1g trunking 1
on B02. 1q trunking 1

¥lans allowed on trunk
1-4094
1=-4054
1-4054
1-4054
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Fal/23
Fal/24

Fort

Fal/1l%
Fal/2z0
Fald/21
Fal/22
Fal/23

Fort
Fal/24

Port

Fad/13
Fal/20
Fal/21
Fal/22
Fal/23
Fad/Z4

1=4054
1-4054

¥lans allowed and active in management domain

1,124
1,124
1,124
1,124
1,124

¥lans
1,124

allowed and active in management domain

vlans in spanning tree forwarding state and not pruned

none
none
nona
none
none

none

SWlksh spanning-tres vlan 124

VLANOLZ 4
Spanning tree enabled protocol isee

Reot ID Eriority 24700
Rddress 001%. 0e0c. TelD
This bridge is tha root
Hello Time 2 sec Max Age 20 sec Forward Delay 1% sec
Bridge ID Friority 24700 (pricrity 24576 sys-id-ext 124}
Rddress 001 %, 060c. 7600
Hello Time 2 sec Max Age 20 sec Forward Delay 15 sec
RAging Time 15
Interface Role Sts Cost Pric.Hbr Type
GLO/2 Desg FWD 4 128.2 P2p
Fal/1 Desg FWD 100 128.3 EZp
Fal/4 Desg FWD 1% 128.6 P2p
Fal/1% Desg EWD 1% 128.21 EZp
Fad/20 Desg EFWD 15 1z8.22 FZp
Fad/21 Desg FWD 1% 128.23 EZp
Fad/22 Desg FWD 15 128.24 F2p
Fal/23 Desg FWD 1% 128. 25 P2p
Fad/24 Desg EWD 19 128.26 F2p
Kote beth Root MAC address and Bridge MAC address are the same. This means this
switeh is & root bridge for VLAN 124.
Alsc note that all trunks are in forwarding state. This is because all paths teo
the route bridge muist be anabled.
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Task 2
Erase the startup config and reload the routers before proceeding to the next lab.
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LAB 3.66. Preventing IP spoofing

10.1.24.0 /4

Lab Setup
# Configure the FO/0 interface of R4 and G0/0 interface of R2 in VLAN 24

» The Frame-relay interface of these routers should be configured in a point-to-
point manner.

Task 1
Configure the routers such that R2 uses its GO/0 interface to reaches network 1.0.0.0
/8, whereas, R4 uses the frame-relay cloud to reach network 2.0.0.0/8, .

Configuration
Complete these steps:

Step 1 R4 configuration.

R4 {configl#ip route 2.0.0.0 255.0.0.0 s0/0/0,42

Step 2 R2 configuration.

B2 (configl#ip route 4.0.0.0 255.0.0.0 go/0

Verification

Rd #show ip route static
=3 2.0.0.0/8 is directly connected, Serial0/0/0.42

B2 §#show ip route static
58 4.0.0.0/8 is directly connected, GigabitEtherneto/d
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Task 2
Configure uRPF on R2's Frame-relay interface

Configuration
Complete these steps:

Step 1 R2 configuration.

RZ (config)#int 50/1/0.24
R2 (config-subif}# ip verify unicast scurce reachable-via rx

Hote that there is also an old format command which basically do the
same “"ip verify unicast reverse-path”. However, Cisco recommeands

using a new command when confiquring uRFF.

Veri n

R2#show ip inter s0/1/0.24 | b IF verify
IPF verify source reachable-via RX
0 verification drops

0 suppressed verification drops

0 verification drop-rate
Hote with URFF enabled, the local router (R2) will compare the source IP
address of all packets received te its routing table. This is done te ensure
that they arrive on the bast path interface, meaning that the closest interface
back te the scurce. If the check fails, the packets are dropped, if the check

passes, the packets are processed.

Rédping 2.2.2.2 source lol

Type escape sequence to abork.
Sending 5, 100-byte ICMP Echos to 2.2.2.2, timeout is 2 seconds:
Packet sent with a source address of 4.4.4.4

Success rate is 0 parcent (0/5)

R2#show ip inter 50/1/0.24 | b IP verify
IF verify source reachable-via RX
5 wverification drops
0 suppressed verification drops

0 verification drop—rate

Page 504 of 507



CCIE SECURTY vd Lab Workbook

Kote the ping failed because the socurce IF address of the ICMF Echo message is
4.4.4.4 and from R2's perspective these packats should have arrived through its
&0/0 interface and WOT the Frame-relay interface.

To test the configuration further:

R2 (config)#accesa=1iat 100 permit ip any any log=input

B2 [config)#int g0/ 0
B2 {config-if)#ip access-group 100 in

RZ (config=-if)#int =0/1/0.24
R2 (config-subif) #ip access-groip 100 in

In order te show the scurce/destination IF addresses and the interfaces, the
above access-list is configured with “"log-input” and applied to both 30/1/0.24

and G0/0.

Rddping 2.2.2.2 scurce lod

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 2.2.2.2, timecut is 2 seconds:
Packet sent with & source address of 4.4.4.4

Success rate is 0 percent (0/5)

Tou should ses the fellowing message on R2's consola:

ASEC-6- IPACCESSLOGDP: list 100 permitted icmp 4.4.4.4 (SerialdS1/0.24 ) -» 2.2.2.2
(0/0), 1 packet

Hota the cutput of the following command shows that R2 expects the traffic from
4. 4.4.4 to come through its &0/0 and HOT 20/1/0.24 interface; therefore, it

drops the packets.

RZ#sho ip route static
8 1.0.0.0/8 is directly connected, GigabitEthernsti/0

Task 3

Configure R2 such that it allows ingress traffic from network 1.0.0.0 /8 through any
interface. DO NOT modify the routing table or remove the “ip verify unicast source
reachable-via rx" command to accomplish this task.

Page 505 of 507



CCIE SECURTY vd Lab Workbook

Configuration
Complete these steps:

Step 1 R2 configuration.

Hote te accomplish this task, an access-list is cenfigured te permit
all traffis from netwerk 1.0.0.0 /8 and tied to the “ip wverify
unicast scurce reachable-via rx" command. The conditien of the
access-list is checked OHLY when the condition of URFF fails, IF THE
CONDITION OF URFF IS SUCCESSFUL, THE ACCESS-LIST IS5 HWOT CHECEED.

RZ (config)#int =0/1/0,.24
HEZ (config-subif)# ip werify unicast source reachable-via rx 104

R2 {config) #access-list 104 permit ip 4.0.0.0 0.255.255.255 any

Verification

Ri#sh ip int 50/1/0.24 | be IP verify
IP verify source reachable-via RX, ACL 104
10 verification drops
0 suppressed verification drops
0 wvarification drop-rate

Rd#ping 2.2.2.2 source lod

Type escape seguence to abort.

Sending 5, 100-byte ICMP Echos to 2.2.2.2, timeout is 2 seconds:
Packet sent with a source address of 4.4.4.4

1nin

Success rate is 100 percent (5/5), round-trip minfavg/max = 1/2/4 ms

Hote you should sese the following message on R2's console:

$SEC-6-IFRCCESSLOGDP: list 100 permitted icmp 4.4.4.4 (Seriald/1/0.24 ) —> 2.2.2.2
{0/0), 5 packets

BZf#sh ip int =20/1/0.24 | ba IP verify
IP verify source reachable-—via R¥, ACL 104
10 verification drops
5 suppressed verification drops
0 wverification drop-rate
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Task 4

Re-configure R2 based on the previous conditions such that ONLY ICMP packets are
allowed through any interface, all other traffic from this network MUST come through
GO0/0 interface, if they don't, they should be dropped.

Configuration
Complete these steps:

Step1 R2 configuration.

R2 (config) #H0 access-list 104

RZ (config) #access—1ist 104 permit dicmp 4.0.0.0 0.255.255.255 any

Verification

Ridfdping 2.2.2.2 source lod

Type escape segquence to abort.

Sending 5, l00-byte ICMPF Eches to 2.2.2.2, timeocut is 2 seconds:
Packet sent with a source address of 4.4.4.4
i

Success rate is 100 percent (5/5), round-trip minfavg/max = 1/2/4 ms

Hote the IOMP traffic works fine, whereas, the following TCP traffic failed.

Bdltel 2.2.2.2 fso loD
Trying 2.2.2.2 ...

% Connection timed out; remote host not responding

R2§
¥SEC-6-TPACCESSLOGE: list 100 permitted tcp 4.4.4.4(0) (Serial0/1/0.24 } => 2.2.2.2(0),
1 packet

R2é#sh ip int 80/1/0.24 | ba IF wverify
IP verify source reachable-—via R¥, ACL 104

1% werification drops
10 suppressed verification drops
0 verification drop-rate
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